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Preface

As companies continue to integrate computer technology into their business operations,
it becomes increasingly important to properly administer the IT function, particularly
with respect to performance and cost.

CIMS Server provides an essential component of an effective financial management
system. The technology behind CIMS Server is based on CIMS Lab’s many years of
experience in the development and implementation of Resource Accounting, Capacity
Planning, and IT Chargeback products.

About CIMS Lab

Founded in 1974, CIMS Lab has focused on meeting the financial and resource reporting
requirements of Information Services Departments. CIMS has evolved with corporate IT
management requirements. Focused commitment to client service and support sets
CIMS apart from competing products. Our goal is to provide the best chargeback and
resource reporting software in the world at the lowest possible cost to our customers.

CIMS Lab strongly believes in and executes the concept of continuous product
improvement. Customers have access to CIMS product development personnel to
ensure that customer feedback and other critical issues are incorporated into the next
release of the product.
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Contacting CIMS Lab

To contact CIMS Lab with questions, comments or problems, please use one of the

B xvi

following methods:
For product assistance or information:

USA & Canada, toll free - (800) 283-4267
International - (916) 783-8525

FAX - (916) 783-2090

World Wide Web - http://www.cimslab.com

Mailing Address:

CIMS Lab, Inc.
3013 Douglas Blvd., Suite 120
Roseville, CA 95661-3842
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About This Guide

This guide describes the installation procedures and administration functions and
features of CIMS Server.

The following table describes the chapters in this guide. If you are installing and setting
up CIMS Server for the first time, you should begin with Chapter 1, About CIMS Server
and then continue to Chapter 2, Installing CIMS Server and Getting Started before
continuing to the other chapters in the guide.

Ch.

No. Chapter Name Content Description

1 About CIMS Server Describes the overall structure and feature set of the
CIMS Server system.

2 Installing CIMS Server Discusses the installation of the CIMS Server system
and Getting Started components and provides a Getting Started section.
3 Setting Up the System Explains how to configure the various components of
the system.
4  Report Administration Describes how to administer and distribute reports.

5 Database Administration — Describes how to use CIMS Server Administrator to
create and administer CIMS Server databases.

6  Processing Data Provides an overview of the data processing cycle and
components and describes how to use CIMS Server
Administrator to set processing options.

7 Working With CIMS Describes CIMS Financial Modeler. This Web-based
Financial Modeler application provides an interface for performing IT
finance-related tasks, such as cost analysis and
allocation and rate calculation.

8  Troubleshooting and Describes problems you may encounter while setting
Additional Information up and using the CIMS Server system and how to solve
them.
A Database Tables Describes the layout of key database tables used by
CIMS Server.
B File Layouts Describes the file layout of important files used by the
CIMS Server system.
C  Scripts Describes the scripts that are included in the CIMS
Server installation.
D  Control and Processing Describes the control and processing statements used
Statements by CIMS Processing Engine.
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Conventions

Some or all of the following conventions appear in this guide:

Symbol or

Type Style

Represents

Example

Alternate hyperlinked cross-references to  ...see Chapter 1.
color other sections or chapters in this
guide; if you are viewing this
guide online, you can click the
cross-reference to jump directly
to its location
Italic words that are emphasized ...the entry after the current entry...
a new term ...called a source object.
the titles of other manuals CIMS Server Web Reporting User's
Guide
variables in file names or system [USR_computername
names
AcctExcp-yyyymmdd. txt
Bold names of interface items such as  Select the Use 13 Periods check box
tabs, boxes, buttons, lists, and .
check boxes. Enter the path in the Process
Definition Path box
Monospace directories, file names, command Processes folder
names, computer code, computer BatchReport . wsf script
screen text, system responses,
command line commands, what Type inetmgr
the user types
<> the name of a key on the Press <Enter>
keyboard
» navigating a menu or a folder File » Import » Object

Terminology: Reports, Spreadsheets, and Graphs

For simplicity, in this guide, the term “report” refers to reports, spreadsheets, and graphs.

Related Publications

As you use this guide, you might find it helpful to have these additional guides available
for reference:

m CIMS Server Web Reporting User's Guide
m CIMS Data Collectors for Microsoft Windows Installation and User Guide
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About CIMS Server

This chapter describes the overall structure, benefits, and features of the CIMS Server

system.

WHhat IS CIMS SEIVEI? ...uiniiiiiiiieieieienereeneuseeecsesesesssssasesscsssasasassssanns 1-2
Benefits Of CIMS Server . ... ... o e 1-4
System Features . ... ... .. . e 1-4
CIMS Data ColleCtOrS ..o vvtiiriteitiieieeeeiaeieeessasessssasssssssssessssssscassssssens 1-5
CIMS Data Collectors for WINdOWS ......... .. i i 1-5
CIMS Mainframe Data Collector and Chargeback System ................. .. ... ... ..... 1-6
CIMS Data Collector for UNIX . . . ... oo e 1-7
AbOUt CSRaNA CSRHFleS ....oviiiuiiiiiiiiiiiiiiiiiieitiiiiiieieneienesececncncncnenns 1-8
CIMS Server System COmponent OVerVIEW ........cocivuiiieieninienencneenecncenencncns 1-9
CIMS Server Application SEIVEr . ... ... e 1-9
Database SErVer . . ... ... 1-11
WD SOV .o 1-12
CIMS Server System Architecture Diagram .......... ... oot 1-14
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What Is CIMS Server?

What Is CIMS Server?

CIMS Server is a full-featured resource accounting and chargeback system that enables
users to consolidate accounting data from multiple IT resources into a common output
format for costing and reporting. This output is database ready and may be used for
multiple purposes such as reporting and as a feed to internal or third-party systems.

CIMS Server tracks usage data associated with:

Operating systems
Databases
Network systems
Storage systems
Internet systems
E-mail systems

Other applications or monitors that create usage metering data

As shown in Figure 1-1 on page 1-3, it is useful to think of CIMS Server as a funnel that
accepts usage data and returns organized information that can help IT managers and staff
to track and allocate resources.
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Spreadsheets
Reports
Graphs

HTML

Resource Cost Chargeback
Usage Allocation and Billing

Figure 1-1 « CIMS Server Collects Usage Data and Organizes It As Reporting Information
CIMS Server runs on the Microsoft® Windows® 2000 Server, Windows Server 2003, or

Windows XP operating system with any of the Database Management Systems (DBMS)

described in Database Server on page 1-11 and a Microsoft Internet Information Services
(IIS) Web server.
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Benefits of CIMS Server

Keeping track of IT usage can be a formidable task for any organization. Most sizable
enterprises consist of many platforms, systems, and subsystems, each costly to own,
maintain and operate. In addition, each component has its own unique record format
and metrics.

With CIMS Server, you can process, access, and analyze IT resource usage metrics from
many IT resources and view the results right in your Web browser. CIMS Server helps you
to better understand who is using IT resources and how the resources are being used.

The following are just a few of the benefits of CIMS Server:

m Enterprise-wide cost analysis of IT systems. CIMS Server enables enterprise-wide
cost analysis of IT systems. CIMS Server allows you to allocate, distribute, or charge
IT costs to users, cost centers, and organizations in a manner that is fair,
understandable, reproducible, and easy to administer.

m Centralized data processing. CIMS Server centralizes the processing of your
accounting data on one computer and allows you to view the data on the Web via
extensive customizable reporting features. It is possible to view both high-level and
detailed information with a few clicks of a mouse.

m Full data access and reporting capabilities. CIMS Server integrates Microsoft SQL
Server Reporting Services or Crystal Reports with an ODBC-compliant database to
give your enterprise full data access and reporting capabilities.

System Features
CIMS Server features include:
m Report, spreadsheet, and graph generation and viewing via the Web.

m Batch processing and report generation. (You can also run processes and reports
individually.)

m Multi-level drill down capabilities to view detailed cost and usage information in
reports.

m Integration with the CIMS Data Collectors for Windows, Mainframe, and UNIX®/
Linux® systems.

m Up to 128-byte account code with powerful account code conversion.
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CIMS Data Collectors

CIMS Data Collectors read and convert usage metering data generated by applications
(usually standard usage metering files such as log files) and produce a common output
file that is used by CIMS Server.

CIMS Data Collectors include the following individual data collection applications:
m CIMS Data Collectors for Microsoft® Windows®

m CIMS Mainframe Data Collector and Chargeback System

m CIMS Data Collector for UNIX

The following sections provide a brief overview of these data collectors and describe the
files that the collectors produce for CIMS Server.

CIMS Data Collectors for Windows

The CIMS Server installation includes the option of installing CIMS Data Collectors for
Windows. (Contact CIMS Lab for licensing requirements.) These collectors run on the
Windows operating system, but collect usage data from Windows and Windows-
compatible applications (including older Windows operating systems such as
Windows NT®) and non-Windows applications and operating systems. For more
information about CIMS Data Collectors for the Windows, refer to the CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

Each Windows collector collects usage data for a specific application or system and
converts the data to an input file, the CIMS Server Resource (CSR) file, that can be
processed by CIMS Server or CIMS Mainframe Data Collector and Chargeback System.

The CSR file contains comma-delimited records that show the resource or resources that
were consumed and an identifier or identifiers that denote the source of the resources.
For more information about this file, see About CSR and CSR+ Files on page 1-8.
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CIMS Mainframe Data Collector and Chargeback System

CIMS Mainframe Data Collector and Chargeback System provides comprehensive job
accounting, chargeback, resource utilization, and system performance reporting for
mainframe systems including z/OS®, OS/390®, MVS, CICS®, DB2®, VSE, storage
systems/SAN and many more.

You can use CIMS Mainframe to perform all of your mainframe data processing and
reporting or you can perform all or part of your processing and reporting using CIMS
Server. This flexibility enables you to view your mainframe data using CIMS Server’s
powerful Web-based reporting and report drill down capabilities.

CIMS Mainframe Data Collector and Chargeback System produces the following files for
integration with CIMS Server. The files differ depending on whether CIMS Server is used
to perform the processing and reporting of mainframe data or just reporting.

m CIMS Server Resource (CSR) file. This file is produced by CIMS Mainframe 11.6 and
earlier. The CSR file requires processing by CIMSAcct and CIMSBill in CIMS Server
before it can be loaded into the CIMS Server database. For more information about
this file, see About CSR and CSR+ Files on page 1-8.

Or

m CIMS Server Resource Plus (CSR+) file. This file is produced by CIMS Mainframe
12.0 and later. The format of the CSR+ file is the same as the CSR file, with the
exception that the records in the CSR+ file contain an additional header at the
beginning of the record. For more information about this file, see About CSR and
CSR+ Files on page 1-8.

The CSR+ file requires processing by CIMSAcct and CIMSBill in CIMS Server before it
can be loaded into the CIMS Server database.

Or

m CIMS Ident, Detail, and Summary files. These files are produced by CIMS
Mainframe 12.0 and later. These files do not require processing by CIMSAcct and
CIMSBIll. They are loaded directly into the CIMS Server database. For more
information about these files, see Chapter 6, Processing Data and Appendix B, File
Layouts.

For more information about the creation of these files and about data collection and
processing using CIMS Mainframe, refer to the CIMS Mainframe Data Collector and
Chargeback System User Guide.

For more information about integrating these files with CIMS Server, refer to the CIMS
Data Collectors for Microsoft Windows Installation and User Guide.
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CIMS Data Collector for UNIX

CIMS Data Collector for UNIX collects usage data for UNIX/Linux systems including
databases such as Oracle and DB2 and other software. CIMS UNIX collects data such as
disk storage, CPU time, connect time, 1/Os, pages printed, and user sessions.

CIMS Data Collector for UNIX produces the CIMS Server Resource (CSR) file, which can
be processed by CIMS Server or CIMS Mainframe Data Collector and Chargeback
System. For more information about this file, see About CSR and CSR+ Files on page 1-8.

For more information about the creation of the CSR file and about data collection using
CIMS UNIX, refer to the CIMS Data Collector for UNIX User Guide.

For more information about integrating the CSR file with CIMS Server, refer to the CIMS
Data Collectors for Microsoft Windows Installation and User Guide.
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About CSR and CSR+ Files

CSR files are created by CIMS Data Collectors for Windows, CIMS Data Collector for
UNIX, and CIMS Mainframe Data Collector and Chargeback System (11.6 and earlier).
CSR files can also be created by many other third-party applications.

CSR+ files are created by CIMS Mainframe Data Collector and Chargeback System 12.0
and later.

The format of the CSR and CSR+ file records is the same, with the exception that the
records in the CSR+ file contain an additional header at the beginning of the record.

For a complete description of the CSR and CSR+ file formats, see Appendix B, File Layouts.

Key pieces of information in the CSR and CSR+ records include the identifiers and
resources. All CIMS Data Collectors define the most useful identifiers and resources to
be collected from the usage data and provide this information in the records of the
output CSR or CSR+ file.

For example, the CIMS Data Collector for Microsoft Exchange Server produces CSR
records with one identifier and four resources as shown in the following example
records:

Exchange, 20060916, 20060916,01:00:47,01:00:47,,1,User, " joe" 4, EXEMRCY, 1, EXBYRCY, 3941, EXEMSNT 0, EXBYSNT, 0
Exchange, 20060916, 20060916,01:00:47,01:00:47, ,1,User, "mary" 4, EXEMRCV, 1, EXBYRCV, 3863, EXEMSNT, 0, EXBYSNT , 0
Exchange, 20060916, 20060916,01:00:47,01:00:47, ,1,User, " joan", 4, EXEMRCV, 1, EXBYRCV, 2748, EXEMSNT 0, EXBYSNT ,0

The identifier name, User, is followed by the identifier value designating the ID of the
user who consumed the resources. Examples of other identifier names and values that
might appear in a CSR or CSR+ record are those that designate device name, server name,
system ID, job name, user ID, phone number, state code, or building number.

The resources consumed are designated by the rate codes EXEMRCV (e-mails received),
EXBYRCV (bytes received), EXEMSNT (e-mails sent), and EXBYSNT (bytes sent).

Processing Identifiers and Resources (Rate Codes)

All identifiers and resources in the CSR or CSR+ records must be defined in the CIMS
Server database. However, the process for defining identifiers and resources differs.

Resource rate codes require a monetary value and other user-defined options that must
be defined before the CSR or CSR+ records are processed. CIMS Lab pre-loads the rate
codes produced by many of the data collectors (including the Exchange Server rate codes
in the preceding example) in the CIMSRate table. You can then use CIMS Server
Administrator to modify the monetary value and other options for the rate codes for
your site as described in Working With Rates on page 3-9.

Note ¢ The rate codes for some collectors are not pre-loaded in the CIMSRate table
and must be added. To determine whether the rate codes for a specific collector are
pre-loaded, refer to the documentation for that collector.

Because identifier names and values do not require additional definition, you do not
need to define the names and values for CIMS Server before the CSR or CSR+ records are
processed. Identifier names and values in the records are automatically defined in the
CIMSIdent table when the CSR or CSR+ file is processed.
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CIMS Server System Component Overview

The CIMS Server system is composed of the following components:
m The CIMS Server application server

B A database server

m A Web server

You can install all components on one server or on separate servers. The most common
configuration is to have CIMS Server and the Web server on one server and the database
on a second server. For more information, see CIMS Server System Components on

page 2-3.

The following sections describe each of the CIMS Server system components.

CIMS Server Application Server
The CIMS Server application server contains the following key components:

m CIMS Processing Engine

m CIMS Server Administrator

CIMS Processing Engine

CIMS Processing Engine is a fast, efficient data processing engine capable of processing
and applying business rules to large volumes of data. CIMS Processing Engine consists
of multiple programs. The four main programs are CIMSAcct, CIMSSort, CIMSBill, and
CIMSAdminLib:

m CIMSAcct processes the input sources provided by CIMS Data Collectors (see CIMS
Data Collectors on page 1-5) and performs functions such as account code conversion.
CIMSAcct produces an output file containing records that are properly formatted for
input into CIMSBill.

m CIMSSort sorts output from CIMSAcct and produces a sorted file that is ready to be
processed by CIMSBill.

m CIMSBill processes the output from CIMSAcct and builds output files that contain the
billing information that is used to generate invoices and reports.

m CIMSAdminLib contains the class CCIMSCBSLoad that loads the output files from
CIMSAcct and CIMSBill into the CIMS Server database. CIMSAdminLib is the central
controlling library for all Windows-based CIMS Server functions. It contains all the
COM objects used to manipulate CIMS data.

For more information about CIMS Processing Engine, see Chapter 6, Processing Data.

CIMS Server’s powerful data processing capability provides all the data needed to
produce complete and detailed reports, spreadsheets, and graphs. The actual generation
of reports, however, is completed by SQL Server Reporting Services or Crystal Reports
(see Web Server on page 1-12).
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CIMS Server Administrator

CIMS Server Administrator is the administration tool for the CIMS Server system. This
Windows-based GUI application allows the system administrator and CIMS Server
administrators to configure and maintain the information contained in the CIMS Server
database such as rates, users and groups, clients, system configuration settings, and
processing and reporting settings. CIMS Server Administrator also enables

administrators to perform real-time processing.

ans CIMSServer, - CIMS Administrator
File Wiew Help

CIMS

Server

i on Options
Chargeback Sdministration
£3 Chargeback Takle Maintenance
B Clients
[ Rate Codes
[ Rate Groups
B Table Manager
B Account Code Structure
B Calendar
B £3 Processing
* £3 Database Loading
£3 System Administration
B CIMS Data Source Maintenance
23 Database
B Configuration Information
[ Identifiers Maintenance
£3 Users and Groups
£3 Reporting
B Event Viewer

ClSServer -

Figure 1-2 « CIMS Server Administrator Main Window
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The following table shows the administrative tasks performed by the system
administrator and the CIMS Server administrator.

System Administrator Tasks CIMS Server Administrator Tasks

m Defining and configuring the CIMS m Defining account code structures

Server database ) o )
m Creating and maintaining rate, client,

m Selecting the Open Database and calendar definitions

Connectivity (ODBC) Data Source .
m Defining CIMS Server users and groups

m Creating, adding, and dropping ) ) )
database tables m Setting reporting options

m Configuring the CIMS Server system

m Creating, adding, and dropping ;
settings

database objects

m Loading and exporting data to and

m Performing database backup f be datab
rom the database

procedures

m Defining and categorizing input W Setting processing options

sources m Executing processing jobs

m Scheduling input selection m Setting CIMSAcct and CIMSBill options

Database Server

The database stores administration information as well as the Ident, Detail, and
Summary records that are produced by CIMS Processing Engine (see Chapter 6, Processing
Data, for more information about these records). These records are used by SQL Server
Reporting Services or Crystal Reports to provide robust Web reporting.

The DBMS that you can use with CIMS Server depends on the edition of CIMS Server that
you are using as discussed in the following sections.

CIMS Server Enterprise Edition

If you are using CIMS Server Enterprise Edition, you can use any of the following
databases:

B Microsoft SQL Server 2000 or 2005.
m Oracle 9 (UNIX or Windows). If you are using Oracle 10, contact CIMS Lab.
m DB2 8 (Universal Database for z/OS)

m MSDE 2000. MSDE 2000 is included with the CIMS Server installation. However, the
use of MSDE has some disadvantages as discussed in CIMS Server Professional Edition.

Note * SQL Server Reporting Services is not available for MSDE. In addition, CIMS
Server 4.3 does not support the use of Reporting Services with a DB2 database.

CIMS Server Administrator's Guide 1-11 N



B About CIMS Server

CIMS Server System Component Overview

CIMS Server Professional Edition

CIMS Server Professional Edition requires MSDE 2000. The use of MSDE provides the
following advantages and disadvantages:

Advantages

m No additional cost—MSDE 2000 is included with the CIMS Server installation
m Easy upgrade path from MSDE to Microsoft SQL Server

Disadvantages

m Limit of 2 GB of storage

m Limit of two processors per computer

® Limited administrative tool

m Does not support SQL Server Reporting Services

Web Server

H 1-12

The Web server contains the following key components:

m IS and the reporting application as follows:

If you are using Crystal Reports, IIS and Crystal Reports must be installed on the same
server.

If you are using SQL Server Reporting Services, IIS can be on the same server or on a
separate server than Reporting Services. Regardless of which server you choose to
install Reporting Services on, the server must have SQL Server 2000 or 2005 installed.
For more information, see Installing SQL Server Reporting Services on page 2-18.

Note ¢ SQL Server Reporting Services is not available for MSDE. In addition,
CIMS Server 4.3 does not support the use of Reporting Services with a DB2
database.

m CIMS Server Web Reporting
m CIMS Financial Modeler

CIMS Server Web Reporting

The CIMS Server Web Reporting application provides comprehensive cost accounting,
chargeback, and resource reporting in an easy-to-use, browser-based environment. CIMS
Server Web Reporting includes the following features that ensure that users receive the
data they need in a clear, user-friendly format:

m Drill down. CIMS Server Web Reporting invoices and many other reports include
drill down that enables users to view detailed cost and usage information.
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m Multiple report formats. CIMS Server Web Reporting provides reports in report,
graph, and spreadsheet format.

m User customization options. CIMS Server Web Reporting users can set up their own
list of favorite reports, spreadsheets, and graphs. Users can also create reports “on-the-
fly” within the CIMS Server Web Reporting Web site and publish reports for review
by other users.

CIMS Server Web Reporting works with both SQL Server Reporting Services and Crystal
Reports. Both tools provide a feature-rich environment for creating Web-based and
paper reports. However, a benefit of SQL Server Reporting Services is that it is provided
with your SQL Server 2000 or 2005 license (for more information go to http://
www.microsoft.com/sql/reporting/howtobuyy/).

Note  SQL Server Reporting Services is not available for MSDE.

CIMS Server includes standard reports written in both Crystal Reports and the Report
Definition Language (RDL) for SQL Server Reporting Services. RDL is an XML-based
industry standard used to define reports.

Your report developer can use these standard reports as templates to create custom
reports for your organization. Reports created specifically for your organization are
referred to as “custom reports” in this guide to differentiate them from the CIMS
standard reports.

For more information about CIMS Server Web Reporting, including descriptions of the
standard reports that are provided with CIMS Server, refer to the CIMS Server Web
Reporting User’s Guide.

CIMS Financial Modeler

CIMS Financial Modeler provides a browser-based interface for performing IT finance-
related tasks, such as cost analysis and allocation and rate calculation. For more
information about CIMS Financial Modeler, see Chapter 7, Working With CIMS Financial
Modeler.
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CIMS Server System Architecture Diagram

Figure 1-3 shows the most common system configuration in which CIMS Server and the

Web server are on one server and the database is on a separate

server. For a detailed list

of hardware and software specifications required for the CIMS Server system, see

page 2-4.

CIMS Server Application Server/
Web Server

Server specifications: Server specifications:

* 30 GB hard drive space * 80 GB hard drive sp:
e 3 GHz processor
« 2 GB memory

processors are helpfi
« 2 GB memory
o SQL Server clusters
supported

Windows Server
2000 or 2003

CIMS Data
Collectors

Crystal Reports or
SQL Server
Reporting Services

CIMS Processing

o 3 GHz processor (multi-

Processes data/loads the DB

Database Server

ace

ul)

SQL Server

2000/2005

Oracle 9/10
DB2 8

1

~ Engine
Windows Terminal emulation software CIMS Server Administers the DB
Administrator
OR

S Performs cost analysis and other
CIMS Financial financial tasks
Modeler
(I B |

CIMS Server
Administrator

CIMS Server Reports data
Internet Web Reporting
Explorer

Administrator

Internet Internet Internet
Explorer Explorer Explorer

End User End User End User

Figure 1-3 « Example CIMS Server System Architecture
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This chapter provides installation, configuration, and upgrade procedures for the CIMS
Server system. This chapter also provides a Getting Started section to help you to quickly
set up the system.

CIMS Server System COMPONENES .......iuiiiiiiitiirieirieeierecsasessassnssssossnsens 2-3
Suggested Software and Hardware ..........c.ccoeiiiiiiiiiiiiiiieiiieienienecneenencnens 2-4
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Installing ASP.INET . .. . 2-17
Enabling ASP.INET ... ... 2-17
Installing SQL Server Reporting SrVICeS .......cevuiiiieieieiiieieeieneneieiesececncnenes 2-18
About Licensing Reporting Services . .......... .o e 2-18
Overview of Reporting Services COmponents . ...ttt iiinnneennn... 2-18
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Installing Reporting SErviCes . ... ...t e e 2-20
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Start CIMS Server Web Reporting . ... e 2-80
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CIMS Server System Components

Note ¢ For an overview of the CIMS Server system architecture,
see Chapter 1, About CIMS Server.

The CIMS Server system is composed of the following hardware/software components:

m CIMS Server application server. Contains the CIMS Server application (includes the
Processing Engine and Administrator components).

If you are using an Oracle database, the Oracle Client must be installed on this server.
The client installation includes OO40 (Oracle Objects for OLE), which is required to
access the database.

m Database server. Contains an ODBC-compliant database (see Server Specifications on
page 2-4).

m Web server. Contains Microsoft IIS, CIMS Server Web Reporting, and other CIMS
Web applications. If you are using Crystal reports for reporting, Crystal Reports must
also be installed on this server. If you are using SQL Server Reporting Services reports
for reporting, Reporting Services can be installed on any server that has SQL Server
2000 or 2005 installed (see Installing Reporting Services on page 2-20).

If you are using an Oracle database, the Oracle Client must be installed on this server.

You can install all components on one server or on separate servers. The most common
configuration is to have CIMS Server and the Web server on one server and the database
on a second server (see example Figure 1-3 on page 1-14). In general, a configuration
involving multiple servers might offer users better performance.

Note ¢ If you install the CIMS Server application server and Web server on separate
servers, you need to install CIMS Server Administrator on the Web server (see Install
CIMS Server Administrator and CIMS Web Applications on the Web Server (If Using a
Separate Server) on page 2-66).

In addition, the system might include multiple clients containing the CIMS Server
Administrator application, terminal emulation software such as Microsoft Terminal
Services, or both.

If you have questions regarding setting up and configuring the CIMS Server system for
your organization, contact CIMS Lab.
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Suggested Software and Hardware

CIMS Lab recognizes that different organizations have unique existing enterprise systems
in place. As a result, this section describes suggested specifications, not absolute, rigid system
requirements. It is possible that CIMS Server can be run on components not matching
these suggestions, although the system was developed with these specifications in mind.

If you have any questions regarding compatibility of your existing system with
CIMS Server, contact CIMS Lab.

Server Specifications

The following are the suggested server specifications for the CIMS Server system. The
specifications reflect a two server configuration in which CIMS Server and the Web server
are on one server and the database is on another server. However, all components can
be on one server or each component can be on a separate server.

CIMS Server Application Server/Web Server

m Microsoft Windows 2000 Server or Windows Server 2003 with the latest service pack.

Note ¢ If the Web server is on a computer running Microsoft Windows XP
(unlikely), you might receive errors when you attempt to run reports from the
CIMS Server Web Reporting Web site.

® Microsoft IIS 5.0 or later (included with Windows 2000 Server and Windows
Server 2003).

® Microsoft SQL Server Reporting Services (included with SQL Server 2000 and 2005,
see I[nstalling SQL Server Reporting Services on page 2-18).

Note ¢ SQL Server Reporting Services is not available for MSDE. In addition,
CIMS Server 4.3 does not support the use of Reporting Services with a DB2
database.

Or

m Crystal Reports (see the following note).

Note ° If you are using a SQL Server database, CIMS Server supports Crystal
Reports 8.5 Developer Edition, Crystal Reports 9 and 10 Advanced Edition, and
Crystal Reports XI Server Edition.

If you are using an Oracle or DB2 database, CIMS Server supports Crystal Reports
9 and 10 Advanced Edition and Crystal Reports XI Server Edition and Developer
Edition.
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® Microsoft .NET Framework 1.1 (you can install the .NET Framework during the
installation of CIMS Server or you can download it from the Microsoft Web site [see

page 2-11]).

m ASP.NET (included with Windows 2000 Server and Windows Server 2003, see
Installing and Enabling ASP.Net on page 2-17).

B Java" 2 Standard Edition Runtime Environment (JRE) 1.5 (required by CIMS Web
Console and CIMS Integrator, installed by default during the CIMS Server
installation)

For more information about CIMS Web Console, see Setting Up and Starting CIMS
Web Console on page 2-82. For more information about CIMS Integrator, refer to the
CIMS Data Collectors for Microsoft Windows Installation and User Guide.

m Apache Tomcat 5.5 (required by CIMS Web Console, installed if CIMS Web Console
is selected for installation)

m Oracle Client (if you are using an Oracle database)
m 30 GB available hard drive space.

B 3 GHz processor.

m 2 GB of memory.

Database Server

m Any of the following DBMS platforms:

e Microsoft SQL Server 2000 or 2005 with the latest service pack.

Note ¢ CIMS Server supports SQL Server clusters. A cluster refers to a group of
two or more servers that work together and represent themselves as a single
virtual server to a network.

e Oracle 9 or 10 (UNIX or Windows).

Note ¢ CIMS Server supports only native Oracle drivers for Oracle. Contact
CIMS Lab for information about using Microsoft or other drivers.

e DB2 8 (Universal Database for z/OS)

e MSDE 2000. MSDE 2000 is included with the CIMS Server installation. However,
the use of MSDE has some disadvantages as discussed in CIMS Server Professional
Edition on page 1-12.

m 80 GB available hard drive space (depending on particular data requirements).
m 3 GHz processor (multi-processors are helpful).

B 2 GB of memory (additional memory is helpful).
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If You Are Installing CIMS Server on Multiple Computers

If you install CIMS Server components on multiple computers, consider the following:

If you are running CIMSAcct or CIMSBIll on a client and the database is on a server,
the data is stored in the database but physical processing occurs on the client. This
can result in slower performance because large amounts of data need to be transferred
over the network during processing. CIMS Lab recommends that you perform all
CIMSAcct or CIMSBIll processing directly on the server using terminal emulation
software.

If the CIMS Server Administrator application on each computer (server or client)
points to the same database, you should assign a share to the ...CIMSLab\Processes
and ...CIMSLab\Server\Reports<type> folders and use a Universal Naming
Convention (UUNC) name for the paths to the folders (see Enter CIMS Server
Configuration Settings on page 2-59). The use of logical drive names is not
recommended when using multiple computers.

If you use a UNC for the Reports<type> folder, CIMS Lab recommends that the folder
is located on the Web server. In addition you need to assign the following folder
security or share permission for the Windows account that the CIMS Server Web
Reporting Web site is running under:

e [If the Web site is running under the local ASPNET or NETWORK SERVICE system
account, you need to assign a security permission of Read and Write. To set the
permission:

a Right click the report folder, and click Sharing and Security.

b On the Security tab, add the ASPNET or NETWORK SERVICE account and select the
Read and Write permissions.

e Ifthe Web site is running under one or more Windows user or group accounts, you
need to assign a share permission of Read for each account. To set the permission:

a Right click the report folder, and click Sharing and Security.
b On the Sharing tab, click Permissions.
¢ Add the user/group accounts and select the Read permission for each account.

Note that user or group accounts rather than the local ASPNET or NETWORK SERVICE
account are used only if <identity impersonate="true"/> is added after the end of
authorization element in the Web.config file as follows:

<authorization>
<allow users="*"/> <!-- Allow all users -->

<I-- <allow users="[comma separated 1ist of users]"
roles="[comma separated 1ist of roles]"/>
<deny users="[comma separated 1list of users]"

roles="[comma separated 1ist of roles]"/>
-->
</authorization>
<identity impersonate="true"/>

If you install CIMS Server in the default location, the Web.configfileisin C:\Program
Files\CIMSLab\Server\Web\CIMSReporting. For more information about the use of
this file, contact CIMS Lab.
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Client Specifications

The following are the specifications for installing CIMS Server Administrator on a client
(optional) and for viewing reports.

For Installing CIMS Server Administrator (Optional)

CIMS Server Administrator is a Windows-based GUI application that enables
administrators to create and maintain the administrative and processing settings for
CIMS Server. Administrators can access CIMS Server Administrator remotely using
terminal emulation software to connect to the application on the server (recommended)
or directly by installing CIMS Server Administrator on a client.

The following are the suggested specifications for installation on a client:
® Microsoft Windows 2000/2003/XP with the latest service pack.

m 40 MB available hard drive space.

m 400 MHz or faster processor.

m 128 MB of memory.

You can also install and run CIMS Processing Engine on a client. However, if possible, it
is recommended that you run CIMS Processing Engine on the server using terminal
emulation software to connect to the engine.

Important! ¢ Ifyou are using an Oracle database, the Oracle Client must be installed
on the client.

For Viewing Reports

The following requirements apply to computers used to view reports in CIMS Server Web
Reporting:

m Internet Explorer 5.5 or later on the Windows platform (if you are using Netscape
Navigator, contact CIMS Lab).

m Internet or network access with necessary security permissions.
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Report Design Specifications

The following are the specifications for designing Crystal and SQL Server Reporting
Services reports.

For Designing Custom Crystal Reports

The following are the suggested specifications for computers used to design custom
Crystal reports for use with CIMS Server:

Crystal Reports 8.5 or later (preferably the same edition that is on the Web server).

Note ¢ If you are using an Oracle or DB2 database, CIMS Server does not support
Crystal Reports 8.5.

Microsoft Windows 2000/2003/XP.
30 MB hard drive space minimum.

128 MB of memory.

For Designing Custom SQL Server Reporting Services Reports

The following are the specifications for computers used to design custom SQL Server
Reporting Services reports for use with CIMS Server:

Reporting Services Report Designer.

Microsoft Visual Studio .NET 2003 or another product that provides the Visual Studio
2003 shell (such as Visual Basic .NET 2003 or Visual C# .NET 2003).

SQL Server 2000 or 2005 with the latest service pack.
30 MB hard drive space minimum.

128 MB of memory.
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Pre-Installation Setup

Before you install CIMS Server, you should review the following sections to make sure
that you have all required third-party software licenses and have your system set up
correctly (including set up for internationalization if needed).

Third-Party Software Licensing Requirements

In addition to licensing CIMS Server, your organization must obtain the appropriate
licenses for the following products. These products are integral to the CIMS Server
system:

m Microsoft SQL Server, Oracle, or DB2 (note that this is not applicable if you are
using MSDE).

B Microsoft Windows 2000 Server or Windows Server 2003.

m SQL Server Reporting Services. Reporting Services requires a valid license for SQL
Server 2000 or 2005 (for license requirements, go to http://www.microsoft.com/sql/
reporting/howtobuy/).

Or

Crystal Reports.

Note * Use of Crystal Reports may require specific licensing based on the number
and type of users. For more information or clarification about licensing issues,
contact CIMS Lab.
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System Setup Checklist

Before installing CIMS Server, make sure that you have installed and configured the
components in the following list. Note that the Web server, database server, and CIMS
Server application server may be on one computer.

On the Web Server B Windows 2000 Server or Windows Server 2003.

m [IS 5.0 or later (included with Windows 2000 Server
and Windows Server 2003).

m Crystal Reports (if used for reporting).

m If SQL Server Reporting Services is used for reporting,
Reporting Services can be installed on the Web server
or another server. (Regardless of which server you
choose to install Reporting Services on, the server
must have SQL Server 2000 or 2005 installed.) See
Installing SQL Server Reporting Services on page 2-18
for the steps required to install Reporting Services for
CIMS Server.

m Oracle Client (if you are using an Oracle database)

m Open Web access (and FTP access if necessary). The
server must have Port 80 open for HTTP access by
other client computers in the organization.

On the Database Server B Microsoft SQL Server 2000 or 2005, Oracle 9 or later,
DB2 8, or MSDE 2000.

B Available database user ID (login) that has
permission to create tables, views, stored procedures,
and indexes.
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On the CIMS Server
Application Server

On All Servers

On All Clients Accessing
CIMS Server Web Reporting

On All Clients Running
CIMS Server Administrator
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Pre-Installation Setup

Windows 2000 Server or Windows Server 2003.
ASP.NET.

If you are using Microsoft Windows 2000 Server,
ASP.NET is installed by default as part of the IIS
installation.

If you are using Windows Server 2003, you need to
install and enable ASP.NET as described in Installing
and Enabling ASP.Net on page 2-17.

Microsoft .NET Framework 1.1.

You can install the .NET Framework during the
installation of CIMS Server (see page 2-24) or you
can download it from the Microsoft Web site, http://
v4.windowsupdate.microsoft.com.

If you download the .NET Framework, on the
Windows Update page, click Pick updates to install
and then click your operating system. Microsoft .NET
Framework 1.1 appears in the Recommended
Updates list if it is not installed on your system.

Oracle Client (if you are using an Oracle database)

Terminal emulation software such as Microsoft
Terminal Services or physical access to the server.

Servers are connected to the network and are visible
to each other—preferably on the same Windows
domain.

User has administrative access to the servers.

File share enabled (preferred) or FIP access to all
Servers.

If using CIMS Mainframe, FTP access from the servers
to the z/OS system and vice versa.

If using CIMS UNIX, FTP or Secure Shell access from
the servers to the UNIX system and vice versa.

Internet Explorer 5.5 or later on the Windows
platform.

Administrative authority on the client to install
CIMS Server Administrator.

2-11 H


http://v4.windowsupdate.microsoft.com
http://v4.windowsupdate.microsoft.com

B Installing CIMS Server and Getting Started

Pre-Installation Setup

On All Clients Running m Authority for the client computer and client user ID
Terminal Emulation Software to access the servers via terminal emulation software.

m Oracle Client (if you are using an Oracle database).

Other Tasks m Obtain the CIMS Server license key provided by
CIMS Lab. You will need to enter the license key in
CIMS Server Administrator after installation.

If you do not have your license key, contact CIMS
Lab.
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Internationalization Setup

Note ¢ The steps in this section are applicable if you are using a SQL Server database.
If you are using an Oracle or DB2 database, contact CIMS Lab for assistance in
localizing CIMS Server.

You can localize the following features in CIMS Server to reflect the language required
for your organization (the default is US English).

m Date and numeric formatting (such as numbers and currency) that appear in:
e The CIMS Server Web Reporting Web site
e CIMS Server Administrator
e Reports

m Headers and footers that appear in reports

You cannot localize the text that appears in CIMS Server Administrator or the Help text
in CIMS Server Administrator and CIMS Server Web Reporting. In addition, it is not
recommended that you change the text that appears on the CIMS Server Web Reporting
Web site. Changing this text requires changes to the Active Server Pages (ASP’) and
JavaScript code that runs the Web site.

Setting Up Your System for Internationalization

The language used by CIMS Server is determined by the following settings:

m The locale ID set in the Site Localization ID (LCID) box in the Configuration dialog
box (see Web Settings on page 3-49).

m On the Web server, the regional settings for the Crystal Reports services (see
page 2-14).

® On the CIMS Server application server, the language specified for the database ODBC
Data Source(s) used by CIMS Server (see page 2-15).

m On the server running CIMS Server Administrator, the regional settings for the
Windows user account logged on to the server (see page 2-15).

® On a client accessing CIMS Server Web Reporting, the regional settings for the
Windows user account logged on to the client (see page 2-15).

Important! ¢ To avoid unexpected results, make sure that all of the preceding
settings are set to the same language. If you want to use the same database to produce
Web reports in different languages, you need to set up a separate Web server and
repeat the steps in this section for each language.
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The following are the instructions for configuring internationalization settings for your
organization. In most cases, you will already have these settings set to the correct language. The
instructions are ordered by the component on which they are installed.

Note * Where individual steps are provided in the instructions, the steps reflect the
Microsoft Windows Server 2000 operating system. If you are using another operating
system, refer to the Microsoft documentation if needed.

On the Web Server

Set the Crystal RAS User Log On Account (Crystal Reports
9 or 10 only)

If you are using Crystal Reports 9 or 10, the Crystal RAS
uses the local system account for the Web server by
default.

If you do not want Crystal Reports to use the regional
settings for the local system account, you need to set the
log on to an account with the correct regional settings.
CIMS Lab recommends that you create a user for use as
the RAS log on. This user should have a password that is
never changed.

To set the Crystal RAS Log On:

1 In Windows Control Panel, double-click
Administrative Tools » Services.

2 Double-click Crystal Report Application Server.
3 On the Log On tab, click This account.
4 Enter the account and password.

A message appears stating that the log on will not
take affect until you restart the service.

5 Click OK, and then restart the Crystal RAS service
(right-click the service and click Restart).

Set the Crystal Reports Cache, Job, and Page Server Log
On Account (Crystal Reports XI only)

If you are using Crystal Reports XI, the Crystal Reports
Cache, Job, and Page Server use the local system account
for the Web server by default.

If you do not want Crystal Reports to use the regional
settings for the local system account, follow the same
instructions as provided for creating a RAS user log on
account (see preceding), except select the services
Crystal Reports Cache Server, Crystal Reports Job
Server, and Crystal Reports Page Server rather than
Crystal Report Application Server.
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On the CIMS Server
Application Server

On the Server Running
CIMS Server Administrator

On All Clients Accessing CIMS
Server Web Reporting

Pre-Installation Setup

Select the Language for the ODBC Data Source

In the Windows ODBC Data Source Administrator, you
need to select the language for each ODBC Data Source
used by CIMS Server. The steps for configuring a data
source for CIMS Server are provided in Configure the
CIMS Data Source for the Database on page 2-33.

Note * The change to the language source will not
appear in reports until you restart IIS. (To restart IIS,
see page 8-5.)

Select the CIMS Server Administrator User’s Regional
Settings

You need to select the regional settings for the user
logged on to the server running CIMS Server
Administrator. To select the regional settings for the
user:

1 In Windows Control Panel, double-click Regional
Options.

The Regional Options dialog box appears.

2 On the General tab, click the language that you want
from the list.

3 Click OK to save the change and close the dialog box.

Select the CIMS Server Web Reporting User’s Regional
Settings

You need to set the correct regional setting for the user
on each client that is using CIMS Server Web Reporting.
This enables Microsoft Excel to display dates, times,
currency, and numbers in the correct format when you
view a report as a spreadsheet.

To select the regional settings for the user, follow the
steps in Select the CIMS Server Administrator User's
Regional Settings.
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Changing the Report Text (Optional)

CIMS Server includes a variety of standard reports and spreadsheets for Crystal Reports,
SQL Server Reporting Services, and CIMS Advanced Spreadsheets. You can use these
reports and spreadsheets as templates to create custom reports/spreadsheets (see About
CIMS Server Reports on page 4-3), and then change the text as follows.

For Crystal reports:

1

2

3

In Crystal Reports, open the report that you want to change.
Right-click the text that you want to change, and then click Edit Text Option.

Save the report using the same file name in the Custom reports folder.

For SQL Server Reporting Services reports:

1

9

In Visual Studio .NET or another product that provides the Visual Studio 2003 shell,
click File » New Project.

In Business Intelligence Projects, double click Report Projects.

Right-click the Reports folder in the Solution Explorer window, and then click Add
Existing [tem.

Browse to find the report file that you want to edit, and then open the report.
Right click the text that you want to change, and then click Expression.

In the Edit Expression dialog box, change the text in the Expression box.
Click OK.

Repeat steps 1 through 5 for each text area that you want to change.

Click File » Select Items when you are finished.

For CIMS Advanced Spreadsheets:

Contact CIMS Lab for assistance in changing the text and other culture-specific
information in CIMS Advanced Spreadsheets.
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Installing and Enabling ASP.Net

If you are using Microsoft Windows 2000 Server, ASP.NET is installed by default as part
of the IIS installation.

If you are using Windows Server 2003, you need to install and enable ASP.NET as
described in this section.

Installing ASP.NET
To install ASP.NET on a computer running Windows Server 2003:
1 In Windows Control Panel, click Add/Remove Programs.

2 Click Add/Remove Windows Components, and then select the Application Server
check box if it is not selected.

3 Click Details, and then select the ASP.NET check box if it is not selected.

Enabling ASP.NET
To enable ASP.NET:
1 In IIS Manager, navigate to and click Web Service Extensions.

Note that you can easily start IIS Manager by clicking Start » Run. Type inetmgr in the
Open box, and then click OK.

2 Click Active Server Pages and then click Allow.
3 Click ASP.NETv<version number> and then click Allow.

4 Make sure that Allowed appears in the status column for these features.
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Installing SQL Server Reporting Services

Note ¢ This section is applicable only if you want to use SQL Server Reporting
Services for reporting.

The installation steps in this section are preceded by a brief overview of the licensing
requirements, components, and system requirements for SQL Server Reporting Services.
For more detailed information about obtaining, licensing, installing, and using
Reporting Services, go to http://www.microsoft.com/sql/reporting/.

About Licensing Reporting Services

Reporting Services is part of the SQL Server 2000 or 2005 license. There is not a separate
license for Reporting Services. If you have a licensed copy of SQL Server, you may run
Reporting Services on the same server for no additional license fee. If you want to run
Reporting Services on a server that is not licensed for SQL Server, you will need to obtain
a SQL Server license for that additional server.

For example, if you want to have your CIMS Server database on one server and Reporting
Services and IIS on a separate Web server, you will need to obtain a separate SQL Server
license and install SQL Server on the second server.

Overview of Reporting Services Components

H 2-18

Reporting Services is composed for four main components:

B Report Server. A Web service that handles report management and processing. It
connects to a SQL Server database for report metadata and caching.

B Report Server database. A SQL Server database used for report metadata and caching.
m Report Manager. A Web-based tool for managing Report Server.

m Report Designer. A graphical report-authoring tool that is integrated with Microsoft
Visual Studio .NET 2003.

Report Server requires a local or remote connection to the Report Server database. If you
have Report Server on one server and the Report Server database on another server, a
separate SQL Server license is required for each server.
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System Requirements for Reporting Services
For the Server Running Reporting Services:
m SQL Server 2005
Or
SQL Server 2000 with the following:
e The latest SQL Server 2000 Service Pack.

e The latest Reporting Services Service Pack (see Installing Reporting Services on
page 2-20).

m ASP.NET. If you are using Microsoft Windows 2000 Server, ASP.NET is installed by
default as part of the I1S installation. If you are using Windows Server 2003, make sure
that ASP.NET is installed and enabled (see Installing and Enabling ASP.Net on
page 2-17).

For the browser used with Reporting Services Report Manager:

For the browser used to access and manage Report Server using Report Manager, the
client computer must have Microsoft Internet Explorer 6.0 with Service Pack 1 (SP1),
with scripting enabled.
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Installing Reporting Services

The following steps reflect installing Reporting Services from a CD. To perform the
installation from another source, refer to the Microsoft documentation. You must have
SQL Server 2000 or 2005 installed on the server to install Reporting Services.

Note * Once you have installed Reporting Services and CIMS Server, you need to
complete configuration steps in both applications. See Set Up SQL Server Reporting
Services on page 2-71.

To install Reporting Services From a CD:
1 Logon to Windows as a user in the Administrators group.

2 Insert the Reporting Services CD. If the CD does not start automatically, browse to
your CD-ROM drive and double-click setup.exe.

3 Follow the instructions in the Reporting Services installation wizard.

Install the latest Reporting Services Service Pack after you install Reporting Services.

Note ¢ If you do not have Visual Studio .NET 2003 or another product that provides
the Visual Studio 2003 shell installed, you will receive notification when the installer
checks for Reporting Services prerequisites. Visual Studio 2003 is not required unless
you want to use Report Designer.

Installing Crystal Reports

B 2-20

Note  This section is applicable only if you want to use Crystal Reports XI for
reporting. For information about installing other versions of Crystal Reports, see
Chapter 8, Troubleshooting and Additional Information.

Effective for Crystal Reports XI, the Crystal Reports product suite includes Crystal Reports
Server. You need to install Crystal Reports Server before installing Crystal Reports. If
possible, both components should be installed on the same drive.

Crystal Reports Server requires a database to store information about the system and its
users. The following instructions describe how to install Crystal Reports Server using the
default configuration which installs an MSDE database. If you want to create a database
before installing Crystal Reports Server and/or you want use a different database, refer to
the BusinessObjects document Installing Crystal Reports Server on Microsoft Windows. This
guide is available from the BusinessObjects Web site and is included with the Crystal
Reports Server installation files.

Important! ¢ After you install the Crystal Reports XI components, you need to follow
the steps in Configure Crystal Reports Server on page 2-77 before you can run reports.
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To install Crystal Reports XI Server:

1

2

Log on to Windows as a user in the Administrators group.
Do one of the following:

e Ifyou are installing from the installation CD, insert the Crystal Reports CD. If the
CD does not start automatically, browse to your CD-ROM drive and double-click
setup.exe.

e If you are installing from another location, for example from a network drive,
double-click setup.exe.

Click Install Crystal Reports Server and proceed with the instructions in the
Installation Wizard until the Select Client or Server installation dialog box appears.

Click Perform Server Installation, and then click Next.

In the Directory Selection dialog box, enter an installation directory or accept the
default. Click Next.

In the Install Type dialog box, click New. Leave the Install MSDE or use existing local
SQL Server check box selected. Click Next.

The installation differs depending on whether MSDE or SQL Server is already
installed on the server. Follow the instructions presented.

In the Start Installation dialog box, click Next.

Click Finish when the installation is complete. (If you do not want to launch the
BusinessObjects Administration Console, clear the check box before you click
Finish).

To install Crystal Reports XI:

Double click setup.exe on the installation CD or other location and follow the
instructions presented in the Installation Wizard. CIMS Lab recommends that you click
Typical in the Select Installation Type dialog box.

Install Crystal Reports Service Pack 1 after you install Crystal Reports.
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Installing CIMS Server

This section describes the steps required to install CIMS Server. Before you begin the
installation, make sure that you have installed and configured the components described
in System Setup Checklist on page 2-10.

Note ¢ You can install the CIMS Server Administrator component of CIMS Server on
a client or clients (see Client Specifications on page 2-7) in addition to installation on
the server. You can also install CIMS Processing Engine on a client. However, if

possible, it is recommended that you install CIMS Processing Engine on the server.

To begin the CIMS Server installation:

1 Logon to Windows as a user in the Administrators group.
2 Click the Windows Start button, and then click Run.

3 Enter the path to the CIMS Server setup program (Setup. version&release.exe), and
then click OK. (The path depends on the location of the setup program, i.e., CIMS
Product CD, network drive, etc. For example, if you are installing from the CIMS
Product CD on drive D, the path is D: \CIMSServer\Setup. version&release.exe.)

4 Follow the steps provided in the InstallShield Wizard as described in the following
sections. The steps differ depending on whether you are performing a new
installation or modifying an existing installation. To modify an existing installation,
see page 2-25.

Performing a New Installation

m 2-22

Note ¢ The CIMS Server 4.3 installation includes Microsoft Data Access Components
(MDAC) 2.8. This is the current MDAC version as of this CIMS Server release. If a
later MDAC version is available at the time that you install CIMS Server 4.3, you can
download the new version from http://msdn.microsoft.com/data/downloads/
updates/default.aspx#MDACDownloads.

The InstallShield Wizard contains the following steps that guide you through the
installation.

Choose the Destination Location

Choose the default location for installation (C: \Program Files\CIMSLab) or click Browse
to choose another location. Click Next after making your selection.

Note ¢ The folder in which you install CIMS Server (CIMSLab or other) should be
backed up periodically.
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Select the Features That You Want to Install

Select the CIMS Server components that you want to install or clear the components that
you do not want to install. Click Next after you have made your selections. For a detailed
description of these components, see Chapter 1, About CIMS Server.

CIMS Administrator. This option installs CIMS Server Administrator. CIMS Server
Administrator is a graphical interface that enables you to create and maintain
administrative and processing settings.

CIMS Processing Engine. This option installs CIMS Processing Engine components
including CIMSACCT.d11, CIMSBILL.d11, CIMSSORT.d11, and CIMSAdminLib.d11. These
components process the CIMS Server Resource (CSR) or CIMS Server Resource Plus
(CSR+) files and load the output into the CIMS Server database. This option also
installs CIMS Aggregation Engine (CIMSAggregation.d11) used by CIMS Data
Collectors.

CIMS Web Console. This option installs CIMS Web Console. This Web-based
application provides an interface for creating job files, viewing job log files, and
performing some CIMS Server administration tasks. CIMS Web Console is a beta
release in CIMS Server 4.3. For more information about this application, contact
CIMS Lab. To set up and start CIMS Web Console, see Setting Up and Starting CIMS
Web Console on page 2-82.

CIMS Web Reporting. This option installs CIMS Server Web Reporting. This Web-
based application allows end users to view reports from a Web browser.

Scripts. This option installs scripts that can be used to automate tasks in CIMS Server.
For example, scripts that enable batch reporting, scripts used by CIMS Data
Collectors, etc. For a description of these scripts, see Appendix C, Scripts.

CIMS Conversion Engine. This option installs CIMS Conversion Engine. CIMS
Conversion Engine is a utility that converts data collected by CIMS Universal Data
Collector and converts the data into CSR files. For more information about CIMS
Conversion Engine and the CIMS Universal Data Collector, refer to the CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

CIMS Collectors & Processors. This option installs the collector and process
components of CIMS Data Collectors for Windows. These components enable you to
gather usage data from many different sources such as operating systems, databases,
and applications for input into CIMS Server.

To install individual collectors and processes, expand CIMS Collectors & Processors,
and then select the collectors that you want.

MSDE—Microsoft SQL Server 2000 Desktop Data Engine. This option installs
MSDE 2000. In a production environment, it is strongly recommended that you use
SQL Server, Oracle, or DB2 to manage your database. However, in other situations,
MSDE might meet your requirements. For more information, see CIMS Server
Professional Edition on page 1-12.

CIMS Financial Modeler. This option includes CIMS Financial Modeler in the
installation. CIMS Financial Modeler is a Web-based application that provides an
interface for performing IT finance-related tasks, such as cost analysis and allocation
and rate calculation. For more information about this application, see Chapter 7.
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Select the Program Folder

Choose the program folder. Use the default (CIMS Server), type a new program folder
name, or select one from the list. Click Next when you are finished.

Start Copying Files

Click Next to begin copying program files to your system. If IIS is running, a message
appears asking you to confirm that is okay to shut down IIS. Click Yes. Note that the
installer restarts IIS before finishing installation.

Install Microsoft .NET Framework 1.1 (If Applicable)

If you have not installed Microsoft .NET Framework 1.1, the Microsoft .NET Framework
1.1 Setup appears. Follow the instructions in the setup, and then click OK when the
installation is complete.

Note ¢ If the message Files In Use appears during the installation, click Ignore. The
.NET Framework will continue to install.

Enter the 1IS Web User Name

There are two options for controlling user access to the CIMS Server Web Reporting Web
site: anonymous access and Windows authenticated access. Anonymous access allows
remote access by the IUSR_computername account. IIS user access is described in detail in
Set the User Authentication Method for the Web Sites on page 2-67.

The InstallShield Wizard allows you to enter the IUSR_computername. This name is used
for granting security permissions for CIMS Server folders as described in Assign Folder
Security Permissions on the Web Server on page 2-69.

In most situations, the IUSR_computername account that appears is correct and you can
click Next to continue. If you want to confirm that it is correct, follow the instructions in
To set anonymous access: on page 2-68 to locate the IUSR_computername. If the
IUSR_computername is not correct (for example, you changed your computer name after
installing IIS), you can change it here and then click Next.

If you do not enter the correct IUSR_computername here, you can assign the required
folder privileges manually (see page 2-69). A series of error messages will appear. Click
OK for each message.

Complete the Installation

Follow the instructions in the Setup Complete—Reboot Required dialog box, and then
click Finish.
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Modifying an Existing Installation

Follow the steps in this section to modify an existing installation. For example, you have
already installed certain CIMS Data Collectors but now want to install others.

1 Run the CIMS Server setup program.
Or

In Windows Control Panel, click Add or Remove Programs, and then click Change
for CIMS Server.

The InstallShield Wizard appears.
2 Click Moditfy, and then click Next.

Note ¢ Do not click Repair to modify the installation. The Repair option should
be ignored.

3 Select the check boxes for the components that you want to install. (For a description
of all components, see Select the Features That You Want to Install on page 2-23.) Do
not clear a check box unless you want to delete that component.

4 Follow the instructions presented in the wizard to complete the installation.
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Upgrading to a New Release of CIMS Server

Important! ¢ If you are performing an upgrade, you should back up the Program
Files\CIMSLab folder before you upgrade to a new version of CIMS Server. If you have
made changes to files in this folder and have not renamed these files, the files will
be overwritten when you upgrade to a new version or release of CIMS Server.

You should also confirm that you have a regular and working backup schedule for
the following: the CIMSLab folder; the folder that contains your process definitions
(this folder is referred to as Processes in this guide); and your database.

To upgrade to a new release of CIMS Server:

1

10

11

B 2-26

Follow the steps in To begin the CIMS Server installation: on page 2-22 to start the
InstallShield Wizard.

In the InstallShield Wizard, a message appears asking you to confirm that is okay to
uninstall the existing CIMS Server version. Click Yes.

When prompted to modify, repair, or remove the existing installation, make sure that
Remove is selected, and then click Next.

Click OK in the Confirm Uninstall message box.

If TIS is running, a message appears asking you to confirm that is okay to shut down
11S. Click Yes.

Choose the default location for the upgrade. Click Next after making your selection.

Important! « When you upgrade to a new version or release of CIMS Server, make
sure that you install the program in the same folder as the existing CIMS Server
installation. If there is a reason that you want to keep your previous CIMS Server
version and install the upgrade, contact CIMS Lab.

Select the check boxes for the components that you want to upgrade, and then click
Next. (For a description of all components, see Select the Features That You Want to
Install on page 2-23.) Do not clear a check box unless you want to delete that
component.

Choose the program folder. Use the default (CIMS Server), type a new program folder
name, or select one from the list. Click Next when you are finished.

Click Next to begin copying program files to your system. If IIS is running, a message
appears asking you to confirm that is okay to shut down IIS. Click Yes.

Accept the default IIS Web user name or enter a new name as described in Enter the
[IS Web User Name on page 2-24, and then click Next.

Follow the instructions in the Setup Complete—Reboot Required dialog box, and
then click Finish.
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Getting Started

This section takes you through the steps required to set up and use CIMS Server. You
should follow these steps in the order presented.

To help you to get started quickly, this section does not contain the detailed information
found in other chapters in this guide. Where applicable, references to more detailed
information are provided.

Before getting started, make sure that you have installed the system components
required by CIMS Server as shown in System Setup Checklist on page 2-10.

Create a Database

The database stores administration information as well as the output records produced
by CIMS Processing Engine. These records are called the Ident, Detail, and Summary
records and contain data processed from CSR or CSR+ records. Each process definition
in the Processes folder produces separate Ident, Detail and Summary files .

You can use more than one database with CIMS Server. For example, you might have a
production database and a development database. For more information about creating
multiple databases, see Chapter 5, Database Administration.

The following sections provide steps for creating a database in MSDE 2000 or Microsoft
SQL Server. Information about recommended database back up methods follows these
sections.

Note * To create an Oracle or DB2 database, consult your DBA. For more
information about the requirements for using an Oracle or DB2 database with CIMS
Server, refer to the CIMS Server for UNIX Installation and User Guide or CIMS Server
for DB2 Database Setup Guide. Continue to Configure the CIMS Data Source for the
Database on page 2-33.

Creating an MSDE 2000 Database

To create an MSDE database, use either the OSQL or ISQL command-line interface as
follows. Press <Enter> after each command.

1 At the command prompt, log on to the database server. For example:
osql -S servera-test -t

Where -S servera-test indicates the server name and -E indicates use a trusted
connection. Note that there are other switches that you may have to use depending
on your environment. For example, you may have to specify the login ID (-U) and
password ( -P) switches. To view the OSQL switches, type osql /? at the command
prompt.
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2 At the 1> prompt, type:
create database database name

Where database name is the name that you want to give the database. The name
CIMSServer is used in this guide, but you can use any name.

3 At the 2> prompt, type:
go
The following messages appear:

The CREATE DATABASE process is allocating 0.63 MB on disk ‘database name .
The CREATE DATABASE process is allocating 0.49 MB on disk "database name_log .

4 At the 1> prompt, type:

quit

Note * Because the MSDE master database contains system tables, CIMS Lab
recommends that you do not use this database as your CIMS Server database.
However, if you do choose to use the master database, it is supported by CIMS Server.

Creating User Logins for the MSDE Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. CIMS Lab recommends that
you use the default SQL Server user login sa with a password of sa for both CIMS Server
administrators and end users.

If you want to use a user login or logins other than sa, you can use the OSQL or ISQL
command-line interface or a third-party product for maintaining the MSDE database.
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Creating a Microsoft SQL Server Database

Note * The steps in this section reflect creating a database in SQL Server 2000. If you
are using SQL Server 2005, refer to the Microsoft documentation if needed.

You can create a database using SQL Server Enterprise Manager or the OSQL or ISQL
command-line interface. The following are the steps needed to create a database using
Enterprise Manager:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » computername » Databases.

3 Right-click the Databases folder, and then click New Database.

4 In the Database Properties dialog box, enter the configuration information for the
new database as follows:

¢ On the General tab do the following:

¢ In the Name box, type a name for the database. The name CIMSServer is used in
this guide, but you can use any name.

¢ In the Collation name box, click SQL_Latinl_General_CP1_CI_AS. Make sure
that you select only this database collation type and not a type that looks
similar. CIMS Server currently does not support other collation types.

e Unless you need to change the default settings for the database, you do not need
to reset values in the Data File or Transaction Log tabs.

5 Click OK when you are finished.

Creating User Logins for the Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. After you create the database,
you need to create a database login for these users. You can create one login for both user
types or separate logins. For example, you can create a login for the end users that has
fewer database permissions than the login for the administrator(s).

Note ¢ You can also create a separate login for the CIMS Job Runner application.
This application runs CIMS Data Collectors in batch. The login for CIMS Job Runner
must have the same database permissions as the CIMS Server administrator.
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The user login includes the user authentication method for the database (Windows
authentication or SQL Server authentication). When creating a login, consider the
following when choosing the authentication method:

m Windows authentication verifies the SQL Server user using the Windows user
account. If the user is the CIMS Server administrator, SQL Server uses the account on
the computer running CIMS Server Administrator.

SQL Server authentication verifies the user using the SQL Server login ID and
password. Using this authentication method, you could create a single login for all
CIMS Server administrators, a login for all CIMS Server Web Reporting end users, or
a login for both administrators and end users.

Note ¢ CIMS Server provides an optional table audit feature that enables you to
track changes that have been made to the data in certain database tables (see Table
Audit Settings on page 3-54). This information includes the user ID of the person
who made the change. If you use SQL Server authentication for multiple users,
you will not be able to identify the actual user who made the change.

The authentication type that you can use is dependent on the SQL Server and IIS
configuration as shown in Table 2-1. Note that if you are using SQL Server Reporting
Services for reporting, Windows authenticated access is recommended for
configurations where authenticated access or anonymous access can be used for IIS.
See Set the User Authentication Method for the Web Sites on page 2-67.

Required IIS Required SQL Server
IIS and SQL Server Configuration User Authentication User Authentication
IIS and SQL Server on the same  Authenticated Windows authentication
server. CIMS Server Web access
Reporting on an intranet site. Or
Authenticated SQL Server
access authentication
Or
Anonymous access  SQL Server
authentication
I1S and SQL Server on separate Authenticated SQL Server
servers. CIMS Server Web access authentication

Reporting on an intranet site. Or

Anonymous access  SQL Server
authentication

IIS and SQL Server on same or Anonymous access  SQL Server
separate servers. CIMS Server Web authentication
Reporting on an Internet site.

Table 2-1 « 1IS and SQL Server User Authentication Requirements
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B The number of ODBC Data Sources and CIMS Data Sources that you need to
configure for a database depends on the number of logins that you created for the
database and the authentication method used for the logins. The steps required to set
up ODBC and CIMS Data Sources are provided in Configure the CIMS Data Source for
the Database on page 2-33. A summary table of possible ODBC and CIMS Data Source
configurations is provided on page 8-18.

To create a user login:

Note ¢ For example purposes, the following steps reflect creating a separate user
login for CIMS Server administrators and CIMS Server Web Reporting end users. To
create one login for both user types, follow the steps as if you are creating an
administrator login.

1 In the SQL Server Enterprise Manager, right-click the CIMSServer database.

2 Click New » Database User. The Database User Properties—New User dialog box
appears.

3 In the Login name box, click <new>. The SQL Server Login Properties—New Login
dialog box appears.

4 On the General tab, do the following:
¢ In the Name box, do one of the following:
¢ To use Windows user authentication, enter the user name. To browse for a user,
click the Browse button E

* To use SQL Server user authentication, type a user login name, for example
CIMSAdmin or CIMSUser.

e In the Authentication area, click either Windows Authentication or SQL Server
Authentication. If you select SQL Server Authentication, type a password.

¢ In the Defaults area, enter the CIMSServer database in the Database box.

5 Ifyou are creating a login for a CIMS Server administrator, on the Server Roles tab,
select the System Administrators check box.

6 On the Database Access tab, select the Permit check box for the CIMSServer database.
A list of database permits appears with the public check box selected.
7 Leave the public check box selected and do one of the following:

e If you are creating a login for a CIMS Server administrator, select the db_owner
check box, and then click OK.

e Ifyou are creating a login for CIMS Server Web Reporting end users, select the
db_datareader and db_datawriter check boxes, and then click OK.

8 Ifyou selected SQL Server authentication, in the Confirm Password dialog box, type
the login password again, and then click OK.
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9 Click OK to close the SQL Server Login Properties—New Login dialog box, and then

click the Close button [¥] to close the Database User Properties—New User dialog
box.

To confirm that the user login has been added, expand the database and click Users.

Backing Up the MSDE or SQL Server Database

It is extremely important that you back up your CIMS Server database(s) so that you can
recover your data in case of media failure or natural disaster. CIMS Lab recommends that
you back up your database(s) weekly and that you back up to a different server at another
site.

If you are using an MSDE database, you can use the script SampleSQLMaintenance.bat to
back up and maintain the database. For more information about this script, see
SampleSQLMaintenance.bat Script on page C-26.

If you are using an SQL Server database, you can use the SampleSQLMaintenance.bat
script or you can use the steps shown in Backing Up and Maintaining Databases on
page 5-5.
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Set Up CIMS Server

To set up CIMS Server, start CIMS Server Administrator (Start » Programs » CIMS
Server » Administrator if you installed CIMS Server in the default location) and follow
the steps in this section.

Configure the CIMS Data Source for the Database

CIMS Server Administrator, the CIMS Web and batch reporting, and CIMS Data
Collectors all require access to the database that you created for CIMS Server. To enable
these components to use the database, you need to do the following:

m Create an ODBC Data Source that points to the database.

m Create a CIMS Data Source that points to the ODBC Data Source. The CIMS Server
components use the CIMS Data Source ID to identify and access the correct ODBC
Data Source.

When you install CIMS Server for the first time, the CIMS Data Source Maintenance
dialog box in CIMS Server Administrator opens automatically. This dialog box is initially
blank. Use this dialog box to create the ODBC Data Source and CIMS Data Source. The
options required to create the ODBC and CIMS Data Source depend on the database that
you are using with CIMS Server.

m For SQL Server, see the following.
m For MSDE, see page 2-41.

m For Oracle, see page 2-44.

m For DB2, see page 2-49.

Configuring the Data Source for a SQL Server Database

The number of ODBC Data Sources and CIMS Data Sources that you need to configure
for a SQL Server database depends on the number of logins that you created for the
database and the authentication method used for the logins as follows:

m Ifyou created one database user login for both the CIMS Server administrators and
CIMS Server Web Reporting end users or you created separate logins that both use
Windows authentication, you need one ODBC Data Source and one CIMS Data
Source.

For an example of how to set up this configuration, see Example Configuration 1 on
page 2-34.

m If you created one login for the administrators and one login for the end users and
both logins use SQL Server authentication, you need one ODBC Data Source and two
CIMS Data Sources that point to the ODBC Data Source. One CIMS Data Source will
contain the user ID and password for the administrator login and the other CIMS
Data Source will contain the user ID and password for the end user login.

For an example of how to set up this configuration, see Example Configuration 2 on
page 2-37.
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If you created one login for the administrators and one login for the end users and
each login uses a different authentication method, you need to create a separate
ODBC Data Source and CIMS Data Source for each login.

For an example of how to set up this configuration, see Example Configuration 3 on
page 2-39.

Example Configuration 1

Assume that one user login has been created for the database. This login uses SQL Server
authentication with user ID of CIMSAdmin and a password of admin. This login is used by
both the CIMS Server administrators and the CIMS Server Web Reporting end users.

In this situation, you need to create one ODBC Data Source that points to the database
and one CIMS Data Source that points to that ODBC Data Source.

1

H 2-34

In the CIMS Data Source Maintenance dialog box, click Add. (If the CIMS Data Source
Maintenance dialog box is not open, click System Administration » CIMS Data
Source Maintenance.)

In the Add CIMS Data Source dialog box, type an ID for the CIMS Data Source, and
then click OK. In this example, the CIMS Data Source ID is CIMSServer. The Configure
CIMS Data Source dialog box appears.

Click ODBC Data Source Administrator. The ODBC Data Source Administrator
dialog box appears.

On the System DSN tab, click Add. The Create New Data Source wizard appears.

Follow the steps provided in the wizard to point to the database. Consult your SQL
Server DBA to determine the settings that you should select in the wizard. Note the
following:

¢ The wizard prompts you to type a name for the ODBC Data Source. For this
example, the name is CIMSServer.

¢ Select the specific SQL Server installation that you want to connect to regardless of
whether the the database is on the local server. Do do not select (Tocal).

¢ The wizard prompts you with the following: How should SQL Server verify the
authenticity of the login ID? Click the correct authentication method (Windows
or SQL Server). If you select SQL Server authentication, type the SQL Server user
ID and password in the Login ID and Password boxes.

In this example, you would click the SQL Server authentication method and then
type the user ID CIMSAdmin and the password in the Login ID and Password boxes.

¢ For Internationalization Only. To select the language for the data source other
than the default language, select the Change Language of SQL Server Messages
to check box and click the language that you want from the list.

Important! « Do not select the Use regional settings when outputting currency,
numbers, dates, and times check box (the default for this check box is
unselected). CIMS Server does not support this option. Regional settings are
supplied by the regional options for the user logged on to the computer (see
Internationalization Setup on page 2-13).
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6 When the wizard completes, click Test Data Source to make sure that the
configuration was successful, and then click OK until the wizard and ODBC Data
Source Administrator dialog boxes close.

7 1In the Configure CIMS Data Source dialog box, do the following:

a In the Select a System ODBC Data Source list, click the ODBC Data Source that
you just created.

b In the User ID and Password boxes, type the SQL Server user ID CIMSAdmin and
the password admin as shown in example Figure 2-1. The password is encrypted.

¢ In the Owner/Schema box, CIMS Lab strongly recommends that you leave the
default dbo. prefix. This prefix sets the owner of the database objects in the
database to dbo, which allows any authorized database user to view the objects. For
more information about the database objects in CIMS Server, see Chapter 5,
Database Administration.

d In the Additional Parameters box, type any additional parameters that are
required to enable connection to the database. For more information, consult
your SQL Server DBA or CIMS Lab.

=42 Configure CIMS Data Source

Wi

Maching: | Local) j

Select a System CDBC Data Source:

QDBC Data Source Mame QDBC Driver Description
SA S

SErver

User |D: CIMS A cimin
Pazswaord: ’*****—
CrvnerfSchema: dhn.

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 2-1 « Configure CIMS Data Source Dialog Box—SQL Server Example 1
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8 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box. The data source entry appears in the CIMS Data Source
Maintenance dialog box as shown in example Figure 2-2.

Because the CIMSServer data source entry is the only entry in the list, it is
automatically set as the default data source for the Web and batch reporting and CIMS
Data Collectors. For more information about setting the default data source, see

page 5-7.

ans CIMS Data Source Maintenance

Edit  Wiew

Maching: | Local) j

Clhy et Cl| vEF SGL Server Yes

CIMS Data Source ID | ODBC Data Source Mame | Database Type | Default for WebiCollectors? | User ID

CIMS A dmin

Parameters | Owr

*

Add | Remave | Ediit |

Set WehiCollector Defautt |

Close |

Figure 2-2 « CIMS Data Source Maintenance Dialog Box—SQL Server Example 1

Note that if you pointed to the master database when you set up the ODBC Data
Source, the following message appears when you close the CIMS Data Source

Maintenance dialog box:

The data source <0DBC Data Source Name> is using the database 'master’. The
use of the ’master’ database to store CIMS data is not recommended. Do you
want to create a database called <ODBC Data Source Name> and use it instead?

If you want to use the master database, click No.

If you do not want to use the master database, click Yes and a database with the same

name as the ODBC Data Source is created.

B 2-36
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Assume that two user logins have been created for the database: one login for the

administrators and one login for the end users. Both logins use SQL Server

authentication. The user IDs for the administrator and end user logins are CIMSAdmin

with a password of admin and CIMSUser with a password of user, respectively.

In this situation, you need to create one ODBC Data Source that points to the database
and two CIMS Data Sources that point to that ODBC Data Source. One CIMS Data
Source will contain the user ID and password for the administrator login and the other
CIMS Data Source will contain the user ID and password for the end user login.

1 Complete the steps in Example Configuration 1 on page 2-34 to create the ODBC Data

Source and the CIMS Data Source for the administrator login CIMSAdmin.

2 To add the second CIMS Data Source for the end user login, click Add in the CIMS
Data Source List Maintenance dialog box.

3 Inthe Add CIMS Data Source dialog box, type an ID for the second CIMS Data Source,
and then click OK. In this example, the CIMS Data Source ID is CIMSServerUser. The

Configure CIMS Data Source dialog box appears.
4 1In the Configure CIMS Data Source dialog box, do the following:

a In the Select a System ODBC Data Source list, click the ODBC Data Source that

you created in Step 1.

b In the User ID and Password boxes, type the SQL Server user ID CIMSUser and the
password user as shown in example Figure 2-3. The password is encrypted.

¢ Leave the other boxes set to the defaults unless you have a specific reason

otherwise (see Step 7 on page 2-35 for more information).

=42 Configure CIMS Data Source

Wi

Machine: J

Select a System CDBC Data Source:

CE®

QDBC Data Source Mame QDBC Driver Description

CIMSServer

User ID: CISUser
Pazswaord: ’****—
CrvnerfSchema: dhn.

Additional Parameters: |

QDBC Data Source Administrator ... | OK |

Cancel |

Figure 2-3 - Configure CIMS Data Source Dialog Box—SQL Server Example 2
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5 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box.

Two data source entries appear in the CIMS Data Source Maintenance dialog box as
shown in example Figure 2-4.

=42 CIMS Data Source Maintenance |:||E|r‘5__<|
Edit  Wiew

Machine: | (LOCAL) j

" CIMS Data Source |0 | QDBC Data Source Mame | Database Type | Default for WebiCollectors? | User ID Parameters | Owr|
CliSServer ClSServer SOL Server Yes IS A clmin dho.

rllzer VEF WEr LMSUSEr

|
v

Al | Remove Eclit Set WebiCaollector Default | Close |

Figure 2-4  CIMS Data Source Maintenance Dialog Box—SQL Server Example 2
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Example Configuration 3

Assume that two user logins have been created for the database: one login for the
administrators and one login for the end users. The administrator login uses SQL Server
authentication and the end user login uses Windows authentication.

In this situation, you need to create two ODBC Data Sources that both point to the
database and separate CIMS Data Sources that point to each ODBC Data Source.

1

Complete the steps in Example Configuration 1 on page 2-34 to create the ODBC
source and CIMS Data Source for the administrator login CIMSAdmin.

To add the ODBC Data Source and CIMS Data Source for the end user login, click Add
in the CIMS Data Source List Maintenance dialog box.

In the Add CIMS Data Source dialog box, type an ID for the second CIMS Data Source,
and then click OK. In this example, the CIMS Data Source ID is CIMSServerUser.

The Configure CIMS Data Source dialog box appears.

Click ODBC Data Source Administrator. The ODBC Data Source Administrator
dialog box appears.

On the System DSN tab, click Add. The Create New Data Source wizard appears.

Follow the steps provided in the wizard to point to the database. Consult your SQL
Server DBA to determine the settings that you should select in the wizard. Note the
following:

e The wizard prompts you to type a name for the ODBC Data Source. For this
example, the name is CIMSServerUser.

e Select the specific SQL Server installation that you want to connect to regardless of
whether the the database is on the local server. Do do not select (Tocal).

e The wizard prompts you with the following: How should SQL Server verify the
authenticity of the login ID? Click the Windows authentication method.

When the wizard completes, click Test Data Source to make sure that the
configuration was successful, and then click OK until the wizard and ODBC Data
Source Administrator dialog boxes close.

In the Configure CIMS Data Source dialog box, do the following:

a In the Select a System ODBC Data Source list, click the ODBC Data Source that
you just created.

b Leave the User ID and Password boxes blank as shown in example Figure 2-5 on
page 2-40.

¢ Leave the other boxes set to the defaults unless you have a specific reason
otherwise (see Step 7 on page 2-35 for more information).
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=42 Configure CIMS Data Source |:||E|P5__<|

Wi

Machine: | J

Select a System CDBC Data Source:

| QDBC Data Source Mame QDBC Driver Description

ClSServer SOL Server
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User ID: ’—
Passwoard: ’—
CrvnerfSchema: b,

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 2-5 « Configure CIMS Data Source Dialog Box—SQL Server Example 3

9 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box. Two data source entries appear in the CIMS Data Source
Maintenance dialog box as shown in example Figure 2-6.

For example purposes, the CIMSServer data source entry is set as the default data
source for Web and batch reporting and CIMS Data Collectors. For more information
about setting the default data source, see page 5-7.

=42 CIMS Data Source Maintenance |._||’E|r‘5__<|

Edit  Wiew

Machine: |(LOCAL) j

" CIMS Data Source |0 | QDBC Data Source Mame | Database Type | Default for WebiCollectors? | User ID Parameters | Owr|
CliSServer ClSServer SOL Server Yes IS A clmin dho.

I
F

Cl Uzer Clh rUzer er

Al | Remove | Eclit | Set WebiCaollector Default | Close |

Figure 2-6  CIMS Data Source Maintenance Dialog Box—SQL Server Example 3
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Configuring the Data Source for an MSDE Database

The following steps assume that you are using the database user login sa for both the
CIMS Server administrators and the CIMS Server Web Reporting end users. In this
situation, you need to create one ODBC Data Source that points to the database and one
CIMS Data Source that points to that ODBC Data Source.

Example Configuration

1 Inthe CIMS Data Source Maintenance dialog box, click Add. (If the CIMS Data Source
Maintenance dialog box is not open, click System Administration » CIMS Data
Source Maintenance.)

2 In the Add CIMS Data Source dialog box, type an ID for the CIMS Data Source, and
then click OK. In this example, the CIMS Data Source ID is CIMSServer.

The Configure CIMS Data Source dialog box appears.

3 Click ODBC Data Source Administrator. The ODBC Data Source Administrator
dialog box appears.

4 On the System DSN tab, click Add. The Create New Data Source wizard appears.

5 Follow the steps provided in the wizard to point to the database. Consult your SQL
Server DBA to determine the settings that you should select in the wizard. Note the
following:

e The wizard prompts you to type a name for the ODBC Data Source. For this
example, the name is CIMSServer.

e Select the specific SQL Server installation that you want to connect to regardless of
whether the the database is on the local server. Do do not select (Tocal).

e The wizard prompts you with the following: How should SQL Server verify the
authenticity of the login ID? Click the SQL Server authentication method and
type sa in both the Login ID and Password boxes.

¢ For Internationalization Only. To select the language for the data source other
than the default language, select the Change Language of SQL Server Messages
to check box and click the language that you want from the list.

Important! « Do not select the Use regional settings when outputting currency,
numbers, dates, and times check box (the default for this check box is
unselected). CIMS Server does not support this option. Regional settings are
supplied by the regional options for the user logged on to the computer (see
Internationalization Setup on page 2-13).

6 When the wizard completes, click Test Data Source to make sure that the
configuration was successful, and then click OK until the wizard and ODBC Data
Source Administrator dialog boxes close.
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7 1In the Configure CIMS Data Source dialog box, do the following:

a In the Select a System ODBC Data Source list, click the ODBC Data Source that
you just created.

b In the User ID and Password boxes, type sa (the SQL Server user ID and
password) as shown in example Figure 2-7.

¢ Leave the other boxes set to the defaults unless you have a specific reason
otherwise (see Step 7 on page 2-35 for more information).

=42 Configure CIMS Data Source

Wi

Maching: | Local) j

Select a System CDBC Data Source:

QDBC Data Source Mame

QDBC Driver Description
CIMSServer SGL Serw
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User ID: ’33—
Pazswaord: ’**—
CrvnerfSchema: dhn.

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 2-7 « Configure CIMS Data Source Dialog Box—MSDE Example

8 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box. The data source entry appears in the CIMS Data Source
Maintenance dialog box as shown in example Figure 2-8 on page 2-43.

Because the CIMSServer data source entry is the only entry in the list, it is
automatically set as the default data source for Web and batch reporting and CIMS
Data Collectors. For more information about setting the default data source, see
page 5-7.
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ans CIMS Data Source Maintenance
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Figure 2-8 « CIMS Data Source Maintenance Dialog Box—MSDE Example

Note that if you pointed to the master database when you set up the ODBC Data
Source, the following message appears when you close the CIMS Data Source

Maintenance dialog box:

The data source <0DBC Data Source Name> is using the database 'master’. The
use of the ’master’ database to store CIMS data is not recommended. Do you
want to create a database called <0DBC Data Source Name> and use it instead?

If you want to use the master database, click No.

If you do not want to use the master database, click Yes and a database with the same
name as the ODBC Data Source is created.
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Configuring the Data Source for an Oracle Database

Note ¢ The information in this section assumes that the Oracle database has been
created and connection to the database has been set up as described in the CIMS
Server for UNIX Installation and User Guide.

You need to create one ODBC Data Source that points to the database. The number of
CIMS Data Sources that you need to create for the ODBC Data Source depends on the
number of database users that you created for CIMS Server.

If you created one database user for all CIMS Server users you need to create one ODBC
Data Source and one CIMS Data Source. See Example Configuration 1.

If you created multiple database users (for example, one for the CIMS Server
administrators and one for the CIMS Server Web Reporting end users), you need to
create one ODBC Data Source and then create a separate CIMS Data Sources that points
to that ODBC Data Source for each user. Each CIMS Data Source will contain the
appropriate database user ID and password. See Example Configuration 2 on page 2-47.

Example Configuration 1

Assume that one Oracle user has been created for the database. This user is used by both
CIMS Server administrators and the CIMS Server Web Reporting end users. The user ID
is CIMSAdmin and the password is admin.

In this situation, you need to create one ODBC Data Source that points to the database
and one CIMS Data Source that points to that ODBC Data Source.

1 In the CIMS Data Source Maintenance dialog box, click Add. (If the CIMS Data Source
Maintenance dialog box is not open, click System Administration » CIMS Data
Source Maintenance.)

2 In the Add CIMS Data Source dialog box, type an ID for the CIMS Data Source, and
then click OK. In this example, the CIMS Data Source ID is CIMSServer.

The Configure CIMS Data Source dialog box appears.

3 Click ODBC Data Source Administrator. The ODBC Data Source Administrator
dialog box appears.

4 On the System DSN tab, click Add. The Create New Data Source wizard appears.

5 Click the Oracle driver that you want to use to set up the data source and then click
Finish. The Oracle ODBC Driver Configuration dialog box appears.

6 Inthe Oracle ODBC Driver Configuration dialog box, do the following. Consult your
Oracle DBA for assistance. The dialog box also includes a Help button.

a Inthe Data Source Name box, type the name that you want to assign to the ODBC
Data Source. For this example, the name is CIMSServer.

b In the optional Description box, type a description of the ODBC Data Source.
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¢ In the TNS Service Name box, enter the location of the Oracle database from
which the ODBC driver will retrieve data. This is the same name entered in the
tnsnames.ora file using the Oracle Net Manager.

d In the optional User ID box, type a user ID for the Oracle database from which the
ODBC drive will retrieve the data. If you do not provide the user ID in this box,
you can type it when you test the connection to the database in Step 7.

e You can leave the remaining options in the dialog box set to the defaults or change
the options as needed.

7 When you have set the options in the Oracle ODBC Driver Configuration dialog box,
click Test Connection to make sure that the configuration was successful. The Oracle
ODBC Driver Connect dialog box appears. Type a user ID and password for the
database and click OK. If you entered a user ID in the User ID box, that user ID
appears by default.

8 Click OK until you return to the Configure CIMS Data Source dialog box and do the
following. Consult your Oracle DBA for assistance.

a In the Select a System ODBC Data Source list, click the ODBC Data Source that
you just created.

b In the User ID and Password boxes, type the Oracle user ID CIMSAdmin and the
password admin as shown in example Figure 2-9 on page 2-46. The password is
encrypted.

¢ In the Owner/Schema box, type the name of the database schema that is used for
the CIMS Server database. Consult your Oracle DBA for the database schema. In
example Figure 2-9, the schema is CIMS.. Note that the period at the end of the
schema name is required and will be added automatically if you do not include it.

Important! ¢ The preceding steps associate a user ID with the schema for the
CIMS Server database. The user ID may or may not be the same as the schema
name. Because the user ID and schema defined here are not applied to all CIMS
administrative options, CIMS scripts, or Crystal Reports, you need to install a
trigger that changes the user’s default schema to the CIMS database schema if
the user ID and schema are different. For example, in Figure 2-9 the user ID is
CIMSAdmin and the schema is CIMS. You would need to install a trigger that
changes the default schema for the user CIMSAdmin to the CIMS schema. To create
and install the trigger, use the OraclelLogonTrigger.bat script as described on
page C-16.

d In the Additional Parameters box, type any additional parameters that are
required to enable connection to the database. For more information, consult
your Oracle DBA or CIMS Lab.
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Figure 2-9 - Configure CIMS Data Source Dialog Box—Oracle Example 1

9 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box. The data source entry appears in the CIMS Data Source
Maintenance dialog box as shown in example Figure 2-10. Because the CIMSServer
data source entry is the only entry in the list, it is automatically set as the default data
source for Web and batch reporting and CIMS Data Collectors. For more information
about setting the default data source, see page 5-7.

ans CIMS Data Source Maintenance
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Figure 2-10 « CIMS Data Source Maintenance Dialog Box—Oracle Example 1
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Example Configuration 2

Assume that two Oracle users have been created for the database: one for CIMS Server
administrators and one for CIMS Server Web Reporting end users. The user IDs for the
administrator and end user logins are CIMSAdmin with a password of admin and CIMSUser
with a password of user, respectively.

In this situation, you need to create one ODBC Data Source and two CIMS Data Sources
that point to the ODBC Data Source. One CIMS Data Source will contain the user ID and
password for the administrator and the other CIMS Data Source will contain the user ID
and password for the end user.

1 Complete the steps in Example Configuration 1 on page 2-44 to create the ODBC Data
Source and the CIMS Data Source for the user CIMSAdmin.

2 To add the second CIMS Data Source for the end user login, click Add in the CIMS
Data Source List Maintenance dialog box.

3 Inthe Add CIMS Data Source dialog box, type an ID for the second CIMS Data Source,
and then click OK. In this example, the CIMS Data Source ID is CIMSServerUser.

The Configure CIMS Data Source dialog box appears.

4 In the Configure CIMS Data Source dialog box, do the following. Consult your Oracle
DBA for assistance.

a In the Select a System ODBC Data Source box, click the ODBC Data Source that
you added in Step 1.

b In the User ID and Password boxes, type the Oracle user ID CIMSUser and the
password user as shown in example Figure 2-11 on page 2-48. The password is
encrypted.

¢ In the Owner/Schema box, type the name of the database schema that is used for
CIMS Server. Consult your Oracle DBA for the database schema. In example
Figure 2-11, the schema is CIMS.. Note that the period at the end of the schema
name is required and is added automatically.

Important! ¢ As noted on page 2-45 in the instructions for creating the
CIMSAdmin user, you need to install a trigger that changes the user’s default
schema to the CIMS database schema if the user ID and schema are different.
For example, in Figure 2-11 the user ID is CIMSUser and the schema is CIMS. You
would need to install a trigger that changes the default schema for the user
CIMSUser to the CIMS schema. To create and install the trigger, use the
OraclelLogonTrigger.bat script as described on page C-16.

d In the Additional Parameters box, type any additional parameters that are
required to enable connection to the database. For more information, consult
your Oracle DBA or CIMS Lab.
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Figure 2-11 + Configure CIMS Data Source Dialog Box—Oracle Example 2

5 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box. Two data source entries appear in the CIMS Data Source
Maintenance dialog box as shown in example Figure 2-12.

For example purposes, the CIMSServer data source entry is set as the default data
source for Web and batch reporting and CIMS Data Collectors. For more information
about setting the default data source, see page 5-7.
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Figure 2-12 « CIMS Data Source Maintenance Dialog Box—Oracle Example 2
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Configuring the Data Source for a DB2 Database

Note ¢ The information in this section assumes that the DB2 database has been
created and connection to the database has been set up as described in the CIMS
Server for DB2 Database Setup Guide.

The following are a data source configuration examples for a single DB2 database and
multiple databases.

Example Configuration—One Database

Assume that the user ID cimsadmin and the password admin is used to access the database.
This user is used by both CIMS Server administrators and the CIMS Server Web Reporting
end users. The CIMS Server database is named CIMSSERVER and the creator is CIMS.

In this situation, you need to create one ODBC Data Source that points to the database
and one CIMS Data Source that points to that ODBC Data Source.

1

In the CIMS Data Source Maintenance dialog box, click Add. (If the CIMS Data Source
Maintenance dialog box is not open, click System Administration » CIMS Data
Source Maintenance.)

In the Add CIMS Data Source dialog box, type an ID for the CIMS Data Source, and
then click OK. In this example, the CIMS Data Source ID is CIMSServer. The Configure
CIMS Data Source dialog box appears.

Click ODBC Data Source Administrator. The ODBC Data Source Administrator
dialog box appears.

On the System DSN tab, click Add. The Create New Data Source wizard appears.

Click the DB2 driver that you want to use to set up the data source and then click
Finish. The driver name - Add dialog box appears.

In the driver name — Add dialog box, do the following:

a Inthe Data source name box, type the name that you want to assign to the ODBC
Data Source. For this example, the name is CIMSServer.

b In the Database alias list, click the alias for the database that you want the ODBC
Data Source to point to. You can also click Add to add an alias if needed. If you
need assistance choosing or creating the database alias, consult your DB2 DBA.

¢ In the Description box, type an optional description of the ODBC Data Source.
d Click OK to close the dialog box and return to the System DSN tab.

Double-click the ODBC Data Source that you just added. The CLI/ODBC Settings
dialog box appears.
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On the Data Source tab, do the following:

a Type the DB2 user ID cimsadmin and the password admin in the User ID and
Password boxes.

b Click Connect to test the connection.

On the Advanced Settings tab, the parameter DBALIAS appears with the alias that you
selected in Step 6 on page 2-49. You need to add the parameters DBNAME and
CURRENTSCHEMA. You can locate the database name and schema in the DB2 Control
Center under Databases. The schema name is in the Creator column.

To add the DBNAME parameter:
a Click Add. The Add CLI/ODBC parameter dialog box appears.
b In the Select a CLI/ODBC parameter list, click DBNAME, and then click OK.

¢ In the MVS DBNAME filter dialog box, type the database name CIMSSERVER, and
then click OK.

To add the CURRENTSCHEMA parameter:

a Click Add.

b In the Select a CLI/ODBC parameter list, click CURRENTSCHEMA, and then

click OK.

¢ In the Schema for 'SET CURRENT SCHEMA' issued after connect dialog box, type
the schema name CIMS, and then click OK.

Click Apply. The parameters DBNAME and CURRENTSCHEMA appear in the
parameter list on the Advanced Settings tab as shown in example Figure 2-13. Click
OK to close the dialog box.

CLIODBC Settings - CIMSServer 53
Data Source  Advanced Seftings l
Select a parameter to change its value.
CLI Parameter Walue | Pending Yalue | Type | Drescription Add
DEALIAS ROCADO
DEMAME CIMSSERVER En.. Y5 DEMAME filer Remove
CURREMTSCHE... CIMS En.. Schema for 'SET CUI
Change

< >
Hint

See the DB2 Releaze Motes or Information Center for information on this kepword,

=]

Cancel | | Help

Figure 2-13 + CLI/ODBC Dialog Box—DB2 Example
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11 Click OK until you return to the Configure CIMS Data Source dialog box and do the
following.

a In the Select a System ODBC Data Source list, click the ODBC Data Source that
you created for the database.

b In the User ID and Password boxes, type the DB2 user ID cimsadmin and the
password admin as shown in example Figure 2-14. The password is encrypted.

¢ Inthe Owner/Schema box, the schema value must be the same as the schema value
that you typed for the CURRENTSCHEMA parameter in Step 9 on page 2-50.

In this example, the schema is CIMS. as shown in example Figure 2-14. Note that
the period at the end of the schema name is required and will be added
automatically if you do not include it.

Important! ¢ At this time, there is not an automated check to ensure that the
value in the Owner/Schema box matches the CURRENTSCHEMA parameter
value, so it is very important that you confirm that the values are the same in
both places.

d In the Additional Parameters box, type any additional parameters that are
required to enable connection to the database. For more information, consult
your DB2 DBA or CIMS Lab.

=42 Configure CIMS Data Source

Wi

Machine: J

Select a System CDBC Data Source:

QDBC Data Source Mame QDBC Driver Description .

|IBM DB2 ODBEC DRIVER

CIMSServer

Uszer ID: ’W
Pazswaord: ’*****—
CrvnerfSchema: CIMS.

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 2-14 « Configure CIMS Data Source Dialog Box—DB2 Example
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12 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box. The data source entry appears in the CIMS Data Source
Maintenance dialog box as shown in example Figure 2-15.

Because the CIMSServer data source entry is the only entry in the list, it is
automatically set as the default data source for Web and batch reporting and CIMS
Data Collectors. For more information about setting the default data source, see
page 5-7.

ans CIMS Data Source Maintenance

Edit  Wiew

Machine: J

CIMS Data Source ID | ODBC Data Source Mame | Database Type | Default for WebiCollectors? | User ID OwvneriSchemsa
( { DE2 e cimzadmin  CIMS.

Al | Remove | Eclit | Set WebiCaollector Default | Close |

Figure 2-15 « CIMS Data Source Maintenance Dialog Box—DB2 Example

Example Configuration—Two Databases

If you are using multiple DB2 databases with CIMS Server, each database must have
tables with a unique creator.tablename pair.

In the preceding example, the creator for the tables in the CIMSSERVER database is CIMS.
Assume that CIMSSERVER is your production database and you have also created a
development database named CIMSDEV that also has a creator of CIMS. In this situation,
you need to create tables for the CIMSDEV database with a unique creator.

The following example shows you how to create a creator named CIMSD for the tables in
the CIMSDEV database. The DB2 user ID and password for the DB2 subsystem is cimsadmin
and admin, respectively.

1 In the DB2 Control Center application, create a database user named CIMSD. The user
must have privileges to select, insert, update, and delete tables.

2 In CIMS Server Administrator, open the CIMS Data Source Maintenance dialog box
and click Add.
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3 In the Add CIMS Data Source dialog box, type an ID for the CIMS Data Source, and
then click OK. In this example, the CIMS Data Source ID is CIMSDEV. The Configure
CIMS Data Source dialog box appears.

4 Click ODBC Data Source Administrator. The ODBC Data Source Administrator
dialog box appears.

5 On the System DSN tab, click Add. The Create New Data Source wizard appears.

6 Click the DB2 driver that you want to use to set up the data source and then click
Finish. The driver name - Add dialog box appears.

7 1In the driver name — Add dialog box, do the following:

a In the Data source name box, type the name that you want to assign to the ODBC
Data Source. For this example, the name is CIMSDEV.

b In the Database alias list, click the alias for the database that you want the ODBC
Data Source to point to. You can also click Add to add an alias if needed. If you
need assistance choosing or creating the database alias, consult your DB2 DBA.

¢ In the Description box, type an optional description of the ODBC Data Source.
d Click OK to close the dialog box and return to the System DSN tab.

8 Double-click the ODBC Data Source that you just added. The CLI/ODBC Settings
dialog box appears.

9 On the Data Source tab, do the following:

a Type the DB2 user ID cimsadmin and the password admin in the User Id and
Password boxes.

b Click Connect to test the connection.

10 On the Advanced Settings tab, the parameter DBALIAS appears with the alias that you
selected in Step 7. You need to add the parameters DBNAME and CURRENTSCHEMA. The
schema name is database user that you created in Step 1 on page 2-52.

To add the DBNAME parameter:
a Click Add. The Add CLI/ODBC parameter dialog box appears.
b In the Select a CLI/ODBC parameter list, click DBNAME, and then click OK.

¢ In the MVS DBNAME filter dialog box, type the database name CIMSDEV, and then
click OK.
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To add the CURRENTSCHEMA parameter:

a Click Add.

b In the Select a CLI/ODBC parameter list, click CURRENTSCHEMA, and then

click OK.

¢ In the Schema for 'SET CURRENT SCHEMA' issued after connect dialog box, type
the schema name CIMSD, and then click OK.

The parameters DBNAME and CURRENTSCHEMA appear in the parameter list on the
Advanced Settings tab as shown in example Figure 2-16. Click APPLY and then click

OK to close the dialog box.

CLI/ODBC Settings - CIMSDev 53
Data Source  Advanced Seftings l
Select a parameter to change its value.
CLI Parameter Walue | Pending ' alue | Type | Description Add
DEALIAS ROCADO
DEMAME CIMSDEY En.. Y5 DEMAME filer Remove
CURRENTSCHE... CIMSD En.. Schema for 'SET CURREM
Change
< ¥
Hint
See the DB2 Releaze Motes or Information Center for information on this kepword,
QK | Cancel | | Help

Figure 2-16  CLI/ODBC Dialog Box—DB2 Example
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11 Click OK until you return to the Configure CIMS Data Source dialog box and do the

following:

a In the Select a System ODBC Data Source list, click the ODBC Data Source that

you created for the database.

In the User ID and Password boxes, type the DB2 user ID cimsadmin and the
password admin as shown in example Figure 2-17. The password is encrypted.

In the Owner/Schema box, the schema value must be the same as the schema value
that you entered for the CURRENTSCHEMA parameter in Step 10 on page 2-53.

In this example, the schema is CIMSD. as shown in example Figure 2-17. Note that
the period at the end of the schema name is required and will be added
automatically if you do not include it.

Important! ¢ At this time, there is not an automated check to ensure that the
value in the Owner/Schema box matches the CURRENTSCHEMA parameter
value, so it is very important that you confirm that the values are the same in
both places.

In the Additional Parameters box, type any additional parameters that are
required to enable connection to the database. For more information, consult
your DB2 DBA or CIMS Lab.

=42 Configure CIMS Data Source

Wi

Machine: J

Select a System CDBC Data Source:

QDBC Data Source Mame QDBC Driver Description .

1B DB2 ODBC DRIVER
ClSServer IBhd DE2 ODBC DRIVER

Uszer ID: ’W
Pazswaord: ’*****—
CrvnerfSchema: CIMSD.

Additional Parameters: |

QDBC Data Source Administrator ... | OK | Cancel |

Figure 2-17 + Configure CIMS Data Source Dialog Box—DB2 Example
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12 Click OK to save the data source information and close the Configure CIMS Data
Source dialog box. The data source entry appears in the CIMS Data Source
Maintenance dialog box as shown in example Figure 2-18.

ans CIMS Data Source Maintenance

Edit  Wiew

Machine: J

DB2

sta Source Mame | Databasze Type | Default for WebiCollectors? | User ID

es

CrvnerfSchema
cimzadmin  CIMSD.
cimzadmin - CIMS.

Add | Remave | Ediit |

Set WehiCollector Defautt |

Close |

Figure 2-18 « CIMS Data Source Maintenance Dialog Box—DB2 Example

13 Close the CIMS Data Source Maintenance dialog box, and go to the Select CIMS Data
Source list at the bottom of the CIMS Server Administrator main window. This list
enables you to point CIMS Server Administrator to the data source that you want to
use. Make sure that you select the CIMSDev data source that you just created and not

the CIMSServer data source.

14 Click System Administration » Database » Initialize Database and initialize the
database as described in Initialize the Database on page 2-57.

The initialization process will create tables in the CIMSDEV database with a creator of
CIMSD. To confirm that the tables have been created, start the DB2 Control Center and
navigate to the subsystem that contains the CIMSDEV database. Expand the subsystem,
and click Tables. The tables for CIMSDEV database should appear with a creator of CIMSD.
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Initialize the Database

When you add a CIMS Data Source, the data source appears in the Select CIMS Data
Source list at the bottom of the CIMS Server Administrator main window. This list
enables you to point CIMS Server Administrator to the data source that you want to use.

At this point, you should have created one CIMS Data Source for the database and the
data source ID should appear in Select CIMS Data Source list.

To enable CIMS Server to use the database referenced by the CIMS Data Source, you need
to initialize the database. Initializing the database performs the following tasks:

m Creates new database tables
m Populates these tables with an initial set of data

m Creates necessary database objects

Note ° A database should be initialized only once. Initializing will overwrite any
existing data. You will receive a warning if you attempt to initialize a database that
has already been initialized.

To initialize the database:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Initialize Database.

The Database Initialization dialog box appears as shown in Figure 2-19.

=% Database Initialization

Initialization Results:

Initislize Databasze | Close |

Figure 2-19 - Database Initialization Dialog Box
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2 Click Initialize Database to populate the database with the necessary defaults.

Note ¢ If the user ID that you are using to access the database does not have
sufficient system administration authority, CIMS Server might not be able to
create database objects or to create objects with the appropriate permissions
during database initialization. In this situation, a warning message appears
recommending that you contact your database administrator or CIMS Lab before
continuing.

3 In the Select Web Reports Version dialog box, click the report version that you are
using for Web reporting (SQL Server Reporting Services or Crystal Reports 8.5, 9, 10,
or XI), and then click OK. The report version that you select determines the default
report paths that appear in the Configuration dialog box (see Reporting Tab on
page 2-60).

4 Click OK when the initialization is complete.

Create a Processes Folder

In Windows, rename and/or move the Sample Processes folder. This folder is in
C:\Program Files\CIMSLab if you installed CIMS Server in the default location.

CIMS Lab recommends that you rename this folder Processes and move it to a location
where you keep data that is backed up. However, you can give this folder any name and
move it to any location. This folder is referred to as Processes in this guide.

The Processes folder is used to store process definitions. A process definition is a folder
that contains the files required to process usage data from a particular source such as a
database, operating system, or application. For more information about process
definitions, see CIMS Server Administrator Processing on page 6-21.

Note that the process definitions in the Sample Processes folder contain sample CSR or
CSR+ files that you can process and load into the database as described in Process a
Sample Resource File (Optional) on page 2-64.
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Enter CIMS Server Configuration Settings

You need to set the configuration settings for CIMS Server in CIMS Server Administrator.
To configure the settings:

1 In the main window, click System Administration » Configuration Information.

The Configuration dialog box appears.

2 For the purpose of getting started, complete the Organization, Processing,
Reporting, and License tabs as shown in the following sections. For information
about the remaining tabs, see Configuring System Settings on page 3-42.

Organization Tab

Enter your organization name and address (maximum of 255 characters in each line).
This information appears on the standard invoices that are provided with CIMS Server.
Processing Tab

In the Process Definition Path box, enter the path to the Processes folder as shown in
example Figure 2-20.

Wi

Organization Processing l Reporting ] Database ] License ] Wk ] Aud'rting] Archiving ] Ciption List]

Path l Options] Closing]

Process Definition Path: |D:\Pr0c:esses\ Browse...

Reset To Defaultts

Figure 2-20 + Configuration Dialog Box—Processing Tab

For more information about the Processing tab, see Processing Settings on page 3-44.
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Reporting Tab

The Reporting tab contains the settings for CIMS Server Web and batch reporting. The
default report paths that appear on the Paths subtab are determined by the report type
that you selected when you initialized the database. The Paths subtab contains the paths
to the following report folders:

m Standard. CIMS Server produces chargeback and resource accounting reports based
on IT usage data from your organization. This folder contains a variety of standard
reports that you can use as templates to create custom reports for your organization.
For a description of each of the standard reports, refer to the CIMS Server Web
Reporting User’s Guide.

m Custom. This folder contains custom reports. Custom reports are those that your
report developer creates either independently or from the standard reports.

m Published. This folder contains published reports. Published reports are reports that
have been saved with the data that was generated at the time the reports were run.
Publishing a report enables users to view a report without having to regenerate it.

Note * End user access to published reports is dependent on the security
permissions described in Folder Permissions Required for Publishing and Viewing Batch
Reports on page 4-48.

CIMS Lab recommends that you keep the Standard folder in the default location because
standard reports might be updated and/or added with a new version or release of CIMS
Server. (A list of new and updated reports is included in the release notes that accompany
the new CIMS Server version or release. You can also view all of the available standard

reports at http://www.cimsserver.com.)

You can keep the Customand Published report folders in the default location or you can
rename and/or move the folders to any location. The reports in the Customand Pub1ished
report folders are not overwritten when you upgrade to a new version or release of CIMS
Server. CIMS Lab recommends that if you move the Customand Pub1ished report folders,
you move the folders to a location where you keep data that is backed up.
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Enter the paths for storing your reports or accept the default locations as shown in
example Figure 2-21.

Wigw

Organizaﬁon] Processing  Reporting l Database ] License ] Weh ] Aud'rting] Archiving ] Ciption List]

Paths l Options] Invaoice ]

Path to standard reports folder:

|C:\Pr0gram Filez\ZIMSLab'Server ReportsMSRSStandardy Browwse...
Path to custom reports folder:

|C:\Pr0gram Filez\ZIMSLabiServer ReportsMEREWustom!, Browwse...

Path to publizhed reports folder:

|C:\Pr0gram Filez\ZIMSLab'Server ReportsMERSPublished) Browwse...

Reset To Defaults

Figure 2-21 + Configuration Dialog Box—Reporting Tab

For more information about the Reporting tab, see Reporting Settings on page 3-45.
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License Tab

CIMS Server requires a license key that is provided by CIMS Lab. If you do not have your
license key, contact CIMS Lab.

To enter licensing information:

1 Click the appropriate workstation (machine) and enter the license key as shown in

example Figure 2-22.

If you installed CIMS Server on Windows XP or Windows Server 2003, you should be
logged on to the CIMS Server application server as a user in the Windows
Administrators group to enter the license key. If you are not a member of this group,
complete the steps in Update the System Registry.

Wigw

Organizaﬁon] Processing ] Reporting ] Database License ]Web ] Aud'rting] Archiving ] Ciption List]

Machine: | (LOCAL) ﬂ

e [EEEEEEEEEEE

Expiration Date: 12i31/2005

Update License | Remove License

Reset To Defaultts

Figure 2-22 « Configuration Dialog Box—License Tab

2 Click Update License.

Update the System Registry

1

2

3

4

5

Click the Windows Start button, and then click Run.
Type regedit, and then click OK.

Navigate to HKEY_LOCAL_MACHINE » SOFTWARE » CIMS.
Right-click the CIMS folder, and then click Permissions.

Add the user account that will be working with CIMS Server and give the account
Full Control and Read permissions.

Note that if you installed CIMS Server on Windows 2000 Server, you cannot set registry
permissions at the key level.
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Set the Account Code Structure

CIMS Server uses an account code to identify entities for billing and reporting. This code
determines how CIMS Server interprets and reports input data. The account code
structure defines the account code levels that appear on invoices and other reports.

To define the account code structure:

Getting Started

1 Click Chargeback Administration » Chargeback Table Maintenance » Account
Code Structure.

The Account Code Structure List Maintenance dialog box appears.

2 Click Edit.

The Account Code Structure Maintenance dialog box appears as shown in

Figure 2-23.

a5 Account Code Structure Maintenance

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Level

Description Lencth Full Lencth
1| Application 4 4
2 Resource Group 16 20
3| Platform 16 36

4| Server 20 a6

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

- B

Figure 2-23 + Account Code Structure Maintenance Dialog Box

3 Edit the example account code levels (descriptions and lengths) for your site and then
click OK. You can add or delete levels as needed. For detailed instructions on how to
define the account code levels, see Setting Up the Account Code Structure on page 3-3.
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Process a Sample Resource File (Optional)

Note ¢ This is an optional step intended to provide a quick introduction to
processing CSR and CSR+ files. For more information about processing these files,
see Chapter 6, Processing Data.

The primary method for input into CIMS Server is the CSR or CSR+ file. The CSR file is
produced by CIMS Data Collectors for Windows and UNIX. The CSR file is also
produced by CIMS Mainframe Data Collector and Chargeback System 11.6 and earlier.

The CSR+ file is produced by CIMS Mainframe Data Collector and Chargeback System
12.0 and later.

CIMS Server includes sample CSR and CSR+ files from different databases, operating
systems, and applications. The files are contained in process definition subfolders within
the Processes folder that you created in Create a Processes Folder on page 2-58. You can
process a sample CSR or CSR+ file as follows:

1 In the CIMS Server Administrator main window, click Chargeback Administration »
Processing » Process Definitions.

The Process Definitions List Maintenance dialog box appears as shown in Figure 2-24.

av Process Definitions List Maintenance

Wi

" Process Definitions i
Apach
CIhiS sk

CIMSAINEventLog

CIMSWinPrint

CISWinProcess

DBESpace

Mainframe

MainframeCICS

MainframeDB2

MainframeDisk

MainframeshFE

MSExchange

MSExchangehi

MSIS-ieh

MSReportingServices

MSSEL2000

Prorate

Tranzactions

Universal

UnixDE2

i PSS

D:Processes)

Add | Remave

Ediit | Rename Process |

Close

Figure 2-24 « Process Definitions List Maintenance Dialog Box
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2 Click the process definition that contains the resource file that you want to process,
and then click Process.

Note ¢ Processing of the Apache and VMware sample CSR files will not be
successful unless the rate codes contained in these files have been entered in the
CIMSRate table. The rate codes for Apache and VMware are not entered by default.
For more information about rate codes, see Working With Rates on page 3-9.

3 The processed data loads to the database and the Processing Complete! message
appears. Click Yes to view the event log (the Event Viewer appears showing the files
processed) or No to skip the event log.

To view the processing results, make sure that the process definition is selected, and then
click Edit. Click the Process Results tab to view the results. (For more information, see
Process Results Tab on page 6-37.)

Increase the Event Viewer Maximum Log Size

CIMS Server logs all events (successful and unsuccessful) to the Windows Event Viewer.
To accommodate the large number of data loads generated by CIMS Server, you need to
increase the maximum log size in the Event Viewer as shown in the following steps.
(Note that these steps are for the Microsoft Windows Server 2000 operating system. If
you are using another operating system, refer to the Microsoft documentation if needed.)

1 In Windows Control Panel, double-click Administrative Tools » Event Viewer.
The Event Viewer window appears.

2 Right-click Application, and then click Properties.
The Application Properties dialog box appears.

3 On the General tab, increase the Maximum log size to at least 16000 KB.

4 Choose one of the following options under When maximum log size is reached:
e Click Overwrite events older than and enter 45 days.
Or

¢ Click Do not overwrite events. This option requires that you clear the log
manually rather than automatically when the log is full.

To avoid deleting older events, do not click Overwrite events as needed.

5 Click OK when you are finished.
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Follow the steps in this section to set up the Web server. The Web server may reside on
the same server as the CIMS Server application server or on a separate server. Note that
these steps are for IIS 5.1 on the Microsoft Windows 2000 Server operating system. If you
are using another operating system, refer to the Microsoft documentation or contact
CIMS Lab.

Install CIMS Server Administrator and CIMS Web Applications on
the Web Server (If Using a Separate Server)

Note ¢ If the Web server resides on the same server as the CIMS Server application
server, skip this section and continue to Set the User Authentication Method for the Web
Sites on page 2-67.

If you are installing the Web server on a separate server than the CIMS Server application
server, you need to install CIMS Server Administrator and CIMS Server Web Reporting
on the Web server. If you want to use the optional CIMS Web Console and CIMS
Financial Modeler applications, you must also install these applications on the Web
server.

To install the applications, run the CIMS Server setup program and choose the CIMS
Administrator, CIMS Web Reporting, CIMS Web Console, and CIMS Financial
Modeler options (see Performing a New Installation on page 2-22).

When installation is complete, you need to start CIMS Server Administrator and point to
the CIMS Data Source for the database in the Select CIMS Data Source list. To add a
CIMS Data Source for the database, see Configure the CIMS Data Source for the Database
on page 2-33.
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Set the User Authentication Method for the Web Sites

By default, the CIMS Server Web Reporting application uses the IIS Default Web Site and
sets the home directory path to ...Program Files\CIMSLab\Server\Web.

Virtual directories for other CIMS applications and files and for Crystal Reports and SQL
Server Reporting Services are installed below the Default Web Site.

There are two options for controlling user access to the default Web site and virtual
directories: anonymous access and authenticated access. Anonymous access allows
remote access by the IUSR_computername account. Users can connect to the Web site or
directory without a user name or password. Authenticated access uses the current
Windows user information on the client computer to allow users to connect to the Web
site or directory.

If the Web site and directories are accessed via the Internet, you must set the user access
for the default Web site and directories to anonymous.

If you are using a SQL Server or MSDE database and the Web site and directories are
accessed via an intranet, CIMS Lab recommends that you set the Web site/directories to
authenticated access.

If you are using an Oracle or DB2 database and the Web site and directories are accessed
via an intranet, you can set the Web site/directories to authenticated access or
anonymous access.

To set authenticated access:

1 In IIS Manager, navigate to the Web site or directory.

2 Right-click the Web site or directory, and then click Properties.

3 In the Properties dialog box, click the Directory Security tab.

4 In the Anonymous access and authentication control area, click Edit.

5 In the Authentication Methods dialog box, select the Integrated Windows
authentication check box and clear all other check boxes.

6 Click OK until the Properties dialog box closes.

7 Restart IIS.
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To set anonymous access:

1

2

3

4

5

Complete Step 1 through Step 4 on page 2-67.
Click the Anonymous access check box and clear all other check boxes.
Click Edit and do the following in the Anonymous User Account dialog box:

a Enter the Windows account IUSR_computername in the Username box. If the [IUSR
name does not appear, click Browse to find it.

b Select the Allow IIS to control password check box. CIMS Lab recommends this
option because it enables IIS to change the password for each access to the CIMS
Server Web Reporting Web site.

Anonymous User Account x|

Anonymous Uzer

Select the Windows Uszer Account used to access this computer when an
anonymous uger connects to this site.

Usermame: IIUSH_computemameI Browse... |

Bassword: I xxxxxxxxxx

¥ &llow 115 to control password

QK I Cancel | Help |

Figure 2-25 + Anonymous User Account Dialog Box

Click OK until the Default Web Site Properties dialog box closes.

Restart IIS.

Features Not Available With Anonymous Access

B 2-68

Auto logon for CIMS Web applications. CIMS Server Web Reporting and the other
CIMS Web-based applications provide an auto logon feature. This feature enables end
users and administrators to use the application without entering a CIMS user ID and
password to log on. (To enable auto logon, see Web Settings on page 3-49.) The auto
logon feature is not available if you use anonymous access for IIS.

Tracking user IDs for transactions. If you use anonymous access and are using the
transaction audit feature, the user ID associated with the transaction will not reflect
the actual user. The transaction audit feature enables CIMS Server administrators to
track miscellaneous, recurring, and credit transactions created in CIMS Server Web
Reporting. (For more information about transactions, refer to the CIMS Server Web
Reporting User’s Guide). To enable transaction audits and other table audits such as
client and rate, see Table Audit Settings on page 3-54.

Note ¢ The table audit feature is available if you are using a SQL Server database.
Support for Oracle and DB2 will be included in a future release of CIMS Server.
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Assign Folder Security Permissions on the Web Server

The CIMS Web application users must have the following security permissions for the
CIMS Server folders shown. The default location for these folders is C: \Program

Files\CIMSLab.

Server Read & Execute
Server\Web\temp Full Control
Server\Reports\Published Read & Execute, Write
Admin Read & Execute

If anonymous access is enabled for IIS, the user is IUSR_computername and that user name
must be provided with these permissions. If Windows authenticated access is enabled,
each Windows user that will be accessing the Web application must be provided with
these permissions.

Note ¢ If the user is IUSR _computername and you entered the correct
IUSR_computername account during installation, CIMS Server automatically sets the
folder security permissions for the user. See Enter the IIS Web User Name on page 2-24.
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Enable Secure Sockets Layer (SSL) for the
CIMS Server Web Reporting Web Site (Optional)

CIMS Server provides an optional auto logon feature that enables users to access the
CIMS Server Web Reporting Web site without entering a user ID and password (see Web
Settings on page 3-49). If you use this feature, Secure Sockets Layer (SSL) is not needed.

If you do not use the auto logon feature, you can enable SSL to protect the user ID and
password needed to access the Web site. SSL is a protocol for ensuring security and
privacy in internet communications via encryption. When SSL is enabled, https://
rather than http:// appears in the URL when a user accesses the Login page of the CIMS
Server Web Reporting Web site.

To set up and enable SSL for the Web site, you need to first obtain a SSL certificate from
a third-party certificate authority and install the certificate for the site. For the steps
required to obtain and install the certificate, refer to the Microsoft Knowledge Base
Article 298805.

Once you have installed the SSL certificate, complete the following steps to enable SSL
for the login ID and password and then restart IIS.

In the 1IS Manager Window:
1 Navigate to Default Web Site and expand it.

N

Right-click the Secure folder, and then click Properties.
3 On the Directory Security tab, click Edit in the Secure communications area.

4 In the Secure Communications dialog box, select the Require secure channel (SSL)
check box, and then click OK.

In CIMS Server Administrator:

1 Click System Administration » Configuration Information » Web tab » General
subtab.

2 Select the Secure Login check box.

3 Ifyou are using an SSL port other than the default port 443 for the Web site, type the
port number in the Secure Port check box.

4 Click OK when you are finished.
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Set Up SQL Server Reporting Services

Note ¢ This section is applicable only if you selected SQL Server Reporting Services
when you initialized the CIMS Server database.

To use SQL Server Reporting Services with CIMS Server, you need to perform the
following configuration steps in the order presented.

Make sure that you have installed Reporting Services as described in Installing SQL Server
Reporting Services on page 2-18.

Enter the Reporting Services Report Server URL

The URL for Reporting Services Report Server must be entered as a configuration option.
From the CIMS Server Administrator main Window, click System Administration »
Configuration Information to open the Configuration dialog box and then click the
Web tab. The URL is entered in the Report Server URL box.

If you are upgrading from a previous CIMS Server release, the place holder ServerName
appears in the URL (e.g., http://ServerName/ReportServer). Change ServerName to the
name of the server that Reporting Services resides on.

If you are installing CIMS Server for the first time and have initialized the database, the
correct URL will appear in the Report Server URL box if Reporting Services is on the local
server.

If Reporting Services is not found on the local server, the Report Server URL box is blank
and you need to type the URL for the remote server.

Note ¢ The Report Server URL box will also be blank if CIMS Server Administrator
could not connect to Reporting Services on the local server during initialization. For
example, IIS or Report Server was not running.
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Configure Reporting Services With CIMS Server Administrator

CIMS Server Administrator must perform certain configuration tasks in Reporting
Services. If CIMS Server Administrator is able to connect to Reporting Services on the
local server, these configuration tasks are performed during the CIMS Server database
initialization process.

If CIMS Server Administrator is unable to connect to Reporting Services, either because
Reporting Services is installed on a remote server or another issue is preventing
connection, the following message appears during initialization:

CIMS Administrator

The system was not able ko make a connection ko the Reporting Services Report Server, This could be due ko any of the
following reasons:

a. Reporting Services is not installed locally, IF Reporting Services is not installed locally, you need to update the
configuration option Report Server URL after the initialization completes, To access the Report Server URL option, click System
Administration - = Configuration Information -= Web from the CIMS Administrator main window,

b. II5is not running.

c. The Report Server is not running.

‘When initialization completes, correct the problem and then click System Administration - = Reporting - = Configure Reporting
Services with CIMS Administrator from the CIMS Administrator main window,

You need to correct the issue and then click System Administration » Reporting »
Configure Reporting Services with CIMS Administrator.

Set 1IS User Authentication for Report Manager
and Report Server

As described in Set the User Authentication Method for the Web Sites on page 2-67, CIMS
Lab strongly recommends that you set Integrated Windows authenticated access for the
IIS Default Web Site and its virtual directories (which include the Reporting Services
Reports and ReportServer virtual directories). Because Reporting Services can be installed
on any server, Reports and ReportServer may be on the Web server or another server.

Install CIMS Report Component on the Reporting Services Server
(If Reporting Services and the Web Server are on Separate
Servers)

CIMS Report Component contains CIMS components required by SQL Server Reporting
Services. CIMS Report Component is installed by default when you install the CIMS
Server components on the Web server. If Reporting Services and the Web server are on
separate servers, you need run the CIMSRSLibSTD.ms1 file to install CIMS Report
Component on the Reporting Services server.

You can find the CIMSRSLibSTD.ms1 file in the following locations:
m Inthe ...CIMSLab\Redist\CIMSWebRsReports folder.

m On the CIMS Product CD or FIP site in the CIMSServer\CIMS MSRS Additional Files
folder.

m On the CIMS Server Product Downloads page on the CIMS Lab Web site.

When you run the CIMSRSLibSTD.ms1 file, the CIMS Report Component DLL
(CIMSRSLibSTD.d11) is installed in the Report Server bin folder.
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Create a Role in Reporting Services

Reporting Services uses a role definition to define which tasks a user is allowed to
perform in connection with a folder, report, or other item. In Reporting Services Report
Manager, you need to create one role definition for all CIMS Server Web Reporting users
and set the user options for that role as described in the following sections.

To create a role:

1 Start Report Manager.

If Reporting Services is installed on a remote server, you must access Report Manager
through your Web browser using the Report Manager URL. For example:

http://roca/Reports

If Reporting Services is installed on the local server, you can use the URL or you can
click Start » Programs » Microsoft SQL Server » Reporting Services » Report
Manager.

Note ¢ If you receive a message stating that the report server cannot decrypt the
symmetric key when you try to start Report Manager, follow the steps in Report
Server cannot decrypt the symmetric key message appears on page 8-12.

2 Click Site Settings in the upper right corner of the Report Manager home page.

3 On the Site Settings page, click Configure item-level role definitions under Security.
4 On the Item-Level Roles page, click New Role.

5 On the New Role page, do the following:

e In the Name box, type a name for the role. The name CIMSUser is used in this
guide, but you can use any name.

¢ Inthe Description box, type a description for the role. For example, Role used for
CIMS users to view/deploy reports.

¢ Click the following tasks:
e Manage data sources
e Manage folders
e Manage reports
* Manage resources
e View reports
* View resources

6 Click OK.
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The role is saved to the Reporting Services Report Server database. The role name and
description appears on the Item-Level Roles page as shown in example Figure 2-26.

= | Report Manager - Microsoft Internet Explorer

File Edit View Favorites Tools  Help
@ Back - < \ﬂ \ELI _I\J /..-\J Search ‘,,\“) Favorites 6\* = .,'_,’. x| - ﬁ ﬁ év
Address |2:| http: firoca-deborahzkiReports/PagesiRoles, aspx?System=False
Home | My Subscriptions | Site
[= SqQL Server Reporting Services
% ltem-Level Roles Search for:| |
L Mew Role
Raoled Description
Browser May view folders, reports and subscribe to reports,
| CIMSUzer Role used for CIMS users to view/deploy reports,
Content Manager May manage content in the Report Server. This includes folders, reports and resources,
My Reports May publish reports and linked reports; manage folders, reports and resources in a users My Rep
Publisher May publish reports and linked reports to the Report Server,
@Done

Figure 2-26 + Report Manager Item-Level Roles Page
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Assign Users to the CIMSUser Role

The users that you can add to the CIMSUser role are dependent on whether you are
running Reporting Services on the Web server or another server.

m If you are running Reporting Services on the Web server, you can add the following
local Windows user account to the role. This account enables all users to access
Reporting Services.

e computername\ASPNET (Windows 2000)
Or
e NT AUTHORITY\NETWORK SERVICE (Windows 2003)

m If you are running Reporting Services on a server other than the Web server, you
cannot use the local user account ASPNET or NETWORK SERVICE. In this situation, you
need to do the following:

1 On the Web server, add a local Windows user account named CIMSUser to be used
for Reporting Services. Assign a password of password to the user. Make sure that
you disable the option to change the password at next logon and enable the
password never expires option.

2 Inthe ...CIMSLab\Server\Web\CIMSReporting\Web.config file on the Web server,
add the following after the end of the authorization element:

<authorization>
<allow users="*"/> <l-- Allow all users -->

<I-- <allow users="[comma separated list of users]"
roles="[comma separated 1ist of roles]"/>
<deny users="[comma separated 1ist of users]"

roles="[comma separated 1ist of roles]"/>
-
</authorization>
<identity impersonate="true" userName="CIMSUser" password="password"/>

Where password is the actual password for CIMSUser, not a placeholder.

Note ¢ The updated Web.config file will not be overwritten when you upgrade
to a new release of CIMS Server.

3 Assign the following security permissions for CIMSUser account to the folders

shown:

e Full Control .. .WINDOWS\Microsoft.NET\Framework\v1l.1.4322\Temporary
ASP.NET Files

e Read and Write ...Program Files\CIMSLab\Server\ReportsMSRS

4 On the server running Reporting Services, create a user account CIMSUser with the
password password.

5 Add the user account CIMSUser to the CIMSUser role (see To assign users to a role: on
page 2-76).

6 Make sure that IIS is set for Integrated Windows authentication on both the Web
Server and the server running Reporting Services. If you are using anonymous
access, contact CIMS Lab.
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To assign users to a role:

1

6
7

On the Report Manager home page, click the CIMSReporting folder. This is the folder
that contains the CIMS reports.

On the CIMSReporting page, click the Properties tab.
Click the Security link in the left frame.

Click New Role Assignment. (If New Role Assignment does not appear immediately,
click Edit Item Security, and then click OK in the message box.)

In the Group or user name box, type CIMSUser.
Select the check box for the role that you created in To create a role: on page 2-73.

Click OK.

The user is saved to the Reporting Services Report Server database. The user name and
role appears on the Properties tab as shown in example Figure 2-27.

2 Report Manager - Microsoft Internet Explorer

File Edit View Favorites Tools  Help
; Py A, ;
OBack @ Q @ \ﬂ \ELI | 2 ! Search Ay Favarites {‘} = ﬂ = ﬁ '5
Address |ﬁj http: fflocalhost fReports/Pages Folder . aspx?ItemPath="%2FCIMSReporting&viewMode=List&:SelectedTabld=PropertiesTab&SelectedSubTabld=AuthorizationTab
v|DeIete v| *" Fndit ¥ Reference “. Highlight = 2ablacked ~ i 32°F - @ SCrEEnsavers, com
] p
- SqQL Server Reporting Services Home | My Subscriptions | 4
Home =
= Search for:
// CIMSReporting
x | 42 Mew Role assignment £ Revert to Parent Security
General
Security O Group or Userd Roleds)
[] Edit BUILTIM\Administrators Content Manager
||:| Edit CIMSUser CIMSUser

Figure 2-27 + Report Manager Properties Tab
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Configure Crystal Reports Server

Note ¢ This section is applicable only if you selected Crystal Reports XI when you
initialized the CIMS Server database.

This section provides information to enable you to quickly configure Crystal Reports
Server to work with CIMS Server. If you want more detailed information about
configuring Crystal Reports Server, refer to the documentation that accompanies the
product including the BusinessObjects Enterprise 11 Administrator’s Guide.

To use Crystal Reports XI with CIMS Server, you need to add CIMS users as Crystal
Reports Server users and deploy CIMS reports to Crystal Reports Server. CIMS Server
Administrator provides a wizard that enables you to perform these steps easily as
described in Configuration in CIMS Server Administrator: on page 2-78.

Before you run the wizard in CIMS Server Administrator, CIMS Lab recommends that
you start BusinessObjects Enterprise Central Management Console and perform the
steps in Configuration in BusinessObjects Enterprise Central Management Console:. (Crystal
Reports Server is a component of BusinessObjects Enterprise.) Detailed instructions for
using Central Management Console are provided in the application’s Help files and in
the BusinessObjects Enterprise 11 Administrator’s Guide.

Configuration in BusinessObjects Enterprise Central Management Console:

1 Tologon to the Central Management Console, open your Web browser and go to the
following page:

http://webserver/businessobjects/Enterprisell/WebTools/adminlaunch/default.aspx

Where webserver is the name of the Web server. If you changed this default virtual
directory on the Web server, you will need to type your URL accordingly.

2 On the BusinessObjects Enterprise Administration Launchpad page, click Central
Management Console.

The Central Management Console Log On page appears.

3 Type Administrator in the User Name box. This default account does not have a
password until you create one.

4 Click Enterprise in the Authentication Type list.

5 Click Log On.
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6 From the Central Management Console home page, do the following:

The default administrator account for Crystal Reports Server is Administrator
with no password. You can use this default account for CIMS Server; however,
CIMS Lab recommends that you assign a password for the account as follows:

a Click Users.
b On the All Users page, click the Administrator account.
¢ Set a password for the Administrator account.

If you do not want to use the Administrator account, you can click New User on
the All Users page to create another account and password for use by CIMS Server.

The user password requirements (e.g., number and type of characters) differs
between CIMS Server and Crystal Reports Server. You will receive an error message
when you try to add a password in CIMS Server Web Reporting or CIMS Server
Administrator that does not match the requirement for Crystal Reports Server. To
avoid this message, you can change the password restrictions in BusinessObjects
Enterprise Central Management Console as follows:

a From the Central Management Console home page, click Authentication and
clear the restriction check boxes on the Authentication page.

b Click Update.

Configuration in CIMS Server Administrator:

1 In the CIMS Server Administrator main window, click System Administration »
Reporting » Configure BusinessObjects Enterprise Server.

2 When the Configure BusinessObjects Enterprise Wizard appears, click Next.

3 Enter the following, and then click Next.

Enterprise Server Name. Type the name of the server running Crystal Reports
Server.

User Name. Type the default user account Administrator or the user account that
you created for CIMS Server.

Authentication Type. If you are using the default Administrator account, click
Enterprise. If you are using another account, click the applicable authentication
type (Enterprise or Windows).

Password. Type the password for the account.

4 Type a name for the BusinessObjects Enterprise user group for CIMS users or accept
the default (CIMS Users), and then click Next.

5 Type a name for the BusinessObjects Enterprise folder in which CIMS reports will be
deployed, or accept the default (CIMS Reports). Click Next.
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6 CIMS Server provides an optional auto logon feature that enables users to access the
CIMS Server Web Reporting Web site without entering a user ID and password (see
Web Settings on page 3-49). If you want to use this feature, click Single sign-on is
enabled. Otherwise, the auto logon feature will be disabled in CIMS Server
Administrator. That is, the setting in the Single sign-on is enabled check box controls
the setting of the Enable Intranet Auto Logon check box in the Configuration dialog
box.

7 1In the CIMS Users box, click the CIMS users that you want to include as Crystal
Reports Server users, and then click Add to move the users to the appropriate tab in
the BusinessObjects Enterprise Users box. Note that depending on when you run
the wizard, the CIMS user Admin may be the only user that appears in the CIMS Users
box (see Notes About Using the Configure BusinessObjects Enterprise Wizard on
page 2-80).

The tab or tabs that appear for adding the users depends on the type and number of
licenses that you purchased for Crystal Reports. The type and number of licenses
available appear in blue on the line that begins with Enterprise Licenses. If you are
licensed for named users, the number of unassigned named user licenses available is
provided below the Enterprise Licenses line.

e If Crystal Reports is licensed for named users, the tab Named appears in the
BusinessObjects Enterprise Users box. Add the CIMS users that you want to
specify as named users (up to the maximum number of licensed named users
allowed). If you do not have a named users or processor license, this tab does not
appear.

e If Crystal Reports is licensed for concurrent users, the tab Concurrent appears in
BusinessObjects Enterprise Users box. You can add or remove as many CIMS
users from this tab as you want to share concurrent licenses. If you do not have a
concurrent users license, this tab does not appear.

e If Crystal Reports is licensed for processor, the tab Named appears in the
BusinessObjects Enterprise Users box. Add the CIMS users that you want to
specify as named users (up to the maximum number of licensed named users
allowed). In this situation, the Concurrent tab does not appear.

Note * You can also use the Configure BusinessObjects Enterprise Wizard to
remove CIMS users from Crystal Reports Server.

8 Click Finished.

9 Click OK in the configuration ran successfully message box, and then click OK to
close the wizard.
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Notes About Using the Configure BusinessObjects Enterprise
Wizard

The wizard is intended to provide an easy-to-use interface that enables you to access
Crystal Reports Server to perform the basic configuration required to run CIMS
reports. You can perform the same steps using the BusinessObjects Enterprise Central
Management Console.

The wizard is intended to deploy CIMS users and reports to Crystal Reports Server in
the following situations:

e You are setting up CIMS Server for the first time.
¢ You have upgraded from an earlier release of Crystal Reports to Crystal Reports XI.

e You have changed the Crystal Reports Server account that you were previously
using for CIMS Server.

After using the wizard to initially deploy CIMS users and reports, you will be able to
add users and reports to Crystal Reports Server when you are adding users or reports
in CIMS Server Administrator.

When you use the wizard to add CIMS users to Crystal Reports Server, the users’
passwords are not saved in the Crystal Reports Server database. To update the
passwords in Crystal Reports Server, you need to do the following for each CIMS user:

1 Log on to the CIMS Server Web Reporting Web site using the CIMS user ID with
the password password. Logging on the Web site is discussed in Start CIMS Server
Web Reporting.

2 At the prompt to change the password, type a password. You can use the user’s
previous password or choose a new password.

Start CIMS Server Web Reporting

1

2
3

B 2-80

In your Web browser, enter the address for the Web server. This is the server that you
set up in Set Up the Web Server on page 2-66.

Click Login to open the Login page.

Type the user ID admin and the password password, and then click OK. This is a default
user and password created by CIMS Server (see About Users and Groups on page 2-82).

If you are using Crystal Reports XI, you will be prompted to change the password. You
can type a new password or you can type in password if you want to continue using
this password. Passwords are alphanumeric and case-sensitive and can be a
maximum of 16 characters.

Note ¢ You can enable the auto logon feature that allows users to access CIMS
Server Web Reporting without entering a user ID and password. For more
information, see Web Settings on page 3-49.
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If you have successfully loaded sample data from the Processes folder, you should be
able to create reports from the Reports » Run Reports menu (see Figure 2-28). For
instructions, refer to the CIMS Server Web Reporting User’s Guide.

<A http:/localhost/TReports.asp?select=1 - Microsoft Internet Explorer,

File Edit View Favorites Tools Help
- ) A D Ju i i £ . - 3

@ Back. </ \ﬂ @ ol | A~ Search 1. Favorites @ Media €} == ‘3

Address 8:] http:/ localhost/ TReparts. asp?select=1

CIMS

Server

Login Spreadsheets Favorites Admin Help Logout Home
RepO Vie‘bPuhlished Reports

Create a Report

Invoices

Account Reports

Top Usage Reports

Yariance Reports

Trend

Resource Detail

Audit

Other
8:] TReports,asp?select=1 L

Figure 2-28 + CIMS Server Web Reporting—Reports Menu

Note ¢ If you are using Crystal Reports for Web reporting, you can select the Crystal
Report viewer that you want to use to view reports (see Web Settings on page 3-49). If
you are using Crystal Reports 9, 10, or XI, the default is the HTML viewer. If you are
using Crystal Reports 8.5, the default is the ActiveX viewer.

If you select the ActiveX or Java viewer, you will receive a warning message asking if
you want to install and run Crystal Smart Viewer for ActiveX or Java when you
attempt to run a report after installing CIMS Server for the first time. Click Yes. It is
also advisable that you select the Always trust content from Crystal Decisions, Inc
check box.
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About Users and Groups

A user is an individual with access rights to CIMS Server Web Reporting. Each user can
belong to only one user group. Users are granted the rights and privileges granted to the
group. This system of users and groups allows you to control which reports a user can
access, the clients that the user can view in reports, and the administrative privileges for
the user.

When you initialized the database (see page 2-57), CIMS Server added the default
administrator user admin that belongs to the user group Admin. The group Admin has
administrative privileges in CIMS Server Web Reporting and can view all reports and
clients.

For instructions on how to create users and groups, see Working With Users and Groups
on page 3-28.

Troubleshooting

For troubleshooting information, see Chapter 8.

Setting Up and Starting CIMS Web Console

CIMS Web Console is a Web-based application that provides an interface for creating job
files, viewing job log files, and performing some CIMS Server administration tasks. CIMS
Web Console is a beta release in CIMS Server 4.3. For more information about this
application, contact CIMS Lab.

CIMS Web Console requires a CIMS user ID to access the application. The ID must
belong to a user group that has CIMS Web Console access enabled (see Defining User
Groups on page 3-33).

Configuring IIS for Apache Tomcat

H 2-82

CIMS Web Console uses Apache Tomcat, a servlet container for Java Servlet and
JavaServer Pages (JSP) technologies. To configure IIS for use with Tomcat, you need to
do the following depending on the Microsoft Windows version that you are using.

For Microsoft Windows 2000 Server:

1 In IIS Manager, navigate to the Default Web Site.

2 Right-click Default Web Site, and then click Properties.
3 In the Properties dialog box, click the ISAPI Filters tab.
4 On ISAPI Filters tab, click Add.
5

In the Filter Properties dialog box, type the filter name jakarta, and then click
Browse.

Note * Make sure that you type jakarta in lowercase as shown.
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Browse to the folder ...CIMSLab\Server\Web\Tomcat\bin\win32, click
isapi_redirector.dl1, and then click Open.

The path to the DLL appears in the Executable box in the Filter Properties dialog box.

Click OK until the Filter Properties and Properties dialog boxes close.

Restart IIS.

For Microsoft Windows Server 2003:

1

Complete the steps to set the ISAPI filter as described in For Microsoft Windows 2000
Server: on page 2-82. (Do not restart IIS until you complete the following steps.)

In IIS Manager, navigate to and click Web Server Extensions.
Click Add a new Web service extension.

In the New Web Service Extension dialog box, type the extension name jakarta, and
then click Add.

Note * Make sure that you type jakarta in lowercase as shown.

In the Add file dialog box, click Browse.

Browse to the folder ...CIMSLab\Server\Web\Tomcat\bin\win32, click
isapi_redirector.dl1, and then click Open.

The path to the DLL appears in the Path to file box in the Add file dialog box.
Click OK to close the Add file dialog box.

In the New Web Service Extension dialog box, select Set extension status to Allowed,
and then click OK.

The extension jakarta appears in the Web Service Extension list with a status of
Allowed.

Restart IIS.
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Starting CIMS Web Console

Note ¢ To start CIMS Web Console, you must have job log files in XML format. To
set the file format for job log files, refer to the CIMS Data Collectors for Microsoft
Windows Installation and User Guide.

You can start CIMS Web Console in either of the following ways:

m From the Web browser, type http://servername/CIMSAdmin/
ListJdobRunnerdobs.faces, where servername is the Web server name.

m From CIMS Server Web Reporting, click Admin » Web Console. Note that the Web
Console link appears only if the CIMS user ID that is used to log on to Web Reporting
belongs to a user group that has CIMS Web Console access enabled.

Logging On to CIMS Web Console

By default, auto logon is enabled for the CIMS Web Console. The auto logon feature for
CIMS Web Console is independent of auto logon for other CIMS Web applications.

To enable manual log on, you need to change require.login=false to
require.login=true in the cims.properties file. If you installed CIMS Server in the
default location, this file is in C: \Program Files\CIMSLab\Server\Web\Tomcat\webapps\
CIMSAdmin\WEB-INF\conf.

Moving and Resizing Dialog Boxes

You can move and resize the dialog boxes in CIMS Server Administrator. To move a
dialog box, simply drag the box. To resize the box, point to the horizontal or vertical edge
of the box. When the double arrow appears, click the edge of the box and drag it to the
size that you want.

To return a dialog box to its original position and size, click View » Reset Form Position
to Default where this command is available. Where this command is not available, the
dialog box returns to its original location and size when it is closed and reopened.

Viewing Online Help

Press <F1> to view context-sensitive online help in CIMS Server Administrator.

Downloading Product Updates
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You can download product updates by visiting the CIMS Lab Web site (http://
www.cimslab.com) and clicking Customer Area » Product Updates. Note that you need
to provide your CIMS Server license key as a password.
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Setting Up the System

This chapter describes how to use CIMS Server Administrator to set up the CIMS Server
system, including defining the account code structure, entering rates and rate groups,
creating users and groups, and setting reporting options.
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Setting Up the Account Code Structure

CIMS Server uses an account code to identify entities for billing and reporting. This code
determines how CIMS Server interprets and reports input data.

One of the first steps in implementing CIMS Server is defining the account code
structure. This structure defines the account code levels that appear on invoices and other
reports.

For more information about account codes, see Setting Up Account Codes and Performing
Account Code Conversion on page 6-39.

Account Code Structure Example

An account code can contain up to 128 bytes. The structure of the account code reflects
the chargeback hierarchy for your organization arranged from highest to lowest level
(e.g., company, division, department). You can define as many account code levels as
necessary within the maximum available 128-byte field length.

For example, the following 17-byte account code contains four levels:

AABBBBCCCDDDDDDDD

Level 1, AA
Full Length = 2 bytes
Description = Company

Level 2, AABBBB
Full Length = 6 bytes
Description = Division

Level 3, AABBBBCCC
Full Length = 9 bytes
Description = Department

Level 4, AABBBBCCCDDDDDDDD
Full Length = 17 bytes
Description = User

To see how you would define this account code for CIMS Server, see Figure 3-3 on
page 3-6.

Note ¢ You can use business rules to map identifiers to applications in addition to
or instead of business units, departments, cost centers, etc.
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Defining the Account Code Structure

CIMS Server includes a default account code structure called Standard. Use this structure
to define your account code.

If you need to create additional account code structures for reporting, see Defining
Alternate Account Code Structures on page 3-8.

To create account code levels:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Account Code Structure.

The Account Code Structure List Maintenance dialog box appears as shown in
Figure 3-1.

an5 Account Code Structure List Maintenance

Wigw

Account Code Structure

A | Remave | Ediit | Rename

Figure 3-1 « Account Code Structure List Maintenance Dialog Box
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2 Click Edit.

The Account Code Structure Maintenance dialog box appears as shown in Figure 3-2.

242 Account Code Structure Maintenance |:||E| rz|

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Lewel Description Lencth Full Lencth
1| Application 4 4
2 Resource Group 16 20
3| Platform 16 36
4| Server 20 a6

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

Figure 3-2 « Account Code Structure Maintenance Dialog Box

3 In the Starting Offset into Account Code box, accept the default to begin reporting
from the first account code level or enter another starting position to begin reporting
at another level (see To set the starting offset number: on page 3-7).

4 In the Description and Length boxes, edit the sample description and length for each
level of the account code (maximum of 128 levels where each level is a length of 1).
To add a level to the end of the account code structure, click Add Entry. To add a level
above an existing level, click the level, and then click Insert Entry.

For example, the account codes structure shown in Account Code Structure Example on
page 3-3 is entered as shown in Figure 3-3 on page 3-6.
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an5 Account Code Structure Maintenance

Account Code Structure: Standard
Starting Offzet into Account Code: 1

Define Account Code Levels

Lewel Description Lencth Full Lencth
1| Company
2 | Divigion
3 Department

2
4
3
g

Adld Entry | RemoveEntry| In=ert Entry |

OK | Cancel |

Figure 3-3 < Example Account Code Structure

Note the difference between the length and full length. The length is the number of
bytes representing the specific entity. For example, the 4-byte BBBB in Level 2
represents the division.

The full length is automatically calculated and represents the total number of bytes
for the level. For example, Level 2 includes 2 bytes for the company and 4 bytes for
the division for a total of 6 bytes.

5 Click OK when you are finished.
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To set the starting offset number:

The starting offset number determines the account code levels that are presented in
reports. If you want to begin reporting from a level other than Level 1, enter the offset
position for the level at which you want to begin reporting.

For example, if you have two user groups and one group wants to begin reporting at the
User level shown in Figure 3-3 on page 3-6, you could set up a second account code
structure with one level for User and an offset of 10 (the position where the User level
begins in the account code structure) as shown in Figure 3-4.

an5 Account Code Structure Maintenance

Account Code Structure: Group B
Starting Offzet into Account Code: 10

Define Account Code Levels

Lewel Description Lencth Full Lencth
1 |Uszer g g

Adld Entry | RemoveEntry| In=ert Entry |

Figure 3-4 « Adding a Second Account Code Structure with Different Starting Offset

Note that in this situation, users in groups using this account code structure cannot view
any account code levels other than User in CIMS Server Web Reporting. To avoid this
restriction, your report developer could create a report for the User level rather than
create an additional account code structure. For more information, contact CIMS Lab.
To remove an account code level:

Click the level, and then click Remove Entry.
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Defining Alternate Account Code Structures

B 3-8

If needed, you can create additional account code structures. For example, you may need
account codes with different levels or different offset positions.

Note * You can assign multiple account code structures to a user group. This enables
users of the group to select the account code structure that they want to use for
reports on the CIMS Server Web Reporting Web site. For more information, see To
add a user group: on page 3-33.

To add an alternate account code structure:

1

6

In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Account Code Structure.

The Account Code Structure List Maintenance dialog box appears.
Click Add.

In the Add Account Code Structure dialog box, enter the name of the new account
code structure (maximum of 32 characters), and then click OK.

The Account Code Structure Maintenance dialog box appears.

In the Starting Offset into Account Code box, accept the default or enter a starting
offset number (see To set the starting offset number: on page 3-7).

Click Add Entry to add each level. (To add a level above an existing level, click the
level, and then click Insert Entry).

Click OK when you are finished.

To rename an alternate account code structure:

1

2

Click the structure, and then click Rename.

In the Change Account Code Structure Name dialog box, enter the new name of the
account code structure, and then click OK.

To remove an alternate account code structure:

Click the structure, and then click Remove.
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Working With Rates

CIMS Server uses a rate to calculate a cost for each resource being reported. Rates are
organized by rate codes, tables, and groups as described in the following sections.

Defining Rate Codes

The CIMS Server Resource (CSR) and CIMS Server Resource Plus (CSR+) files used by
CIMS Server contain rate codes. Rate codes represent the resource units being reported
(CPU time used, jobs started, data received or sent, disk space used, lines printed, etc.).

To enable CIMS Server to process and report the rate codes in the CSR or CSR+ file, the
codes must be defined in the CIMSRate table. The definition for each rate code includes
a monetary value for the rate code and other rate processing information.

CIMS Lab pre-loads the rate codes produced by many of the CIMS Data Collectors in the
STANDARD rate table within the CIMSRate table. You can then use CIMS Server
Administrator to modify rate code values, delete rate codes that you do not use, and/or
add rate codes that are not included in the STANDARD table by default.

Note ¢ One of the settings associated with a rate code is the rate value. You can use
CIMS Financial Modeler to calculate and and update rates for rate codes as described
in Chapter 7, Working With CIMS Financial Modeler.

If you need to perform differential costing, for example, you want to charge Client A
different rates than Client B, you can create other rate tables in addition to the
STANDARD table (see Defining Alternate Rate Tables on page 3-15).

Each rate code belongs to one rate group. Rate groups are logical groups that are used for
grouping resources on invoices and other reports and for drill down (detailed) reporting.
For more information about rate groups, see Defining Rate Groups on page 3-17.

To add a rate code:

Note ° A rate table can contain a maximum of 999 rate codes.

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

The Rate Code List Maintenance dialog box appears.

2 Ifthe Rate Table list contains multiple tables, click the rate table that you want to add
the rate to. (If there are multiple tables, All appears in the Rate Table list by default.)

3 Click Add Rate.

4 In the Add New Rate Code dialog box, enter the new rate code (maximum of eight
characters), and then click OK.

Important! < Rate codes are case-sensitive. Type the rate code exactly as it appears
in the CSR or CSR+ file.
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The Rate Code Maintenance dialog box appears as shown in example Figure 3-5.

=44 Rate Code Maintenance |:| [E| g|

[ STANDARD f Z003 ]
[ General |

Description: |Mainframe CPU Minutes

Walue: 10 Rate Indexx: 5
Rate Group:  |ainframe Batch  « Add rate group ...

[ Detsil |

Iv Use 4 decimals for rate Resource Conversion: |Divide By 60 j
[ Rate iz per thousand Conversion Factar: ’7
[ Do not adjust for zero cost Resource Decimals: m
[~ Flat fee money charges
v CPU Value Report Flag 1: |1—
Repart Flag 2: |—
Currency Symbal: ’—

Detail Description: |Mainframe Cpu Minutes

Comments: |

Edit Rate Shifts | Remaove Rate Shifts | OK | Cancel

Figure 3-5 « Rate Code Maintenance Dialog Box

5 Edit the rate code settings as follows:

e Description. Enter a meaningful description of the rate code (maximum of 255
characters). The description appears on reports, graphs, and spreadsheets. CIMS
Lab recommends that you include units of measurement (GB, MB, hours,
minutes, etc.) as applicable.

e Value. Enter the amount to be charged for the consumption of the resource
represented by this rate code. Keep in mind:

¢ Rate value corresponds to the specified rate code.

Note ¢ The following currency values are for example purposes only. CIMS
Server supports all currencies.

e $25isinput as 25.

e $1.25is input as 1.25.

* Negative values are preceded by a minus (e.g., -1).
* Maximum Rate is 9999999v99999999.

e The value is multiplied by the resource amount contained in matching CSR or
CSR+ file. For example, if the rate code value is 25 and a matching resource file
contains a value of 5 hours, then the total charge would be $125.

CIMS Server Administrator's Guide



Setting Up the System N
Working With Rates

¢ Rate Index. The rate index defaults to the order in which the rate code appears in
reports. You can change the order; however, you cannot enter an index number
that is already in use.

¢ Rate Group. Click the rate group for the rate code or click Add rate group to create
a new rate group. All rate codes must be assigned to a rate group.

Note * You can also create rate groups and assign rate codes using the Rate
Group Maintenance dialog box (see Defining Rate Groups on page 3-17).

e Use 4 decimals for rate. This option determines the number of decimal digits that
appear in the rate value in reports. If this check box is selected, the rate value
includes four decimal digits. If this check box is not selected, the rate value
includes eight decimal digits. For an example of rate values in a report, see
page 4-13.

e Rate is per thousand. Select this check box to change the rate in reports from per
resource unit to per thousand units.

¢ Do not adjust for zero cost. Select this check box if you do not want the associated
rate code to be included in zero cost calculations.

About Zero Costing

It is possible within CIMS Server Web Reporting to enter a target recovery amount
for the billing period. (See the CIMS Server Web Reporting User’s Guide for
information about the CIMS Server Zero Cost Center Invoice). CIMS Server then
makes the appropriate adjustments to recover the targeted amount rather than the
amount reflected by the standard multiplication of rate by resource units. This
zero costing allows IT departments to recover a specified amount each billing
period rather than show a profit or loss.

It is not always desirable to apply zero costing to all rates. Often, fixed cost items
such as leased line charges, delivery services, or license fees are excluded from zero
costing. The cost of these items is used as part of the overall calculation, but the
specific rate is not adjusted.

» Flat fee money charges. Select this check box if the resource units for the rate code
are considered a monetary amount rather than units of utilization. In this
situation, the resource units and the charges are the same in reports.

Note + When this check box is selected, the Value box does not appear and any
rate value previously entered in the Value box is ignored. However, the value

does appear in the rate column in CIMS standard reports. You can customize

the standard reports to remove or modify this value as needed.

e CPU Value. Select this check box to normalize CPU usage for this rate (see
Normalizing CPU Values on page 6-55).
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6

Resource Conversion. You can adjust the total resource units value in reports
using the following conversion factors:

e Default. No conversion is performed.

* Divide By or Multiply By. The total resource units are divided or multiplied by
a set conversion factor (e.g., Divide by 1000, Multiply by 60, etc.).

e Multiply By Conversion Factor. The total resource units are multiplied by the
factor in the Conversion Factor box.

Conversion Factor. This box is available only when Multiply By Conversion
Factor is selected in the Resource Conversion box. Type a number by which you
would like to multiply the total resource units for the rate code. This factor can be
up to 16 digits including a decimal.

Resource Decimals. This option determines the number of decimal digits that
appear in the resource units value in reports (e.g., 0= 99, 4 = 99.9999). The default
is two decimal digits. For an example of resource units in a report, see page 4-13.

Report Flag 1 and 2. The use of these boxes is user-specified. These boxes allow
you to type a one-character value that you can use in custom reports.

Currency Symbol. The use of this box is user-specified. This box allows you to type
a currency symbol (maximum of three characters) that you can use in custom
reports.

Detail Description. The use of this box is user-specified. This box allows you to
type a description of the rate code that you can use in custom reports. Maximum
of 255 characters.

Comments. Type any comments regarding the rate code. Maximum of 255
characters.

Click OK when you are finished.

You cannot add duplicate rate codes to a rate table. Each rate code in a table must be
unique. If you want to use the same rate code more than once, e.g., you charge different
clients different rates for the same resource, you must create separate tables (see Defining
Alternate Rate Tables on page 3-15).

Note ¢ Rates in the Rate Code List Maintenance dialog box are sorted by the index
number. To sort the rates by rate code, rate group, description, etc., click the
appropriate column header. To reverse the sort order, click the column header again.

m 3-12
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To edit a rate code:
1 Double-click the code, or click the code and then click Edit Rate.

The Rate Code Maintenance dialog box appears.

2 Follow the steps in To add a rate code: beginning with Step 5 on page 3-10.

To remove a rate code:

Click the rate code, and then click Remove Rate.

Setting Rate Shifts

Rate shifts allow you to set different rates based on the time of day. For example, if a user
is using a computer's resources at 4 a.m., you might charge the user less than if he uses
these resources at 1 p.m. By default, every rate code has one shift. If your CSR or CSR+

files contain multiple shift codes, you can define up to eight additional rate shifts for rate
code for a total of nine shifts.

You can set rate shifts by clicking the Edit Rate Shifts button from either of the following
locations:

m From the Rate Code List Maintenance dialog box. First click the rate code that you
want to apply rate shifts to.

m From the Rate Code Maintenance dialog box for a specific rate code.
The Rate Shift Maintenance dialog box appears. Complete this dialog box as follows:

1 Click the Rate Value box next to the shift number and enter a monetary value. In the
adjacent Description box, enter an optional short description of the rate shift. See
example Figure 3-6.

=42 Rate Shift Maintenance

[ STANDARD FLLW110]

Rate Yalue | Description
Shift #2 75 Might
Shift #3 5 Swving
Shift #4
Shift #5
Shift #6
Shift #7
Shift #5
Shift #9
|

Kevboard Usage: Press the Enter key to edit 2 cell. Use the arrow keys to navigate between celis.

OK | Cancel

Figure 3-6 « Rate Shift Maintenance Dialog Box
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2 Click OK when you are finished.

Note ¢ To enable CIMS Server to use rate shift values to calculate costs for a rate
code, you must have the Use Shift Codes option enabled in the Edit Process
Definitions dialog box (see page 6-33). If you do not have this option enabled, the
default rate shift 1 is used for processing regardless of the rate codes that appear in
the CSR or CSR+ file.

Removing Rate Shifts

Once you click OK in the Rate Shift Maintenance dialog box, the rate values for the shifts
are applied as applicable when CSR or CSR+ files are processed. Therefore, if a rate shift
value is set to 0, a rate of 0 will appear in reports for the applicable rate code and shift.

If you decide that you do not want to use rate shifts after you have saved them for a rate
code, you can remove the shifts by clicking the Remove Rate Shifts button from either
of the following locations:

m From the Rate Code List Maintenance dialog box. First click the rate code that you
want to remove the rate shifts from.

m From the Rate Code Maintenance dialog box for a specific rate code.
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Defining Alternate Rate Tables

If needed, you can create rate tables in addition to the STANDARD table. For example,
you might have clients who are charged different rates for the same resource usage (the
Finance department is charged $20 per hour of CPU usage while the Marketing
department is charged $5 per hour). In this case, you could use the STANDARD table for
the Finance department and create a second rate table with the same rate codes but
different values for the Marketing department.

Note ¢ To use a rate table other than STANDARD for a client, you need to assign the
rate table to the client in the Client Maintenance dialog box (see Defining Clients on
page 3-20) and to select the Enable client search check box in the Process Definition
dialog box for each process (see page 6-35).

To add a rate table:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

The Rate Code List Maintenance dialog box appears.
2 Click Add Table at the top of the dialog box.

3 Inthe Add New Rate Table dialog box, enter a name (maximum of eight characters),
and then click OK.

The new rate table appears in the Rate Code List Maintenance dialog box.

4 To add rates to the table, follow the steps for adding a rate code in To add a rate code:
on page 3-9.

To duplicate a rate table:

1 Click a table in the Rate Table list, and then click Duplicate Table.

2 In the Duplicate Rate Table dialog box, enter a name (maximum of eight characters),
and then click OK.

The new rate table appears in the Rate Code List Maintenance dialog box. The new
table contains all of the rate codes contained in the original rate table.

3 To edit the rates in the table, double-click the code, or click the code and then click
Edit Rate, and follow the steps in To add a rate code: beginning with Step 5 on
page 3-10.

To remove a rate table:

Click the table in the Rate Table list, and then click Remove Table.

WARNING - When you remove a rate table, you lose all rate codes with their associated
rates specific to that table.
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Synchronizing Rate Tables With CIMS Mainframe

If you are using CIMS Mainframe 12.1 or later in addition to CIMS Server, you can
maintain the rate tables on the CIMS Mainframe system or on the CIMS Server system.

If you maintain the rate tables on the CIMS Server system, use the
ExportRatetoMainframe.wsf script to create rate files that you can load into CIMS
Mainframe. (For more information about this script, see page C-14). In this situation,
the rate tables on the CIMS Mainframe system are considered secondary.

If you maintain the rate tables on the CIMS Mainframe system, use member CIMSRTPR in
CIMS.DATAFILE to create the rate files that you can load into CIMS Server. In this
situation, the rate tables on the CIMS Mainframe system are considered primary.

Sending Rate Tables to CIMS Server

On the CIMS Mainframe system, use member CIMSRTPR in CIMS.DATAFILE to unload the
CIMS Rate file and create flat files that are sent via FTP to the CIMS Server application
server. To write the files, customize the JCL in the members that control the FTP request
including the FTPID and FTPRATEP members. These members control the FTP request to
write the files.

To load the rate files into CIMS Server, see Managing Database Tables on page 5-11.

Getting Rate Tables from CIMS Server

On the CIMS Mainframe system, use member CIMSRTSC in CIMS.DATAFILE to get a file
containing rate tables from CIMS Server and rebuild the CIMS Rate file in CIMS
Mainframe. To get the file, customize the JCL in the members that control the FTP
request including the FTPID and FTPRATES members. These members control the FTP
request to get the file from the CIMS Server computer.
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Defining Rate Groups

Tip * When working with rate groups, you can access commands for an item by
clicking the appropriate button, or you can access the same commands by right-
clicking the item.

Creating and using rate groups lets you create rate subtotals in reports, graphs, and
spreadsheets. Grouping rates such as Mainframe charges, Windows charges, and UNIX
charges allows reports to be summarized in a way that is meaningful. It also allows users
to create reports based on grouping rates that have the same identifier or identifiers.

All rate codes must be assigned to a group. For more information, see Adding an
Unassigned Rate Code to a Rate Group on page 3-19.

Note ¢ Itis recommended that you do not assign rate codes with different identifiers
to the same rate group. Combining rate codes with different identifiers within the
same group results in reporting anomalies.

Suggestion: Create a separate rate group for each resource file type. For example a
UNIX charges group for UNIX resource files with the same identifiers. This ensures
that the rate codes within the group have the same identifiers.

To add a rate group:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Groups.

2 The Rate Group Maintenance dialog box appears displaying an expandable hierarchy
of existing rate groups. Individual rate codes appear within each rate group. See
example Figure 3-7 on page 3-18.
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@44 Rate Group Maintenance

Wi

[ Rate Group ]

Remove Rate Group |

Change Rate Group Title

Change Rate Group Description

Change Rate Group Sequence

[ Rate Code |

Add Unassigned Rates to Group

Rate Group Title:
Rate Group Description:

Mainframe TS0
Mainframe TS0 Charges

Rate Groups

+

L B e e e e e e e e R e R

Mainframe Batch Charges
Mainframe TS rES
Z020 - TS0 CPU Minutes
021 - TS0 Inputs
Z022 - TS0 Outputs
Z034 - TS0 CPU Minutes (TCH)
Z035 - TS0 CPU Minutes (Intistor)
Z036 - TS0 CPU Minutes (210
ZI04 - TS0 Connect Minutes
Mainframe Service Unit Charges
Mainframe PrinterReader Charges
Mainframe Print Charges
Mainframe DB2 Charges
Unix Interactive Job Type Charges
Unix DB2 Charges
Unix Print Charges
MS WindowsCharges
Unix Cracle Charges

Unix Filesystem
I mive Crfbueara Damlans Charmias

Close

Figure 3-7 - Rate Group Maintenance Dialog Box

3 Click Rate Groups at the top of the group list (if it is not selected), and then click Add

Rate Group.

4 1Inthe Add Rate Group dialog box, enter a description of the rate group (maximum of
32 characters), and then click OK.

To remove a rate group:

Click the rate group, and then click Remove Rate Group. If the rate group contains rate
codes, you must delete the codes before you can delete the group.

Changing the Rate Group Description and Title

When you add a rate group, the description and title default to the description that you
assigned to the group. You can change both the description and title of the rate group.
In most cases you do not need to change the title unless you require a shorter field length
for custom reports. Standard reports show the description field, not the title field.

To change the rate group description:

1 Click the group and click Change Rate Group Description.

2 In the Change Rate Group Description dialog box, enter the new description of the
rate group (maximum of 255 characters), and then click OK.
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To change the rate group title:

1 Click the group and click Change Rate Group Title.

2 In the Change Rate Group Title dialog box, enter the new title of the rate group
(maximum of 32 characters), and then click OK.

Changing the Rate Group Sequence

The sequence in which the rate groups appear in the tree is the sequence that the groups
will appear in reports. You can sequence the rate groups in any order.

To change the group sequence:
1 Click Change Rate Group Sequence.
The Rate Group Display Sequence dialog box appears.
2 Click a group, and then click the up or down arrow to reposition the group.

3 Click OK when you are finished.

Adding an Unassigned Rate Code to a Rate Group

To add an unassigned rate code to a rate group:

1 Click the group, and then click Add Unassigned Rates to Group.
The Select Rate Code dialog box appears.

2 Choose the code or codes that you want to add, and then click OK.

Note * In most cases, rate codes are assigned to a rate group when the rate code
is added (see Defining Rate Codes on page 3-9).

Moving an Assigned Rate Code to Another Rate Group

To move a rate code from one group to another, click the rate code that you want to
move and drag it to the desired rate code description.

Removing a Rate Code from a Rate Group

To remove a rate code from a rate group, click the rate code, and then click Remove Rate
From Group.
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Working With Clients

Once you have created the account code structure (see Setting Up the Account Code
Structure on page 3-3), you can assign descriptions for the clients represented by your
structure. These descriptions appear in place of the client’s account code in invoices and
other reports. For example, if account code AABBBBCCC represents the Marketing
department, you might assign the description Marketing Department for this code.

You can also specify the rate table used for the client and set up budget and contact and
information.

Note ¢ CIMS Server provides sample clients. You should remove these sample clients
before adding clients for your organization (see To remove a client: on page 3-22).

Defining Clients

To add a client:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears as shown in example Figure 3-8.

Note ¢ Clients in the Client List Maintenance dialog box are sorted by account
code. To sort the clients by account name, rate table, etc., click the appropriate
column header. To reverse the sort order, click the column header again.

ans Client List Maintenance

Tools  Wiew

Account Code | Account Mame Rate Table | Aternate Account Code
AL Company A4 STAMDARD
AABBBEE Operations Divizion STAMDARD

Purchasing Departmert  STANDARD

Al | Remove | Eclit Budgets | Contacts | Close |

Figure 3-8 « Client List Maintenance Dialog Box
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2 Click Add.

3 Inthe Add Account Code dialog box, enter the account code for the client (maximum
of 128 characters), and then click OK. The Client Maintenance dialog box appears.

4 Edit the client settings as follows:

Account Name. Enter the name of the client as you want it to appear in invoices
and other reports. Maximum of 255 characters.

Alternate Account Code. Enter an alternate account code if used for reporting to
a General Ledger system or other types of reporting where the standard account
code is different. Maximum of 128 characters.

Rate table. If other than STANDARD, click the rate table used for calculating the
client’s charges. Alternate rate tables are used for clients who are charged different
rates for the same resource usage. For example, the Finance department is charged
$20 per hour of CPU usage, while the Marketing department is charged $5 per
hour. For more information, see Defining Alternate Rate Tables on page 3-15.

Invoice Contact. If a contact is available for this client, the contact appears in this
list box (see Defining Client Contacts on page 3-25). If there are multiple contacts
for this client, click the appropriate contact from the list.

Action Codes. CIMS Server does not use action codes. These codes are strictly for
reporting purposes and can be used in the custom reporting process for selecting
data.

5 Click OK when you are finished.

An example of a configured Client Maintenance dialog box is shown in Figure 3-9.

ans Client Maintenance

Account Code: A4

Accourt Mame:

Alternste Account |
Codle:

Rate Table:

Invoice Contact:

Action Codes:

Contacts |

|C0mpany [aime

STAMNDARD -

|000001 - Brian Jones |

rrrrrrr

]

Budgets | Cancel

Figure 3-9 « Client Maintenance Dialog Box

For information on adding a budget and contact for the client, see Setting Up Client
Budgets on page 3-22 and Defining Client Contacts on page 3-25.

CIMS Server Administrator's Guide

3-21 N



Bl Setting Up the System

Working With Clients

To edit a client:

1 Double-click the client or click the client, and then click Edit.
The Client Maintenance dialog box appears.
2 Follow the steps in To add a client: beginning with Step 4 on page 3-21.

To remove a client:

Click the client, and then click Remove.

Setting Up Client Budgets

Using CIMS Server’'s powerful budgeting feature, you can establish budgets by amount
or units for the individual resources used and/or all resources used by a client. These
budgets allow users to report on client actual vs. budget information.

CIMS Server includes reports that you can use as templates to create custom account level
and resource level budget reports for your organization. For more information about
CIMS Server budget reports, see the CIMS Server Web Reporting User’s Guide.

To create a budget:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears.
2 Click the client that you want to establish a budget for, and then click Budgets.
The Client Budget Maintenance dialog box appears.
3 Edit the budget settings as follows:
e Year. Click the appropriate year. If the year is not listed, click Budget » Add Year.

e Overall Account Budget. You can set both an overall account budget and budgets
for individual resources.

To set an overall budget for an account, click Overall Account Budget.

To set a budget for individual resources, click Budget » Add Resource Budget or
right-click Overall Account Budget, and then click Add Resource Budget. The
Select Rate Codes dialog box appears. Select the rate code or codes for the
resources that you want, and then click OK. The rate codes appear under Overall
Account Budget.
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¢ Budget Amount/Budget Units. You can budget by the monetary amount of

consumed resources (Budget Amount) or the unit amount of consumed resources
(Budget Units). You can enter a total budget and a budget for each month
(period) within the year.

Enter the total budget amount or budget units for the year in the Total box and the
budget amount for each period in the Period boxes (1 through 12/13). (To use 13
month periods, see page 3-27.)

Divide Total (Budget Amount and Budget Units). Click Divide Total to divide
the total budget amount of budget units by the number of periods and
automatically populate the Period boxes with the result. Note that if you change
a total, you must perform this step again.

Sum Periods (Budget Amount and Budget Units). Click Sum Periods to add the
amounts entered in Period boxes and automatically enter the sum in the Budget
Amount Total or Budget Units Total boxes. Note that if you change the amount

for a period or periods, you must perform this step again.

4 Click Apply to save the changes or click OK to save the changes and close the dialog

box.

An example of a configured Client Budget Maintenance dialog box is shown in
Figure 3-10. In this example, a budget is set for the resource represented by rate code

Z003.

@44 Client Budget Maintenance

Budget  View

Account: A4 - Company & ear: |onns -
[ Budget Detail ]
Overall Account Budget .
Budget Amourt  Budget Units
LL&10S - Unix Interactive User CPU (Minutes) Total 7600 0
LL&106 - Unix Interactive System CPU (Minute ) | |
LLA107 - Unix Interactive Total CPU (Minutes) Divide Total | _ Divide Total |
LLT101 - MS Windows Logins Sum Periods | Sum Periods |
LLT102 - MS Windows Connect Time (Hours) R
LLT103 - MS Windows Image Court S d | 7300 | 0
Z001 - Mainframe Jobs Started Period 2 | 7300 | 0
Z002 - Mainframe Steps Started
7003 - Mainframe Cl vy Period 3 | 7300 | 0
Period 4: | 7300 | 0
Petiod 5: | 7300 | 0
Petiod f: | 7300 | 0
Petiod 7: | 7300 | 0
Period & | 7300 | 0
Petiod 3 | 7300 | 0
Petiod 10: | 7300 | 0
Petiod 11: | 7300 | 0
Petiod 12: | 7300 | 0
£ >
Ok | Cancel | Apply

Figure 3-10 « Client Budget Maintenance Dialog Box
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To remove a budget:

To remove all budget information for a year, click Budget » Remove Year. This removes
the overall budget and all individual resource budgets for the year selected in the Year
box.

To remove an individual resource budget, click the budget, and then click
Budget » Remove Resource Budget, or right-click the budget, and then click Remove
Resource Budget. The budget is removed from all years.
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Defining Client Contacts

You can create one or multiple contacts for each client. Contact information includes
name, street and e-mail addresses, phone numbers, and department.

The first contact in the client contact list appears in CIMS Server standard invoices.
However, you might develop custom reports that display multiple contacts.

To add a contact:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Clients.

The Client List Maintenance dialog box appears.

2 Click the client that you want to establish a contact for, and then click Contacts.
The Client Contact List Maintenance dialog box appears.

3 Click Add.

4 In the Client Contact Maintenance dialog box, edit the contact settings as follows:

e Address tab. Type the contact’s name and company and e-mail addresses. You can
type the street address on any address line or lines. However, if want to use the
View Address Map button to view a map for the address, you need to enter the
address in the following order:

e Address Line 1: Street Address
¢ Address Line 3: City, State, Zip
¢ Phone tab. Enter the contact’s phone numbers.

e Other tab. Enter other contact information such as department, comments, and
Web site URL.

5 Click OK when you are finished.

The contact appears in the Client Contact Maintenance dialog box with an index
number. This number is a key that uniquely identifies the contact for reports.

To edit a contact:
Click the contact, and then click Edit.

To remove a contact:

Click the contact, and then click Remove.

Importing and Exporting Client Data

Client information is contained in the CIMS Client table. You can load and unload data
to/from the CIMS Client table via a number of custom scripts that are provided with
CIMS Server. For more information, see Appendix C, Scripts or contact CIMS Lab.
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Setting Up a Calendar

CIMS

Server Administrator includes a default calendar with the standard 12 monthly

periods (the first day of the month to the last day) by year. Organizations using standard
monthly/yearly periods do not need to change the calendar.

If you do not want to run billings using standard monthly/yearly periods, you can
change the period start and end dates and optionally include 13 periods per year (see
page 3-27).

Setting Up Calendar Information

1 Click Chargeback Administration » Chargeback Table Maintenance » Calendar.

The Setup Calendar dialog box appears as shown in example Figure 3-11.

== Calendar,

Wigw

1
2
3
4
5
6

Year! |EITEIN - add vear Remave ear

Period  Beginning Date Ending Date Close Date Feriod  Beginning Date Ending Date Clase Date

|1 i1 12005 |1 i31/2005 Nt Avalagle | T ‘ 711 f2005 ‘ 7 ;3142005 8H005

| 21172005 | 2 282005 Nt Avalagle | ° ‘ /1 2005 ‘ 6 /3142005 an 005

| 31172005 | 3 3172005 Nt Avalagle | 2 ‘ 911 2005 ‘ 9 /30/2005 10/ 2005

10

Nt st [10r1 2005

[[4 11 2008 11412005

| 413072005 ‘mm 12005

| 51172005 | 5 13172005 Nt Avaiapis | 1! ‘11:1 12005 ‘11500005 12012005

Lef Lol Lo Lef Lef L]
Lef Lol Lo Lef Lef L]
Lef Lol Laf Lef Lef ]
Lef Lol Laf Lef Lef ]

| 61172005 | 6 /3042005 7H0005 12 ‘12:1 12005 ‘12;‘31 12005 12005

Set From Period 1

oK Cancel | Apply

Figure 3-11 « Setup Calendar Dialog Box

2 Edit the calendar as follows:

B 3-26

In the Year list, click the appropriate year if it is not displayed.
Set the Beginning Date and Ending Date for each period as needed.

To have all periods proceed sequentially from the first period, click Set From
Period 1.

To add a new year, click Add Year.

To remove the currently displayed year, click Remove Year.
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Note that the Close Date for the period appears if a day-of-month close date has been
set (see page 3-44). The close date appears for the period in which it was set, the
previous period, and future periods. In example Figure 3-11 on page 3-26, a first of
the month close date was set in Period 7 (July). Therefore Period 6 and all future
periods show a close date.

Note ¢ If you do not set a close date or set a specific close date rather than a day-
of-month date, the Close Date column does not appear in the CIMSCalendar
table.

Click Apply to save the changes or click OK to save the changes and close the dialog
box.

Using 13 Accounting Periods

If your organization uses 13 accounting periods, you can set this calendar format as
follows:

1

2

3

In the CIMS Server Administrator main window, click System
Administration » Configuration Information.

In the Configuration dialog box, click the Processing tab.

On the Options subtab, select the Use 13 Periods check box, and then click OK.

Calendar Considerations

The maximum entries that CIMSAcct or CIMSBill reads from the CIMSCalendar table
is 52. (See page A-14 for more information about the CIMSCalendar table.)
Therefore, you need to delete periods from previous years as they pass.

The periods for a particular year must be entered in date sequence.

The CIMSCalendar table must have the current and previous periods defined.
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Working With Users and Groups

A user is an individual with access rights to CIMS Web-based applications (i.e., CIMS
Server Web Reporting, CIMS Financial Modeler, etc.). Each user can belong to only one
user group. Users are granted the rights and privileges granted to the group.

In CIMS Server Web Reporting, this system of users and groups allows you to control the
following:

m The reports that a user can access in CIMS Server Web Reporting. A user can access
only those reports that are assigned to the user’s group.

B The clients (account codes) that a user can view in reports. A user can view only those
clients that are assigned to the user’s group.

B Theadministrative privileges for a user. A user assigned to a group with administrative
privileges can update configuration and other information in CIMS Server Web
Reporting.

In other CIMS Web applications, this system allows you to control who can access the
applications.

Default Administrator User and Group

When you initialize the database during the setup process (see Initialize the Database on
page 2-57), CIMS Server adds a default user and user group. This group has
administrative privileges in CIMS Server Web Reporting and can view all reports and
clients.

The ID for the default user is admin and the password is password. The ID for the default
user group is Admin.

Defining Users

B 3-28

You can use CIMS Server Administrator to create and maintain user information such as
e-mail address, ID, password, and other user-specific options.

To add a user:

1 In the CIMS Server Administrator main window, click System
Administration » Users and Groups » Users.

The User List Maintenance dialog box appears as shown in example Figure 3-12 on
page 3-29.

CIMS Server Administrator's Guide



Setting Up the System N

@4: User List Maintenance

Working With Users and Groups

8=

Uszer ID | Full Mame

The Web Session ID is the session ID

| assigned to the user on the last time the
user logged on to the CIMS Server Web
Reporting Web site.

A Web Session ID of 0 means that the
user has never logged on to the Web
site.

Wieh Session D
31773428

1057494965

CIMS Server Administratar
Joan Watzon

A Ediit |

Edit Configuration Cptions | Close |

| Remave |

Figure 3-12 « User List Maintenance Dialog Box

Click Add.

In the Add New User dialog box, enter an ID for the user (maximum of eight

characters) and the click OK. The User Maintenance dialog box appears.

CIMS Server Administrator's Guide

Edit the user settings as follows.

Full Name. Type the user’s full name.

Email Address. CIMS Server includes an automatic report distribution feature (see
Distributing Published Reports on page 4-26). To enable the user to receive reports
using this feature, type the user’s e-mail address.

Display full path on Favorites page. Select this check box to display the full path
for published reports on the Favorites page of CIMS Server Web Reporting. For
more information, refer to the CIMS Server Web Reporting User’s Guide.

Display full path on Published Reports page. Select this check box to display the
full path for published reports on the Published Reports page of CIMS Server Web
Reporting. For more information, refer to the CIMS Server Web Reporting User’s
Guide.

Crystal Viewer. Click the Crystal viewer used for this user in CIMS Server Web
Reporting. (To set this option for all users, see Web Settings on page 3-49.) If you
are using SQL Server Reporting Services for reporting, leave this box set to Default.

You can choose one of the following. For the advantages and disadvantages of
each viewer, see page 3-49.

e Default. This option uses the viewer set on the Web tab of the Configuration
dialog box.
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e ActiveX. This option works only in Internet Explorer.

e Java using Browser JVM. This option works in Internet Explorer or Netscape
Navigator. This viewer requires the Java Virtual Machine. Because this viewer
might be more difficult to set up, CIMS Lab recommends that you use the HTML
or ActiveX viewer.

e HTML. This option works in Internet Explorer or Netscape Navigator.

Group. Click the group that you want to add the user to or accept the default Admin
group. Note that if you need to add a new group for the user, you can create the
group and add the user as described in Defining User Groups on page 3-33.

Configuration Options Maintenance. When you click this button, the User
Configuration Options List Maintenance dialog box appears. You can add user
configuration options that can be used for custom reports and Web pages in this
dialog box. See To add configuration options: on page 3-56.

CIMS Lab recommends that you consult technical support for assistance in adding
user configuration options.

Domain Name/Domain User ID. CIMS Server Web Reporting and the other CIMS
Web-based applications provide an automatic logon feature. To enable a user to
use this feature, you need to enter the user's Windows domain name and user ID.
You also need to enable auto logon (see Web Settings on page 3-49) and to set IIS
security for the CIMS Server Web Reporting Web site and any other CIMS sites to
Integrated Windows authentication (see page 2-67).

You can click Browse to select the domain and user from the Select Domain Name
and User ID dialog box. To find a domain and user in the Select Location and
Select User lists:

a Type a complete or partial value in the text box and then click Find or use the
scroll bar.

b Click OK when you are finished.

New Password. If you are not using the automatic logon feature for CIMS Web
applications, use this box to enter a password for the user or to change an existing
password as follows:

a Type the password. The password is alphanumeric and case-sensitive and can
be a maximum of 16 characters.

b Click OK.

¢ In the Confirm New Password dialog box, type the password again, and then
click OK.

d Click OK to confirm that the password has been changed.
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If you are using Crystal Reports XI, note the following

e The user password requirements (e.g., number and type of characters) differs
between CIMS Server and Crystal Reports Server. You will receive an error
message when you try to add a CIMS user password that does not match the
requirements for Crystal Reports Server. To avoid this message, you can change
the password restrictions in BusinessObjects Enterprise Central Management
Console as described in Configuration in BusinessObjects Enterprise Central
Management Console: on page 2-77.

e When the user logs on to the CIMS Server Web Reporting Web site for the first
time, the user will be prompted to change the password. The user can use the
password entered here or choose a new password.

5 Click OK when you have finished editing the user settings. If you are using Crystal XI
for reporting, a message appears asking if you would like to add the user to
BusinessObjects Enterprise Manager. Click Yes.

An example of a configured User Maintenance dialog box is shown in Figure 3-13.

ans ser Maintenance

Joan

Full Mame: |J0an Watzon

Email &ddress: |iwatson@abcco.com

Perzonalization
Dizplay full path on Favorites page v

Dizplay full path on Publizhed Reports page v

Crystal Viewer: |Defaun

Lelle]

Group: | ap

Configuration Options Maintenance... |

Domain User Information

Domain Mame: ARCCO Browse...
Domain User 10 ioan

Change Password

Mewe Passward:

Ok Cancel |

Figure 3-13 « User Maintenance Dialog Box
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To edit a user:
1 Click the user, and then click Edit.

The User Maintenance dialog box appears.
2 Follow the steps in To add a user: beginning with Step 4 on page 3-29.

To remove a user:

Click the user, and then click Remove. If your are using Crystal XI for reporting, the user
is automatically removed as a Crystal Reports Server user.
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Defining User Groups

You can use CIMS Server Administrator to create and maintain user groups including
adding users to groups; defining one or multiple account code structures for a group;
assigning group access to reports and clients for Web reporting; and assigning access
rights to CIMS Web applications.

Tip * When working with groups, you can access commands for an item from the
menu bar, or you can access the same commands by right-clicking the item.

Note ¢ A user can belong to only one group. If you need to place a user in more than
one group, create a new group for the user. For example, a user who needs access to
the reports assigned to Group A and Group B should be assigned to Group C that has
access to the combined reports of Group A and Group B. Assigning a user to only one
group makes it easier to determine the user’s full access rights.

To add a user group:

1 In the CIMS Server Administrator main window, click System
Administration » Users and Groups » Groups. The Group List Maintenance dialog
box appears as shown in example Figure 3-14.

1{ Group List Maintenance

GEroups View

Accounts Payable
B Acmin

Group - ROOT

List Mairtenance

Users Reports Clients

Figure 3-14 + Group List Maintenance Dialog Box
2 Click Groups » Add Group on the menu bar.

3 In the Add Group dialog box, enter an ID for the group (maximum of eight
characters), and then click OK. The Group Maintenance dialog box appears.
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4 Edit the group settings as follows:

e Description. Use this box to change the description of the group (the default is the

group ID followed by “Group”). Note that if you add a description, the description
rather than the group ID appears in the Group List Maintenance dialog box.

Selected Account Code Structures/Available Account Code Structures. Use these
boxes to define the account code structure or structures that the users of the group
can use for reporting.

You can add and remove structures from one box to the other. All structures that
appear in the Selected Account Code Structures box are available to users in the
group from the CIMS Server Web Reporting Web site. This feature enables users to
dynamically select the account code structure that they want to use to generate
reports.

If you have multiple account code structures in the Selected Account Code
Structures box, you need to set one of the structures as the default structure by
clicking the structure and then clicking Make Default. The default structure
appears on the Set User Options page of the CIMS Server Web Reporting Web site
until another structure is selected from the Web site. The default structure is also
used when publishing reports in batch for a user or group (see Working With Batch
Reporting/Published Reports on page 4-25).

Note ¢ The account code structure selected as the default in the Select Account
Code Structures box initially determines the structure that appears on the Web
site when the site is accessed by a user in the group. However, once the user
selects another account code structure on the Web site, that structure is stored
in a cookie and not the CIMS Server database. Changing the default structure
in CIMS Server Administrator does not change default structure on the Web
site.

Allow Transaction Maintenance. Select this check box to allow the users in this
group to perform transaction maintenance in CIMS Server Web Reporting. For
more information, refer to the CIMS Server Web Reporting User’s Guide.

Administrative Access. Select this check box to give the users in this group
administrative configuration options in CIMS Server Web Reporting. For more
information, refer to the CIMS Server Web Reporting User’s Guide.

Allow Financial Modeler Access. Select this check box to allow users in this group
to access CIMS Financial Modeler. If this check box is selected, Financial Modeler
appears as a link in the CIMS Server Web Reporting Admin menu. For more
information about CIMS Financial Modeler, see Chapter 7, Working With CIMS
Financial Modeler.

Allow Web Console Access. Select this check box to to allow users in this group
to access CIMS Web Console. If this check box is selected, Web Console appears
as a link in the CIMS Server Web Reporting Admin menu. CIMS Web Console is a
beta release in CIMS Server 4.3. For more information about this application,
contact CIMS Lab.
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e Split Account Code on Transaction Entry. If this check box is selected (the
default), users in this group are allowed to enter account codes by levels when
adding account codes in the Miscellaneous, Recurring, and Credit Transaction
pages in CIMS Server Web Reporting. Users can either type the account code in the
box for each level or select the code if an accompanying select box is available. The
following option, Max Levels of Account Code to Display, determines the
number of account code levels that include a select box.

The account code levels displayed are dependent on the levels defined in the
account code structure selected for the group.

For more information about using transactions in CIMS Server Web Reporting,
refer to the CIMS Server Web Reporting User’s Guide.

¢ Max Level of Account Code to Display. If the Split Account Code on Transaction
Entry check box is selected, type the number of levels that you want to include
select boxes for. For example, if you have five account code levels, but only want
to include select boxes for the three highest levels, type 3 in this box. The
remaining two levels will have a text box in which users can type the account code,
but no select box to browse for the account code.

The data loaded in the select boxes is pulled from the CIMSClient table. If the
CIMSClient table is large, the transaction page can take more time to load if
multiple select boxes are included. Limiting the number of select boxes can reduce
the amount of time required for the transaction page to load.

The default, 0, specifies that all account code levels include select boxes.

¢ Configuration Options Maintenance. When you click this button, the Group
Configuration Options List Maintenance dialog box appears. This dialog box
contains entries for some of the group configuration options that you have set. For
example, the option TransSplitAccountCode represents the Split Account Code
on Transaction Entry check box. Do not delete these entries.

You can add group configuration options that can be used for custom reports and
Web pages in this dialog box. See To add configuration options: on page 3-56.

CIMS Lab recommends that you consult technical support for assistance in adding
group configuration options.

5 Click OK when you are finished editing the group settings.

An example of a configured Group Maintenance dialog box for the Admin group is shown
in Figure 3-15 on page 3-36. In this example, the account code structure Alternate has
been added to the list of structures that the users in this group can use for reporting. This
group has been given all group priveleges.
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Group (D Addmin
Description: & clmin
Selected Account Code Structures Available Accourt Code Structures

Remaove =

L1

Make Default

Group Privileges
Allowe Transaction Maintenance v Allowe Financial Modeler Access
Administrative Access v Allowe Weh Consale Access

EURY

Tranzaction Entry
Split Account Code on Transaction Entry v

Mz levels of Account Code to display: 0

Configuration Cptions Maintenance |

OK Cancel

Figure 3-15 + Group Maintenance Dialog Box

To edit a user group:

1 Click the group and click Groups » Edit on the menu bar.
The Group Maintenance dialog box appears.
2 Follow the steps in To add a user group: beginning with Step 4 on page 3-34.
To add a user to a user group:
1 Click the group, and then click Groups » Add User on the menu bar.
The Select User dialog box appears.

2 Choose the user or users, and then click OK.

Note ¢ You can edit a user’s settings by double-clicking the user in the Group List
Maintenance dialog box.
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To remove a user from a user group:

Click the user, and then click Users » Remove on the menu bar.

To remove a user group:

Click the group, and then click Groups » Remove on the menu bar.

Adding or Removing Report Access to/from a Group

By default, new users are added to the Admin group, which has administrative access
enabled and full access to all reports. If you want to restrict user access to reports, you
need to do the following:

m Select the Use Report Access Security check box on the Configuration dialog box
Reporting/Options subtab (see page 3-45). If this check box is not selected, all users
can access all reports regardless of whether administrative access is enabled for their

group.

m Create a group or groups that do not have administrative access enabled (the
Administrative Access check box is not selected) and add the appropriate users.
(Users that belong to a group that has administrative access enabled have access to all
reports.)

B Add reports to the group as described in To add access to reports:.

Note  If you change the Use Report Access Security option (i.e., you select the check
box or clear it), the change will not take effect in CIMS Server Web Reporting until
you click Upgrade Configuration on the Edit Configuration page or restart IIS.

To add access to reports:

Expand the group, click Reports Allowed, and do one of the following:

m To allow all reports, click Reports » Allow All Reports on the menu bar. When you
add a group, this is the default.

m To allow certain reports, click Reports » Add on the menu bar. In the Select Report
dialog box, choose the report or reports that you want to add, and then click OK.

Reports Allowed expands to show All Reports or the reports that you added.

To remove access to a ri epor t
1 Expand Reports Allowed.

2 Click the report, and then click Reports » Remove on the menu bar.
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Adding or Removing Client Access to/from a Group

You can add access to clients to each group. This allows members of the group to see
these client account codes in reports. For more information about clients, see Working
With Clients on page 3-20.

To add access to clients:

1 Expand the group, click Clients Allowed, and do one of the following:

e To allow all clients, click Clients » Allow All Clients on the menu bar. When you
add a group, this is the default.

e To allow certain clients, click Clients » Add on the menu bar. In the Select Client
dialog box, choose the client or clients that you want to add, and then click OK.

Note ¢ To prevent duplicate data in reports, you cannot add a client with an
account code that overlaps an existing client account code in the Clients
Allowed list. For example, if you add client AABBB you cannot add client AA or
AABBBCC.

2 Expand Clients Allowed to view the clients that you added.

Note that the account code structure selected for the group might have an offset position
greater than 1. However, client access is always determined by the first position in the
account code, regardless of the offset position. The clients that you add will contain the
full account code as assigned for the clients in the CIMSClient table.

Although the full account code appears for the clients in the Clients Allowed list for the
group, the users assigned to the group will be able to view data for only the account code
level(s) specified by the offset.

For example, assume that you have the following account codes:

AABBB
AACCC

In the account code structure selected for the group, the first level of the account code is
defined as a length of 2 and the second level is defined as a length of 3. The offset
position for the account code is 3, which determines that users assigned to the group can
view data for clients BBB and CCC only. However, the complete client account codes AABBB
and AACCC appear in the Clients Allowed list.

For more information about the account code structure, see Setting Up the Account Code
Structure on page 3-3.

To remove access to clients:

1 Double-click Clients Allowed.

2 Click the client, and then click Clients » Remove on the menu bar.

Accessing User, Report, and Client Lists

You can edit user, report, and client settings by clicking Users, Reports, or Clients in the
Group List Maintenance dialog box.
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Using Web Reporting Headlines

Headlines are links that appear in the home page of the CIMS Server Web Reporting Web
site. A headline can link to any URL. This feature has many uses including displaying
announcements such as the latest CIMS chargeback data is available, a new report is
available, etc.

To add a headline:

1 In the CIMS Server Administrator main window, click System
Administration » Reporting » Web Reporting Headlines.

The Web Reporting Headline Maintenance dialog box appears.
2 Click Add.

The Headline Maintenance dialog box appears.
3 Enter the headline settings as follows:

e Date. Click the date that you want to assign to the headline. Note that this is not
the date that the headline appears on the Web site—the headline appears as soon
as it is created.

¢ Headline. Type the text of the headline.
¢ Headline Link. Type the URL for the headline (the headline appears as a link).
4 Click OK when you are finished.

An example of a configured Headline Maintenance dialog box is shown in Figure 3-16.

#4% Headline Maintenance |:|[E| E|

Headlline IC: 1

Date: 21242005 -

Headline: |elcome to CIMS Lak!

Headline Link: |hﬂp:.l’.i\vvww.c:imslab.com

OK | Cancel |

Figure 3-16 + Headline Maintenance Dialog Box

To edit a headline:

1 Click the headline and in the Web Reporting Headline Maintenance dialog box, and
then click Edit. The Headline Maintenance dialog box appears.

2 Follow the steps in To add a headline: beginning with Step 3.

To remove a headline:

Click the headline in Web Reporting Headline Maintenance dialog box, and then click
Remove.
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Maintaining Identifiers
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When you process a CSR or CSR+ file, the identifier names within that file are stored in
the CIMSIdent table. You can perform the following maintenance tasks for the
identifiers:

® Add a description for the identifier. By default, the identifier description is the same
as the identifier name. For reporting purposes, you can add detailed descriptions for
identifiers that are difficult to decipher such as alphanumeric strings. In reports that
provide drill down by identifier, the identifier descriptions appear in the Identifier
list to enable drill down of units or rates by identifier.

B Remove unused identifiers. You can remove any unused identifiers from the
CIMSIdent table. Unused identifiers are those that are not contained in the
CIMSDetailldent table. For more information about the CIMSIdent and
CIMSDetailldent tables, see Appendix A, Database Tables.

m Enable options for custom reporting. You can set options for each identifier, such
as flags, for custom reporting.

To add an identifier description:

1 In the CIMS Server Administrator main window, click System
Administration » Identifiers Maintenance. The Identifier List Maintenance dialog
box appears.

2 Click the identifier that you want to edit, and then click Edit. The Identifier
Maintenance dialog box appears.

3 Enter the identifier settings as follows:

¢ Active/Inactive. These options are available for custom reports. The use of these
options is user-specified.

¢ Name. This is the name of the identifier as it appears in the CSR or CSR+ file. Do
not change the name unless you want to assign a new identifier to the same
description. For example, the identifier ABC has been changed to ABCD. The
identifier name has changed, but the description remains the same.

e Description. Enter a description for the identifier (maximum of 255 characters).

e Report Flag. This box allows you to enter a one-character value that you can use
in custom reports. The value for this flag is user-specified.

An example of a configured Identifier Maintenance dialog box is shown in Figure 3-17
on page 3-41.
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s |dentifier Maintenance |L||'E|['S__(|
Identifier I g + Active
" Inactive
Mame: |C_IP
Description: |Client IP Address
Report Flag:

OK | Cancel ‘

Figure 3-17 - Identifier Maintenance Dialog Box

To remove unused identifiers:

Click Remove Unused Identifiers.
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Configuring System Settings

You can configure the following system settings using CIMS Server Administrator:

B 3-42

Organization information. Name and address of your organization.

Processing settings. Global processing settings for the system such as the path to the
Processes folder and whether a close date is used for processing.

Reporting settings. Report-related settings such as file location, invoice numbering,
and security.

Database settings. Database-related settings such as time-out period and load
priority.

License information. Product license key.

Web settings. Web site settings for CIMS Server Web Reporting.
Table audit settings. Table audit options.

Database load archive settings. Settings for archiving database loads.

Configuration options. Additional settings for custom reports and Web pages.

Important! ¢ If you change any of these settings in CIMS Server Administrator, the
changes will not take effect in CIMS Server Web Reporting until you click Upgrade
Configuration on the Edit Configuration page or restart IIS.

In addition, some of these settings can be configured in CIMS Server Administrator
or CIMS Server Web Reporting. If CIMS Server Web Reporting is open when you
make these changes, click Refresh before you click Upgrade Configuration. This
ensures that the settings are populated with the values that you set in CIMS Server
Administrator.
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Configuring System Settings

1 In the CIMS Server Administrator main window, click System

Administration » Configuration Information.

The Configuration dialog box appears as shown in example Figure 3-18.

Wigw

Organization Mame:

Address Line 1:
Address Line 2
Address Line 3

Address Line 4

Organization l Processing ] Reporting ] Databasze ] License ] Wiek ] Aud'rting] Archiving ] Option List]

|The Big Time Company

|C0rp0rate Headoguarters

|3013 Douglas Bivd.

[Rosevile, Ca 95681

|Un'rted States of America

Reset To Defaultts

Figure 3-18 + Configuration Dialog Box

2 Complete the tabs in the dialog box as shown in the following sections, and then click

OK to save the settings and close the dialog box.

Note ¢ To return the settings in all tabs to the original default settings, click Reset

To Defaults.

Organization Information

Use the Organization tab to type the name and address of your organization (maximum
of 255 characters in each line), and then click OK. This information appears on the

standard invoices that ship with CIMS Server.

You can also type this information on the Edit Configuration page in CIMS Server Web

Reporting.
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Processing Settings
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Use the Path, Options, and Closing subtabs on the Processing tab to set the processing
settings for CIMS Server.

Path Subtab

Process Definition Path. Enter the path for the process definitions (maximum of 255
characters). For more information about process definitions, see CIMS Server
Administrator Processing on page 6-21.

Options Subtab

Use 13 Periods. Select this check box if your organization uses 13 accounting periods.
For more information, see Using 13 Accounting Periods on page 3-27.

Decimal positions used in money calculation. Enter the number of decimal digits
(0-6) that you want to appear in money values in the CIMSSummary table. Before
you set this value, you should review Defining Decimal Positions for Money Values in the
CIMSSummary Table on page 4-13.

Closing Subtab

Close Date. You can set an optional close date for processing input file records.
Records that contain dates before or after this date are processed as described in How
Accounting Dates Are Calculated on page 6-19. You can also set close dates for an
individual process definition or definitions (see page 6-32). If you set a close date for
an individual process definition, it overrides the date that you set here.

Click one of the following:
¢ No Close Date. No close date is set.
e Use Specific Date. Enter a specific close date.

e Use Day Of Month. Type the day of the month that you want to set as the close
date. For example, type 15 if you want a close date of the fifteenth of each month.
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Reporting Settings

Use the Paths, Options, and Invoice subtabs on the Reporting tab to set the report
settings for CIMS Server Web Reporting.

Note ¢ You can also enter some of these settings on the Edit Configuration page in
CIMS Server Web Reporting.

Paths Subtab

m Path to standard reports folder. Enter the path for standard reports (maximum of
255 characters). Standard reports are those that are provided with CIMS Server. In
most cases, standard reports require customizing for your organization.

CIMS Lab recommends that you keep the Standard folder in the default location
because standard reports may be updated and/or added with a new version or release
of CIMS Server.

m Path to custom reports folder. Enter the path for custom reports (maximum of 255
characters). Custom reports are those that your report developer creates either
independently or from the standard reports provided with CIMS Server. Custom and
standard (if applicable) reports are available to users via the Reports or Spreadsheets
page of CIMS Server Web Reporting.

m Path to published reports folder. Enter the path for published reports (maximum of
255 characters). Published reports are reports that have been saved with the data that
was generated at the time the reports were run. Publishing a report enables users to
view a report without having to regenerate it.

CIMS Server provides a batch reporting feature that creates and distributes published
reports. This feature includes the option of distributing reports via a UNC link in an
e-mail message. If you want to use this option, you need to type a UNC path in this
box. For example, if you are using the default Pub1ished folder for published reports,
the UNC path might be \\servername\Pub1ished.

For more information about creating and distributing published reports in batch, see
Working With Batch Reporting/Published Reports on page 4-25.

Note * End user access to published reports is dependent on the share
permissions described in Folder Permissions Required for Publishing and Viewing Batch
Reports on page 4-48.
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Options Subtab

m Last Reporting Date. Enter the last reporting date for reports that CIMS Server Web
Reporting users who do not have administrative privileges can view. For example, if
you do not want non-administrator users to view reports for dates after March 2005,
enter 03/31/2005. Users with administrative privileges can view reports for any date.

m Rate Drilldown Report. Type the file name for the Multilevel Drilldown on Rate
report (IINXC006). This report enables you to drill down on up to five identifiers
concurrently when you drill down on the units for a rate in a Web report. If you are
using a custom version of this report, enter the file name for the custom report.

Note ¢ Consult CIMS Lab before replacing this report with a custom report. The
report must follow certain rules.

m Rate Group Drilldown Report. Type the file name for the Multilevel Drilldown on
Rate Group report (IINXC007). This report enables you to drill down on up to five
identifiers concurrently when you drill down on the units for a rate group in a Web
report. If you are using a custom version of this report, type the file name for the
custom report.

Note ¢ Consult CIMS Lab before replacing this report with a custom report. The
report must follow certain rules.

m Report Script Timeout. Enter the length of time in seconds that the ASP page will
allow a script to generate a report before timing out. The default is 900 seconds (15
minutes). The minimum value for this setting is 600 seconds (10 minutes) and the
maximum value is 2700 seconds (45 minutes).

Note ¢ IIS allows you to set the time-out value for ASP scripts. The value set for
Report Script Timeout overrides the time set in IIS only for scripts that are
generating reports. All other scripts use the time-out value set in IIS.

m Currency Symbol. The use of this box is user-specified. This box allows you to enter
a currency symbol that you can use in custom reports (maximum of three characters).

m Currency Description. The use of this box is user-specified. This box allows you to
enter a currency description that you can use in custom reports (maximum of 255
characters).

m Use Report Access Security. Select this check box to set access to reports by user
group (see Adding or Removing Report Access to/from a Group on page 3-37). If this
check box is not selected, users within a group can view all reports regardless of
whether the report is allowed for the group.
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m Use only 1 Crystal Report License on drilldown reports.

Note ¢ This check box works only with Crystal Reports 8.5. This feature does not
provide a benefit for the Crystal Reports 9 or later licensing structure.

By default, when you open a second window in Crystal Reports (for example, when
you drill down on resource units or a rate group in a Web report), a second Crystal
Reports license is used.

When this check box is selected, all report information appears in the same window
and only one Crystal Reports license is used.

m Use PDF for Published Reports. This option is required only if you are using Crystal
Reports XI and you have not purchased the full Crystal Reports Server license. In this
case, published reports cannot be viewed in Crystal Reports. If this check box is
selected, reports are published as PDF files and Acrobat Reader rather than Crystal
Reports is invoked when the file is viewed. Note that the group tree that is used for
navigation in a report does not appear in reports published as PDF files.

This option is applicable only when reports are published from the CIMS Server Web
Reporting Web site. For more information about batch reporting including how to set
the report format for batch reports, see Working With Batch Reporting/Published Reports
on page 4-25.

Invoice Subtab

B Invoice Number Automation. When this check box is selected, invoice numbers in
CIMS Server Web Reporting increase sequentially from the number set in the Invoice
Number box.

When this check box is selected, the parameter Invoice Number does not appear as a
report parameter in CIMS Server Web Reporting. For more information about Web
report parameters, refer to the CIMS Server Web Reporting User’s Guide.

m Invoice Number. If the Invoice Number Automation check box is selected, use this
box to set the number at which you want invoice numbers to begin. Invoice numbers
increase in sequential order from this number. If the Invoice Number Automation
check box is not selected, the invoice number entered as a report parameter in CIMS
Server Web Reporting is used.
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Database Settings

Use the Database tab to set the following:

m Connection Timeout (seconds). Type the maximum number of seconds (maximum
0f9999) that a database may respond to a query before timing out. If this time period
is exceeded, CIMS Server Administrator assumes that the database server is not
responding and returns an error message.

If you accept the default (0), no time-out period is applied.

m Database Load—Process Priority Class. This setting determines the priority in which
CIMS Server processes are run (CIMSAcct, CIMSBIll, database loads, etc.). Because
these processes can use a large amount of CPU time, CIMS Lab recommends that you
accept the default, Below Normal, which allows other processes (for example, IIS and
SQL Server tasks) to take precedence. Consult CIMS Lab before using a priority other
than Below Normal.

Note ¢ Below Normal will not cause processes to run longer if the system is idle.
However, if other tasks are running, processes will take longer to run.

License Information

B 3-48

Use the License tab to enter the license key provided by CIMS Lab. If you do not have
your license key, contact CIMS Lab.

To enter a license:

1 Enter the appropriate workstation (machine) and type the license key.
2 Click Update License.

To remove a license for a workstation:

1 Enter the workstation.

2 Click Remove License.

If you installed CIMS Server on Windows XP or Windows Server 2003, you should be
logged on to the CIMS Server application server as a user in the Windows Administrators
group to enter or remove the license key. If you are not a member of this group, complete
the following steps:

1 Click the Windows Start button, and then click Run.

2 Type regedit, and then click OK.

3 Navigate to HKEY_LOCAL_MACHINE » SOFTWARE » CIMS.

4 Right-click the CIMS folder, and then click Permissions.
5

Add the user account that will be working with CIMS Server and give the account
Full Control and Read permissions.

Note that if you installed CIMS Server on Windows 2000 Server, you cannot set registry
permissions at the key level.
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Web Settings

Use the General, User Logging, and Customization subtabs on the Web tab to set the
Web site settings for CIMS Server Web Reporting, including optional custom settings.

General Subtab

m Session Timeout Minutes. Enter the number of minutes of inactivity that are allowed
before a CIMS Server Web Reporting user is automatically logged off the system. The
minimum is 1 minute and the maximum is 9999 minutes. The default is 60 minutes.

m Display Account Code Selection to Level. This setting determines the level of
account codes that appear in the Starting Account Code and Ending Account Code
parameter lists in CIMS Server Web Reporting. For example, if you type 1, only the
top level account codes appear. However, if you type 3, the first, second, and third
level account codes appear. For more information, about using starting and ending
account codes, refer to the CIMS Server Web Reporting User’s Guide.

You can also enter this setting on the Edit Configuration page in CIMS Server Web
Reporting.

m Crystal Report Viewer. Click the Crystal viewer used for CIMS Server Web Reporting.
If you are using SQL Server Reporting Services for reporting, leave this box set to
Default. You can also enter this setting on the Edit Configuration page in CIMS Server
Web Reporting.

Note * You can set different viewers for individual users. CIMS Server Web
Reporting uses the viewer set for the user if it differs from the viewer set here. To
set this option for an individual user, see page 3-28.

You can choose the following:

e Default. If you are using Crystal Reports 9, 10, or XI, the default is the HTML
viewer. If you are using Crystal Reports 8.5, the default is the ActiveX viewer.

e ActiveX. This option works only in Internet Explorer. This viewer has the following
advantages and disadvantages:

Advantage: This viewer provides more features than the HTML viewer provides.

Disadvantage: This viewer requires that the Crystal Smart Viewer for ActiveX be
installed on the user’s computer (see Start CIMS Server Web Reporting on

page 2-80). The user might not have the administrative privileges required to
install and run the viewer.

e Java using Browser JVM. This option works in Netscape Navigator or Internet
Explorer. This viewer requires the Java Virtual Machine. Because this viewer might
be more difficult to set up, CIMS Lab recommends that you use the HTML or
ActiveX viewer.

e HTML. This option works in Internet Explorer or Netscape Navigator. This viewer
has the following advantages and disadvantages:

Advantage: This viewer works with any browser and does not require any
additional files or set up.

Disadvantage: This viewer provides fewer features than the ActiveX viewer
provides.
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m Crystal Release. Click the Crystal Reports release that you are using for Web
reporting: 85, 90, 10, or XI.

Or

Click RS if you are using SQL Server Reporting Services. Type the URL for the
Reporting Services Report Server virtual directory if the correct URL does not appear
by default. For more information, see Enter the Reporting Services Report Server URL on
page 2-71.

m Port Number. If SSL is not enabled for the CIMS Server Web Reporting Web site and
a port other than port 80 is used, type the port number.

m Secure Port. If SSL is enabled for the CIMS Server Web Reporting Web site and a port
other than port 443 is used, type the port number.

m Site Localization ID (LCID): If you want to use regional settings other than US
English for the CIMS Server Web Reporting Web site, type the locale ID for the settings
that you want to use. This must be one of the decimal values provided at http://
msdn.microsoft.com/library/en-us/script56/html/vsmsclcid.asp. Do not use the
short string or hex values. For more information about setting CIMS Server up for
internationalization, see page 2-13.

m Enable Intranet Auto Logon. Select this check box to enable users to automatically
log on to CIMS Server Web Reporting and other CIMS Web-based applications. This
feature saves time for users and eliminates the need to maintain user passwords in the
CIMS Server database.

To use this feature, the Windows domain name and user ID for the user must be
entered in the User Maintenance dialog box (see page 3-28) and IIS security for the
CIMS Server Web Reporting Web site and any other CIMS Web sites must be set to
Integrated Windows authentication (see page 2-67).

m Secure Login. Select this check box if SSL is enabled for the CIMS Server Web
Reporting Web site. For more information about enabling SSL, see page 2-70.

m Allow Password Change. Select this check box to enable users to change their user
password on the CIMS Server Web Reporting Login page.

m Display Account Name on Account Code drop downs. Select this check box to
display the account code description in the Starting Account Code and Ending
Account Code parameter lists in CIMS Server Web Reporting. If you do not select this
check box, the account code description does not appear with the account code.
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m Enable Client Dropdown Exact Length. When this check box is selected, only
account codes of the level set in the Display Account Code Selection to Level box
appear as parameters in CIMS Server Web Reporting.

For example, assume that you have an account code of AABBBCCCC, where AA is
level 1, AABBB is level 2, and AABBBCCCC is level 3. If Display Account Code
Selection to Level is set to 3, only code AABBBCCCC appears in the Starting Account
Code and Ending Account Code parameter lists in CIMS Server Web Reporting.

Note that if you select this check box and you do not have clients defined in the
CIMSClient table for the level set in Display Account Code Selection to Level, no
account codes will appear in the parameter lists.

User Logging Subtab

m Log File. If you are logging the usage of CIMS Server Web Reporting, enter the path
for the log file.

m Log IP Address To Skip. If you are logging the usage of CIMS Server Web Reporting,
type the IP address of any client that you do not want to track in the log file. If you
enter only the first number or numbers of an address, any address that begins with
the number(s) will not appear in the log file. For example, if you enter 127.0.0, the
addresses 127.0.0.0 and 127.0.0.1 are not included.

B Require Company Name on login. When this check box is selected, the user must
enter a company or organization name when logging on to CIMS Server Web
Reporting. A text box for the name appears on the Login page.

CIMS Server Administrator's Guide 3-51 N



Bl Setting Up the System

Configuring System Settings

B 3-52

In Windows:

Customization Subtab

CIMS Server enables you to create custom Web site settings for CIMS Server Web
Reporting. For example, you might want the Web site to conform to your corporate
standards or to use a custom startup ASP page.

You can use the custom settings feature to select the cascading style sheets, images,
background color, and menu alignment for the Web site.

To use custom Web site settings, you need to first set up the appropriate folders and files
in Windows.

1 Make sure that you have a Custom folder in C:\Program Files\CIMSLab\Server\Web.

(This is the default location. The location of the Web folder might differ on your
system.) The Custom folder should contain an images folder. See example Figure 3-19.

B Web
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Figure 3-19 « Web Folder Contents

Copy everything in Web\images to Web\Custom\images. (Click Yes to replace the
existing topgraphic.gif file in Custom\images).

Copy the CIMS.css file from the Web folder to Web\Custom.

Customize the CIMS.css file in the Custom folder as needed.

Customize the images in Custom\images as needed.
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6 In Web\Custom\images, replace the topgraphic.gif file with your own image. This is
the image that appears at the top of all Web pages. The image must be named
topgraphic.gif, but it can be in the GIF or JPEG format.

7 1In the Custom folder, customize the default.asp page. This is the home page.

In CIMS Server Administrator:

1 On the Web tab, click Custom in the Custom Site box. Edit the following:
¢ Background Color. Type the hexadecimal number for the background color.
e CSS Location. Type Custom\CIMS.css (do not add beginning or ending slashes).
* Image Location. Type Custom\images (do not add beginning or ending slashes).

e Menu Vertical Start Position. Enter the start position (in pixels) for the menu. The
menu begins at the specified number of pixels from the top of the page. The
number of pixels depends on the size of your topgraphic.gif image. To
determine the number of pixels:

a Right-click the topgraphic.gif file, and then click Properties.
b Click the Summary tab to get the image height.
2 Click OK when you are finished.
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Table Audit Settings

B 3-54

Important! ¢ Auditing a table can degrade the table’s performance because the audit
feature uses SQL triggers. Do not use this feature for tables that you do not need to
audit.

This feature is available if you are using a SQL Server database. Support for Oracle
and DB2 will be included in a future release of CIMS Server.

Use the Auditing tab to audit changes to certain database tables. Auditing tracks changes
that have been made to the data in the tables, including the Windows user ID of the
person who made the change and the date and time that the change occurred.

Note ¢ Transaction audits might reflect the SQL Server login ID rather than the
Windows user ID. For more information, see Creating User Logins for the Database on
page 2-29.

To audit tables, select the appropriate check boxes in the Select audit types area. Audit
data for a table is stored in an additional table named CIMSAudit<audit type>. For
example, the CIMSAuditRate table tracks changes to the CIMSRate table.

You can also view changes to the CIMSClient, CIMSRate, and CIMSTransaction tables via
the following standard Web reports.

m Client Audit Report (file name RACLX001. rpt)
m Rate Audit Report (file name RARTX001.rpt)
m Transaction Audit Report (file name RATRX001.rpt)

For more information about these reports, including examples, refer to the CIMS Server
Web Reporting User’s Guide.

Note ¢ You need to add these reports to the reports list in the Report List
Maintenance Dialog box and to a report group in the Report Group Maintenance
Dialog box if the reports are not already present (see Adding Reports to the CIMS Server
Report List on page 4-19 and Defining Report Groups on page 4-21).
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Database Load Archive Settings

Note ¢ These settings support the database load archive feature described in
Archiving, Purging, and Restoring Database Loads on page 5-20.

Use the Archiving tab to set the archiving options for database loads. Archiving saves
selected database loads in a format that you can reload (restore) into the database if the
loads are purged.

Archive Path. Enter the path for storing the archived database loads. The default path
is C:\Program Files\CIMSLab\Admin\Archive\DSNname, where DSNname is the name of
the CIMS Data Source selected in the Select CIMS Data Source list. If you are using
multiple databases with CIMS Server, you should store the archived loads from each
database in separate folders. The archived database loads are stored in a zip file and
you cannot determine the data source by the zip file name.

Compression Type. Click the compression type that you want to use for the archive
files or None. The default, Deflate, is recommended; however, Deflate64 and
BurrowsWheeler may be used for zip tools that support them.

Compression Level. Move the slider to set the compression level. The compression

level controls the amount of compression to be applied when compressing data. The
greater the amount of compression applied, the greater the time it takes to perform

the compression.
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Configuration Options

The Option List tab stores the following variables used by CIMS Server for batch
reporting. These variables should not be deleted or changed without consulting CIMS
Lab.

m BatchPortNumber
B BatchServerNode
m BatchVirtualDir

The Option List tab also stores the following variables for use with Crystal Reports XI.
These variables are set using the Configure BusinessObjects Enterprise Wizard (see
Configure Crystal Reports Server on page 2-77 for more information about using the
wizard).

m BOEnterpriseAuthenticationMethod

m BOEnterpriseFolderName

BOEnterpriseServerName
m BOEnterpriseUserGroupName
® BOEnterpriseUserName

You can use this tab to add optional configuration settings as documented in other
sections in this guide and to add options for use in custom reports. CIMS Lab
recommends that you consult CIMS Lab for assistance in adding configuration settings
for custom reports.

To add configuration options:

1 Click Add.

2 In the Add New Configuration Option dialog box, enter the name for the new option
(maximum of 80 characters), and then click OK. The Configuration Option
Maintenance dialog box appears.

3 Enter the following information for the option:
e Description. An optional description of the setting. Maximum of 80 characters.

e Value. The value for the setting (e.g., a folder path or a flag value). Maximum of
255 characters.

e Data Type. The data type for the value: String, Integer, Floating Point, or Date/
Time.
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This chapter describes how to use CIMS Server Administrator to define and group the
reports that appear on the CIMS Server Web Reporting Web site. This chapter also
describes how to generate and distribute published reports in batch mode.
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Folder Permissions Required for Publishing and Viewing Batch Reports ................. 4-48
Creating a Virtual Directory for the Published Folder ................... .. ... .. ..... 4-49
Drilling Down in Published Reports ............c. i 4-50
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About CIMS Server Reports

CIMS Server processes data contained in an input CIMS Server Resource (CSR) or CIMS
Server Resource Plus (CSR+) file and produces CIMS Ident, Detail, and Summary files.

The data in these files is loaded into the CIMSSummary, CIMSDetail, CIMSDetailldent,
and CIMSIdent tables in the CIMS Server database. The data in these tables is then used
for reporting. For more information, see Tables Used for Reports on page 4-7.

CIMS Server includes a variety of standard reports that can be used “as is” or can be
customized for your organization. For a description of each of the standard reports, refer
to the CIMS Server Web Reporting User’s Guide.

This section describes the folder hierarchy for storing CIMS Server reports and describes
the types or reports available.

Location of CIMS Server Reports

If CIMS Server is installed in the default location, reports are located in the following
folders. Each of these folders contains the subfolders Standard, Custom, and Published.
For example, ReportsMSRS\Standard, ReportsMSRS\Custom, and ReportsMSRS\Pub1ished.

Crystal Reports

m C:\ProgramFiles\CIMSLab\Server\Reports85 (contains Crystal 8.5 reports for SQL
Server only)

B ...\ReportsORADB? (contains Crystal reports for Oracle and DB2)

m ...\ReportsSQL (contains Crystal reports for SQL Server)

SQL Server Reporting Services Reports
m C:\Program Files\CIMSLab\Server\ReportsMSRS

Note ¢ SQL Server Reporting Services is not available for MSDE. In addition,
CIMS Server 4.3 does not support the use of Reporting Services with a DB2
database.

CIMS Advanced Spreadsheets
B C:\Program Files\CIMSLab\Server\AdvSpreadsheets
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How CIMS Server Determines the Report Folder to Use

During database initialization, CIMS Server determines the default folder to be used for
reporting based on the following:

m Ifyou selected Crystal Reports 8.5 during database initialization, the Reports85 folder
is used.

m Ifyou selected Crystal Reports 9, 10, or XI, the type of database determines the default
folder (e.g., if the database selected for initialization is a SQL Server database, the
default reports folder is ReportsSQl).

m If you selected SQL Server Reporting Services, the ReportsMSRS folder is used.

If you move the report folder to another location or move the Standard, Custom, or
Published subfolders, you need to change the paths on the Reporting tab in the
Configuration dialog box (see Reporting Settings on page 3-45).
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Types of CIMS Server Reports
There are four types of reports available with CIMS Server:

m Standard or Custom Reports. CIMS Server includes a variety of standard Crystal and
SQL Server Reporting Services reports. These standard reports include invoice, budget,
summary, trend, and variance reports in report, graph, and spreadsheet format.
Standard reports are available as . rpt files for Crystal Reports and .rd1 files for SQL
Server Reporting Services.

Standard Crystal and Reporting Services reports are stored in the Reports<database
type>\ Standard folder and the ReportsMSRS\Standard folder, respectively. For a
description of each of the standard reports, refer to the CIMS Server Web Reporting
User’s Guide.

Typically, your report developer will customize the CIMS standard reports for your
organization or will create new reports. The CIMS Server installation includes a
default Reports<database type>\Custom or ReportsMSRS\Custom folder that you can
use to store these custom reports.

If a report of the same name is in both the Standard and Custom folder, CIMS Server
will use the report in the Custom folder.

Once you have the standard and custom reports in the appropriate folders, you need
to specify which of the reports that you want to use with CIMS Server (see Adding
Reports to the CIMS Server Report List on page 4-19 and Defining Report Groups on
page 4-21). Users can then run these reports from the CIMS Server Web Reporting
Web site.

m CIMS Web User Created Reports. Web reporting end users create these reports
directly within the CIMS Server Web Reporting Web site using report templates that
are supplied with CIMS Server or developed by your Crystal Reports developer. These
templates are stored in the Standard\Templates folder. For more information about
these reports, refer to the CIMS Server Web Reporting User’s Guide.

By default, Web user-created reports are placed in the Custom or Custom
Spreadsheets report groups. However, you can use CIMS Server Administrator to
define any report group as the default group for user-created reports (see To set the
default group for reports created by CIMS Web users: on page 4-23).
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m Published Reports. Published reports are standard or custom reports that have been

saved with the data that was generated at the time the reports were run. Publishing a
report enables users to view a report without having to regenerate it. Published
reports are stored in the Pub1ished folder that is defined in the Configuration dialog
box.

Users can publish reports from the CIMS Server Web Reporting Web site or you can
use CIMS Server Administrator and batch reporting scripts to automatically generate
and publish reports. For more information about generating and publishing reports
in batch, see Working With Batch Reporting/Published Reports on page 4-25.

CIMS Advanced Spreadsheets. CIMS Advanced Spreadsheets have more advanced
features than Crystal Reports or SQL Server Reporting Services spreadsheets,
including drill down and sorting capability.

Note ¢ If you are using an Oracle or DB2 database, contact CIMS Lab for
information about using CIMS Advanced Spreadsheets.

CIMS Advanced Spreadsheets are XML definition files. You can use these files “as is”
or your report developer can customize these files for your organization or can create
new files.

Although the standard advanced spreadsheets are installed in the
Server\AdvSpreadsheets\Standard folder, you need to copy the standard
spreadsheets that you want to use to the Standard or Custom folder that is defined in
the Configuration dialog box (see Reporting Settings on page 3-45). You can choose
either folder; however, you might want to use the Standard folder for consistency.

Likewise, you need to place any custom advanced spreadsheets in the Custom folder
defined in the Configuration dialog box and not in the Server\AdvSpreadsheets\
Custom folder.

As with all CIMS Server reports, if a spreadsheet of the same name is in both the
Standard and Custom folder, CIMS Server will use the spreadsheet in the Customfolder.

To copy the standard advanced spreadsheets to the appropriate folder, do the
following:

1 In the Configuration dialog box, click the Reporting tab to view the paths to the
report folders that have been defined for your standard and custom reports. The
paths appear in the Path to standard reports folder and Path to custom reports
folders boxes.

2 In Windows Explorer, copy the advanced spreadsheets from the
AdvSpreadsheets\Standard folder to either the Standard or Custom folder that is
defined in the Configuration dialog box. For example, copy the spreadsheets from
the AdvSpreadsheets\Standard folder to ReportsSQL\Standard folder.

3 Define the advanced spreadsheets that you want to use with CIMS Server (see
Adding Reports to the CIMS Server Report List on page 4-19 and Defining Report
Groups on page 4-21). Users can then run these spreadsheets from the CIMS Server
Web Reporting Web site.

For more information about CIMS Advanced Spreadsheets, refer to the CIMS Server
Web Reporting User’s Guide.

CIMS Server Administrator's Guide



Report Administration H
Tables Used for Reports

Tables Used for Reports

CIMS Server processes data contained in an input CSR or CSR+ file and loads the data
into the tables described in this section.

CIMSSummary Table

All reports that include money values use the CIMSSummary table. The CIMSSummary
table contains summarized resource units, rate, and money values for the lowest level of
the account code by rate code/date range. That is, if there are multiple records in the CSR/
CSR+ file for the same account code, date range, and rate code, the values in the records
are aggregated together.

Example CIMSSummary Table Data

Assume that the following are the lowest level account codes that appear in the
CIMSSummary table:

E AABBBCCC
m AAEEEFFF

The CIMSSummary table might contain the following data:

Resource Rate Money

AccountCode RateCode StartDate EndDate Units Value Value
AABBBCCC LLG104 7/01/2005 7/01/2005 1.247 0.01 0.01
AABBBCCC LLG105 7/01/2005 7/01/2005 2.940 0.018 0.05
AAEEEFFF LLG104 7/01/2005 7/01/2005 1.182 0.01 0.01
AAEEEFFF LLG105 7/01/2005 7/01/2005 0.759 0.018 0.01
AABBBCCC LLG104 7/02/2005 7/02/2005 1.984 0.01 0.02
AABBBCCC LLG105 7/02/2005 7/02/2005 1.201 0.018 0.01
AAEEEFFF LLG104 7/02/2005 7/02/2005 3.084 0.01 0.03
AAEEEFFF LLG105 7/02/2005 7/02/2005 1.199 0.018 0.02
AABBBCCC LLG104 7/03/2005 7/03/2005 1.083 0.01 0.01
AABBBCCC LLG105 7/03/2005 7/03/2005 2.162 0.018 0.04
AAEEEFFF LLG104 7/03/2005 7/03/2005 0.014 0.01 0.00
AAEEEFFF LLG105 7/03/2005 7/03/2005 0.875 0.018 0.02

Note that the CIMSSummary table contains fields other than those shown. For a
description of the fields in the CIMSSummary table, see page A-40.
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To run a report, the user must specify the account code level and date for the data that
will appear in the report. Data aggregation is performed in the report from the lowest to
the highest account code level for the specified date range.

For example, assume that the highest level account code for account codes AABBBCCC
and AAEEEFFF is AA. The second level account code is AABBB or AAEEE. If the report is
run with a date range of 7/01/2005 to 7/03/2005 for the second level account code, the
following aggregated data would appear in the report:

AccountCode RateCode StartDate EndDate Resource Rate Money
Units Value Value
AABBB LLG104 7/01/2005 7/03/2005 4.314 0.01 0.04
AABBB LLG105 7/01/2005 7/03/2005 6.303 0.018 0.11
AAEEE LLG104 7/01/2005 7/03/2005 4.28 0.01 0.04
AAEEE LLG105 7/01/2005 7/03/2005 2.833 0.018 0.05

In this example, the resource units for July 1 through July 3 are aggregated by account
code/rate code.

CIMSDetail Table

Some reports use the CIMSDetail table rather than the CIMSSummary table. These
reports do not include money values, which are not included in the CIMSDetail table. In
addition, the drill down reports I INXCOO1. rpt through IINXC007.rpt (which are invoked
from a main report) use the CIMSDetail table.

The CIMSDetail stores resource data in the most detailed level. Each record in this table
corresponds to a specific record in the input CSR or CSR+ file and contains a single rate
code and its resource units from that record. For example, if one input CSR/CSR+
contains the rate codes LLG104 and LLG105, a separate record is created for each rate
code in the CIMSDetail table

Each record in the CIMSDetail table identifies the number of the original CSR or CSR+
record from which the rate code and resource units were taken (i.e., 1 if it is the first
record, 2 if it is the second record, etc.). This number is used to associate the rate codes
from the input CSR/CSR+ records with identifiers that are in the input records. The
identifier values from the input records are stored in the CIMSDetailldent table.
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Example CIMSDetail Table Data

Using the same account codes, rate codes, and date ranges shown in the CIMSSummary
table example on page 4-7, the CIMSDetail might contain the following data. As with the
CIMSSummary table, the account codes in the CIMSDetail table are always the lowest
level account code.

DetailLine AccountCode RateCode StartDate EndDate Resource
Units
1 AABBBCCC LLG104 7/01/2005 7/01/2005 0.599
2 AABBBCCC LLG104 7/01/2005 7/01/2005 0.233
3 AABBBCCC LLG104 7/01/2005 7/01/2005 0.415
4 AAEEEFFF LLG104 7/01/2005 7/01/2005 1.003
5 AAEEEFFF LLG104 7/01/2005 7/01/2005 0.179
1 AABBBCCC LLGI05 7/01/2005 7/01/2005 1.295
2 AABBBCCC LLG105 7/01/2005 7/01/2005 1.645
3 AAEEEFFF LLG105 7/01/2005 7/01/2005 0.117
4 AAEEEFFF LLG105 7/01/2005 7/01/2005 0.318
5 AAEEEFFF LLGI05 7/01/2005 7/01/2005 0.324

Comparing this example to the CIMSSummary table example on page 4-7, the
CIMSDetail record contains multiple records for the same rate code, rate code, and date
range, while the CIMSSummary table contains one record with an aggregated resource
units value.

Note that CIMSDetail table contains fields other than those shown. For a description of
the fields in the CIMSDetail table, see page A-23.
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Drilling Down on Resource Units by Identifier

You can drill down on resource values in a report to view a second report that shows the
resources by broken down by specified identifier values such system ID, work ID, user
name, server name, etc. For example, the following CSR records for the same date range
contain the same identifier names and rate codes, but different identifier values:

Exchange,20050916,20050916,01:00:47,01:00:47,,1,User,"joe",1,EXEMRCY,1
Exchange,20050916,20050916,01:00:47,01:00:47,,1,User,"mary",1,EXEMRCV,2

In this example, an aggregated resource units value of 3 would appear in reports for rate
code EXEMRCV. However, you could drill down to view the units by identifier values
broken down by joe and mary.

The number in the DetailLine column of the CIMSDetail table indicates the record in the
CSR or CSR+ from which the data was taken. Record numbers are also specified in the
CIMSDetailldent table which contains identifier values. CIMS uses the record numbers
in the CIMSDetail and CIMSDetailldent tables to determine which identifier values are
associated with the resource units.

For more information about drill down reports, including examples, refer to the CIMS
Server Web Reporting User’s Guide.
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CIMSIdentTable and CIMSDetailldent Tables

The CIMSIdent table contains the identifier names from the input CSR or CSR+ file
records. The CIMSDetailldent table contains the identifier values associated with the
identifier names in the CIMSIdent table.

Example CIMSIdent Table Data and CIMSDetailldent

In this example, the identifier SYSTEM_ID and USERNAME are stored in CIMSIdent table.
These identifiers are represented by the numbers 1 and 2, respectively.

CIMSIlident Table

IdentNumber IdentName

1 SYSTEM_ID

2 USERNAME

The identifier values that appear in the CSR or CSR+ records for SYSTEM_ID and USERNAME
are stored in the CIMSDetailldent table. The number in the DetailLine column identifies
the number of the original CSR or CSR+ record from which the identifier value was taken

(i.e., 1 ifitis the first record, 2 if it is the second record, etc.). The value in the
IdentNumber column correlates to the IdentNumber in the CIMSIdent table.

CIMSDetailldent Table

DetailLine IdentNumber IdentValue
1 1 zeus

1 2 root

2 1 zeus

2 2 cims

3 1 zeus

3 2 cims

4 1 athena
4 2 adm

5 1 athena
5 2 webadm

Note that CIMSDetailldent and CIMSIdent tables contain fields other than those shown.
For a description of the fields in these tables, see page A-24 and page A-25.
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Defining Decimal Positions for Unit, Rate, and
Money Values in Reports

H 4-12

Most reports use the CIMSSummary table, which includes resource unit, rate, and money
values. Other reports and all drill down reports use the CIMSDetail table, which include
rate or money values. The number of decimal digits shown for the unit, rate, and money
values in reports may or may not match the number shown in the originating table
depending on the rate code and configuration settings as follows:

m Units and rate values. The number of unit and rate decimal digits that appear in
reports are set by rate code. The decimal digits for units can be 0-5. The decimal digits
for rate values can be 4 or 8. To set the unit and rate decimal digits for a rate code, see
Defining Rate Codes on page 3-9.

B Money values. Money values in reports always contain two decimal digits. However,
the number of decimal digits that are included in the money value in the
CIMSSummary table can be 0-6 positions. For more information, see Defining
Decimal Positions for Money Values in the CIMSSummary Table on page 4-13.

In the following report example, the decimal digits set for the unit values in the Units
column and rate values in the Rate column are two and four, respectively. The Charge
column contains money values, which are always shown with two decimal digits.

/M=Divide by 1000
This option is set by rate code

Units Rate J Charge
im

Unix Process Block I/0 (1,0005) 2 0.1000 0,00
Unix Process Character A2 (100,0005) 73102 o.oozo M 0.19
Unis Process Irmage Time (Hours) 2,780.92 0.0000 0.00
Unix Process User CPU [Minutes) 156.658 0.0100 1.57
Unix Process System CPU (Minutes) 44,50 0.01580 0.74
Unix Process Total CPU (Minutes) 201.18 0.0300 £.02
Unix Process Memory [MB Days) 333,795,235 o.ooos M 0.26
Unix Process Image Count 33,459 0.,0z00 £ 062

| Unix Process Charges 9.40

Figure 4-1 « Example Report 1
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Defining Decimal Positions for Money Values in the
CIMSSummary Table

As described in the previous section, money values in CIMS standard reports always
contain two decimal positions. However, you can define the number of decimal
positions (0-6) that appear in the money value in the CIMSSummary table. To set the
decimal positions for the money value that appears in the CIMSSummary table, see
Processing Settings on page 3-44.

Note ¢ For the advantage and disadvantage of using a greater number of decimal
positions for money values in the CIMSSummary table, see page 4-15.

Example Using Four Decimal Digits

Looking at Figure 4-1 on page 4-12, note that many of the money values do not match
the corresponding units multiplied by rate. For example, the units for rate code Unix
Process System CPU (Minutes) are 44.50 and the rate is .0180. If you multiply the units
by the rate code, the sum is .801(which would be rounded to .80). However, .74 appears
as the sum in the report.

This discrepancy is due to the rounding that occurs in the CIMSSummary table for
money values. In Figure 4-1, the money values in the CIMSSummary table were rounded
to two decimal digits. If the decimal digits in the money values had been set to four in
the CIMSSummary table, the report would appear as shown in Figure 4-2.

Units Rate Charge

Unix Pracess Block If0 (1,000s) 2 o.1ooo0 M 0.00
Uniz Process Character I/O (100,0005) 73,102 o.oozg M 0.15
Unix Process Image Time (Hours) 2, 780,92 0.0000 0.00
Unix Process User CPU (Minutes) 156,65 0,0100 1.57
Unix Process System CPU (Minutes) 44,50 00180 0,20
Unix Process Total CPU (Minutes) 201.18 0.0200 5,04
Unix Process Mearnory (MB Days) 333,795,235 o.ooos M 0.20
Unix Process Image Count 33,489 0.,0z00 M 067
| Uniz Process Charges 9.42

Figure 4-2 - Example Report 2

The charges for each rate code in the report now match the units multiplied by the rates.
Assume that the charges for each rate code represent the total for all of the days in June.
Using the rate code Unix Process System CPU as an example, Table 4-1 shows the
difference between the money calculations using two digits and four digits.

Date Units Rate Money Value 2 Dec. Digits Money Value 4 Dec. Digits
6/1 1.295 0.018 0.02 0.0233
6/2 1.316 0.018 0.02 0.0237
6/3 1.323 0.018 0.02 0.0238
6/4 2.182 0.018 0.04 0.0393
6/5 2.117 0.018 0.04 0.0381

Table 4-1 « Money Value Calculation Example
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Date Units Rate Money Value 2 Dec. Digits Money Value 4 Dec. Digits
6/6 1.575 0.018 0.03 0.0284
6/7 2.934 0.018 0.05 0.0528
6/8 2.899 0.018 0.05 0.0522
6/9 2.923 0.018 0.05 0.0526
6/10  1.887 0.018 0.03 0.0340
6/11  0.665 0.018 0.01 0.0120
6/12  0.581 0.018 0.01 0.0105
6/13  2.076 0.018 0.04 0.0374
6/14  1.352 0.018 0.02 0.0243
6/15  1.636 0.018 0.03 0.0294
6/16 1413 0.018 0.03 0.0254
6/17 1317 0.018 0.02 0.0237
6/18 0.691 0.018 0.01 0.0124
6/19  0.567 0.018 0.01 0.0102
6/20 1.572 0.018 0.03 0.0283
6/21  1.339 0.018 0.02 0.0241
6/22  1.313 0.018 0.02 0.0236
6/23  1.302 0.018 0.02 0.0234
6/24  1.350 0.018 0.02 0.0243
6/25 0.692 0.018 0.01 0.0125
6/26  0.575 0.018 0.01 0.0104
6/27  1.578 0.018 0.01 0.0284
6/28 1.365 0.018 0.03 0.0246
6/29  1.326 0.018 0.02 0.0239
6/30 1.336 0.018 0.02 0.0240
Totals 44.497 0.74 0.801

Table 4-1 « Money Value Calculation Example (Continued)
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Advantage and Disadvantage of Setting a Greater Number of
Decimal Digits for Money Values

The following are the advantage and disadvantage of changing the number of decimal
digits for money values from the default setting (2 digits) to a greater number of digits.

Advantage

m A greater number of decimal digits in the money values ensures that the charges in
reports match the units multiplied by the rate on a line-by-line basis. Usually four
decimal digits are sufficient.

Compare Figure 4-1 on page 4-12 to Figure 4-2 on page 4-13 for an example of the
same report using money values with two underlying decimal digits vs. four
underlying decimal digits.

Disadvantage

m There is a possibility of a plus or minus one cent difference between totals in the
reports for an account across account levels. For example, the total for account code
AA might be 4309.33, but the total money value for account code AABBB might equal
4309.34. There is also the possibility of the same difference between the sum of
individual charges shown in a report and the total for those charges. This is because
total charges are calculated from the four decimal digit money values in the
CIMSSummary table, not from the two digit money values in the report. For example,
the total charge in the report in Figure 4-2 appears as 9.42. However, if you add the
money values that appear in the report, the total is 9.43.

If the CIMSSummary table contains two or fewer decimal digits, total charges will
always match the sum of the money values within a report and charges will match
across account code levels. Two decimal digits are set as the default because accuracy
across account levels is usually more important than accuracy across the individual
lines of a report.

If you want to see the difference that the decimal digits setting makes in the money value,
run a report for a single day of data at the lowest account level. In this situation, there are
no differences in the money value on a line-by-line basis or in total charge values,
regardless of the number of decimal digits that you have set. Then run the report for a
month of data and compare the differences.
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Customizing Report Parameters (Optional)

The CIMS standard reports include parameter field names that correlate to ASP.NET
.ascx files (user controls). If you installed CIMS Server in the default location, these user
controlsarein C: \Program Files\CIMSLab\Server\Web\CIMSReporting\CIMSParameters\
CIMSComponents\Standard.

If you want to use parameters other than the default parameters provided by CIMS Lab,
you need to create parameter fields in your reports and user controls in the
CIMSComponents\Custom folder. The process for creating custom parameters differs
depending on whether your organization generates reports from the CIMS Server Web
Reporting Web site or generates reports in batch only.

You can also customize the standard user controls for the parameters provided with
CIMS Server. However, the ability to customize is limited to changing presentation logic.

Creating Custom Parameters for Web Reports

Creating Parameters Using CIMS Templates

To create custom parameters used by reports that run from the Web site, modify the
paramTemplate.ascx user control and paramTemplate.ascx.cs source file in the Custom
folder. For assistance with modifying these files, contact CIMS Lab.

When you modify the user control and source file, all of the following must match:
m The file name of the user control and source file.

m The parameter field name defined in the report.

m The control name for the parameter within the user control.

For example, if the user control and source files are paramABC.ascx and
paramABC.ascx.cs, the parameter field name in the report must be ABC (or @ABC if the
parameter is not used in a stored procedure), and the control name must be "ABC".

You should save custom parameter files in the Custom subfolder on the CIMS Server
application server (see Saving Custom Parameters on page 4-18).

Note ¢ If parameter files of the same name are in both the Standard and Custom
parameter folder, the parameter files in the Custom folder are used.
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Creating Parameters Using Parameter Fields
(Crystal Reports Only)

You can also use parameter fields to create parameters within a report. To add parameter
fields:

1 Open the report in Crystal Reports, and then click Insert » Field Object.
2 Right-click Parameter Fields, and then click New.

3 In the Create Parameter Field dialog box, type the name of the field.

4 In the Prompting text box, type one of the following:

e LEN= This creates a text box with the specified maximum character length on the
report parameters page in CIMS Server Web Reporting. For example, LEN=6
limits the maximum characters that can be typed in the box to six.

e YorN This creates a Y/N select box on the report parameters page in CIMS Server
Web Reporting.

5 In the Value type box, leave the value at String (the default).

6 Click OK to save the parameter field.

Note ¢ You can set options in the Options area of the Create Parameter Field dialog
box. However, these options are not used by CIMS Server Web Reporting. Refer to
your Crystal Reports documentation for more information about these options.
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Creating Custom Parameters for Batch Reports Only

If you are distributing reports in batch mode only, the .ascx and .ascx.cs files required
for Web reports are not needed. To use custom parameters with batch reports, do the
following:

1 Create a blank .txt file with the same name as the as the parameter field name in the
report.

2 Savethefilein the CIMSParameters\CIMSComponents\PlaceHolders\Show folder on the
CIMS Server application server (see Saving Custom Parameters on page 4-18).

For example, if the parameter field name is paramAAADate, you need to create an empty
file named paramAAADate. txt in the Show folder as shown example Figure 4-3.

Note ¢ The Show folder contains default parameter files used by some standard
reports when the reports are run in batch mode only. All of these files are empty
and are used only when running reports in batch.

File Edit W“iew Favorites Tools  Help
Q- O & ) search | [ Foders | [21] -
address |3 C:\Program FilesiCIMSLabYServer|webl CIMSReporting| CIMSPAR AME TERS|CIMSCOMPOMENTS|PlaceHoldersiShow v a Go
Folders X Tame: Size | Type
=[5 server paramAaabate bt OKE  Text Document
& () AdvSpreadsheets =| paramAccountCodeEnd bxt =] OKB  Text Document
& ) Reports1o [Z) paramalidentz.txt OKE  Text Document
) [) Reportsas [Z) paramalident3. bxt OKB  Text Document
® [ ReportsMaRs [2) parameliidenta.txt OKE  Text Document
[ [ ReportsCRA, [%) paramailidents. b OKE  Text Document
# [ RepnrtssoL [%) paramDateEnd. bk . OKE  Text Document
& ) Samples Example flle 2] paramEnd_value.txt Default f[]es OKE  Text Document
= () web [Z) paramperiod.txt OKE  Text Document
) [ aspnet_client [Z]) paramRsteCodesz.bxt OKB  Text Document
5 [ CIMSReparting [Z) paramR ateCodesa. it OKE  Text Document
3 B %) paramRateCodesd.txt OKE  Text Document
5 [ CIMSPARAMETERS [%) paramRateCodeSs.txt OKE  Text Document
= [(5) CIMSCOMPORENTS [2) paramToph.bxt OKE  Text Document
153 Custom [2) paramTrans_ID_Endtxt ] OKE  Text Document
I images
=l I2) PlaceHalders
|21 MaShow
) o
|2 standard
I data
153 MAGES
& ) Crystal9Files
& I2) Crystall0Files
Custom
£ |2 Help
|2 images
I scripts
) Secure
1) temp
& ) viewer
£ amnk
[# I2) Common Files
153 ComPlus Applications
-: I Crystal Decisions 3 @ >

Figure 4-3 « Show Folder Contents

Saving Custom Parameters

If the CIMS Server application server and the Web server are on separate servers, make
sure that you save custom parameter files in the Custom or Show folder (as applicable)
on the application server. The files are not read from the Web server.
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Adding Reports to the CIMS Server Report List

The report list in conjunction with the reports assigned to the user groups (see Defining
User Groups on page 3-33) determines the reports that users can access from the CIMS
Server Web Reporting Web site. You need to add a report to this list before it can appear
on the Web site or be assigned to a user group.

By default, the report list contains CIMS standard reports (either Crystal or SQL Server
Reporting Services reports). If you are using custom reports, you can remove the standard
reports from the list (see To remove a report: on page 4-20). If a standard report is in a
report group, you must first remove the report from the group (see To remove a report from
a report group: on page 4-22).

Note ¢ If you want to use more than one report type, for example, Crystal Reports
and Advanced Spreadsheets, make sure that all reports are in the same report folder
and that the folder is defined in the Configuration dialog box. For more information
about the location of CIMS reports, see page 4-3.

To add a report:

1 In the CIMS Server Administrator main window, click System Administration »
Reporting » Reports.

The Reports List Maintenance dialog box appears as shown in example Figure 4-4.

Note * Reports in the Report List Maintenance dialog box are sorted by ID
number. To sort the reports by name or description, click the appropriate column
header. To reverse the sort order, click the column header again.

=42 Report List Maintenance

Wigw

I # | [Maime | Description | Report Type | Report File .
000000001 Invoice RIMYC CrystalReports  RINWCOOT rol
000000002 Bucdget RBDGT CrystalReports RBGTCOO1 rdl

| e | |

Figure 4-4 « Reports List Maintenance Dialog Box

2 Click Add.
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3 Inthe Add New Report dialog box, enter the name of the report (e.g., Cost Variance),
and then click OK. Maximum of 32 characters.

The Report Maintenance dialog box appears.
4 Enter the report settings as follows:
e Name. Use this box to change the name of the report.
¢ File Name. The name of the report file without the path (maximum of 255
characters). To browse for a report file, click the Browse button E
¢ Template File Name. Consult CIMS Lab before using this option.

e Description. Enter a description of the report. Maximum of 255 characters.
5 Click OK when you are finished.

If you added a SQL Server Reporting Services report, the report is automatically deployed
to the Reporting Services Report Server. If you added a Crystal report and are using
Crystal Reports XI, the report is automatically deployed to Crystal Reports Server.

An example of a configured Report Maintenance dialog box is shown in Figure 4-5.

@15 Report Maintenance |-_|E|g|
Report ID: 3
Iame: |C031 Wariance
File Mame: R aRCOD1 rol
(Exclode the path name)
Template File Narme: | j
Description: |RVARC

OK | Cancel

Figure 4-5  Report Maintenance Dialog Box
To edit the settings for a report:
1 Click the report, and then click Edit.
The Report Maintenance dialog box appears.
2 Follow the steps in To add a report: beginning with Step 4.

To remove a report:

Click the report, and then click Remove. If the report is in a report group or a report cycle,
you must first remove the report from the group or cycle (see Defining Report Groups on
page 4-21 and Creating a Report Cycle on page 4-29).

If your are using Crystal XI for reporting, the report is automatically removed from
Crystal Reports Server.
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Defining Report Groups

Tip * When working with report groups, you can access commands for an item from
the menu bar, or you can access the same commands by right-clicking the item.

Report groups are useful in CIMS Server Web Reporting because they allow you to
categorize related reports in a single group. For example, you might create groups by
report type (e.g., invoice, variance, account) or by data type (e.g., Mainframe, UNIX,
Windows).

There are two types of report groups:
e Start Groups. These are the larger groups that contain other groups.

e Groups. These are the standard report groups that are contained in a Start Group.
Groups contain reports.

There are three default Start Groups: Reports, Graphs, and Spreadsheets. Although you
can add other Start Groups, only the default groups appear on the CIMS Server Web
Reporting Web site. To use Start Groups other than the default groups, you need to create
a customized Web site.

The default Start Groups (Reports, Graphs, and Spreadsheets) are required for CIMS
Server Web Reporting and must be ordered 1, 2, and 3 as shown Figure 4-6. Do not
remove, rename, or reorder these groups.

To add a report group:

1 In the CIMS Server Administrator main window, click System
Administration » Reporting » Report Groups. The Report Group Maintenance
dialog box appears as shown in example Figure 4-6.

=42 Report Group Maintenance

Group View

= % 1 - Reports
+ % Invoices
% Account Reports
% “ariance Reports
% Trend
% Resource Detail
% Cither
% Custom
Graphs
Spreadsheets
% Standard Spreadshests
% Custom Spreadsheets

F-[- -

2-
3-

+ P

Start Group Description: Root

Report List Maintenance

Figure 4-6 - Report Group Maintenance Dialog Box
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2 Do one of the following:

e To add a Start Group, click Group » Add Start Group on the menu bar. In the Add
Start Group dialog box, enter the name of the Start Group, and then click OK.

e Toadd a group to a Start Group, click the Start Group, and then click Group » Add
Group on the menu bar. In the Add Group dialog box, enter the name of the
group, and then click OK.

To add a report to a report group:

1 To add areport to a report group, click the group, and then click Group » Add Report
on the menu bar. Note that you cannot add a report to a Start Group.

The Select Report dialog box appears.
2 Choose the report or reports that you want to add, and then click OK.

To view the reports that you added, double-click the group.

Note * Report groups that do not contain at least one report will not appear on the
Reports page on the CIMS Server Web Reporting Web site.

To remove a report from a report group:

Click the report, and then click Report » Remove Report from Group on the menu bar.

Note ¢ Removing a report deletes the report from the report group, not from the
system.

To remove a report group:

Click the group, and then click Group » Remove Group on the menu bar. If the report
group contains groups and/or reports, you must delete the groups and reports before you
can delete the group.

Other Report Group Options

Once you have created a report group, you can:

m Rename the group or change its description.

B Re-sort the group or report display order.

m Make a group the default group for reports created by CIMS Web users.

To rename a report group or change its description:

1 Click the group, and then click Group » Change Group Name or Change Group
Description on the menu bar.

2 In the Change Group Name/Description dialog, box enter the new name or
description. Note that the description is the same as the group name by default.
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To re-sort the group or report display order:

1 Click the group that contains the groups or reports that you want to re-sort, and then
click Group » Change Group Display Order or Change Report Display Order on
the menu bar.

The Report Group/Report Display Sequence dialog box appears.
2 Click a group/report, and then click the up or down arrow to reposition the item.

3 Click OK when you are finished.

To set the default group for reports created by CIMS Web users:

In CIMS Server Web Reporting, end users can create reports using the standard templates
provided with CIMS Server or custom templates developed by your Crystal Reports
developer. For more information about these reports and descriptions of the standard
templates, refer to the CIMS Server Web Reporting User’s Guide.

To make a group the default group for reports or spreadsheets created by end users, click
the group, and then click Group » Default Report/Spreadsheet Group on the menu bar.
The default group appears bold and is designated by *Reports/Spreadsheet Default in
the lower right corner of the Report Group Maintenance dialog box.

The user-defined reports or spreadsheets appear in the group selected as the default
group on the Reports or Spreadsheets page of the CIMS Server Web Reporting Web site.

The default group for user-defined reports is Custom and the default group for user-
defined spreadsheets is Custom Spreadsheets.
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Changing the Logo in Reports

By default, the CIMS logo appears in reports. If you want to replace this logo with a
custom logo, you need to complete the following steps. The steps differ depending on
whether you are using Crystal or SQL Server Reporting Services reports.

Note ¢ If the custom logo is not the same height as the CIMS logo, report header data
might be lost.

For Crystal reports, you must modify each report file to include the logo that you want.

For Reporting Services, all reports automatically use the report image that is published
to the Reporting Services Report Server.

To change the logo for Crystal reports:

—)

In Crystal Reports, open the report that you want to change.

N

Right-click logo, and then click Delete.

W

On the menu bar, click Insert » Picture.

=

Locate the file for the logo that you want to use and place it in the report.
5 Save the report in the Custom reports folder.

To change the logo for Reporting Services reports:

1 Ifyou installed CIMS Server in the default location, locate the ReportlLogo. jpg file in
C:\Program Files\CIMSLab\Server\Web\Images.

2 Rename the Reportlogo. jpg file CIMSReportlLogo. jpg.

3 Place the file for the logo that you want to use in the Images folder. The file must be
named ReportlLogo. jpg, but it can be in the JPEG or GIF format.

4 In the CIMS Server Administrator main window, click System
Administration » Reporting » Configure Reporting Services with CIMS
Administrator. This publishes the new logo file to the Reporting Services Report
Server where it is used by all CIMS Reporting Services reports.
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Working With Batch Reporting/Published Reports

Note ¢ This section is not applicable for SQL Server Reporting Services reports. The
batch reporting feature will be supported for Reporting Services in a future CIMS
Server release.

Batch reporting enables you to automate the generation of published reports. A
published report is a report that has been saved with the data that was generated at the
time the report was run.

Publishing a report enables users to view a report without having to regenerate it. The
report displays quickly because the data has already been read from the database and
formatted.

Batch reporting also enables you to provide published reports to end users in a way that
best meets the users’ needs, including attaching the report to an e-mail or including a
link to the report in an e-mail. The distribution methods for published reports are
described in detail in Distributing Published Reports on page 4-26.

This section describes how to create and distribute published reports in batch using
CIMS Server Administrator in conjunction with the ReportDistribution.wsf script. If
you installed CIMS Server in the default location, this script is in C: \Program
Files\CIMSLab\Scripts\Batch Reporting.

Creating Published Reports
Published reports can be created in either of the following ways:

m From the CIMS Server Web Reporting Web site. This method requires that users
publish reports from the Web site by clicking Publish after the report is generated.
This method is described in detail in the CIMS Server Web Reporting User’s Guide.

m In batch. CIMS Lab provides the ReportDistribution.wsf script that you can use to
automatically create, publish, and distribute reports. To publish reports using this
script, you need to do the following:

e Create a report cycle in CIMS Server Administrator for the report or reports that
you want to publish. The ReportDistribution.wsf script uses the definitions in the
report cycle to generate and distribute the reports. For more information about
distributing published reports and creating report cycles, see Distributing Published
Reports on page 4-26 and Creating a Report Cycle on page 4-29.

e Setup and run the ReportDistribution.wsf script as described in Running a Report
Cycle on page 4-44.
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To best meet your users’ needs, CIMS Server provides you with the flexibility to distribute
published reports in any of the following ways.

Distribute reports from the CIMS Server Web Reporting Web site. This method
requires that users search for and access published reports from the Web site by
clicking Reports » View Published Reports. This method is described in detail in the
CIMS Server Web Reporting User's Guide.

You can use this distribution method with or without the following e-mail
distribution feature. E-mail distribution notifies a user or users that the report is
available and provides a link to the CIMS Server Web Reporting Web site.

Distribute reports via e-mail. This method enables you to “push” published reports
to users. You can deliver the reports in any of the following ways:

Attach the report to the e-mail. A benefit of this method is that the user receives
the report directly. A disadvantage is that large reports included as attachments can
affect the performance of your e-mail system.

Provide a link to the report in the e-mail subject or body. This method saves
e-mail space and enables the user to easily access the report by clicking the link.
Published reports are stored in subfolders within the Pub1ished folder on the
CIMS Server application server. (See Storing Published Reports Using the Published
Folder Structure on page 4-27.)

Provide a link to the CIMS Server Web Reporting Web site in the e-mail subject
or body. You can use this method to provide a link to the Web site home page or
a link directly to the report on the Web site (if auto logon is enabled for the user
[see Web Settings on page 3-49]). A benefit of this method is that the security set
up for the Web site is used to control user access to published reports (see Security
Requirements for Viewing Reports on page 4-48).

To use the e-mail report distribution feature, you need to create a report cycle in CIMS
Server Administrator as described in Creating a Report Cycle on page 4-29.
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Storing Published Reports Using the Published Folder Structure

The Published folder contains the following subfolders for storing published reports.
(The path to the Published folder is defined on the Reporting tab on the Configuration
dialog box).The subfolder in which a report is stored is specified by the CIMS Web end
users if the report is published from the CIMS Server Web Reporting Web site or is
defined in the report cycle if the report was produced in batch (see Creating a Report Cycle
on page 4-29).

The security and access rights for the published reports differ depending on whether
users are accessing a published report from the Web site or directly from a link (see Folder
Permissions Required for Publishing and Viewing Batch Reports on page 4-48).

m user. This folder contains subfolders for specific users. Each subfolder name reflects
a CIMS user ID. The following is the structure for the user folder. Note that the
structure of the lowest two subfolders within the user folder is the same for the group,
account, and global folders.

e Published\user\userid\periodpublished\reports (contains Crystal reports and
reports and spreadsheets published as PDF files)

e Published\user\userid\periodpublished\spreadsheets (contains Excel
spreadsheets)

e Published\user\userid\periodpublished\CSV (contains reports and spreadsheets
published as CSV files)

For example, user\Joan\200507\reports contains Crystal reports and reports/
spreadsheets in PDF format for the user Joan that were published in July 2005 (if you
are using the default periods in the CIMSCalendar table).

Note ¢ Published reports in the CSV subfolder are not accessible from the CIMS
Server Web Reporting Web site.

m group. This folder contains subfolders for specific user groups. Each subfolder name
reflects a CIMS user group ID. The following is the structure for the group folder:

PubTlished\group\groupid\periodpublished\<reports/spreadsheets/CSV>

For example, group\AP\200507\spreadsheets contains Excel spreadsheets for the
group AP that were published in July 2005 (if you are using the default periods in the
CIMSCalendar table).
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m account. This folder contains subfolders for specific account codes. The following is

the structure for the account folder:
Published\account\accountcode\periodpublished\<reports/spreadsheets/CSV>

For example, account\AABBCCC\200507\CSV contains reports and spreadsheets
published as CSV files for the account code AABBCCC in July 2005 (if you are using the
default periods in the CIMSCalendar table).

You cannot publish reports to the account folder if you are using a report cycle.

global. Reports in this folder are for all users, groups, and accounts. The following is
the structure for the global folder:

Published\global\datepublished\<reports/spreadsheets/CSV>

For example, global\200507\reports contains Crystal reports and reports/
spreadsheets in PDF format that were published in July 2005 (if you are using the
default periods in the CIMSCalendar table).

You cannot publish reports to the global folder if you are using a report cycle.

Deleting Published Reports

B 4-28

To delete published reports, start Windows Explorer and navigate to the Pub1ished
folder. Delete the reports from the applicable subfolder.
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Creating a Report Cycle

The report cycle defines such information as the reports that you want to publish, the
output format for the reports, how you want to distribute the reports (attachment or
link), and the user or user group that you want to distribute the reports to.

To add a report cycle:

1 In the CIMS Server Administrator main window, click System Administration »
Reporting » Report Distribution.

The Report Cycle List Maintenance dialog box appears. This dialog box initially
contains an example report cycle as shown in example Figure 4-7. You can use this
report cycle as a reference or you can edit the cycle to publish and distribute your
reports. If you want to edit this cycle, continue to Step 4.

=% Report Cycle List Maintenance

D # Mame | Report Cycle Description

Sample Beports Cycle

Add Eemene | N Bl

Figure 4-7 - Report Cycle List Maintenance Dialog Box

2 Click Add.

3 In the Add New Report Cycle dialog box, enter the name of the report cycle (e.g.,
Invoice), and then click OK. Maximum of 8 characters.

The Report Cycle Maintenance dialog box appears.

4 Enter the report distribution settings as follows. For an example, see Figure 4-8 on
page 4-42.

e Report Cycle ID. The report cycle ID number is automatically assigned to the
report cycle. Report cycle IDs are assigned in sequential order.
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e Name. Use this box to change the name of the report cycle if needed.

e Description. Enter a description of the report cycle (e.g., Invoice by Account).

Maximum of 255 characters.

Link type. If you want to distribute a report by providing a link directly to the
report, you need to click the type of link that you want to use: UNC or URL. The
Link type box is applicable only if one of the following formats is selected in the
Report format box on the Report Cycle Distribution Request dialog box (see
Step 6 on page 4-32):

e PDF : E-mail with link to report

¢ Excel : E-mail with link to file

e CSV: E-mail with link to file

If any other format is selected, the value in this box is ignored.

If you click UNC, the UNC path for the Published folder must be entered in the
Path to published reports box on the Reporting tab of the Configuration dialog
box (see Reporting Settings on page 3-45). An example of the use of a UNC path is
for in-house users on the same network as the Web server.

If you click URL, a virtual directory must exist for the Pub1ished folder. For more
information, see Creating a Virtual Directory for the Published Folder on page 4-49.
An example of the use of a URL path is to enable users who cannot access the
reports through the network to access reports through the intranet.

CIMS Server URL. If you want to distribute a report by providing a link to the
CIMS Server Web Reporting Web site, type the URL for the site in this box.

This box is applicable only if one of the following formats is selected in the Report
format box in the Report Cycle Distribution Request dialog box (see Step 6 on
page 4-32):

e Crystal : E-mail with link to report (this provides a direct link to the report on
the Web site)

e Crystal : E-mail with link to Web site (this provides a link to the Web site home
page)

e Excel : E-mail with link to Web site (this provides a link to the Web site home
page)

If any other format is selected, the value in this box is ignored.

Reports URL. If you selected URL in the Link type box, type the URL for the virtual
directory for the report.

E-mail from address. Type the fully qualified e-mail address of the sender of the
e-mail.

Note ¢ The “to” address for the recipient of the e-mail is defined by user in the
User Maintenance dialog box. For more information, see To add a user: on
page 3-28.
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e Mail server. The name of the SMTP mail server that will be used to send the e-mail
distribution.

¢ E-mail subject and E-mail body. Use these boxes to type the subject and body of
the e-mail.

It is very important that you include an &WebSite or &Location variable in the
subject or body if you select a report format that includes a link. The &WebSite
variable provides the URL link to the CIMS Server Web Reporting Web site. The
&Location variable provides pre-defined text and a URL link to the CIMS Server
Web Reporting Web site or a URL or UNC link to the published report.

To add these variables and other optional variables, click Add variable and then
click the variable that you want to add (see the following descriptions). The
variables will be automatically populated with the correct information in

the e-mail.

e Link to Reporting Web Site (&WebSite). Provides a URL link for the CIMS
Server Web Reporting Web site. For example, http://roca.

e Link to Location (&Location). Provides text and a UNC or URL link. The link
is provided with the following text depending on whether the link is directly to
the report or to the CIMS Server Web Reporting Web site:

“Report name may be found by using this link:”

Example: Account Budget for Period YTD may be found by using this Tink:
http://Serverl/Published/USER/Joan/200508/Reports/RBGTCO0L . pdf

“Report name has been published at the site:”

Example: Account Budget for Period YTD has been published at the site:
http://Serverl

e User Name (&UserName). The CIMS user name for the user defined for the
report.

e User ID (&UserID). The CIMS user ID for the user defined for the report.
¢ Report Name (&ReportName). The report name.
e Report Cycle Name (&CycleName). The report cycle for the report.

e Date report was published (&Date). The date that the report was published
and the e-mail notification sent.

¢ Report Period (&ReportPeriod). The period in which the report was published
as defined in the CIMSCalendar table.

¢ Requests. This box contains requests for the reports that you want to publish. A
report request defines the settings for the report such as the format that you want
to publish the report in, the parameters for the report, and the report recipient(s).

5 Under the Requests box, click Add.
The Report Cycle Distribution Request dialog box appears.
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6 In the Report Cycle Distribution Request dialog box, enter the settings for the report
that you want to publish as follows. For an example, see Figure 4-8 on page 4-42.

e Report cycle ID. The report cycle ID number is automatically assigned to the
report cycle.

e Request ID. You need to create a separate request for each report that you want to
publish. The request ID number is automatically assigned to the request. Request
IDs are assigned in sequential order.

¢ Report format. Click the format that you want the published report to appear in.
This setting also specifies the distribution method (i.e., link or attachment).

Note ¢ The format that you select in this box should support the report or
spreadsheet that you select in the Report box. For example, if you select a
spreadsheet in the Report box, you might not get the desired results if you
select the Crystal report format in this box.

e PDF : E-mail with report attached. The report is published as a PDF document
and attached to the e-mail. The text “Report name is attached” is placed in the
e-mail body.

Adobe Reader must be installed on the client computer to enable the e-mail
recipient to view the report.

This report format has the following advantages and disadvantage:
Advantages
» The recipient receives the report directly.

* The recipient does not require Windows folder or IIS security privileges to
access the report.

Disadvantage

e Large reports included as attachments can affect the performance of your
e-mail system.
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e PDF : E-mail with link to report. The report is published as a PDF document
and a link to the report is included in the e-mail. The format of the link, UNC
or URL, is determined by the value in the Link type box of the Report Cycle
Maintenance dialog box (see Step 4 on page 4-29).

Adobe Reader must be installed on the client computer to enable the e-mail
recipient to view the report.

This report format has the following advantage and disadvantage:
Advantage

» Enables users to easily access the report without having to attach the report to
the e-mail.

Disadvantage

 If you want to use a URL link for to the report, you must create a virtual
directory for the Published report folder.

¢ Crystal : E-mail with link to report. The report is published as a Crystal report
and a link directly to the report on the CIMS Server Web Reporting Web site is
included in the e-mail. To use this option, the Web site must have Windows
authenticated access enabled and the recipient must be set up to use the auto
logon feature for the CIMS Server Web Reporting Web site (see Web Settings on
page 3-49).

Note that if you are using Crystal Reports XI and you have not purchased the full
Crystal Reports Server license, you cannot publish reports as Crystal Reports
because users cannot view the report from the Web site (this applies to the
following two Crystal Reports formats as well). You need to select another
report format for distributing the report.

This report format has the following advantage and disadvantage:
Advantage

e Provides a link directly to the report on the Web site.
Disadvantage

e The Web site must have Windows authenticated access enabled and the
recipient must be set up to use the auto logon feature for the CIMS Server Web
Reporting Web site.
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e Crystal : E-mail with link to web site. The report is published as a Crystal report

and a link to the home page of the CIMS Server Web Reporting Web site is
included in the e-mail.

This report format has the following advantage and disadvantage:
Advantage

» Enables recipients who are not set up to use the auto logon feature for the
CIMS Server Web Reporting Web site (see Web Settings on page 3-49) to go to
the Web site home page via a link. The recipient can then log on to CIMS
Server Web Reporting and view the published report.

Disadvantage

 Links to the home page for the CIMS Server Web Reporting Web site rather
than directly to the published report on the Web site.

Crystal : No e-mail. The report is published as a Crystal report, but an e-mail is
containing a link to the report is not sent.

Excel : E-mail with file attached. The report is published as an Excel
spreadsheet and attached to the e-mail. The text “Spreadsheet name is attached”
is placed in the e-mail body.

Excel must be installed on the client computer to enable the e-mail recipient to
view the spreadsheet.

This report format has the following advantages and disadvantages:
Advantages
e The recipient receives the spreadsheet directly.

* The recipient does not require Windows folder or IIS security privileges to
access the spreadsheet.

Disadvantages

 Large spreadsheets included as attachments can affect the performance of
your e-mail system.

* The spreadsheet does not appear on the Published Spreadsheets page of the
CIMS Server Web Reporting Web site and cannot be accessed from the Web
site.
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¢ Excel : E-mail with link to file. The report is published as an Excel spreadsheet
and a link to the report is included in the e-mail. The format of the link, UNC
or URL, is determined by the value in the Link type box of the Report Cycle
Maintenance dialog box (see Step 4 on page 4-29).

Excel must be installed on the client computer to enable the e-mail recipient to
view the spreadsheet.

This report format has the following advantage and disadvantage:
Advantage

* Enables users to easily access the spreadsheet without having to attach the
report to the e-mail.

Disadvantage

¢ Ifyou want to use a URL link for to the spreadsheet, you must create a virtual
directory for the Published report folder.

¢ Excel : E-mail with link to web site. The report is published as an Excel
spreadsheet and a link to the home page of CIMS Server Web Reporting Web site
is included in the e-mail.

This report format has the following advantage and disadvantage:
Advantage

e Enables recipients to go to the Web site home page via a link. The recipient
can then log on to CIMS Server Web Reporting and view the published
spreadsheet.

Disadvantage

e Links to the home page for the CIMS Server Web Reporting Web site rather
than directly to the published spreadsheet.

e Excel : No e-mail. The report is published as an Excel spreadsheet, but an e-mail
containing the spreadsheet or a link to the spreadsheet is not sent.

CIMS Server Administrator's Guide 4-35 N



B Report Administration

Working With Batch Reporting/Published Reports

B 4-36

e CSV: E-mail with file attached. The report is published as a comma-separated

values (CSV) file and attached to the e-mail. The text “Report name is attached”
is placed in the e-mail body.

This report format has the following advantages and disadvantages:
Advantages
¢ The recipient receives the CSV file directly.

* The recipient does not require Windows folder or IIS security privileges to
access the CSV file.

Disadvantages

¢ Large CSV files included as attachments can affect the performance of your
e-mail system.

» The CSV file does not appear on the Published Reports or Published
Spreadsheets page of the CIMS Server Web Reporting Web site and cannot be
accessed from the Web site.

CSV : E-mail with link to file. The report is published as a CSV file and a link
to the report is included in the e-mail. The format of the link, UNC or URL, is
determined by the value in the Link type box of the Report Cycle Maintenance
dialog box (see Step 4 on page 4-29).

This report format has the following advantage and disadvantage:
Advantage

e Enables users to easily access the CSV file without having to attach the report
to the e-mail.

Disadvantage

 If you want to use a URL link for to the CSV file, you must create a virtual
directory for the Published report folder.

e Report. Click the report that you want to publish.

e Set default parameters for all users of this report. Click this button to set the
parameters for the report. These parameters will be applied to reports for all users
unless you set override parameters by user or user group (see Set optional
override parameters for this user/user group).

For a description of all report parameters for the standard reports provided with
CIMS Server, see Setting Report Parameters on page 4-37. If you are using custom
reports, your report parameters might differ.
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e User Type—User or User group. This setting determines the user or user group
that you want to send the published report to and where the published report is
stored. If you click User, the report is stored in the Published\user folder in a
subfolder with the same name as the user. For example, Published\user\Joan.

If you click User group, the report is stored in Published\group folder in a
subfolder with the same name as the user group. For example,
Published\group\AP.

Note * Make sure that you have entered an e-mail address for each user that
you want to send the report to as described in To add a user: on page 3-28.

¢ Set optional override parameters for this user/user group. Click this button to
set any parameters that are specific to a user or user group. These parameters will
override the parameters set for all users.

7 Click OK when you are finished and then click OK again to close the Report Cycle
Maintenance dialog box.

The report request appears in the Requests area of the Report Cycle Maintenance dialog
box. A separate e-mail is sent for each report defined in the Requests area.

To edit a report cycle:

1 Click the report cycle, and then click Edit. The Report Cycle Maintenance dialog box
appears.

2 Follow the steps in Creating a Report Cycle on page 4-29 beginning with Step 4.

To remove a report cycle:

Click the report cycle, and then click Remove.

Setting Report Parameters

Note ¢ This section describes the parameters for the standard reports provided by
CIMS Lab. Your reports might use other parameters that are custom for your
organization.

To set the parameters for a report:

1 Click Set Default Parameters for all users of this report in the Report Cycle
Distribution Request dialog box.

The Report Distribution Request Parameters dialog box appears.

2 Type the parameters values that you want to use for the report. Click OK when you
are finished. A description of each of the parameters is provided in Report Parameters
for CIMS Standard Reports on page 4-38.

3 Click OK when you are finished.
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These parameters will be applied to reports for all users unless you set override
parameters by user or user group. To set override parameters for a specific user or user

group:
1 Click User or User Group and then click the user or group that you want to apply the
override parameters to.

2 Click Set Optional Override Parameters for this User/User Group.
The Report Distribution Request Parameters dialog box appears.

3 Type values for only those parameters that you want to override. All other parameters
will remain the same as the parameters for all users.

4 Click OK when you are finished.

Report Parameters for CIMS Standard Reports

The following are the parameters for the standard reports provided with CIMS Server.
The parameters are presented in alphabetical order with the exception of InvoiceLevel,
which is the first parameter for many reports.

Note ¢ Parameters vary by report.

Parameter Description

InvoiceLevel The account code level that you want to view in the report.
For example, the account code AABBBBCCC might
contain the following levels:

(This parameter is
synonymous with
Account Code Level onthe m Level 1, the two-digit company code AA

CIMS Server Web
Reporting Web site.) m Level 2, the 6-digit division code AABBBB
m Level 3, the 9-digit department code AABBBBCCC
In this example, the account code level that you can select
is 1, 2, or 3. The resource use and charge data will reflect
the level that you select.
AccountCodeStart and These parameters work in conjunction with the
AccountCodeEnd InvoiceLevel parameter to specify the account codes for

that level that appear in the report.

For example, if the InvoiceLevel parameter is set to 1 (level
1), and level one of the account code is the 2-digit
company code, only 2-digit account codes in the range
specified by these parameters appear in the report.

If you want all account codes for the account code level to
appear in the report, you can leave these parameters blank
or set the AccountCodeStart parameter to the lowest
account code (for example, AA) and AccountCodeEnd to
the highest account code (for example, ZZ).

Table 4-2 - Standard Report Parameters
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Parameter Description

AuditType The type of changes that you want to view in CIMSClient,
CIMSRate, and CIMSTransaction table audit reports.

Valid values are:

m Aorblank. View all table changes.
m . View table additions.

m U. View table updates.

m D. View table deletions.

DateStart and DateEnd The start and end dates for the data that you want to
appear in the report. You can use a CIMS date keyword or
a date value for either the start or end date. The dates for
the keywords are calculated using the date the report is
published.

CIMS date keywords:

RNDATE  If used for either the start or end date, the date
is the current day.

CURDAY  Ifused for the start date, the date is the previous
day. If used for the end date, the day is the
current day.

CURWEK  Tfused for the start date, the date is the first day
of the current week (Sun-Sat). If used for the
end date, the date is the last day of the current
week.

CURMON  If used for the start date, the date is the first day
of the current month. If used for the end date,
the date is the last day of the current month.

PREDAY If used for either the start or end date, the date
is the previous day.

PREWEK  Ifused for the start date, the date is the first day
of the previous week (Sun-Sat). If used for the
end date, the date is the last day of the previous
week.

PREMON  Ifused for the start date, the date is the first day
of the previous month. If used for the end date,
the date is the last day of the previous month.

Table 4-2 - Standard Report Parameters (Continued)
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Parameter Description

DateStart and DateEnd CURRENT  If used for the start date, the date is the first day

(continued) of the current period as defined in the
CIMSCalendar table. If used for the end date,
the date is the last day of the current period.

PREVIOUS Ifused for the start date, the date is the first day
of the previous period as defined in the
CIMSCalendar table. If used for the end date,
the date is the last day of the previous period.

Date value:
The date must be in month/day/year format as follows:

m month and day with or without a leading 0
m 2 or 4-digit year

For example, 9/16/2005, 09/16/2005, 9/16/05, or
09/16/05.

Graph This parameter specifies whether a graph appears on the
first page of the report. Valid values are:

®m Y (a graph appears)

m N or blank (a graph does not appear)

Identifier or Allldent The name of the identifier that you want to retrieve data
for.
InvoiceNumber Some invoice reports contain separate invoices for the

account codes selected. If you leave this parameter blank,
the invoice numbering begins with the invoice number
defined in the CIMSConfigOptions table.

If you provide an invoice number for this parameter,
invoice numbering begins with that number.

Month The month for the data that you want to appear in the
report. The format is numeric, 1-12.

Period The period (1-13) for the data that you want to appear in
the report. Periods are defined in the CIMSCalendar table
(see Setting Up a Calendar on page 3-26).

Prorate The amount that you want to prorate across accounts in
proration reports.

RateCode The rate code that you want to retrieve data for.

RateGroup, The rate group that you want to retrieve data for. This can
RateGroup4DetRpts, or be the rate group title, description, or index number.
RateGroupwithlIdentifiers

Table 4-2 « Standard Report Parameters (Continued)
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Parameter Description

Start_Value and This parameter provides data by the selected identifier

End_Value value range. For example, if you want data for the
following three identifier values: Server1, Server2, and
Server3, type Serverl as the start and Server3 as the end.

Trans_ID_Start and This parameter provides data by the selected CICS

Trans_ID_Start End transaction ID range. For example, if you want data for the
following three transaction IDs: CESF, DEGV, and TINQ,
type CESF as the start and TINQ as the end.

TopN This parameter specifies the number of account codes that
appear in a report or the drill down for a report. For
example, if you type 1, only the account code that used the
most resources or incurred the most charges appears. If
you type 2, the highest and second highest account codes
appear.

TransactionType The transaction type that you want to retrieve data for.
Valid values are:

m A or blank. All transactions.

m M Miscellaneous transactions.
B R. Recurring transactions.

m C. Credit transactions.

For more information about transactions, refer to the
CIMS Server Web Reporting User’s Guide.

Year The two or four-digit year for the data that you want to
appear in the report.

ZeroCostOption The Zero Cost Invoice report may be processed in two
ways:

m Factor total. This factors the invoice total by the zero
costamount. To factor by total, type A for this
parameter.

m Factor rates. This factors each resource rate by the zero
cost amount. To factor by rate, type B or leave the
parameter blank.

For more information about zero cost, see page 3-11.

ZeroValue The zero cost amount. You can type this amount with or
without the decimal point. For example, 100000 or
100000.00.

Table 4-2 « Standard Report Parameters (Continued)
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Creating a Report Cycle Example
Figure 4-8 shows configured report cycle dialog boxes for the example report cycle

Budget.
a4 Report Cycle Maintenance BEE]  Reports generated using this report cycle are
distributed via a URL link to the virtual directory
Repatopcke D 2 Published (see Creating a Virtual Directory for the
Name [rweice Published Folderon page 4-49).
peseiptor fimoice by AccountLeve ————The variables &ReportName in the subject and
Link typs URL hd

&Location in the body are automatically updated with
the report name and a link to the report as shown in

CIMS Sesver URL: |

Reports UAL: [http: £/ erver! APublished A

i fom ddoss.  [meseermze cam Figure 4-9 on page 4-43.
e [mail.spzco.com

E-mail subject |&Fiepanttame for September 2005 Add variable.

E-mail body: &Location Add variable...

IF you haws any questions about this 1epot, pleass contact
Chiistine Sanchez [csanchez@xyzco.com).

The report Invoice by Account Level is published as a
PDF file and distributed via a URL link in the e-mail.

The e-mail will be sent to the CIMS user Joan. The user’s

Freqests Request 1D # | User or Group [ Report ID e-mail address is defined in the User Maintenance
dialog box (see page 3-29).

=+ Report Cycle Distribution Request rL”E‘E'
Add | |
Report cycle 1D: 2 Inwoice
I Pequest ID: 1
| I:l o] Gl [PDF - il with ik o repot =]
L [ Report Parameters |
1
Repoit 1. invel07.1pt - Invoice by dccount Level ~|
L - —_ -
Set default parameters for all users of this report
i &J
[ User Type | I
i
" User group | I J
St lfonal ovepide parametes or this et ‘
I
eport Distribution Request Parameters, "_ H'EI |&‘ I
-
Set default parameters for all users of report rinve007.rpt I
Report cycle 1D 2 Invoice
Fiequest ID! 0 I
Report ID: T rinve007.pt - Invoice by Account Level I
Parameter Mame Parameter Value I

InwaiceLevel 1
Inwoicahumber 1 -1

_— — —_— —_— — = d

preman
premon

Only first level account codes between AA and CC
| appear in the report. The data presented for the
report is for resources used during the previous
month. Periods are defined in the CIMSCalendar
table.

Figure 4-8 « Report Cycle Settings Example
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The e-mail generated from the settings in the report cycle appears as shown in Figure 4-9.
The e-mail includes a URL link to the report.

B Invoice by Account Level for September 2005 - Message (Plain Text) CE&X
P Fls Edt View Insert Format Tools  Actions  Help

iReply | CiReply ol | EpForamd | o || ¥ S| X | & -+ -8 @

From:  cims.serverBxyzco.com Sent: Mon 10/3/2005 12:25 PM
To: Joan Tatson

Ce:

Subject: Invaice by Account Level For September 2005

Invoice by Ahecount Level may be found by using this link:
http://localhost/USER/ Joan/ 200510/ Repores/ rinve007. pdf

If you have any questions about this report, please contact Christine Sanchez (csanchezBxyzeo.com) .

Figure 4-9 « E-mail Report Distribution Example
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Running a Report Cycle

Once you have created a report cycle, you need to run the ReportDistribution.wsf script
to create, publish, and distribute the reports defined in the cycle. If you installed CIMS
Server in the default location, this scriptisin C: \Program Files\CIMSLab\Scripts\Batch
Reporting.

Defining the Web Server (If Applicable)

Note ¢ This section is not applicable if you are using Crystal Reports 8.5 or XI.

Crystal Reports 9 and 10 use the Crystal Report Application Server (RAS) interface, which
is installed on the Web server. If you are using Crystal Reports 9 or 10 and are not running
the ReportDistribution.wsf script on the Web server, you need to create a configuration
option in CIMS Server Administrator to define the name of the Web server that contains
the RAS interface. To set this option:

1 In the CIMS Server Administrator main window, click System
Administration » Configuration Information.

2 On the Option List tab, click Add.

3 Inthe Add New Configuration Option dialog box, type RASServer and click OK. The
Configuration Option Maintenance dialog box appears.

4 Enter the following information as shown in example figure Figure 4-10:
e Description. An optional description of this option. Maximum of 80 characters.
¢ Value. The name of the Web server.

e Data Type. String.

=42 Configuration Option Maintenance

RASServer

Dezcription: |Web SErver name

Wl |Server1

Data Type: |String j

OK | Cancel |

Figure 4-10 + Configuration Option Maintenance Dialog Box
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Running the ReportDistribution.wsf Script

To run the ReportDistribution.wsf script, you should use the CIMS Job Runner console
application and an XML job file as used for the data collection process for CIMS Server.
The CIMS Job Runner application and its related architecture are described in detail
CIMS Data Collectors for Microsoft Windows Installation and User Guide. This architecture
provides the following benefits:

B You can run the ReportDistribution.wsf script automatically on a scheduled basis
(daily, monthly, etc.) using Windows Task Scheduler.

B You can receive a log file via e-mail that provides the results of the report generation
and distribution process. If a warning or failure occurs during processing, the file
indicates at which point the warning/failure occurred. The log file can be sent to
multiple recipients.

To run the ReportDistribution.wsf script via CIMS Job Runner, you need to create a job
file for the script and then schedule CIMS Job Runner to run the job as shown in the
following sections.

Create a Job File for the ReportDistribution.wsf Script

In the JobFiles folder, create an XML job file for the script using the structure shown in
the following example file. (If you installed CIMS Server in the default location, the
JobFiles folder is in C:\Program Files\CIMSLab.) For a complete description of the
components of a job file, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

<?xml version="1.0" encoding="utf-8"7>
<Jobs xmIns="http://www.cimslab.com/CIMSJobs.xsd">
<Job id="Monthly Report Distribution"”
description="Monthly Report Distribution"
processPriorityClass="Low"
smtpSendJoblog="true"
smtpServer="mail.cimslab.com"
smtpFrom="CIMSProcessResults@cimslab.com"
smtpTo="CIMSProcessResults@cimslab.com"
stopOnProcessFailure="false"
jobTogWriteToXMLFiTe="false"
JjobTogShowStepOutput="true"
JjoblogShowStepParameters="true"
active="true">
<Process id="Monthly Report Distribution"
description="Monthly Report Distribution"
buildProcessFolder="false"
JjobTogShowStepOutput="true"
JjobTogShowStepParameters="true"
active="true">
<{Steps>
<{Step id="Report Distribution"
description="Report Distribution"
type="Process"
programName="Batch Reporting\ReportDistribution.wsf"
programlype="wsf"
active="true">
<Parameters>
<{Parameter Cycle="Budget"/>
</Parameters>
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</Step>
</Steps>
</Process>
</Job>
</Jobs>

In the preceding job file example, only the required parameter Cycle is provided for the
ReportDistribution.wsf script. Table 4-3 describes the required and optional
parameters for the script.

Parameter Description/Values

Cycle (required) The name of the report cycle that you want to run.

DataSourcelD (optional) The CIMS Data Source ID for the database that you want
to use for reporting.

If this parameter is not provided, the data source that is
set as the Web/collector default in the CIMS Data Source
Maintenance dialog box is used (see page 5-7).

To use a CIMS Data Source other than the default, set
this parameter to the appropriate data source ID.

Email (optional) This parameter is helpful in testing or other situations in
which you want to publish reports but do not want to
distribute the reports via e-mail or you want to send an
e-mail for reports that have already been published.

Valid values are:

B Trial. An e-mail message containing the reports is a
not sent, but the reports are published.

m Only. An e-mail is message is sent, but reports are not
published. The e-mail contains a link to the
previously published report.

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not provided, this information does not appear in the
log file.

Table 4-3 « ReportDistribution Script Parameters
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Schedule CIMS Job Runner to Run the Job File

Once you have created a job file, you can schedule CIMS Job Runner to run the file using
Windows Task Scheduler as follows:

1

2

10

11

In Windows Control Panel, double-click Scheduled Tasks.
Double-click Add Scheduled Task.
The Scheduled Task Wizard appears. Click Next.

Click Browse to find the program CIMSJobRunner.exe, and then double click the
program. If you installed CIMS Server in the default location, this program is in
C:\Program Files\CIMSLab\Process Engine.

Type a name for the task or accept the default and click the schedule for the task. Click
Next.

Select the time and day to start the task, and then click Next.

Type the password for the user account under which you want the scheduled task to
run. The password cannot be blank. Click Next.

Note ¢ Make sure that the user account has a security permission of Full Contro]l
for the folder.

Select the Open advanced properties for this task when I click Finish check box,
and then click Finish.

In the Task tab, type following in the Run box where jobfi7lename.xml is the name of
the job file that you want to run:

"C:\Program Files\CIMSLab\Process Engine\CIMSJobRunner.exe" jobfilename.xm]

Click OK.

In the Set Account Information dialog box, type the password for the user account
again, and then click OK.

The task appears in the Scheduled Task list. To execute CIMSJobRunner . exe immediately,
right-click the task, and then click Run. For more information about Task Scheduler,
refer to the Microsoft documentation.
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Folder Permissions Required for Publishing and Viewing Batch Reports

The following sections describe the folder permissions required for the person who is
publishing reports in batch mode and for the users accessing reports.

Permissions for Publishing Reports

To publish a report to a folder, the Windows account of the person who is
publishing the report must have a security permission of Full Control for the folder.

If the folder is shared and is on a server other than the server where you are running the
ReportDistribution.wsf script, the Windows account must also have a share permission
of Full Control. If you are using Windows 2000, the default is to assign Full Contro]
to the Everyone group. However, if you are using Windows XP with Service Pack 2 or
Windows 2003, the default is to assign only the Read permission to the Everyone group.

Security Requirements for Viewing Reports

The security for accessing published reports is dependent on whether a user is viewing
the report from the CIMS Server Web Reporting Web site or directly from a folder via a
link.

Web Site Security

If a user is accessing published reports from the Web site, the CIMS user ID that the user
logs on with determines which reports the user can view. For example, if the user Joan of
the group AP logs on to the Web site, the user can view reports in the
Published\user\Joan, the Published\group\AP folder, and the Published\global folder.
The user can also view reports in any Pub1ished\group\account\accountcodefolder if the
account code for which the folder is named is assigned to the AP group.

Folder Security

If a user is accessing a published report directly from a folder via a link, the permissions
set for the folder determines whether the user can view the report.

If the link is a UNC path, the Windows account must have a minimum security and share
permission of Read for the folder.

If the link is a URL path to a virtual directory with Windows authenticated access
enabled, the user's Windows account is used to determine whether the user can view a
report in a folder. The user's Windows account must have a minimum security
permission of Read for the folder.

If the link is a URL path to a virtual directory with Anonymous access enabled, the
Windows account IUSR_computername is used for all users. To enable users to access
reports using this account, the account must have a minimum security permission of
Read for all applicable folders.
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Creating a Virtual Directory for the Published Folder

Important! ¢ This section is applicable only if you are providing a URL link directly
to a published report. It is not applicable of you are providing a link to the CIMS
Server Web Reporting Web site.

If you are providing a URL link directly to a published report, you need to create a virtual
directory for the Published folder. CIMS Lab recommends that you create the virtual
directory under the CIMS Server Web Reporting Web site (usually Default Web Site) as
follows:

1 In Windows Control Panel, double-click Administrative Tools » Computer
Management.

2 Expand Services and Applications and navigate to Internet Information
Services » Default Web Site.

3 Right-click Default Web Site, and then click New » Virtual Directory.
The Virtual Directory Creation Wizard appears. Complete the wizard as follows:
a Click Next at the welcome screen.
b Type an alias for the virtual directory, and then click Next.
¢ Enter the path for the Published folder, and then click Next.

d When prompted for access permissions, CIMS Lab recommends that you click
only the Read access permission. You can optionally also click the Browse
permission if you want users to be able to browse the entire directory (i.e., the
entire contents of the Published folder) from a browser.

e Click Next and then click Finish to create the virtual directory.
The virtual directory appears below Default Web Site.

4 Right-click the virtual directory, and then click the Directory Security tab in the
properties dialog box.

5 In the Anonymous access and authentication control area click Edit. The
Authentication Methods dialog box appears

6 Click Anonymous access or Integrated Windows access (see Folder Security on
page 4-48).

7 Click OK until the properties dialog box closes.
8 Restart IIS.

For additional assistance, consult your IIS administrator.
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Drilling Down in Published Reports

A key feature of CIMS Server Web Reporting is the ability to drill down on items in a
report to view more detailed information.

Depending on the report, you can drill down on items in reports published as a Crystal
report or as a PDF document. Drill down is not available for CSV files for spreadsheets
regardless of the format in which the spreadsheet is published.

If a report is published as a PDF, it is not accessible via the CIMS Server Web Reporting
Web site and does not have all of the drill down options that are available from the Web
site.

However, if the cursor icon becomes a hand {b when the user points to an item in a PDF
report, the user can drill down on that item. In this case, the applicable page on the CIMS
Server Web Reporting Web site is opened to allow drill down.

For more information about drilling down in reports, including drill down options by
report, refer to the CIMS Server Web Reporting User’s Guide.
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This chapter describes how to use CIMS Server Administrator to create and administer
CIMS Server databases.
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Creating a Database

Note ¢ To create an Oracle or DB2 database, consult your DBA. For more
information about the requirements for using an Oracle or DB2 database with CIMS
Server, refer to the CIMS Server for UNIX Installation and User Guide or CIMS Server
for DB2 Database Setup Guide. Continue to Creating a CIMS Data Source and Initializing
the Database on page 5-4.

You might have already created a database using the steps in Getting Started on
page 2-27. However, you can use more than one database with CIMS Server. For
example, you might have a production database and a development database. The
following sections provide steps for creating additional databases in Microsoft SQL
Server or MSDE. If you require further assistance, consult your SQL Server DBA.

Creating a Database in Microsoft SQL Server

Note * The steps in this section reflect creating a database in SQL Server 2000. If you
are using SQL Server 2005, refer to the Microsoft documentation if needed.

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » computername » Databases.

3 Right-click the Databases folder, and then click New Database.

4 In the Database Properties dialog box, enter the configuration information for the
new database as follows:

¢ On the General tab do the following:

¢ In the Name box, type a name for the database. The name CIMSServer is used in
this guide, but you can use any name.

¢ In the Collation name box, click SQL_Latinl_General_CP1_CI_AS. Make sure
that you select only this database collation type and not a type that looks
similar. CIMS Server currently does not support other collation types.

e Unless you need to change the default settings for the database, you do not need
to reset values in the Data File or Transaction Log tabs.

5 Click OK when you are finished.

Creating User Logins for the SQL Server Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. After you create the database,
you need to create database logins for these users as described in To create a user login: on
page 2-31.
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Creating a Database in MSDE 2000

To create an MSDE database, use either the OSQL or ISQL command-line interface as
follows. Press <Enter> after each command.

1 At the command prompt, log on to the database server. For example:
osql -S servera-test -E

Where -S servera-test indicates the server name and -E indicates use a trusted
connection. Note that there are other switches that you may have to use depending
on your environment. For example, you may have to specify the login ID (-U) and
password ( -P) switches. To view the OSQL switches, type osql /? at the command
prompt.

2 At the 1> prompt, type:

create database database name

Where database name is the name that you want to give the database.
3 At the 2> prompt, type:

go

The following messages appear:

The CREATE DATABASE process is allocating 0.63 MB on disk ‘database name .
The CREATE DATABASE process is allocating 0.49 MB on disk 'database name_log .

4 Atthe 1> prompt, type:
quit

The database is created in C: \Program Files\Microsoft SQL Server\MSSQL\Data (if you
installed CIMS Server, including MSDE, in the default location). You should include the
Data folder in your backup schedule.

Creating User Logins for the MSDE Database

There are two types of CIMS Server users: the CIMS Server administrator or
administrators and CIMS Server Web Reporting end users. CIMS Lab recommends that
you use the default SQL Server user login sa with a password of sa for both CIMS Server
administrators and end users.

If you want to use a user login or logins other than sa, you can use the OSQL or ISQL
command-line interface or a third-party product for maintaining the MSDE database.
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Creating a CIMS Data Source and Initializing the Database

Once you have created a database, you need to follow the steps in the Set Up CIMS Server
section beginning on page 2-33, including creating a CIMS Data Source for the database
and initializing the database.

WARNING - Before you initialize the database, make sure that you have selected the
correct CIMS Data Source for the database in the Select CIMS Data Source List at the
bottom of CIMS Server Administrator main window. Initializing overwrites any existing
data in a database.
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Backing Up and Maintaining Databases

It is extremely important that you back up your CIMS Server database(s) so that you can
recover your data in case of media failure or natural disaster. CIMS Lab recommends that
you back up your database(s) weekly and that you back up to a different server at another
site.

If you are using an Oracle or DB2 database, consult your DBA for assistance in backing
up and maintaining the database.

If you are using a SQL Server database, CIMS Lab recommends that you use the Database
Maintenance Plan feature included with SQL Server to schedule and perform backup up
and maintenance tasks for databases. To use this feature:

1 In Windows, click Start » Programs » Microsoft SQL Server » Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server » SQL
Server Group » computername » Management » Database Maintenance Plans.

3 Right-click Database Maintenance Plans, and then click New Maintenance Plan.
4 Follow the steps provided in the Database Maintenance Plan Wizard.

If you are using a SQL Server or MSDE database, you can also use the script
SampleSQLMaintenance.bat to back up and maintain the database. For more information
about this script, see SampleSQLMaintenance.bat Script on page C-26.

Setting the Database Recovery Model

Note  This section is not applicable if you are using an Oracle or DB2 database. For
information regarding database recovery, consult your DBA.

CIMS Lab recommends that you change the SQL Server recovery model from Full, the
default, to Simple.

Full recovery allows the database to be recovered to the point of failure. Simple recovery
allows the database to be recovered to the most recent backup. Because any lost data can
be recovered and reloaded from the CIMS Server Resource (CSR) or CIMS Server

Resource Plus (CSR+) files, the benefit offered by the Full recovery is not as beneficial as
the smaller SQL Server log file size and disk space savings provided by Simple recovery.

To set the database recovery model.:

1 In Enterprise Manager, navigate to the database that you want.
2 Right-click the database, and then click Properties.

3 On the Options tab, click Simple in the Recovery Model list.
4 Click OK.
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Managing CIMS Data Sources

CIMS Server Administrator, the CIMS Server Web Reporting Web site, CIMS batch
reporting, and CIMS Data Collectors all require access to the databases that you create
for CIMS Server. To enable these components to use a database, you need to do the
following:

m Create an ODBC Data Source that points to the database.

m Create a CIMS Data Source that points to the ODBC Data Source. The CIMS Server
components use the CIMS Data Source to identify and access the correct ODBC Data
Source.

The steps required to create the ODBC and CIMS Data Source depend on the database
that you are using with CIMS Server. The steps for each database type are provided in
Configure the CIMS Data Source for the Database on page 2-33.

Once you have created the ODBC and CIMS Data Source, you can maintain the
configuration via the CIMS Data Source Maintenance dialog box. To open this dialog
box, click System Administration » CIMS Data Source Maintenance in the CIMS Server
Administrator main window.

To add a CIMS Data Source:
1 Click Add.

2 In the Add CIMS Data Source dialog box, type an ID for the CIMS Data Source, and
then click OK.

3 Follow the steps that are applicable to your database as described in Configure the
CIMS Data Source for the Database on page 2-33.

To edit a CIMS Data Source:
1 Click the CIMS Data Source, and then click Edit.
The Configure CIMS Data Source dialog box appears.

2 Edit the CIMS Data Source as applicable for your database as described in Configure
the CIMS Data Source for the Database on page 2-33.

To rename the CIMS Data Source:
1 Click the CIMS Data Source, and then click Edit » Rename CIMS Data Source.

2 In the Rename CIMS Data Source dialog box, type the new ID for the CIMS Data
Source and then click OK.
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To remove a CIMS Data Source:

Important! < Before you remove a CIMS Data Source, make sure that the data source
is not used by CIMS Server Web Reporting or any other CIMS Web application, CIMS
batch reporting, or CIMS Data Collectors.

1 Click the CIMS Data Source, and then click Remove.

2 Click Yes to confirm that you want to remove the CIMS Data Source.

Setting a CIMS Data Source as the Web Site/CIMS Data Collectors Default

If there are multiple entries in the CIMS Data Source List Maintenance dialog box, you
can set any of the entries as the default data source. The default data source setting is used
as follows:

m For Web reporting. CIMS Server Web Reporting uses the default CIMS Data Source
as described in Using Multiple Databases for CIMS Server Web Reporting on page 5-9.

m For batch reporting. The default CIMS Data Source is used for batch reporting unless
another data source is passed as a parameter to the ReportDistribution.wsf script.
See Running the ReportDistribution.wsf Script on page 4-45.

m For CIMS Data Collectors. CIMS Data Collectors load data to the database specified
by the default CIMS Data Source unless another data source is specified in the job file.
For more information, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

Important! ¢ If you are using a CIMS Data Collector that collects data from a
database, you need to create a CIMS Data Source for that database as described in
the CIMS Data Collectors for Microsoft Windows Installation and User Guide. Make
sure that you do not select a non-CIMS Server database as the default.

Until you specifically set one of the CIMS Data Sources as the default, the data source
selected in the Select CIMS Data Source list at the bottom of the CIMS Server
Administrator main window is set as the default.

Notes ¢ The default setting is not applicable when you are using CIMS Server
Administrator to access a database. CIMS Server Administrator points the CIMS Data
Source that is selected in the Select CIMS Data Source list regardless of whether the
data source is set as the Web/collector default.

You should never select a CIMS Data Source for a non-CIMS Server database in the
Select CIMS Data Source list. If you accidently select a CIMS Data Source for a SQL
Server or MSDE database that you are collecting data from and that data source
points to the master database, you will be asked whether you want to create another
database. Click No.
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To set a CIMS Data Source as the default:

m Click the CIMS Data Source, and then click Set Web/Collector Default. Yes appears
in the Default for Web/Collectors? column for the data source entry as shown in

example Figure 5-1.

ans CIMS Data Source Maintenance
Edit  View

Machine: | (LOCAL) j

- B

Parameters | Owr|

" CIMS Data Source |0 | QDBC Data Source Mame | Database Type | Default for WebiCollectors? | User ID
I Cracle CIhAS A

|

cmin

Cracle YES CIMSLser

cims

>

Add | Remave | Ediit | Set WehiCollector Defautt |

Close |

Figure 5-1 « Data Source List Maintenance Dialog Box—Set Web/Collector Default
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Using Multiple Databases for
CIMS Server Web Reporting

There are two scenarios for using multiple databases for Web reporting:

m One Web server with one virtual directory. This scenario allows you to point your
Web site to the default database set in CIMS Data Source Maintenance dialog box.
You can change the default database as needed and then update CIMS Server Web
Reporting to connect that database.

B One Web server with multiple virtual directories. This scenario allows you to access
multiple databases without changing the settings in CIMS Server Administrator. You
can access multiple databases during a CIMS Server Web Reporting session by
creating individual virtual directories for each database other than the default
database.

Both scenarios can be used for development, testing, and upgrade purposes. However,
the second scenario is more commonly used.

Note ¢ If you are using multiple database applications (e.g., SQL Server and Oracle),
you need to restart IIS when you switch between database types.

To use one Web server and one virtual directory:

1 In the CIMS Server Administrator main window, click System Administration »
CIMS Data Source Maintenance.

The CIMS Data Source Maintenance dialog box appears.

2 Click the CIMS Data Source ID for the database that you want to use as the default,
and then click Set Web/Collector Default.

3 Click Upgrade Configuration on the Edit Configuration page of CIMS Server Web
Reporting or restart IIS. The correct data source should appear in the ODBC DSN field
on the Edit Configuration page.

4 Repeat this procedure each time you want to use a different database.

To use one Web server and multiple virtual directories:

A typical configuration for multiple virtual directories is one in which the default
directory is pointing to the production database and another directory is created to point
to a development database. Using this scenario as an example:

1 In CIMS Server Administrator, set the production database as the default CIMS Data
Source (see Step 1 and Step 2 in To use one Web server and one virtual directory:).

2 In Windows, copy the CIMS Web folder and its contents to create a Web site that will
point to the development database. If you installed CIMS Server in the default
location, the Web folder is in C:\Program Files\CIMSLab\Server.
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3 In the new folder, do the following:

e Open the WebReportingDataSource.asp file and enter the CIMS Data Source ID for
the development database as follows:

Application("WebSiteUID") = "UID" (where UID is the CIMS Data Source ID for
the development database [see Managing CIMS Data Sources on page 5-6]).

e Expand the CIMSReporting subfolder. Right click the data subfolder and assign
Read, Write, and Modify permissions for the following user:

e computername\ASPNET (Windows 2000 or XP)
Or
e NT AUTHORITY\NETWORK SERVICE (Windows 2003)

4 In IIS Manager, create a virtual directory that points to the development Web site
folder. For assistance, consult your IIS administrator.

5 Expand the new virtual directory and do the following:
a Right-click the CIMSReporting folder, and then click Properties.
b Click the Create button next to the Application name box.
¢ Click OK when you are finished.

6 To access the database that you want, enter the address that points to the virtual
directory for that database in the Address bar of the browser. For example, http://
Serverl/development.

Important! ¢ The files and subfolders in the Web folder might change from one
CIMS Server release to the next. If you upgrade to a new release of CIMS Server, you
need to delete all Web site folders that you have created and repeat Step 2 and Step 3.
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Managing Database Tables

CIMS Server Administrator includes many powerful tools for managing database tables
used with the CIMS Server system. You can easily create, drop, load, export, and view
database tables.

Note - All database objects, including tables, are XML files that can be customized
for your site. For more information about tables and other database objects, see
Managing Database Objects on page 5-15.

About Exporting, Loading, Dropping, and Creating Tables

The following is a description of the drop, create, export, and load functions used for
database tables:

m Exporting a table from the database creates a comma-delimited text file with the same
name as the table, but does not remove the table or its data. Exporting a table is useful
as a means of backup—the file can be reloaded into the database.

B Loading a table into the database first deletes all data currently in the table and then
loads the table from the file in the directory that you specify. You can load files that
were previously exported from the database or you can load files from another source
such as a mainframe file.

The file must have the same name as the table (e.g., CIMSRate. txt for the CIMSRate
table) and must contain the following:

e The table column heads in the first record of the file.

¢ All required fields for the table provided in comma-delimited format. To
determine whether a field is required, view the table properties in SQL Server or
Oracle Enterprise Manager. Fields that do not have the Nulls check box selected
must be included in file.

For an example of the required format for a file, you can export the table to a file.
For a description of the fields in the file, see the applicable table description in
Appendix A, Database Tables.

WARNING - Extreme caution should be used when loading a table. Deleting or
overwriting data can cause unexpected results. Be sure a backup exists before
performing this procedure.

m Dropping a table removes the table and its data from the database. You should consult
CIMS Lab before you drop tables.

m Creating a table creates the table with no data in the database after the table is
dropped.
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Loading and Exporting Tables

To load or export a table:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Table Manager.

The Database Table dialog box appears as shown in Figure 5-2.

=44 Database Table Manager

Tools  Wiew

[ Select Takbles |

Tahle Exists in Databaze | Owner A

Yes dha Create selected tables
D Audlit - Client Contact Yes dbo

[ At - Cliert Contact Number Yes dho Drop selected tables
O it - Rate Yes dho
D Audit - Transaction Yes dbo

O calendar Ves dbo Load selected tables
EE::;“ Budget ::z 3:2 Export selected tables

O cliert Contact Yes dho
O client Contact Mumber Yes dho
D Configuration - General Yes dbo
D Configuration - Account Levels Yes dbo
M1 cPU Narmalization Yes dbo bt

Select all tables

Figure 5-2 « Database Table Dialog Box

2 Toload atable, select it in the list of tables. To select all table check boxes, click Select
all tables. Note that the ability to select all tables is dependent on the privileges
assigned by your DBA.

3 Click Load selected tables or Export selected tables. A dialog box appears,
prompting you to select the location that you want to load tables from or export
tables to. Select the correct folder, and then click OK.
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Loading and Exporting Client and Rate Tables

The most commonly exported and loaded tables are the CIMSClient and CIMSRate
tables and their related tables. You can export and load these tables from the Database
Table Manager or you can use the Chargeback Tables dialog box. This dialog box
includes only client and rate-related tables.

Note ¢ You can also use the Table.wsf script to load the CIMSClient and CIMSRate
tables in batch. For more information about this script, see Table.wsf Script on
page C-29.

To load or export a client or rate table:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Table Manager.

The Chargeback Tables dialog box appears.

2 Select the tables that you want to export or load as shown in example Figure 5-3.
(Note that if you select Client or Rate, all related tables are selected by default. You
can clear those tables that you do not want.)

@42 Chargeback Tables |:|[E| g|

Wigw

[ Select Takbles |

v Clierit W Rate:

¥ Cliert Budget ¥ Rate Group
[v Client Contact [v Rate To Rate Group
[v Client Contact Mumber Iv Rate Shift

Export Selected Tables Load Selected Tables | Close |

Figure 5-3 « Chargeback Tables Dialog Box

3 Click Export Selected Tables or Load Selected Tables. A dialog box appears,
prompting you to select the location that you want to load tables from or export
tables to. Select the correct folder, and then click OK.

Note * Because referential integrity rules are used in CIMS tables, some tables must
be loaded in combination with other tables.
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Creating and Dropping Tables

WARNING - You should consult CIMS Lab before you drop tables. Dropping a table
removes the table and its data from the database.

To create or drop a table:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Table Manager.

The Database Table Manager dialog box appears.

2 Select the table(s) you want to create or drop. To select all tables, click Select all
tables.

3 Click Create selected tables or Drop selected tables. A confirmation message
appears. Click Yes.

Converting Daily Summary Tables to a Monthly Summary Table

You can consolidate your daily CIMS Summary records so that data is stored in an
aggregated monthly record. This consolidation minimizes storage (there is typically a 90
percent or greater reduction in records) and decreases the time required to generate
monthly reports. A drawback to this consolidation is that you cannot run costed daily
reports against the CIMSSummary table.

To perform the consolidation process, use the ConvertSummaryDailyToMonthly.wsf
script. For more information about this script, see page C-9.

Important! « You should consult CIMS Lab before using this script.

Updating the Rate Identifiers Table

A key feature of viewing invoices in CIMS Server Web Reporting is the ability to drill
down on the units consumed for a resource by identifier. This feature uses the
CIMSRateldentifiers table, which contains the rate codes that are processed from the CSR
or CSR+ files and correlates them to their corresponding identifier names in the
CIMSIdent table.

If the identifiers in the CSR or CSR+ files have changed and/or a rate code or codes in the
resource files have changed, the CIMSRateldentifiers table will retain unused data in
addition to the current data. Although this does not cause processing problems, the table
can accumulate a large amount of data. To update the table so that it contains only the
current data, in the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Update Rate Identifiers.

Viewing Tables

B 5-14

To view tables, in the CIMS Server Administrator main window, click System
Administration » Database » Table Viewers » Table Name.
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Managing Database Objects

WARNING - Certain reports are dependent on database objects. Dropping or altering
database objects could disable these reports.

All database objects are XML files. The standard database objects that are included with
CIMS Server are located in C:\Program Files\CIMSLab\Admin\

DBObjects\Standard (if you installed CIMS Server in the default location). You can also
create custom objects and store them in the Custom folder. If you create a custom object
with the same name as a standard object, CIMS Server uses the custom object.

CIMS Server includes the following types of database objects:

m Tables. Tables are database objects that contain all the data in a database. A table
definition is a collection of columns. In tables, data is organized in a row-and-column
format similar to a spreadsheet. Each row represents a unique record, and each
column represents a field within the record.

Note * You can manage tables from the Database Table Manager dialog box as
described in Managing Database Tables on page 5-11 or from the Database Objects
Manager dialog box described in this section. However, the Database Table
Manager offers more options.

m Views. Each view is essentially a saved SQL statement that performs a query that
allows the system to generate a report or reports.

m Stored Procedures. Each procedure is set of SQL statements that can perform both
queries and actions that allow the system to generate a report or reports. Stored
procedures can accept parameters at runtime, whereas views cannot.

B Indexes. These are files that contain the SQL statements that define how a table index
is created. A table index allows the database program to find data in a table without
scanning the entire table. There can be multiple indexes per table or no index at all.

m Triggers. A trigger is a special type of stored procedure that executes when data in a
specified table is modified. A trigger can query other tables and can include
complex SQL statements.
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You can create or drop (completely remove) standard or custom database objects in the

database.

WARNING - You should consult CIMS Lab before you drop tables. Dropping a table

removes the table and its data from the database.

To create or drop database objects:

1 In the CIMS Server Administrator main window, click System

Administration » Database » Database Objects Manager.

The Database Objects Manager dialog box appears as shown in Figure 5-4.

@44 Database Objects Manager

Wi

COhject Location: ’W‘ Chject Type: |4 j

Defintion File Type “ersion Existz | Owner | Description #
it Tahle 0o1.010 dbo (mare) ...
D CIMSAuditClientContact Tahle oo1.010 Yes dbo [more) ...
D CIMSAuditClientContactMumber Tahle oo1.010 Yes dbo [more) ...
D CIMSAuditRate Tahle oo1.010 Yes dbo [more) ...
D CIMSAuditTransaction Tahle oo1.010 Yes dbo [more) ...
D CIMSCalendar Tahle oo1.010 Yes dbo [more) ...
D CIMSClient Tahle oo1.010 Yes dbo [more) ...
D CIMSCliertBudget Tahle oo1.010 Yes dbo [more) ...
D CIMSClientContact Tahle oo1.010 Yes dbo [more) ...
D CIMSCliertContactMumber Tahle oo1.010 Yes dbo [more) ...
D CIMSConfig Tahle oo1.010 Yes dbo [more) ...
D CIMSConfigdoccountLevel Tahle oo1.010 Yes dbo [more) ...

(nCIMRCnnfinOminnR Tahlr ant mn YRR rbhn fmnre 3 s

CProgram Files\CIMSLabiAdmin DEObjects\Standard

Select Al Drop Selected Ohjects | Create Selected Ohjects |

Close

Figure 5-4 - Database Objects Manager Dialog Box

2 In the Object Location list, click the location of the database objects that you want to
create or drop (i.e., the Standard or Custom folder).

3 In the Object Type list, click the object type or accept the default (A17).

4 Select the object(s) that you want to create or drop. To select all object check boxes,

click Select All.
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5 Click Create Selected Objects or Drop Selected Objects. A confirmation message
appears. Click Yes.

Note ¢ If the user ID that you are using to access the database does not have
sufficient system administration authority, you might not be able to create
database objects or to create objects with the appropriate permissions. In this
situation, a warning message appears recommending that you contact your
database administrator or CIMS Lab before continuing.

To confirm that an object exists in the database, make sure that Yes appears in the Exists
column for that object.
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Loading, Archiving, and Purging the Database

This section provides the procedures for loading, archiving, and purging the CIMS Server
database using the CIMS Server Administrator. You can also perform much of the
functionality described in this section via scripts as described in Appendix C, Scripts.

Loading the Database

B 5-18

If you are using CIMS Data Collectors for Windows, Mainframe, or UNIX, the batch
collection process automatically creates the Ident, Detail, and Summary files used for
reporting and loads them into the CIMS Server database on a defined schedule (daily,
monthly, etc.). For more information about scheduling data collection for CIMS Server,
refer to the CIMS Data Collectors for Microsoft Windows Installation and User Guide.

However, for testing and debugging purposes, you might want to load an individual file
or files into the database. You can load files from the Edit Process definition dialog box
(see CIMS Server Administrator Processing on page 6-21) or you can use the dialog boxes
described in the following sections.

Note ¢ If you receive a warning stating that a file with the same date range has
already been loaded, you are probably loading duplicate data. You can click Yes to
continue to load the data, but you should delete the previous load immediately after
the current load is completed (see Tracking the History of Database Loads on page 5-23).

Loading From CIMS Server

This section describes how to load Ident, Detail, and Summary files into the CIMS Server
database. Note that this process is normally not required because the files are
automatically loaded at the end of batch processing.

To load a database from CIMS Server:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » From CIMS Server. The CIMS Server File
Load dialog box appears as shown in example Figure 5-5.

ans CIMS Server, File Load

Wigw

[ CIMS File Type ]

(* jdert: " CIMSACCT Detail CIMSBILL Detail " Summary

[ File Infarmeation |

File: Mame: |

Wiewy File Select File ...

Destination:  CIMSServer

Jv Use bulk load interface

Load Data | Close |

Figure 5-5 « CIMS Server File Load Dialog Box
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2 Complete the dialog box as follows:
e CIMS File Type. Click one of the following:

 Ident. This file is created by CIMSAcct. This is the identification file that
contains fields such as User ID, department code, division code, server name,
etc. These fields are used during account code conversion to create your account
code structure.

¢ CIMSACCT Detail. This file is created by CIMSAcct. This file provides an
account code for each input file record processed. This file is used as an input
into CIMSBIll. You will rarely need to load this file.

e CIMSBILL Detail. This file is created by CIMSBIll. This file is loaded into the
database for use in the drill down reports. This file contains resource utilization
data.

The CIMSBill Detail file differs from the CIMSAcct Detail file in that the
CIMSBIll Detail file reflects any proration, CPU normalization, or include/
exclude processing that was performed. The CIMSBill Detail file also includes
accounting dates.

e Summary. This file is created by CIMSBIill. This file contains summarized usage
records with applied rates. You can load any number of Summary files
individually.

For more information about these files, see Chapter 6, Processing Data.

¢ File Name. Enter the path of the database file that you want to load. To browse for
a file, click Select File. To view the file in Windows Notepad, click View File.

e Destination. This defaults to the CIMS Data Source selected in the Select CIMS
Data Source list at the bottom of the CIMS Server Administrator main window.
The files are loaded into the database represented by the data source.

e Use Bulk Load Interface. Select this check box to perform a bulk load when
loading the database. This option is recommended because it increases the speed
of loads. A disadvantage is that if there is an error in the data, a generic rather than
specific error message appears. In this case, clear this check box and reload to view
the specific error message.

3 C(Click Load Data.

Loading From CIMS Mainframe or CIMS Desktop

The CIMS Mainframe File Load and CIMS Desktop Table Load dialog boxes are provided
for legacy purposes only. Consult CIMS Lab before using these dialog boxes.
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Archiving, Purging, and Restoring Database Loads

Note ¢ This feature is available if you are using SQL Server database. Support for
Oracle and DB2 will be included in a future release of CIMS Server.

Archiving and purging database loads is a powerful feature that enables you to remove
space and performance consuming data from the database and to store the data in
compressed zip files. You can then easily restore the archived data to the database if
needed.

Archiving, purging, and restoring loads in the database are defined as follows:

B Archive. Saves selected CIMS Summary, CIMSBIll Detail, CIMS Ident, and/or
CIMSAcct Detail loads in a format that you can reload (restore) into the database.
Archiving does not delete the load from the database.

m Purge. Deletes selected loads from the database.

m Restore. Reloads selected purged loads into the database. To use this feature, the
loads must be archived.

You can archive loads, archive and purge loads, or purge loads without archiving them.
To view a history of the loads that have been archived or purged, see Tracking the History
of Database Loads on page 5-23.

Note * You can also use the PurgelLoads.wsf script to purge loads in batch. However,
you should consult CIMS Lab before using this script because it does not archive the
loads before purging them. For more information about this script, see PurgeLoads.wsf
Script on page C-19.

To archive database loads:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Load Archiving & Purging.

The Load Archive dialog box appears as shown in example Figure 5-6 on page 5-21.
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Figure 5-6  Load Archive Dialog Box

In the Loads Filter area, set the following filters. These filters determine the loads that

appear on the Archive tab. For example, you can select only CIMSBill Detail loads or
only those loads with end dates that are in a certain date range.

¢ End Date Range. Loads are selected by the end date stored in the
CIMSLoadTracking table. Click Use All Dates, Use Specific Dates, or a date

keyword to select loads with end dates that fall within the specified date range. For
example, if you click Current Month, loads with end dates in the current month
are selected. If you select Use Specific Dates, enter the dates in the from/to boxes.

Load Types. Select the check box or boxes for the load types that you want to
archive. These are the loads created by CIMS Processing Engine. For more
information, see Chapter 6, Processing Data.

Source File Location. Click All to select loads from all applicable process
definitions or click a specific process definition (see CIMS Server Administrator
Processing on page 6-21).

Show archived loads. Select this check box to show loads that have been archived.
This filter appears only when the Archive tab is active.

Click Apply Filters to retrieve the loads that match the filter criteria.

Note « When you change a setting in the Loads Filter area, the loads on the
Archive tab disappear until you click Apply Filters or click another tab and return
to the Archive tab. Each time that you change the filters, you must apply them.
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4 If you want to purge the loads after they are archived, select the Purge loads after
archiving check box.

5 On the Archive tab, click the load or loads that you want to archive or click Select All
to archive all loads, and then click Archive.

The archived loads are stored in a zip file in the path and folder shown at the bottom of
the Load Archive dialog box. This path is set in the on the Archiving tab of the
Configuration dialog box (see Database Load Archive Settings on page 3-55). The naming
convention for the zip file is CIMSArchive_StartDate_£ndDate_ SequenceNumber.zip.

Important! ¢ Ifyou initialize a database, you should delete any archived files for that
database. Errors can occur if you try to reload these files to the originating database
or another database.

To purge database loads:

Important! « Purging removes database loads from the database. If the loads are not
archived before they are purged, you cannot restore the loads to the database.

To purge loads automatically after they are archived, click the Purge loads after
archiving check box on the Archive tab.

To purge loads independently of archiving:

1 Setand apply the filters for the loads that you want to purge as described in To archive
database loads: on page 5-20.

2 On the Purge tab, click the load or loads that you want to purge or click Select All to
purge all loads, and then click Purge.

To restore database loads:

1 Setand apply the filters for the loads that you want to restore as described in To archive
database loads: on page 5-20.

2 Onthe Restore tab, click the individual load or loads that you want to restore or click
Select All to restore all loads, and then click Restore.
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You can track the history of CIMS Summary, CIMSBill Detail, CIMS Ident, and CIMSAcct

Detail files that have been loaded to and/or deleted from the database.

To track loads:

1 In the CIMS Server Administrator main window, click Chargeback

Administration » Database Loading » Load Tracking.

The Load Tracking dialog box appears as shown in example Figure 5-7.

=49 Load Tracking
Wiew  Edit

Fiters ~Loads ]

Matching Loads: 9

List iz currently fittered, click Fiters tab to change

Source Start Date

Load ID | Load Type
SUmmary Mainframe

14 CIMSBILL Detail  Mainframe 202272005
15 Iekerit Mainframe  2/22/2005
7 SUmmary UnixFS 202212005
g CIMSBILL Detail  UnixFS 202202005
9 Iddent UnizFS 202202005
4 SUmmary MSIS-Weh 202202005
5 CIMSBILL Detail - MSIS-VWeh 202272005
[ Iddent MSIS-eh 202202005

Delete Load

212212005
212212005

212212005
212212005
212212005

212212005
212212005
212212005

2456 202372005 34255 PM
882 202302003 3:42:56 Ph

S 2232005 3:36:25 PM
393 202302003 3:36:25 PM
243 202302003 3:36:26 Ph

4 2232005 33618 PM

B9 22302005 33615 PM
264 202302003 3:36:19 Ph

Select Al | Wiewy Load |

Close

Figure 5-7 « Load Tracking Dialog Box

2 Use the Loads tab to track the files that have been loaded to the database. This tab
provides information such as the type of files loaded, the earliest accounting start date
and the latest accounting end date in the files, the date the files were loaded to the
database, and whether the files have been archived. You can delete and view loads as

follows:

¢ Delete Load. To remove a load or loads from the database, click the load(s) or

click Select All to select all loads, and then click Delete Load.

¢ Delete Load Entry. To remove a deleted load or loads from the database, click the
load(s), and then click Delete Load Entry. Deleted loads appear when using the
Show deleted loads filter on the Filters tab.

e Select All. To select all loads, click Select All.

e View Load. To view a load, click the load, and then click View Load.

CIMS Server Administrator's Guide

5-23 B



B Database Administration

Loading, Archiving, and Purging the Database

B 5-24

3 Use the Filters tab to determine the loads that appear on the Loads tab. For example,
you can choose to track only CIMSBill Detail file loads or only files that were loaded
during a certain date range.

Load Types. Select the check box or boxes for the load types that you want to view.
These are the loads created by CIMS Processing Engine. For more information, see
Chapter 6, Processing Data.

Source File Location. Click All to view loads from all applicable process
definitions or click a specific process definition (see CIMS Server Administrator
Processing on page 6-21).

End Date Range. Loads are selected by the accounting end date of the data in the
loads. (Note that CIMSAcct Detail loads are selected by the usage end date.) Click
Show All Dates, Use Specific Dates, or a date keyword to select loads with end
dates that fall within the specified date range. If you select Use Specific Dates,
enter the dates in the from/to boxes.

Date Loaded Range. Click Show All Dates, Use Specific Dates, or a date keyword
to select loads that were loaded within the specified date range.

Show deleted loads. Select this check box to view loads that have been deleted.

Apply Filters. Click this button to view the loads that match the filter criteria.
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Profiling the Database and Tables

You can view profiles of the database and tables. These profiles provide detailed
attributes of the data.

To view profiles of a database or table:

1 In the CIMS Server Administrator main window, click System
Administration » Database » Database Profiler.

The Database Profiler dialog box appears.

2 Under Database, you can navigate to view attributes of the database. Under Tables,
you can navigate to a specific table and view Dates (created or modified), Columns,
Indexes, or Properties information. See Figure 5-8.

== Database Profiler

+- Connection

+-- G0 Server Details
= Tables (51)

= CIMS Aucit Cliert
+- Dates
+--Columns (317
+-Indexes (1]

Keys (1)

Properties (1)
CIMS AuditClientContact
CIMS AuditCliertContacthlumber
CIMS AuditRate
CIMS AuditTranzaction
CIMSCalendar
CIMSClient
CIMSClientBudget
CIMSClientContact
CISCliertContacthlumber
CIMSConfig
CIMSConfigdoccountLevel
CIMSConfigOptions
CIMSCPUNormalization b

Performance Maonitor Refresh | Close |

e S e e e

Figure 5-8 + Database Profiler Dialog Box
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Important! ¢ Back up the database or make sure that it has recently been backed up
before you upgrade the database.

The new version or release of CIMS Server might contain a new database version. In this
case, you will receive notification that a database upgrade is available when you start
CIMS Server Administrator. Click Yes, and then click Upgrade Database. If you have
more than one database, you will receive this notification each time that you select a
CIMS Data Source that points to a database that is not the latest version in the Select
CIMS Data Source list. The Select CIMS Data Source list is at the bottom of the CIMS
Server Administrator main window.

To view the version of a database at any time, make sure that the CIMS Data Source for
the database is selected in the Select CIMS Data Source list and then click System
Administration » Database » Upgrade Database.
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This chapter provides an overview of the data processing cycle and components and
describes how to use CIMS Server Administrator to set processing options.
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About Processing Data

CIMS Server processes and applies business rules to resource usage data from any
application, system, or operating system on any platform. The primary method for
loading this data into CIMS Server is the CIMS Server Resource (CSR) or CIMS Server
Resource Plus (CSR+) file. The file type depends on the collector that created the file (see
CIMS Data Collectors on page 1-5).

Note ¢ Although the CIMS External Transaction file is also supported, CIMS Lab
recommends that you use the more flexible and efficient CSR or CSR+ file.

The CIMS Data Collector(s) that you are using to collect your system data automate the
data processing cycle. Using the console application CIMS Job Runner, the collectors can
be run in batch mode on a defined schedule (daily, monthly, etc.) to convert usage
metering data created by your system into CSR or CSR+ files. Once the CSR or CSR+ files
are created, the collector processes the data in the files and loads the resulting output files
into the database using the CIMS Processing Engine components CIMSACCT.d11,
CIMSBILL.d11, CIMSSORT.d11, CIMSAdminLib.d11, and CIMSResr1.d11. For more
information about CIMS Data Collectors and CIMS Job Runner, refer to the CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

Although not intended for daily processing, you can also process CSR and CSR+ files
using CIMS Server Administrator. For example, you can use CIMS Server Administrator
to process the sample files that are provided with CIMS Server for demonstration
purposes. To process files using CIMS Server Administrator, see Processing Data Using
CIMS Server Administrator on page 6-38.

The primary use of CIMS Server Administrator in regards to processing is to set the
processing options required by the key processing programs, CIMSAcct and CIMSBill.
These programs are responsible for assigning accountability and cost for resources
consumed, respectively. The process settings for CIMSAcct and CIMSBill are described in
CIMS Server Administrator Processing on page 6-21.
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Data Processing Frequency

The preferred method of processing is to run the full data processing cycle as the data
becomes available. The data produced by the various operating systems (z/OS, UNIX,
Windows, Open VMS, etc.) and applications/databases (CICS, DB2, Oracle, IIS,
Exchange Server, etc.) are usually made available for processing on a daily basis. Other
feeds such as time accounting, help desk, line charges, equipment charges, and other
shared services are usually produced on a monthly basis.

There are several advantages to running the full costing cycle on a daily or data
availability basis:

m The volume of data created makes it more practical to process daily. A single mid-
sized Proxy Server might produce millions of records each day. It is more efficient to
process these records each day of the month rather than try to run many millions of
records through the processing cycle at month end.

m [t is easier to catch processing errors when the data is reviewed on a daily basis. It is
more difficult to troubleshoot a problem when it is discovered at month end. If an
unusual increase in utilization is observed for a specific resource at month end, the
entire month'’s records must be checked to determine when the increase first took
place.

Because there are fewer jobs, transactions, or records to review, the task of
determining what caused the utilization spike is much simpler if caught on the day
in which it occurred.

m If the program CIMSBIll is run monthly, the start date is the first day of the month
and the end date is the last day of the month. Because of this date range, it is not
possible to view CIMS Summary records for a single day or week. The smallest time
range that may be used is the entire month.

Required Folder Permissions for Data Processing

The administrator that executes processes using CIMS Data Collectors or CIMS Server
Administrator requires full access to files in the Processes folder (that is, the ability to
create, modify, delete, overwrite, etc.). Therefore, the Windows user account or group
account for the administrator must have Full Control security permissions for the
Processes folder and all subfolders.
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CIMS Processing Engine

CIMS Processing Engine is composed of COM components. Each component performs
particular functions in the processing cycle. Table 6-1 describes the CIMS Processing
Engine COM components in the order that they appear in the processing cycle and the

output files created by the objects as applicable.

COM Object

Description

Output Files

CIMSACCT.d11 Performs account code conversion, H
shift determination, date selection,
and identifier extraction on the data
contained in the CSR or CSR+ file.
The input file could also be the
CIMSAcct Detail File previously

produced by CIMSAcct.

For more information about
CIMSAcct, including a description if
its input and output files, see

page 6-6.

CIMSSORT.d11 Sorts the CIMSAcct Detail file and
produces a version of the file that is

ready to be processed by CIMSBIll.

CIMSBILL.d11 Processes the sorted CIMSAcct
Detail file from CIMSSort and
performs shift processing, CPU
normalization, proration, and
include/exclude processing and
creates files that contain the billing
information used to generate

invoices and reports.

For more information about
CIMSBIll, including a description of
its input and output files, see
page 6-11.
CIMSAdminLib.d11  Contains the class CCIMSCBSLoad that
loads the output files from
CIMSAcct and CIMSBIill into the
database.

For more information about
CIMSAdminlLib, see page 6-15.

CIMSResrl.dl11 Supports CIMSAcct and CIMSBill.

CIMS Ident. This file is
loaded into the
database.

CIMSAcct Detail. This
file is input into
CIMSSort or can be
reprocessed through
CIMSAcct.

Sorted CIMSAcct
Detail. This file is input
into CIMSBill.

CIMSBIll Detail. This
file is loaded into the
database or can be

reprocessed through
CIMSBill.

m CIMS Summary. This

file is loaded into the
database or can be
reprocessed through
CIMSACcct.

Table 6-1  CIMS Processing Engine Components
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CIMSAcct

CIMSAcct is the first data processing program that is executed. CIMSAcct processes the
records in the input file (see CIMSAcct Input on page 6-7) and performs the following:

m Identifier extraction and account code conversion. CIMSAcct extracts the identifiers
from the input file records and creates the CIMS Ident file, which is loaded into the
database. It also uses specified identifiers to build the account code and perform
account code conversion if required. For more information, see Setting Up Account
Codes and Performing Account Code Conversion on page 6-39.

m Date selection. CIMSAcct selects the input file records to be processed based on the
specified date or date range. For more information, see Date Selection on page 6-27.

m Shift determination. CIMSAcct can determine the shift to be used for processing in
either of the following ways:

e Use the shift code from the input file records. If a shift code is not included, the
default shift code is 1.

e Recalculate the shift using the start date/time in the records. For more information,
see Shifts Subtab on page 6-29.

CIMSAcct produces the CIMSAcct Detail file, which contains records that are properly
formatted for input into CIMSBIll.

Reprocessing CIMSAcct and CIMSBIll Output Files

You can reprocess the CIMSAcct Detail file and the CIMS Summary file from CIMSBill
through CIMSAcct. This is usually done to reprocess data for further account code
conversion. To reprocess either of these files during the data collection process, you need
specify the file name in the XML job file used for data collection. For more information,
refer to the documentation on the CIMSAcct parameter attribute inputFile in the CIMS
Data Collectors for Microsoft Windows Installation and User Guide.
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CIMSAcct Input

Table 6-2 lists the input and processing files used by CIMSAcct. These files are in the
process definition subfolders in the Processes folder.

The file names in Table 6-2 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type File Name Description

Input Files (CIMSAcct can process usage data from any of the following sources)

CSR or CSR+ file CurrentCSR.txt  These are the most commonly used files for
Or processing data through CIMS Server.
Yyyymndd. txt To view the record layout for these files, see
Appendix B, File Layouts.
CIMS External User determined Although the CIMS External Transaction file
Transaction file is supported, CIMS Lab recommends that

you use the CSR or CSR+ file for input into
CIMS Server. The CSR/CSR+ file format is
more flexible and efficient than the CIMS
External Transaction file format.

CIMSAcct Detail file Detail.txt This file is the output from a previous run of
CIMSACcct.

This file provides an account code for each
input file record. This file is input into the
CIMSSort process.

When used as input into CIMSAcct, this file
is used primarily in the reprocessing of data
for date selection or further account code
conversion.

The records within this file are also referred
to as maintenance or 991 records.

CIMS Summary file  BillSummary.txt This file is the output from a previous run of
CIMSBIll. When used as input into
CIMSAcct, this file is used primarily for
reprocessing data for further account code
conversion.

Table 6-2 < CIMSAcct Input
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File Type File Name Description

Processing Files

Control file AcctCntl.txt This file contains the CIMSAcct control
statements (see CIMSAcct Control Statements
on page D-3).

Account Code AcctTabl.txt This optional file contains the account code

Conversion Table conversion table (see Creating an Account

Code Conversion Table on page 6-44).

Process Control file  ProcessCntl.txt This file contains the processing statements
used by CIMS Server Administrator (see
Processing Control Statements on page D-27).

Table 6-2 « CIMSAcct Input (Continued)
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CIMSAcct Output

Table 6-3 lists the CIMSAcct output files. These files are in the process definition
subfolders in the Processes folder.

The file names in Table 6-3 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type File Name Description

CIMSAcct Detail file Detail.txt This file provides an account code for each
input file record. This file is input into
CIMSSort.

CIMS Ident file Ident.txt This file contains all the identifiers (such as

as user ID, jobname, department code,
server name, etc.) that are contained in the
input records. These identifiers are used
during account code conversion to create
your target account code structure.

This file is loaded into the database.

CIMSAcct AcctMsg.txt This file contains processing messages

Message file related to CIMSAcct.

CIMSAcct AcctMsg_cob.txt This file contains any runtime COBOL

COBOL Message file messages related to CIMSAcct. If there are no
errors, this file is blank.

CIMSAcct AcctResults.txt This file contains the CIMSAcct processing

Results file results.

Exception file Exception.txt This is an optional file in CSR or CSR+

format that contains all records that did not
match during account code conversion.
These files can be reprocessed through the
processing cycle as described in About
Exception File Processing on page 6-17.

To produce this file, you must have
exception file processing enabled (see
page 6-42).

Table 6-3 « CIMSAcct Output
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File Type File Name Description

CSR+ file CSRPFiTe.txt The output of a CSR+ file from CIMSAcct is
optional. For example, you might want to
create a CSR+ file to be processed by CIMS
Mainframe Data Collector and Chargeback

System.
Windows Message Events are written to the Windows Event
Events Viewer when the CIMSAcct process starts

and ends and when and warnings or errors
are encountered while processing.

Table 6-3 « CIMSAcct Output
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CIMSBiIl

CIMS Processing Engine

CIMSSort sorts the CIMSAcct Detail file and produces a version of the file that is ready
to be processed by CIMSBIll.

The cost of information services, and which departments are using the services, is of
considerable interest to an organization. When users are made aware of the costs and are
held financially responsible for those costs, they are more likely to use the resources in
a prudent manner. CIMS Server provides comprehensive computer center billing
through the program CIMSBIill.

The primary function of CIMSBill is to perform cost extensions within CIMS Server and
to summarize cost and resource utilization by account code. CIMSBIll uses the rate table
assigned to the client (see Working With Clients on page 3-20) to determine the amount
to be charged for each resource consumed. It is possible to have a unique rate table for
each client.

There are specific rules that CIMSBill follows when charging resource consumption:

m If a resource has a corresponding entry with a monetary amount in the rate table, the
number of resource units are multiplied by this amount. The result appears in the
CIMS Summary records.

m If a resource has a corresponding entry with no or zero currency amount in the rate
table, a zero cost appears in the CIMS Summary records for that resource.

m If a resource does not have a corresponding entry in the rate table, the data for that
resource does not appear in the CIMS Summary records.

m If none of the resources in the CIMSBIill input file have a corresponding entry in the
rate table, the CIMS Summary file will contain no records. If the Load Summary
records check box is selected in CIMS Server Administrator (see page 6-24), the CIMS
Ident file, CIMSBIll Detail file, and CIMS Summary file are not loaded to the
database—the process fails and a failure message is issued. You must have at least one
rate code from the input file in the rate table to produce CIMS Summary records.

If the Load Summary records check box is not selected, the CIMS Ident file and
CIMSBIll Detail file load to the database if the Load Ident records and Load
CIMSBILL Detail records check boxes are selected.
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In addition to standard costing, CIMSBill also performs the following:

B Processes non-standard costs such as miscellaneous, recurring, and credit
transactions. For more information about creating and using transactions, refer to the
CIMS Server Web Reporting User’s Guide.

m Performs proration. See Prorating Resources on page 6-49.

Note ¢ Although you can perform proration using CIMSBill, CIMS Lab
recommends that you use the CIMSPrat program. CIMSPrat provides more
options for proration and enables you to prorate resources multiple times. For
more information about proration using CIMSPrat, refer to the CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

CIMS Server will continue to support proration using CIMSPrat or CIMSBill.

m Performs CPU Normalization. See Normalizing CPU Values on page 6-55.

m Performs include/exclude processing. See Include/Exclude Processing on page 6-58.
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Table 6-4 lists the input and processing files used by CIMSBill. These files are in the
process definition subfolders in the Processes folder.

The file names in Table 6-4 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type
Input Files

CIMSSort/CIMSAcct
Detail file

CIMSBIll Detalil file

CIMS Summary file

Processing Files

Control file

Process Control file

Proration Table

File Name

Detail.txt

BillDetail.txt

Bil1Summary.txt

BillCntl.txt

ProcessCntl.txt

User determined

Description

This is the sorted Detail file from CIMSAcct.

This file is the output from a previous run of
CIMSBIll. When used as input into
CIMSBIll, this file is used primarily for
performing additional proration functions.

To reprocess this file during the data
collection process, you need to define the
file as an input to CIMSBill in the XML job
file. For more information, refer to the CIMS
Data Collectors for Microsoft Windows
Installation and User Guide.

This file is the output from a previous run of
CIMSBIll. When used as input into
CIMSBIll, this file is used primarily for
performing additional proration functions.

To reprocess this file during the data
collection process, you need to define the
file as an input to CIMSBIill in the XML job
file. For more information, refer to the CIMS
Data Collectors for Microsoft Windows
Installation and User Guide.

This file contains the CIMSBill control
statements (see CIMSBill Control Statements
on page D-14).

This file contains the processing statements
used by CIMS Server Administrator (see
Processing Control Statements on page D-27).

This optional file contains the proration
table (see To create a proration table: on
page 6-50).

Table 6-4 « CIMSBIll Input
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B 6-14

CIMSBIll Output

Table 6-5 lists the CIMSBIll output files. These files are in the process definition
subfolders in the Processes folder.

The file names in Table 6-5 are the default names used by both CIMS Data Collectors
and CIMS Server Administrator. If you do not use the default names, you should ensure
that the same file names are used for both programs.

File Type

CIMSBIll Detail file

CIMS Summary file

Prorate Report

CIMSBill
Message file

CIMSBiIll
COBOL Message file

CIMSBill
Results file

Windows Message
Events

File Name Description

BillDetail.txt This file is loaded into the database for use
in drill down reports. This file contains
resource utilization data.

The CIMSBIll Detail file differs from the
CIMSAcct Detail file in that the CIMSBill
Detail file reflects any proration, CPU
normalization, or include/exclude
processing that was performed. The
CIMSBIll Detail file also includes
accounting dates.

Bil1Summary.txt This file is loaded into the database for use
in producing reports. This file contains both
resource utilization and cost data.

ProrateRep.txt  This is an optional report that contains the
original record and all subsequently-
generated prorated records. To enable this
report, see page 6-49.

BillMsg.txt This file contains processing messages
related to CIMSBIll.

Bi11Msg_cob.txt This file contains any runtime COBOL
messages related to CIMSBIlL. If there are no
errors, this file is blank.

Bil1Results.txt This file that contains the CIMSBill
processing results.

Events are written to the Windows Event
Viewer when the CIMSBill process starts and
ends and when and warnings or errors are
encountered while processing.

Table 6-5  CIMSBIll Output
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CIMSAdminLib

CIMSAdminLib is the central controlling library for all Windows-based CIMS Server
functions. It contains all the COM objects used to manipulate CIMS data. These objects
are called from CIMS Server Administrator and Windows Script Host (. wsf) scripts used
by CIMS Data Collectors and CIMS Server.

CIMSAdminLib contains the class CCIMSCBSLoad that loads the output files from
CIMSAcct and CIMSBIll into the database.
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CIMS Processing Engine Architecture Diagram

The diagram in Figure 6-1 shows the input and output for CIMS Processing Engine.
For simplicity, this diagram shows only the key input and output. For a complete
description of all input and output, refer to the preceding sections.

G civs Data a1 Data Cis Convenion nne
Collectors for Collector for Collector for

N . By Other Collectors)
Windows UNIX Mainframe and Transactions Created

in CIMS Web Reporting

CSR or
CSR+ File

CIMSAcct

}

CIMSAcct
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A

CIMS
Ident File

Additional
Conversion?

File

Ident Load CIMSBill
CIMSRate
Table

CIMSBIll
Detail
File

CIMSClient
Table

Summary Load Detail Load
CIMSDetail CIMSIdent CIMSSum. CIMSDetail
Ident Table Table Table Table
CIMS Server Web Reporting
|

o =

End User End User End User

Figure 6-1 * Architecture of the CIMS Server System
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Account Codes and Account Code Conversion

Within chargeback and resource accounting, an account code uniquely identifies an
individual, billing, or reporting entity. The actual definition of what the account code
represents depends on how CIMS Server is used. For example, an account code can
represent an organization, a department in an organization, or an individual.

A key feature of CIMSAcct is its ability to use business rules to convert the identifier
values in the CSR or CSR+ files into account codes. In some cases, the identifier value in
the CSR or CSR+ file is the actual account code. However, in most cases, the identifier
value represents the source of the consumed resources (i.e., a user ID, IP address, server
name, jobname, transaction ID, terminal ID, etc.).

CIMSAcct uses an account code conversion table to convert identifier values into an
account code. For example, an IP address of 10.26.12.255 is converted to the account
code for Human Resources while an address of 10.26.12.260 is converted to the account
code for Accounts Payable. These departments can then be charged for the consumption
of the resources associated with their IP addresses.

For the steps required to set up account code conversion, see page 6-39. For an example
of these steps, see page 6-46.

About Exception File Processing

During account code conversion, CIMSAcct might encounter input file records that do
not match any entry in the account code conversion table. CIMSAcct includes an
optional exception file processing feature that automatically identifies and removes
unmatched records so that they can be reprocessed with the correct accounting
information.

When this feature is enabled, all unmatched records are output to an exception file in the
process definition subfolder. You can use the exception file to identify the information
that needs to be corrected, either in the records in the exception file or in the account
code conversion table, and then reprocess the exception file.

To enable the exception file processing feature, see Setting the Account Code Conversion
Options on page 6-42. For assistance in processing exception files, contact CIMS Lab.
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Accounting Dates

CIMS Server input records contain a usage start date and end date that specify the date
range in which the resources in the record were consumed. CIMSBIill uses the usage end
date to calculate accounting start and end dates, which are used for billing and reporting.

If a close date is not set, the accounting dates produced by CIMSBill are always the same
as the usage end date in the input file records.

If a close date is set, the accounting dates may be the same as or different than the usage
end date depending on the factors described in How Accounting Dates Are Calculated on
page 6-19.

The accounting start and end dates are stored in the following fields in the CIMSBill
output files:

m CIMSBill Detail file. The accounting dates are in the ACCOUNTING-START-DATE and
ACCOUNTING-END-DATE fields (starting positions 159 and 168, respectively).

m CIMS Summary file. The accounting dates are in the AccountingFromDate and
AccountingToDate fields (starting positions 167 and 175, respectively). The Period
and Year fields also reflect the accounting end dates. (These fields are at starting
positions 282 and 284, respectively.) For example, if the end date is 20050916 and the
date falls within the 9th period in the CIMSCalendar table, the Period field would
contain 09 and the Year field 2005.

About the Close Date

B 6-18

You can set an optional close date for processing input file records. Typically, the close
date is set for the same date each month to close data processing for the previous month.
For example, if you set the close date for the third of each month, the close date for
January data would be February 3, the close date for February data would be March 3,
etc. This allows any input records with usage end dates from the previous month to be
processed with that month.

Example

Assume that in November you are processing input records with usage end dates in
October. If the close date is the third of each month, all records with an October usage
end date that are processed on November 1-3 will be processed with accounting dates
in October. All records with an October usage end date processed from November 4 to
December 3 will be processed with accounting dates in November.

You can set a system-wide close date or set close dates for individual process definitions.
To set a system-wide close date, see page 3-44.To set close dates for an individual process
definition or definitions, see page 6-32.

Using a Specific Close Date

When you set a specific close date, that date is applied to the applicable period in the
CIMSCalendar table. For example, if you are using the default periods in the
CIMSCalendar table and you set a close date of October 3, this close date is set for
period 9 (September 1—September 30). When you set a specific close date, you should
set the close date for the current period or the preceding period only.
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How Accounting Dates Are Calculated

The accounting dates are calculated according to the usage end dates, the close date (see
About the Close Date on page 6-18), and the periods defined in the CIMSCalendar table.
The accounting dates may be the same as or different than the usage end date depending
on the factors described in the following sections.

Scenarios in Which Accounting Dates and Usage End Dates are
Always the Same

The accounting dates and usage end date are always the same in the following situations:

m If no close date is set.

m If both the CIMSBIll run date and the usage end date are in the same period (as set in
the CIMSCalendar table), regardless of the close date.

Example Using Calendar Month Periods With Monthly Close Date

Close Date

for Current  CIMSBIll Usage Accounting
Current Period Period Run Date End Date Dates
Sept. 1-30 (Period 9) Oct. 3 Sept. 30 Sept. 16 Sept. 16

Example Using Non Calendar Month Periods With Specific Close Date

Close Date

for Current  CIMSBIll Usage Accounting
Current Period Period Run Date End Date Dates
Sept. 23-Oct. 22 Oct. 25 Oct. 22 Oct. 1 Oct. 1

(Period 9)

m If the usage end date is in the previous period and the CIMSBill run date is prior to
the close date for that period.

Example Using Calendar Month Periods With Monthly Close Date

Close Date
Previous for Prev. Current CIMSBIll Usage Accounting
Period Period Period Run Date End Date Dates
Aug. 1-31 Sept. 3 Sept. 1-30  Sept. 2 Aug. 16 Aug. 16
(Period 8) (Period 9)

Example Using Non Calendar Month Periods With Specific Close Date

Close Date
Previous for Prev. Current CIMSBill Usage Accounting
Period Period Period Run Date End Date Dates
Aug. 23- Sept. 25 Sept. 23— Sept. 24 Sept. 1 Sept. 1
Sept. 22 Oct. 22
(Period 8) (Period 9)
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Scenarios in Which Accounting Dates and Usage End Dates are

Different

The accounting dates and usage end date are different in the following situations:

m If the usage date is in any previous period and the CIMSBIll run date is after the close

B 6-20

date for the period immediately prior to the current period, the accounting dates are
set to the previous day from the day CIMSBill was run.

Example Using Calendar Month Periods With Monthly Close Date

Note that for example purposes, the period immediately prior to the current period
is used. However, this example is applicable for any previous period.

Close Date
Previous for Prev. Current CIMSBIll Usage Accounting
Period Period Period Run Date End Date Dates
Aug. 1-31 Sept. 3 Sept. 1-30 Sept. 5 Aug 16 Sept. 4
(Period 8) (Period 9) (CIMSBIll run
date -1 day)

Example Using Non Calendar Month Periods With Specific Close Date

Close Date
Previous for Prev. Current CIMSBill Usage Accounting
Period Period Period Run Date End Date  Dates
Aug. 23- Sept. 25 Sept. 23— Oct. 22 Sept. 1 Oct. 21
Sept. 22 Oct. 22 (CIMSBIll run
(Period 8) (Period 9) date -1 day)

If the usage end date is in any period prior to the previous period and the CIMSBill
run date is before the close date for the previous period, the accounting dates are set
to the last day of the previous period.

Example Using Calendar Month Periods

Close Date
Period Prior for Prev.
to Previous Period Current CIMSBIll Usage Accounting
Period (Aug. 1-31)  Period Run Date End Date Dates
July 1-31 Sept. 3 Sept. 1-30 Sept. 2 July 16 Aug. 31
(Period 7) (Period 9) (Last day of

previous period)

Example Using Non Calendar Month Periods With Specific Close Date

Close Date
Period Prior for Prev.
to Previous Per. (Aug. Current CIMSBIll Usage Accounting
Period 23-Sept.22) Period Run Date End Date Dates
July 23~ Sept. 25 Sept. 23~ Sept. 24 July 20 Sept. 22
Aug. 22 Oct. 22 (Last day of
(Period 7) (Period 9) previous period)
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CIMS Server Administrator Processing

In CIMS Server Administrator, you can set processing definitions that instruct CIMS
Server how to execute processing jobs for different types of input resource data. A process
definition is a folder that contains the files required to process usage data from a
particular source such as a database, operating system, or application.

Note ¢ If you are using CIMS Data Collectors, process definition folders and
required processing files are created automatically.

The settings that you select for the process definition are stored in the AcctCnt1.txt,
Bi11Cnt1.txt, and ProcessCntl1.txt files in the process definition folder. AcctCnt1.txt
and Bi11Cnt1.txt contain the CIMSAcct and CIMSBIll control statements, respectively.
(For a list of these statements, see page D-3 and page D-14). ProcessCnt1.txt contains
process settings used by CIMS Server Administrator (see page D-27).

You can edit these files using a text editor or through CIMS Server Administrator. For
example, if you select the Perform Account Code Conversion check box in CIMS Server
Administrator (see page 6-42), the control statement ACCOUNT CODE CONVERSION is
automatically added to the AcctCnt1.txt file.
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Adding Process Definitions

When you add a process definition, CIMS Server Administrator builds a folder within the
process definition path (see Processing Settings on page 3-44) and creates the necessary
process definition files within this new folder. The folder shares the name of the process

definition.

To add a process definition:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions. The Process Definitions List
Maintenance dialog box appears as shown in example Figure 6-2.

a3 Process Definitions List Maintenance

View

| Process Detinitions

Apache

I Disk
ClSVWinEwerntlon
CIMSinPrint
CMSnInProcess
DBSpace
Mainframe
MainframeCiCs
MainframeDB2
MainframeDisk
MainframeSMFE
MSE=change
MSExchangehi::
MEIE-yish
MSReportingServices
MSS0L2000

Prarate

Transactions

Universal
UnixDE2

UProcesses)

Add | Remove | Exit ‘

Rename

Process ‘

Close

Figure 6-2 * Process Definitions List Maintenance Dialog Box

2 Click Add.

3 Typeaname for the process definition in the Add New Process Definition dialog box,

and then click OK.

The Edit Process Definition dialog box appears.

4 Edit the new process definition as needed (see Setting Process Definition Options on

page 6-23).

To remove or rename a process definition, click the definition in the Process Definitions

Maintenance List dialog box and click Remove or Rename.

B 6-22

CIMS Server Administrator's Guide



Processing Data H
CIMS Server Administrator Processing

Setting Process Definition Options

The Edit Process Definition dialog box includes a number of tabs and subtabs that
contain settings for the process definition. The main tabs are:

B Process Options

m CIMS Account Options
m CIMS Bill Options

m Process Results

B Versions

The following sections describe the options that are available on these tabs by subtab.
Where applicable, the correlating control or processing statement for each option is also
provided.

Process Options Tab

This tab contains the following subtabs: General, Processing, and Database.

General Subtab

This subtab displays the name and path of the process definition. You can also use this
tab to add a description of the process definition.

Setting Correlating Control File and Statement

Process Definition Path None

The path for the process definition folders.
The use of a UNC path is recommended
(e.g., \\CIMS-SRVI\D$\Processes).

Process Name None

The process name. This name is also shared
by the folder that contains the process
definition files.

Process Description File: ProcessCntl.txt
Type an optional short description of the Statement:

rocess definition. s L
P Description description
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B 6-24

Processing Subtab

Use this subtab to specify the processing options such as processing programs that you
want to run and the output files that you want to load to the database.

Setting Correlating Control File and Statement

Run CIMS Account

Select this check box to instruct the system
to run CIMSAcct as part of this process.

Run CIMS Bill

Select this check box to instruct the system
to run CIMSBIll as part of this process.

Remove output files before processing

Select this check box if you want to delete
previous output files from the process
definition folder. This ensures that old data
is not loaded into the database. This check
box should be selected unless you are
running CIMSBIll or database loads only.

Archive process files

Select this check box to archive previous
output files before processing. Archived files
contain a date in the file name. Archived
files for the same date are indicated by a
number (1, 2, 3...) at the end of the file
name. Note that if you select this option,
you can potentially have a large number of
archived files in the process definition
folder.

Note: This option is not related to the
archive database loads feature described in
Archiving, Purging, and Restoring Database
Loads on page 5-20.

Load Ident records

Select this check box to load CIMS Ident files
from CIMSAcct into the database.

Load Summary records

Select this check box to load CIMS Summary
files from CIMSBIll into the database.

File: ProcessCnt1.txt

Statement:
RunCIMSAcct Yes/No

File: ProcessCnt1.txt

Statement:
RunCIMSBi11 Yes/No

File: ProcessCnt1.txt

Statement:
RemoveFilesBeforeProcessing Yes/No

File: ProcessCnt1.txt

Statement:
ArchiveProcessFiles Yes/No

File: ProcessCntl.txt

Statement:
AutolLoadIdentFile Yes/No

File: ProcessCnt1.txt

Statement:
AutoLoadSummaryFile Yes/No

CIMS Server Administrator's Guide



Processing Data H
CIMS Server Administrator Processing

Setting Correlating Control File and Statement

Load CIMSBILL Detail records File: ProcessCnt1.txt
Select this check box to load CIMSBIll Detail  Statement:
files into the database. AutoloadDetailFile Yes/No

Load CIMSACCT Detail records File: ProcessCntl.txt

Select this check box to load the CIMSAcct  Statement:
Detail files into the database. Consult CIMS

Lab before using this option. AutolLoadResourceFile Yes/No

Use bulk load interface File: ProcessCnt1.txt

If you are using a SQL Server database, select Statement:

this check box to perform a bulk load when |copy 1kl oadInterface Yes/No
loading the database. (Bulk load is !

performed automatically if you are using an

Oracle database.)

This option is recommended because it
increases the speed of loads. A disadvantage
is that if there is an error in the data, a
generic rather than specific error message
appears. In this case, clear this check box
and reprocess to view the specific error
message.
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Database Subtab

Use this subtab to select the ODBC data source for the CIMS Server database that you
want to use for processing the data and storing the output Ident, Detail, and Summary
files. In most cases, this will be the database that CIMS Server Administrator is currently
pointing to.

Setting Correlating Control File and Statement

Use same database connection File: ProcessCnt1.txt

information as CIMS Administrator
Statement:

Leave this check box selected (the default) to oy e
use the database that CIMS Server
Administrator is currently pointing to.

Automatically generate ODBC INF file File: ProcessCnt1.txt
Leave this check box selected (the default). Statement:

This file is required. GenerateODBCINF Yes/No
Data Source Name File: ProcessCntl.txt
Database User ID/Password Statements:

These options are deprecated and are DSN' name

retained for legacy purposes only. DSNUID user ID

DSNPWD password
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CIMS Account Options Tab

This tab contains the following subtabs: General, Files, Account Codes, Shifts, and
Trace.

General Subtab

Use this subtab to specify general CIMSAcct settings such as the record type and date
range for the input records to be processed.

Setting Correlating Control File and Statement

Process Type File: AcctCntl.txt

Click the input record type to be processed Statement:
(CIMS Server Resource Records [this
includes CSR+ records], External Trans
Records, CIMS Maintenance Records from
CIMSAcct, or CIMS Summary Records).

Process record type (see page D-11)

Date Selection File: AcctCntl.txt

Click the date range for records to be Statement:

processed by CIMSAcct. Records are selected  pa1r SELECTION YYYYMMDD YYYYMMDD/
by the end date in the record (the keyword (see page D-6)

accounting end date for CIMS Summary
Records and the usage end date for all other
record types). Click one of the following:

m No Date Selection

m Use Specific Dates. Enter the dates in the
Start Date and End Date boxes.

B Run Date (Today). Selects records based
on the run date.

m Previous Day to Current Day. Selects
records based on the run date and the run
date less one day.

B Current Week. Selects records based on
the run week (Sat-Sun).

m Current Month. Selects records based on
the run month.

m Previous Day. Selects records based on
the run date, less one day.

m Previous Week. Selects records based on
the previous week (Sat-Sun).

m Previous Month. Selects records based on
the previous month.
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Setting Correlating Control File and Statement

B Current Period from Calendar. Selects
records based on the current period from
the CIMSCalendar table.

B Previous Period from Calendar. Selects
records based on the previous period
from the CIMSCalendar table.

For example, if you click Current Month,
records with end dates in the current month
are processed.

Include Fields File: AcctCntl.txt

These fields allow you to move identifiers ~ Statement:
into an area that can be later used by

D-1
CIMSBIll for include/exclude processing. INCLUDE FIELD (see page 0)
For a complete description of this option
and include/exclude processing, see Include/
Exclude Processing on page 6-58.

Files Subtab
Use this subtab to define the CIMSAcct input and output files.

Setting Correlating Control File and Statement

Input File File: ProcessCnt1.txt

The input file to be processed by CIMSAcct. Statement:
The default is CurrentCSR.txt. To select
another file, click Browse. To edit the file in
Windows Notepad, click Edit.

AcctInputFile filename

Output Files File: ProcessCntl.txt

The names of the CIMSAcct output files (the Statement:
CIMSAcct Detail, CIMS Ident, Exception,
and CSR+ [optional] files). CIMSAcct writes ) _
these files to the path listed above the file ~ AcctOutputldentFile filename
names. CIMS Lab recommends that youuse AcctOutputExceptionFile filename
the default file names. CSRPFile filename

AcctOutputDetailFile filename

Create CSR Plus File: ProcessCnt1.txt

The creation of a CSR+ file is optional. Select Statement:
this check box to create a CSR+ file. CreateCSRPFile Yes
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Setting Correlating Control File and Statement

Eliminate duplicates None

If the input file contains duplicate
identifiers, selecting this check box
eliminates the duplicate identifiers from the
CIMS Ident file. Consult CIMS Lab before
using this option.

Account Codes Subtab

This subtab allows you to build the account code from the identifiers in the input file
and to convert the account code if needed. For a description of the options on this subtab
and an explanation of account codes and account code conversion, see Setting Up Account
Codes and Performing Account Code Conversion on page 6-39.

Shifts Subtab

As described in Setting Rate Shifts on page 3-13, you can set rates for a rate code by shift.
This optional feature enables you to set different rates based on the time of day.

If you want CIMS Server to use the shift codes that appear in the input records to process
the rate codes in the record, leave this tab blank. The shift codes that appear in the input
records will appear in the CIMSAcct Detail file. If there is no shift code in the input
record, the default shift code is 1.

If you do not want to use the shift codes in the input record for processing, you can use
this subtab to recalculate the shifts using the start date/time in the records. For each shift
that you want to create, enter a shift number and a time for the end of the shift. CIMSAcct
compares the start dates and times in the input records to the daily shifts that you specify
on this subtab and calculates new shift codes.

You can enter up to nine shifts per day. The shift end times must be listed in 4-character,
24-hour format (see example Figure 6-3 on page 6-30). The recalculated shift codes
rather than the original shift codes appear in the CIMSAcct Detail file.

Note « CIMSAcct will not recalculate the shift codes for CSR or CSR+ files produced
by CIMS Mainframe Data Collector and Chargeback System. CIMS Mainframe
records are aggregated using the shift code as one of the aggregation points.
Therefore, the time in the aggregated record is not representative of every record
within the aggregation. For more information, refer to the CIMS Mainframe Data
Collector and Chargeback System User Guide.

Regardless of whether you use the rate codes from the input file or recalculate the rate
codes, you must select the Use Shift Codes check box on the CIMS Bill Options/

General subtab (see page 6-32). If you do not select this check box, CIMSBill uses the
default rate shift 1 regardless of the shift code that appears in the CIMSAcct Detail file.

For the related AcctCnt1.txt control statements for setting up shifts, see page D-11.
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B 6-30

In the following example, shift 3 is from midnight to 8 a.m., shift 1 is from 8 a.m. to 4

p.m., and shift 2 is from 4 p.m. to midnight.

ans Edit Process Definition, "Mainframe®

Wigw

General ] Files ] Account Codes  Shifts l Trace ]

Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions

Shift # End Time Shift # End Time Shift # End Time Shift # End Time Shift #
Sunday 3 0&:00 1 16:00 2 24:00
Moncay 3 0&:00 1 16:00 2 24:00
Tuesday 3 0&:00 1 16:00 2 24:00
vWednesday |3 0&:00 1 16:00 2 24:00
Thursday 3 0&:00 1 16:00 2 24:00
Friclary 3 05:00 1 16:00 2 24:00
Saturday 3 05:00 1 16:00 2 24:00
£ >

Kevboard Usage: Press the Enter key to edit 2 cell. Use the arrow keys to navigate between celis.

Process

’Tl Cancel Apply

Figure 6-3 « Shifts Subtab
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Trace Subtab

Note ¢ By default, tracing is disabled. Consult CIMS Lab before using one of the
CIMSAcct trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSAcct Message file,
AcctMsg.txt:

m General processing. This is information related to CIMSAcct processing of the
information in the account, define, and move fields.

B Account code conversion. This is information related to the account code
conversion, including the information in the account, define, and move fields and
the account code conversion table, and the number of unmatched records (if

applicable).
Setting Correlating Control File and Statement
Trace flag File: AcctCntl.txt
Click Tracing Disabled, Y - Trace General Statement:
Processipg, or A - Trace Account Code TEST A or Y (see page D-12)
Conversion.
Check for bad file input None

Select this check box to validate each
identifier. Some systems may pass data in
identifier fields that are not valid ASCII
display characters. This can cause
unexpected results during processing. By
pre-validating the data, the system verifies
that the data passes through CIMS Server
successfully.

Note: This option slows down the
processing of CIMSAcct. Consult CIMS Lab
before using this option.
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B 6-32

CIMS Bill Options Tab

This tab contains the following subtabs: General, Files, Define Fields, Include/Exclude

Records, Proration, Client, and Trace.

General Subtab

Use this subtab to specify general CIMSBill settings such as the record type and date
range for the input and output records, to set the close date if other than the system close
date, and enable other options such as CPU normalization and shift code processing.

Setting Correlating Control File and Statement

Process Type

The input record type to be processed (CIMS
Detail records or CIMS Summary records).

Default Close Day

This option allows you to override the
system-wide close date set on the
Processing tab of the Configuration dialog
box (see page 3-44). Consult CIMS Lab
before using this option.

For more information about the close date,
see page 6-18.

Input—Date Selection

Click the date range for records to be
processed by CIMSBIll. Records are selected
by the end date in the record (the usage end
date for CIMSAcct Detail Records and the
accounting end date for all other record
types). Click one of the following:

m No Date Selection

m Use Specific Dates. Enter the dates in the
Start Date and End Date boxes.

B Run Date (Today). Selects records based
on the run date.

m Previous Day to Current Day. Selects
records based on the run date and the run
date less one day.

B Current Week. Selects records based on
the run week (Sun-Sat).

m Current Month. Selects records based on
the run month.

File: Bi11Cnt1.txt

Statement:

PROCESS record type (see page D-23)
File: Bi11Cnt1.txt

Statement:
DEFAULT CLOSE DAY = nn(see page D-18)

File: BiT1Cnt1.txt

Statement:

DATE SELECTION YYYYMMDD YYYYMMDD/
keyword (see page D-17)
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Setting Correlating Control File and Statement

Input—Date Selection (continued)

m Previous Day. Selects records based on
the run date, less one day.

B Previous Week. Selects records based on
the previous week (Sun-Sat).

B Previous Month. Selects records based on
the previous month.

B Current Period from Calendar. Selects
records based on the current period from
the CIMSCalendar table.

B Previous Period from Calendar. Selects
records based on the previous period
from the CIMSCalendar table.

For example, if you click Current Month,
records with end dates in the current month
are processed.

Output-Summary Date Range None

This setting is used to determine the
accounting dates in the CIMSBIll output
files. To ensure that the accounting dates are
calculated correctly, CIMS Lab strongly
recommends that you use the default
keyword, Auto. This setting enables CIMS
Server to calculate the accounting dates as
described in Accounting Dates on page 6-18.
Consult CIMS Lab before changing this
setting.

Back Load Data File: Bi11Cnt1.txt

When this check box is selected, the close ~ Statement:
dateisignored. The accounting dates created

D-1
by CIMSBIill are the same as the usage end BACKLOAD DATA (see page 0)
date, regardless of the close date.

Normalize CPU Values File: Bi11Cnt1.txt

Select this check box to normalize the Statement:

processing speeds of computers in the RMALIZE CPU VALUE D-22
system (see Normalizing CPU Values on N0 CPU VALUES (see page )
page 6-55).

Use Shift Codes File: Bi11Cnt1.txt

Select this check box to instruct CIMSBill to  Statement:

use the shift character specified in the USE SHIFT CODES (see page D-26)

CIMSAcct Detail record and apply the
appropriate rate shift value.
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B 6-34

Files Subtab
Use this subtab to define the CIMSBIll input and output files.

Setting Correlating Control File and Statement

Input File File: ProcessCntl.txt

The input file to be processed by CIMSBill. ~ Statement:
To select another file, click Browse. To edit

BillInputFile filename
the file in Windows Notepad, click Edit. 1 Pt 7

Output Files File: ProcessCnt1.txt

The names of the CIMSBIll output files (the Statement:
CIMSBIll Detail and CIMS Summary files).
CIMSBill writes these files to the path listed ) ]
above the file names. CIMS Lab BillSummaryFile f7lename
recommends that you use the default file

names.

BillDetailFile filename

Define Fields Subtab and Include/Exclude Records Subtab

These subtabs are used together to define data that you would like to include or exclude
for CIMSBIll processing. This is useful if there is certain data that your organization does
not want to report on. For a description of how to use these tabs, see Include/Exclude
Processing on page 6-58.

Proration Subtab

This subtab allows you to charge resources to more than one account. For a description
of the options on this subtab and how to use proration, see Prorating Resources on
page 6-49.

Note * Although you can perform proration using CIMSBill, CIMS Lab recommends
that you use the CIMSPrat program. CIMSPrat provides more options for proration
and enables you to prorate resources multiple times. For more information about
proration using CIMSPrat, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

CIMS Server will continue to support proration using CIMSPrat or CIMSBill.
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Client Subtab

Use this subtab to enable CIMSBIll to search for the applicable rate table (if you are using
multiple rate tables) and to dynamically add clients to the CIMSClient table.

Setting Correlating Control File and Statement

Enable client search File: Bi11Cnt1.txt

If you are using multiple rate tables, select ~ Statement:

this check box to enable CIMSBIll to search

the CIMSClient table for the rate table CLIENT SEARCH ON (see page D-16)
associated with a client. If this check box is
not selected, the STANDARD rate table is
used for all clients.

Add new clients to Client table File: Bi11Cnt1.txt

Select this check box to instruct CIMSBill to  Statement:

insert corresponding client entries in the

CIMSClient It)able fogr all clients that have a DYNAMIC CLIENT ADD ON (see page D-21)
resource usage charge, but are not entered in

the table. If you are using multiple rate

tables, you must also select the Enable

client search check box.

The inserted client entries will include
account names only if a matching top level
account is currently in the CIMSClient table.
For example, if account code AA exists in the
CIMSClient table and account code AABBB
is inserted, account AABBB is assigned the
same account name as AA. However,
contacts and budgets assigned to the top
level account are not copied to the client
that is added.

Note: This option can quickly fill up the
CIMSClient table. Use this option with
caution.

Account Code Search Fields File: Bi11Cnt1.txt

When CIMSBIll is searching the client table Statement:

or adding clients to the table, it needs to DEFINE (see page D-19)
know the account code structure that you

want to use. In the Account Structure box,

click the account code structure that you

want, and then click Populate Fields.

The account code structure appears in

Fields 1-9.

For more information about the account
code structure, see Setting Up the Account
Code Structure on page 3-3.
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Trace Subtab

Note ¢ By default, tracing is disabled. Consult CIMS Lab before using one of the
CIMSBIll trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSBill Message file,
BiT11Msg.txt:

m Date processing. Includes the CIMSBill run date, the input file usage end date(s), and
accounting start and end dates.

m Rate processing. Includes rate code information from the rate tables that are used
during processing.

B General processing. Includes options selected, high-low date calculation, and other
general processing messages.

m Client processing. Includes information related to the clients that are processed.

Setting Correlating Control File and Statement

Trace flag File: Bi11Cnt1.txt

Click Tracing Disabled, D - Trace Date Statement:

Processing, R — Trace Rate Processing, D-2
Y - Trace General Processing, or Z - Trace TEST D, R, Y, or Z (see page 0)
Client Processing.

B 6-36 CIMS Server Administrator's Guide



Processing Data H
CIMS Server Administrator Processing

Process Results Tab
This tab contains the following subtabs: CIMS Account, CIMS Bill, and Event Viewer.

CIMS Account and CIMS Bill Subtabs

B View Message File. Select this check box to view the most recent version of the
CIMSAcct/CIMSBIll Message file.

m View Results File. Click this to view the CIMSAcct/CIMSBIll Results file, which
describes results of the most recent CIMSAcct/CIMSBill processing.

m View Detail File. Select this check box to view the CIMSAcct/CIMSBIll Detail file.
m View Ident File (CIMSAcct only). Click this to view the CIMS Ident file.

m View Exception File (CIMSAcct only). Click this to view the exception file. This
button is unavailable if no exception file is available.

m View CSR Plus File (CIMSAcct only). Click this to view the CSR+ file. This file is
created if the Create CSR Plus check box is selected (see page 6-28).

® View Summary File (CIMSBill only). Click this to view the CIMS Summary file.

m View Proration Report (CIMSBill only). Click this to view the proration report. This
button is unavailable if no proration report is available

m Use External Viewer. When you select this check box and then click one of the
preceding buttons, the files open in Windows Notepad.

m Word Wrap. Select this check box to enable word wrap for the displayed files.

m Copy to Clipboard. Click this to copy the contents of the currently displayed file to
the Windows clipboard

Event Viewer Subtab

m Show Process Events. Click this to view all process events in the Event Viewer (see
page 6-38)

m Show All CIMS Events. Click this to view all CIMS Server-related events in the Event
Viewer

m Start Windows Event Viewer. Click this to open the Windows Event Viewer and view
system-wide events

Versions Tab
This tab provides the version number and path for CIMSAcct, CIMSBill, and CIMSORT.
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Processing Data Using CIMS Server Administrator

To process data using CIMS Server Administrator, click the process definition that you
want to process, and then click Process. You can also click Process in the Edit Process
Definition dialog box for the definition.

Note ¢ If you receive a warning stating that a file with the same date range has
already been loaded, you are probably loading duplicate data. You can click Yes to
continue to load the data, but you should delete the previous load immediately after
the current load is completed (see Tracking the History of Database Loads on page 5-23).

Viewing Events

B 6-38

CIMS Server Administrator enables you to view system events related to CIMS Server and
the processing of CIMS data. This is helpful if you want to see details about a processing
job and any associated problems with it. To view these events:

1 In the CIMS Server Administrator main window, click Chargeback

Administration » Processing » Event Viewer. The Event Viewer dialog box appears

as shown in example Figure 6-4.

= Eyent Viewer

Wi

CIMS Everts |
Fitter

Machine Marme: |(LOCAL) Browese...
Mumber of Days: 7
Apply Fiters
Results
= Processing -

- Z/EBFZ005
=] % Ident File Load Process ID: Z00S02282150400665
Information: 1:50:40 PM: Load Parameters
o Information: 1:50:41 PM: Load Results
Detail File Load Process ID: Z00S0Z2282150400322
Summary File Load Process ID: ZO00E0EEZ8E150400086
CIMEEILL Process ID: Z00E0ZZ2132E03351
CIME Sort Process ID: ZOOE0DZE2Z1L0390E57Z
CIMEACCT Process ID: ZO00E0ZZ213503343
Ident File Load Process ID: ZO00E0EEZ8E141Z90Z4%F Evs

F- - - - F -

Event Message:

Process: ldent File Load ~
Process |d: 2005022582150400665
Load Parameters

Input Filename: C:Program FilesWCIMSLabSample ProcessesMainframeDB2Wdent txd
Database Connection: Provider=S0LOLEDE 1 Extended v

vyincowves Event Wiewer | Close |

Figure 6-4 « Event Viewer Dialog Box

2 Click any event to view the event message at the bottom of the dialog box. To view

Windows system-wide events, click Windows Event Viewer.
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3 If you want to change the criteria for the events that appear, use the options in the
Filter area, and then click Apply Filters.

Note ¢ To refresh the list of events in the Event Viewer dialog box, press <F5>.

Setting Up Account Codes and Performing Account Code
Conversion

This section describes the account codes structure and how to define and convert the
account code.

Defining the Account Code Structure

One of the first steps in implementing CIMS Server is deciding on a final account code
structure. The structure is the chargeback hierarchy for the organization. The levels of this
hierarchy are arranged from highest to lowest level within the account code. The account
code can consist of up to 128 characters.

For example, your final account code structure could consist of:
DDDcCccccuuuuuuuu

D = Division (three characters) (highest level)

C = Cost Center (four characters)

U = User (eight characters) (lowest level)

Note ¢ You can use business rules to map identifiers to applications in addition to
or instead of business units, departments, cost centers, etc.

The next step is to set the account code structure in CIMS Server Administrator, see
Setting Up the Account Code Structure on page 3-3.

Once you have set up the account code structure, you can create an account code
conversion table to convert the identifier values in the input file into an account code
that fits within the final hierarchy pattern.
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Defining the Account Code

The account code is derived from an identifier or identifiers in the input file. In CIMS
Server Administrator, you need to specify the identifier(s) that you want to use to define
the account code as follows:

m If the input file contains an Account_Code identifier, the Account_Code identifier value
is automatically used to define the account code. If this value fits your account code
hierarchy, you can use the value as your account code. If this value does not meet your
account code requirements, you can convert the value to the appropriate account
code.

m If the input file meets any of the following criteria, you need to specify an identifier
or identifiers that you want to use to define the account code:

e The input file does not contain an Account_Code identifier.

¢ The input file contains an Account_Code identifier, but you want to use other
identifiers instead.

¢ The input file contains an Account_Code identifier and other identifiers that you
want to use. In this case, you must define the Account_Code identifier in addition
to the other identifiers.

If the identifier values fit your account code hierarchy, you can use the combined
values as your account code. However, in most cases you will need to convert
combined values to the appropriate account code.

The identifiers that you use (either via the Account_Code identifier values or the
identifiers that you specify) are referred to as the account code input field. For an
example of how to define an account code input field, see Figure 6-5 on page 6-47.

To define the account code input field:

Note * You do not need to define the account code input field if the input file
contains the Account_Code identifier and you are using only it to define your account
code.

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Account Options tab.
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4 Complete the Account Codes subtab as follows:

e Account Fields. Define the identifier(s) that you want to use for the account code
input field beginning at Field 0 and continuing sequentially as needed.

If you want to use the full value for an identifier, use an offset of 1 and the length
of the longest identifier value as defined in the input file. For example, if the
longest identifier value is 7 characters, type 1 as the offset and 7 as the length.

If you want to use a portion of the identifier value, use the offset position at which
you want to start the value and the corresponding length. For example, if you want
to start the 7-character identifier value at the second character, type 2 as the offset
and 6 as the length. You could also select a shorter length if you wanted to further
reduce the identifier value length.

You can define up to 10 account fields (Field 0 - Field 9). The maximum number
of characters for an account field is 128.

Note ¢ Although the maximum number of characters for each account field is
128, the overall length of all account fields added together cannot exceed 128
characters.

Also, keep in mind that the total output account code, including any literals
and move field values, cannot exceed 128 bytes.

The corresponding control statement in the AcctCnt1.txt file is ACCOUNT FIELD
(see page D-5).

¢ Convert account fields to uppercase during processing. Select this check box to
convert lowercase account code input field values to uppercase values in the
resulting account code. For example, the value ddic would be converted to DDIC.
By using this option, CIMSAcct account code processing becomes case-insensitive
and makes defining account conversion tables much easier.

The corresponding control statements in the AcctCnt1.txt file is UPPERCASE
ACCOUNT FIELDS (see page D-13).
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Setting the Account Code Conversion Options

B 6-42

To perform account conversion, regardless of whether you are using the Account_Code
identifier or another identifier, you need to set the conversion options described in this
section and create an account code conversion table as described on page 6-44. Account
codes are assigned by matching identifier values in the input file records to the values in
the account code conversion table.

For an example of how to set the account code conversion options, see Figure 6-5 on
page 6-47.

To set the account code conversion options:
Complete the Account Codes subtab as follows.

B Perform Account Code Conversion. If this check box is selected, the account code
conversion occurs as defined by the following Define Field and Move Field settings
and the account code conversion table:

The corresponding control statement in the AcctCnt1.txt file is ACCOUNT CODE
CONVERSION (see page D-5).

m Define Fields. Use this area to specify the offset and length of the account code input
field values that you want to use for conversion. Begin at Field 0 and continue
sequentially as needed. Note that if you created the account code input field using
account fields as described in To define the account code input field: on page 6-40, the
define fields correlate to the account field values, not to the original identifier values
in the input file.

For example, if you defined the following two identifiers as account fields, the
resulting account code input field value would be JJJJJJUUUUUUU, where J represents
the Jobname identifier and U represents the User identifier.

e Account Field 0—Jobname offset 2, length 6
e Account Field 1—User offset 1, length 7

You would set the Define Field 0 to offset 1, length 6 and Define Field 1 to offset 7,
length 7. You could also select a shorter length if you wanted to further reduce the
define field value.

You can define up to 10 define fields (Field 0 - Field 9). The maximum number of
characters for a define field is 128.

Note ¢ Although the maximum number of characters for each define field is 128,
the overall length of all define fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and
move field values, cannot exceed 128 bytes.

The corresponding control statement in the AcctCnt1.txt file is DEFINE FIELD (see
page D-7).
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® Move Fields. Use this optional setting to include either the define field(s) value or a
literal in the output account code.

If you specify a define field as the move field, the define field value will be included
in the account code. For example, if the define field represents the Jobname value DDIC,
DDIC will appear at the beginning, end, or within the account code as specified in the
account code conversion table.

If you specify a literal, the literal value will be included in the account code. For
example, if the type a literal value of A/P, A/P will appear in the at the beginning, end,
or within the account code as specified in the account code conversion table. The
literal can be a maximum of 40 characters.

For an example of how move fields are used, see Account Code Conversion Example on
page 6-46.

Begin at Field 0 and continue sequentially as needed. You can define up to 10 move
fields (Field O - Field 9).

Note ¢ Although the maximum number of characters for each move field is 128,
the overall length of all move fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and
move field values, cannot exceed 128 bytes.

The corresponding control statement in the AcctCnt1.txt file is DEFINE MOVEFLD (see
page D-8).

m Conversion Table. This is the file name for the account code conversion table. If the
table is located in the definition folder for the process, the file name appears without
the path. If the table is located in a location other than the process definition folder
(e.g., you are using the same table for multiple processes and have the table in a
central location), the file path appears.

To select a table, click Browse. To edit the table, click Edit. To create a table, see
Creating an Account Code Conversion Table on page 6-44.

The corresponding control statement in the ProcessCnt1.txt file is
ACCTCODECONVERSIONTABLE f£7T7ename.

m Enable Exception Processing. Select this check box to enable exception file
processing. This instructs the system to write all non-matched records to an exception
file. If this check box is not selected, the records that are not matched are written to
the CIMSAcct Detail file with the unconverted account code input field value.

If you enable exception processing, do not include a default account code as the last
entry in the account code conversion table (e.g., ", ,DEFAULTCODE"). If a default
account number is used, records will not be written to the exception file.

The corresponding control statement in the AcctCnt1.txt file is EXCEPTION FILE
PROCESSING ON (see page D-9).
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The account code conversion table contains the definitions required to convert the
identifier values defined by the account code input field to user-defined output account
codes. For an example of how to create the account code conversion table, see Figure 6-6
on page 6-48.

Consider the following when creating the account code conversion table:

m The account code conversion table is case-sensitive. For convenience, you can enter
uppercase values in the table and then select the Convert account fields to uppercase
during processing check box on the Account Codes subtab (see To define the account
code input field: on page 6-40). This is especially helpful it you are using one account
code conversion table for multiple process definitions. This ensures that account code
input field values that are lowercase or mixed case are processed.

m Each record in the table can be up to 386 characters (129 for the low identifier, 129
for the high identifier, and 128 for the new account code).

B The identifier fields follow these rules:

e FEach low and high identifier field is compared to the corresponding account code
input field values. If the compares are true, the account code is assigned.

e Thelow identifier fields are padded with x'00” and the high value fields are padded
with xX'FF'.

¢ The high identifier field is set equal to the low field plus the high padding when
the high identifier field value is null.

B You can include a default account code as the last entry in the account code
conversion table by leaving the low and high identifier fields empty (e.g.,
“, ,DEFAULTCODE"). In this case, all records that contain identifier values that do not
match an entry in the account code conversion table will be matched to the default
code.

m Ifyoudo notinclude a default account code, input file records that contain identifier
values that do not match an entry in the account code conversion table are written to
the CIMSAcct Detail file with the unconverted account code input field value.

If you want unmatched records to go to an exception file for reprocessing at a later
time, you need select the Enable Exception Processing check box on the Account
Codes subtab (see page 6-42). If you enable exception file processing, make sure that
you have not included a default account code entry in the account code conversion
table.

m If the PRINT ACCOUNT NO-MATCH statement is included in the AcctCntl.txt file, a
message is printed in the CIMSAcct Message file showing the identifier values from
the input file that were not matched during account code conversion. If this statement
is not present, only the total number of unmatched records is provided. The system
prints up to 1000 messages.

® The number of definition entries that you can enter in the table is limited only by the
memory available to CIMSAcct.
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To create an account code conversion table:

1 In the Conversion Table box, CIMS Lab recommends that you type the default file
name AcctTabl.txt, which is also the default for CIMS Data Collectors. However, you
can type any name in the format 777ename.txt.

2 Click Edit.

3 In the Account Code Conversion Table Maintenance dialog box, click Add Entry and
type the following for each account code input field value that you want to convert.

e The low and high identifier value that you want to use for conversion. You can
enter up to 10 fields of 128 bytes each for the low and high identifiers. (However,
all fields added together cannot equal more than 128 characters.) Each field must
be delimited by a colon (:).

For example, if you type AA as the low identifier and CC as the high identifier, all
account codes that begin with characters greater than or equal to AA or less than
or equal to CC are converted to the specified account code. If you type
AAAAAAAA:BB as the low identifier and CCCCCCCC:DD as the high identifier, all
account codes that begin with characters greater than or equal to AAAAAAAABB or
less than or equal to CCCCCCCCDD are converted to the specified account code.

The asterisk (*) and the question mark (?) characters can be used as wildcard
characters for both the low and high identifiers. Note that using the wildcard
characters can degrade performance; use them only when needed.

If you do not set a high value, the value is equal to the low value by default.
e The account code value that you want to convert to (maximum of 128 characters).

4 To set additional account code conversion entries, click Insert Entry. To remove an
entry, click the entry and then click Remove Entry.

5 Click OK when you are finished.

By default, the table is saved to the process definition folder. But you can move the table
to any location.
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Account Code Conversion Example
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Note  This section provides examples to supplement the preceding sections. Please
refer to these sections for more detailed information.

Assume that you want to use the User identifier values in an input file to define your
account code and that your account code is in the following structure:

DDDCCccuuuuuuuu
D = Division (three characters) (highest level)
C = Cost Center (four characters)

U = User (eight characters) (lowest level)

The following table shows the User identifier values that are in the input file records and
the corresponding account code that you want to convert the value to.

User

Identifier Division Cost Center User

Value from Final Account Account Account
Input File Account Code Code Code Code

DDIC = FINACTGDDIC = FIN ACTG DDIC

SAP = ISDDEVPSAP = ISD DEVP SAP
SAPCOMM = OPSMKTGSAPCOMM = OPS MKTG SAPCOMM
SAPSYS = MISPRODSAPSYS = MIS PROD SAPSYS
TEAM718 = MISTESTTEAM718 = MIS TEST TEAM718
TEAMF99 = OPSTESTTEAMEF99 = OPS TEST TEAMF99

To convert the User identifier values to the final account code, you would complete the
steps in the following sections.
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Define the Account Code and Conversion Options for CIMSAcct

In this example, the User identifier is entered for an offset of 1 and length of 7 because
you want to use the entire identifier value and the longest values (SAPCOMM, TEAM718, and
TEAMF99) are 7 characters.

For account code conversion, you need to define the value from the account field (USER)
at the full 7-character length. Because you also want to include the account field value at
the end of the account code, you need to define a move field for the value.

=ns Edit Process Definition "SAP

Wigw

Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions
General ] Filez  Accournt Codes l Shifts ] Trace ]

Account Fields

Identifier Offzet Lencth M
Field O USER 1 7
Field 1
Field 2
Field 3 3
Insert Entry | Remove Ertry

[v Convert account fields to uppercase during processing

Account Code Conversion
[v Perform &ccount Code Conversion

Define Fields: tdove Fields:

Offzet Length | # Offzet Length | Literal .
Field 0 1 7 Field 0 1 7
Fieldl 1 Fieldl 1
Field 2 Field 2
Field 3 & Field 3 &
—_ InsertErtry | Remove Entry Insert Entry | Remove Ertry
Carvversion Table:  |acctTabl tut Browse .. Edlt ..

[v Enable Exception Processing

Process Ok | Cancel | Apply |

Figure 6-5 + Defining the Account Code and Conversion Options Example
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Create the Account Code Conversion Table

The account code conversion table contains the following entries. Note that the high
identification code is not needed in this example because the low and high identification
codes are the same.

The @0 at the end of the account code value specifies that the move field defined in the
previous step will be included at the end of the account code. For example, the resulting
account code for the first table entry would be FINACTGDDIC. If you placed the @0 at the
beginning of the account code value, the resulting account code would be DDIC<three
spaces>FINACTG. You could place the @) anywhere in the account code.

4% Account Code Conversion, Table Maintenance

Tools

Account Table: C\Program FileshWCIMSLABSample ProcessestSAPACCt Tabl txd

Low Identification Code High Identification Code |Account Code Walue
DLDIC FINACTGEO
SAP ISDDEVPREO
SAPCOM OPSMETGEO
SAPETE MISPRODEO
TEAM71E MISTESTEO
TEAMF23 OPSTESTREO

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 6-6 * Creating the Account Code Conversion Table Example

If you had additional move fields defined, they would be represented by @1, @2, @3, etc.
For example, if you had used another identifier for account conversion in addition to
User and had defined move fields for each (move field 0 and move field 1), @ FINACTG@0
would place the value for move field 1 at the beginning of the account code and the value
for move field 0 at the end of the account code.

Process the CIMS Server Resource File

The converted account codes appear in the CIMSAcct Detail, CIMSBill Detail, and CIMS
Summary files.
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Prorating Resources

Note ¢ Although you can perform proration using CIMSBill, CIMS Lab recommends
that you use the CIMSPrat program. CIMSPrat provides more options for proration
and enables you to prorate resources multiple times. For more information about
proration using CIMSPrat, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

CIMS Server will continue to support proration using CIMSPrat or CIMSBill.

Proration is taking the overall or individual resources used by an account and
distributing those resources and the cost of the resources across multiple accounts at a
specified percentage.

A common use of proration is the equitable allocation of overhead costs across the user
community. An application or system that is normally assigned to the overhead category
tends to be one that does not produce metering data to the end user or account level, or
the processing of such data is considered too expensive to be practical at the end user or
account level.

For example, you have an application that controls print in a centralized environment.
To prorate the costs associated with this application among multiple accounts you need
to do the following:

m Assign the print program resource utilization and cost to a non-billable overhead
account.

m Set the proration options for CIMSBIll.

m Create a proration table assigning the percentage of print program costs for the non-
billable account to the accounts that you want to bill.

To set the proration options:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Bill Options tab.
4 On the Proration subtab, set the following options:

¢ Proration Type. Click type of proration to be performed: Resources or Money. For
a description of each option including its advantages and disadvantages, see
Prorating Resources vs. Prorating Money on page 6-54.

The corresponding control statements in the Bi11Cnt1.txt file are PRORATE MONEY
(see page D-23) and PRORATE RESOURCES (see page D-24).
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Match Length. The level of the account code that you want to match for proration.
For example, if you type 5, accounts AAABB, AAABBBB, and AAABBCC are
prorated. If you type 7, only accounts AAABBBB and AAABBCC are prorated.

This is included in the PRORATE MONEY or PRORATE RESOURCES statement in the
Bi11Cnt1.txt file. For example, PRORATE RESOURCES 5 where 5 is the match length.

Proration Table. This is the file name for the proration table. If the table is located
in the definition folder for the process, the file name appears without the path. If
the table is located in a location other than the process definition folder (e.g., you
are using the same table for multiple processes and have the table in a central
location), the file path appears.

To select a table, click Browse. To edit the table, click Edit. To create a table, see To
create a proration table:.

The corresponding control statement in the ProcessCnt1.txt fileis Bi1TMultFile
filename.

Print Proration Report. Select this check box to create a proration report as part
of the process. The report will reside in the process definition folder.

The corresponding control statement in the Bi11Cnt1. txt file is PRINT PRORATION
REPORT (see page D-25).

To create a proration table:

1

4

In the Proration Table box, type a name for the table in the format 777ename. txt, and
then click Edit.

In the Proration Table Maintenance dialog box, click Add Entry and type the
following for each account that you want to prorate to.

The original account code that you want to prorate from.
The account code that you want to prorate to.

The percentage that you want to prorate to the account code.

Note ¢ You can prorate resource costs at any percentage. The prorate
percentage can be less than or greater than 100 percent.

The individual rate code(s) that you want to prorate or A11 to prorate all rate codes.

To set additional proration entries, click Insert Entry. To remove an entry, click the
entry and then click Remove Entry.

Click OK when you are finished.

By default, the table is saved to the process definition folder. But you can move the table
to any location.
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Proration Table Examples

Assume that you want to split all resources used by overhead account code AAABB
among three different accounts: A1, A2, and A3. Al on average uses about 50 percent of
the resources assigned to the AAABB account, A2 uses about 30 percent, and A3 uses
about 20 percent.

Complete the Proration Table Maintenance dialog box as shown in Figure 6-7.

Proration Table Maintenance

Proration Table:  CProgram Files'CIMSLABSample ProcessesiGeorgeipurple txd

Original Account Code Mewy Account Code Percentage Rate Code
AALBE A1 a0 All
AALBE A2 30 All
AALBB A3 20 All

4| i ] >

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 6-7 « Proration Example 1
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You can also split individual resources among multiple accounts. Using the preceding
example, assume that the only resources from account AAABB that you want to prorate

are represented by the rate codes Z001 and Z002. Create the proration table as shown in
example Figure 6-8.

@44 Praration Table Maintenance

Proration Table:  CProgram Files'CIMSLABSample ProcessesiGeorgeipurple txd

Original Account Code Mewy Account Code Percentage Rate Code
AALBE A1 a0 Zoo1
AALBE A2 30 Zoo1
AALBE A3 20 Zoo1
AALBE 21 a0 ooz
AALBE A2 30 ooz
AALBB A3 20 o0z

1l | >

Adld Entry Remove Entry In=ert Entry |

OK I Cancel

Figure 6-8 * Proration Example 2

In this example, all resources other than Z001 and Z002 would still be charged to the
AAABB account.
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If you want to charge account AAABB for a portion of the resources used, for example

you want to charge account AAABB 40 percent and account AACCC 60 percent for all
resources, create the proration table as shown in example Figure 6-9.

@4 Proration Table Maintenance

Praoration Table:

CHProgram Files\CIMSLABSample Processes\Georgeipurple txd
Original Account Code Mewy Account Code Percentage Rate Code
28058 28058
28058 AARCC

B0 All
40 Al

>
e || B 5

iRemove Entry | Insert Entry |

OK Cancel

/d
Figure 6-9 « Proration Example 3
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In CIMS Server Administrator, you can set the option to prorate on resources or on
money. Both options display the same prorated units and charges in Web reports.
However, you cannot drill down on resource units by identifier if you prorate by money.
The following describes the advantages and disadvantages of prorating resources and
prorating money:

Prorating resources. The CIMSAcct Detalil file from CIMSSort is prorated before
CIMSBIll applies rates and figures money and a new CIMSAcct Detail file is built with all
the prorated resources. The new CIMSAcct Detail file is then used in the CIMSBill
process.

An advantage of prorating resources is that the CIMSBill Detail records match the records
in the CIMS Summary file. Therefore, users can drill down on resource units by identifier
when viewing invoices in CIMS Server Web Reporting. A disadvantage is that the
CIMSBIll Detail file can contain a potentially large number or records.

Prorating money. The CIMS Summary file is prorated just before CIMSBill ends. A new
CIMS Summary file is built with the prorated values.

An advantage of prorating money is that the CIMSBIll Detail file contains fewer records
than it would if you prorated by resources. A disadvantage is that the CIMSBill Detail
records do not match the CIMS Summary records and drilling down by identifier will
not produce accurate data.
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Normalizing CPU Values

Computers within an organization have different processing speeds. This speed
difference might cause users to request that their work be run on the faster machine to
reduce costs. This situation could lead to heavy workloads on the faster computers while
the slower units stand idle. To avoid this problem, you can normalize the processing
speeds to more evenly charge for CPU utilization. That is, you can assign a percentage of
the original CPU time used by a system rather than the actual time to be used during the
billing process.

For example, your organization has two z/OS systems, AL90 and AL95. System AL95 is
20 percent faster than AL90. If you use AL95 as the base system, use a factor of .80 to
normalize AL90 to reflect the speed of AL95.

Note ¢ Due to the disparity between the way different operating systems capture
performance statistics, it is not desirable to normalize the processor times between
platforms (e.g., z/OS to UNIX or UNIX to Windows).

To perform normalization, you need to do the following:

m Select the CPU Value option for the rate code or codes for which you want to perform
normalization.

m Set the normalization factor for the applicable system or systems.
m Select the Normalize CPU Values option for the process definition.

To set the rate code as a CPU value:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Chargeback Table Maintenance » Rate Codes.

2 In the Rate Code Maintenance List dialog box, click the rate code that you want to set
as a CPU value, (for example, Mainframe CPU Minutes [Z003]), and then click Edit.

3 Select CPU Value check box, and then click OK.

Note - If this item is not checked, the rate code value will not be normalized
during CIMSBill processing.
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To set the normalization factor by system:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » CPU Normalization.

2 Click Add in the CPU Normalization Maintenance List dialog box.
3 Enter the following:

e System ID. The name of the system. For z/OS, this is the four-character System
Model ID, for UNIX and Windows, it is the computer name. Note that the input
file must contain an identifier named System_ID to identify the system name for
CIMSBIll.

e Work ID. The subsystem name. This is any other system value that can narrow the
normalization (i.e., the CICS region name, the DB2 plan name, the Oracle
instance, etc.). Note that the input file must contain an identifier named Work_ID
to identify the subsystem name for CIMSBIll.

e Factor. This is the actual normalization factor. In the example at the beginning of
this section, this would be .80.

4 Click OK.

An example of a configured CPU Normalization List Maintenance dialog box is shown
in Figure 6-10.

an5 CPL Normalization List Maintenance

Wigw

System ID | Application or Subsystem | Mormalization Factor

| o | |

Figure 6-10 + CPU Normalization List Maintenance Dialog Box

To edit or remove a factor, click the factor, and then click Edit or Remove. Note that you
cannot change the System or Work ID when you edit the factor.
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To set the CPU normalization option for the process definition:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Bill Options tab.
4 On the General subtab, select the Normalize CPU Values check box.

The corresponding control statement in the Bi11Cnt1.txt file is NORMALIZE CPU
VALUES (see page D-22).

About Ghost Machines

Many organizations attempt to perform normalization against a “ghost machine”. This
is the factor applied to all the processors in the enterprise today, using as a base the speed
of the slowest machine running in the environment. In an attempt to keep costing
philosophy as simple as possible, the old technology “ghost” system is kept as the
baseline for processor speed. This concept worked well when processor speeds were
relatively constant. However, as processor speeds continue to increase, it becomes
difficult to relate the higher CPU speeds of today’s computers to older technology. CIMS
Lab recommends that processor speed factors be restricted to those multipliers and
divisors applicable to the existing environment.
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Include/Exclude Processing

By default, CIMSBIll processes all records within the input CIMSAcct Detail file.
However, you might want to process only certain records or you might want to exclude
certain records. This is useful if there is data that your organization does not want to
report on.

You can exclude records by date using the date selection option in CIMS Server
Administrator. See page 6-27 to set this option for CIMSAcct and page 6-32 to set this
option for CIMSBill.

You can also include or exclude records by identifier values in the records. For example,
you might want to exclude all records that contain a particular Jobname identifier value.

To include or exclude records by identifier values, you need to do the following in CIMS
Server Administrator:

m Define identifier fields that you want to use.

If the input record identifier fields that you want to include or exclude are other than
System_ID, Work_ID, or Account_Code, you need to define identifier fields that you
want to use. The values for these defined identifiers are stored consecutively
beginning at starting position 301 of the CIMSAcct Detail file (see page B-8 for the file
layout).

If you want to include or exclude System_ID or Work_ID identifier fields, you do not
need to define the fields. The values for these identifiers are always stored at starting
positions 57 and 90 (respectively) of the CIMSAcct Detail file.

If you want to include or exclude the Account_Code identifier field, you do not need
to define the field unless the account code has been converted. If the account code
has been converted, the code (stored in position 163 of the CIMSAcct Detail file) will
not match the Account_Code identifier value in the input record. You need to define
the field so that the original identifier value is used.

m Define the identifier fields for CIMSBIll.

m Specify whether you want CIMSBill to include or exclude the defined fields.
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To define the input record identifier fields that you want to include or exclude:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Processing » Process Definitions.

2 In the Process Definition List dialog box, click the process definition that you want,
and then click Edit.

3 Click the CIMS Account Options tab.

4 On the General subtab, enter the following in the Include Fields area beginning at
Field 0:

¢ The identifier name that you want to use to include or exclude records. For
example Jobname, Server, User, etc.

e The offset position at which you want to start the identifier value that you want to
include or exclude. If you want to start the identifier value at the first character of
the value, type 1. If you want to start the identifier at the second character, type 2,
etc. For example, you could start the eight-character Jobname identifier value
DFMALEQZ at position 1, which specifies the full value or at any other position such
as position 4, which specifies just ALEQ2. This would specify that only those records
with Jobname identifier values that contain ALEO? are included or excluded from
processing.

¢ The length of the identifier value. This can be the entire length of the identifier
value starting at the offset position, or a shorter length. Using the preceding
example of ALEO2, you might want just ALE. In this case, you would type a length
of 3.

Note * The overall length of all include fields added together can not exceed
60 characters.

The corresponding control statement in the AcctCnt1.txt file is INCLUDE FIELD (see
page D-10).

If you want to specify more than one identifier for include/exclude processing repeat
these steps for each identifier. However, consult CIMS Lab before doing this to
determine if it is necessary.

To insert an entry in the Include Fields area, click Insert Entry. To remove an entry, click
the entry and then click Remove Entry.
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To define the identifier fields for CIMSBiIll:
1 Click the CIMS Bill Options tab.

2 On the Define Fields subtab, click Add Entry and enter the following for each field
that you specified on the CIMS Account Options » General subtab (see page 6-59).

e Atwo-character ID for the identifier. You will use this ID to specify the records that
you want to include or exclude (see To include or exclude the defined fields in
CIMSBill Processing).

* The offset position at which you want to start the identifier value that you want to
include or exclude. Unlike the offset position 1 through x that you specified for
CIMSAcct processing, this is the position in the CIMSAcct Detail file in which the
identifier value begins. As with the offset position used by CIMSAcct, you can
specify any offset position within the identifier value. For example, if the Jobname
identifier value DFM begins at position 301, you can set the offset at 302 to specify
just FM. This would specify that only those records with Jobname identifier values
that contain FM are included or excluded from processing.

e The length of the identifier value. This can be the entire length of the identifier
value starting at the offset position, or a shorter length.

e An optional description of the field.
The corresponding control statement in the Bi11Cnt1.txt file is Define (see page D-19).

To insert an entry on the Define Fields subtab, click Insert Entry. To remove an entry,
click the entry that you want to remove and then click Remove Entry. To add an entry,
click Add Entry.

To include or exclude the defined fields in CIMSBIll Processing

On the Include/Exclude Records subtab, click Add Entry and enter the following for
each field that you specified on the CIMS Bill Options » Define Fields subtab:

m Click Include or Exclude.
m Click the identifier ID that you created in To define the identifier fields for CIMSBill:.

m In the Low Value and High Value fields, type the range for the identifier values that
you want to include or exclude. For example, if you want to include only those
identifiers that start with ALI type ALI in both fields. If you want identifiers that start
with ALI and ALE, type ALE as the low value and ALT as the high value.

The corresponding control statements in the Bi11Cnt1.txt file are EXCLUDE (see
page D-21) and INCLUDE (see page D-22).

To insert an entry on the Include/Exclude Records subtab, click Insert Entry. To remove
an entry, click the entry that you want to remove and then click Remove Entry. To add
an entry, click Add Entry.
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Include/Exclude Processing

Include/Exclude Processing Example
Assume that you have a CSR+ from a z/OS system with the following identifiers:

...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999, Jobname,BKMALIOL,Start_date,20050714...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI02,Start_date,20050715. ..
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALIO03,Start_date,20050716. ..
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999, Jobname, DFMALEQO]L, Start_date,20050714...
...System ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999, Jobname,DFMALEO2,Start_date,20050715. ..
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999,Jobname,DFMALEO3,Start_date,20050716. ..
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999,Jobname, LCHALUO1,Start_date,20050714. ..
...System ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999, Jobname, LCHALUOZ,Start_date,20050715. ..

..System_ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999,Jobname, LCHALUO3,Start_date,20050716. ..

You want to exclude those records that contain DFMin the Jobname identifier value. Define
the identifier field as shown in Figure 6-11.

=ns Edit Process Definition '05390°

Wigw

Process Options CIMS Account Options l CIMS Bill Options ] Process Results | “ersions

General l Files ] Account Codes] Shifts ] Trace ]

Process Type: |CIMS Server Resource Records j

Date Selection
_ strtoate: [
Keyword: |N0 Date Selection j aR
Endl Diate:
Include Fields
Identifier Offzet Lencth M
Field 0 JOBMAME 1 3
Fieldl 1
Field 2
Field 3 2
Inzsert Row | Remove Row

Cancel Apply

Process

Figure 6-11 « Edit Process Definition—Include Fields

In this example, only the first three characters of the Jobname identifier value are required.
Therefore, the offset is 1 and the length is 3.

CIMS Server Administrator's Guide 6-61 W



B Processing Data

Include/Exclude Processing

B 6-62

Next you need to define the identifier field for CIMSBIill as shown in example
Figure 6-12.

=42 Edit Process Definition "05390"

Wigw

Process Options I CIMS Account Optionz  CIMS Bill Options | Process Results I “ersions I

General I Filez= Define Figlds | Include f Exclude Recordsl Prorationl Client Search I Trace I

-~ Define Includes Exclude Fields

|Identifier | Offset |Length | Description
A1 301 3

Adld Entry Remove Entry In=ert Entry

Process | Ok I Cancel Apply |

|

Figure 6-12 + Edit Process Definition—Define Fields Subtab

In this example, the Jobname identifier value is assigned the ID A1 and begins in position
301 of the CIMSAcct Detail file (the starting position for include/exclude identifier
values).
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Next you need define DFM as the exclude identifier value as shown in example

Include/Exclude Processing

Figure 6-13. Records that contain DFMas the first three characters of the Jobname identifier

value will not be processed.

@ Edit Process Definition ‘05390

Wigw
Process Options I CIMS Account Optionz  CIMS Bill Options | Process Results I “ersions I

General I Files I Define Fields  Include [ Exclude Records | Proraﬁonl Client Search I Trace I

~ Define Includel Exclude Records

[idertifier  [Low value | High value

I IncludeExclude

21 DFt DFt

Adld Entry Remove Entry In=ert Entry

Process | OK I

Figure 6-13 « Edit Process Definition—Include/Exclude Records Subtab
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Rebilling Rate Codes After Changing Rate Code Values
and/or Conversion Factors

Important! < The following scripts change the data in the CIMS Server database. You
should back up the database before running these scripts.

You can recalculate rate codes that you previously processed and loaded into the CIMS
Server database using a different rate value and/or resource conversion factor without
reprocessing the data. That is, if you change the rate value and/or resource conversion
factor for arate code in the CIMSRate table, you can update the rate value and conversion
factor and recalculate the money value directly in the CIMSSummary table. (For more
information about the rate code value and resource conversion factor, see Working With
Rates on page 3-9.)

CIMS Lab provides the following scripts to perform this process:

B Rebill.wsf. This script updates the rate code value and recalculates the money value
for a rate code or codes in the CIMSSummary table. If you have not changed the
resource conversion factor for a rate code or codes, you do not need to run the
ResourceConversion.wsf script.

B ResourceConversion.wsf. This script updates the rate code resource conversion factor
in the CIMSSummary table. You need to run the Rebi11.wsf script after running this
script to recalculate the money value for the rate code.

Important! « Consult CIMS Lab before using the ResourceConversion.wsf script.
If you run this script more than once for the same rate code or codes, the resource
units that are converted are the units that were converted previously, not the
original units. For example, if the conversion factor for a rate code is Divide by 60
and the resource units are 120, the resource unit value after calculating once is 2,
after calculating twice it is.033 (2+60), etc.

This scenario is not applicable to the Rebill.wsf script—you can run this script
multiple times for the same rate code or codes.

For the parameters required for these scripts, see page C-22.
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About CIMS Financial Modeler

CIMS Financial Modeler is a Web-based program that enables CIMS administrators to
easily perform IT finance-related tasks, including the following:

m Determine usage-based cost allocation for resources.

m Calculate and set rates for resource usage (including updating rates in the CIMSRate
table).

m Perform cost analysis.

CIMS Financial Modeler presents data in a familiar spreadsheet format in which data is
presented in cost models containing cost pools and subpools. A cost pool represents the
overall category of costs while the subpool specifies specific cost drivers. For example,
the cost pool Software may contain the subpools Mainframe, UNIX, and Windows,
which contain software-related resource usage costs by computer platform.

CIMS Financial Modeler requires a CIMS user ID to access the application. The ID must
belong to a user group that has CIMS Financial Modeler access enabled (see Defining User
Groups on page 3-33).

When CIMS Financial Modeler is installed on the Web server, a virtual directory named
FinancialModeler is automatically created on the IIS Default Web Site (which is used for
CIMS Server Web Reporting).

Installing CIMS Financial Modeler
CIMS Financial Modeler is included in the CIMS Server installation.

You can also install CIMS Financial Modeler independently of the CIMS Server
installation. For example, you want to install the application with an earlier release of
CIMS Server.

You can find the CIMS Financial Modeler executable CIMSFinancialModelerSetup.msiin
the following locations:

m In the ...CIMSLab\Redist\CIMSFinancialModeler folder.

Bm On the CIMS Product CD or FIP site in the CIMSServer\FinancialModeler Install
folder.

m On the CIMS Server Product Downloads page on the CIMS Lab Web site.
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Starting CIMS Financial Modeler

You can start CIMS Financial Modeler in either of the following ways:

m From the Web browser, type http://servername/FinancialModeler, where
servername is the Web server name.

m From CIMS Server Web Reporting, click Admin » Financial Modeler. Note that the
Financial Modeler link appears only if the CIMS user ID that is used to log on to Web
Reporting belongs to a user group that has CIMS Financial Modeler access enabled.

Logging On to CIMS Financial Modeler

If auto logon is enabled for the CIMS user ID that you are using to access CIMS Financial
Modeler, you do not have to manually log on to the application. (To set the auto logon
feature, see Web Settings on page 3-49.)

If auto logon is not enabled for the CIMS user ID, the Login dialog box appears. Type the
user ID and password, and then click Login.

User Authentication for the CIMS Financial Modeler Web Site

If you want to use the auto logon feature with CIMS Financial Modeler, Windows
authenticated access must be set for the FinancialModeler virtual directory. For more
information about IIS authentication (see Set the User Authentication Method for the Web
Sites on page 2-67).
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Getting Started—Open or Create a Cost Model

When you log on to CIMS Financial Modeler, the Open Model dialog box appears. You
can either open an existing cost model from this dialog box or close the dialog box (click
Cancel) and create a new model.

The Open Model dialog box initially contains a cost model named CIMS Standard
Model. You can use this cost model as a reference or you can edit the cost model for your
organization.

Opening an Existing Cost Model

To open an existing model, click the model in the Open Model dialog box and then
click OK.

Creating a New Cost Model

To create a new model:

1

2

On the toolbar, click New. The Cost Model Wizard appears.
Type the model name (e.g., Storage) and then click Next.

On the Add Cost Pool page, type a name for the first cost pool that you want to create,
and then click Next.

On the Add Subpool page, create one or more subpools for the cost pool. Type each
subpool name in the Name box and then click Add. For example, if the cost pool is
Storage, you might add the subpools Windows, UNIX, and Mainframe. When you are
finished, click Next.

To remove a subpool, click the entry from the Subpools list, and then click Remove.
On the Add Another Cost Pool page, click Yes or No and then click Next.

If you click Yes, the Add Cost Pool and Add Subpool pages appear again.

If you click No, the Add Rate Codes to Model page appears.

Note ¢ You can add or remove cost pools and subpools at any time after
completing the wizard as described in Adding and Removing Cost Pools and Subpools
on page 7-7.
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6 On the Add Rate Codes page, select the rate codes that you want to appear in the cost
model and move them to the Selected Rate Codes box.

e If you want all move all rate codes to the Selected Rate Codes box, click the >>
button.

e If you want to move selected rate codes, click the codes that you want and then
click the > button.

You can move rate codes from one box to the other using the arrow buttons.

Note * You can add or remove cost rate codes at any time after completing the
wizard as described in Adding and Removing Rate Codes on page 7-9.

7 When you are finished, click Finish.

8 Click Save to save the cost model. The data in the model is saved in an XML file in the
...CIMSLab\Server\Web\FinancialModeler\data folder. The file names assigned to
the XML files do not include the cost model name. However, you can determine the
applicable cost model if needed by looking at the name attribute in the XML.

CIMS Financial Modeler opens with the Budget Values tab displayed. This tab shows the
cost pools and subpools that you created in the Cost Model Wizard. Use this tab to create
budgets for each subpool as described in Creating Budgets on page 7-6 and to add or
remove cost pools and subpools as needed.
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Setting Up Cost Models

Follow the steps in the following sections to set up cost models.

Creating Budgets

B 7-6

You need to create a budget for each subpool in a cost pool. A budget is the projected
cost for the resources represented by the subpool over a specific period of time.

To create budgets:
1 Click the Budget Values tab if it is not already selected.

2 Use Period Type select box to specify the type of budget that you want to create (daily,
weekly, monthly, or yearly) and then use the Number of Periods box to specify the
number of periods that you want to apply to the period type.

Example: If you want to create a six-month budget, click Months in the Period Type
box and then enter 6 in the Number of Periods box.

3 In the Enter Total Budget Amounts cell for each subpool, type the total budget
amount for that subpool. This amount is divided by the number of periods that you
entered in the Number of Periods box. The resulting charges appear in the Budget
Per <Day/Week/Month/Year> cell.

Note ¢ Throughout CIMS Financial Modeler, cells that you can type in are yellow.

Example Figure 7-1 presents six month budgets for storage and software resource usage.
In this example, the cost pools Storage and Software have been created and each cost
pool contains the subpools Windows, UNIX, and Mainframe.

File Wiew Action Help
A togout | [ Mew [ open [ save S Add Rate shored
“1% MewModel

Budget Values | Percent Allocation | Cost Calculations | Rate Calculations |

Specify period bype and number of periods and then enter the associsted budget katals For each poal.

Period Type: | Months = Mumber of Periods: & 3:

Storage Software

Windows UNIX Mainframe Windows UNIX Mainframe Total
Enter Total Budget Amounts 1,000,000 500,000 750,000 500,000 250,000 100,000 3,100,000
Budget Per Month 166,667 83,333 125,000 83,333 41,667 16,667 516,667

Use the Period Type and Number of Periods boxes
to define the type and length of the budget.

The numbers in the Budget Per <Period> cells are
the quotients of the total budget amount for the
subpool + by the value entered in the Number of
Periods box.

Ready User: deborah

Figure 7-1 « Setting Up Budgets
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Adding and Removing Cost Pools and Subpools

The Budget Values tab also enables you to add or remove subpools from a cost model.
When this tab is open, the Add Pool/Subpool and Remove Pool/Subpool buttons are
active or inactive on the toolbar depending on the cells that you have selected on the
Budget Values tab.

Note ¢ You can also use the commands in the Action menu to add and remove
Cost Pools and Subpools.

To add a cost pool:

1 Click any cost pool or subpool on the Budget Values tab and then click Add Pool.

File Wiew Action Help

- Shared

Etogout | [JnMew [ open [ save B add u| L Add Subpool I’ Del Fool
L Hewttodsl

Budget Values | Percent Allocation | Cost Calculations | Rate Calculations |

Specify period bype and number of periods and then enter the associated budget katals For each poal.

Period Type: | ¥ears = Mumber of Periods: & 3:

Storage Software
Windows UNIX Mainframe Windows UNIX Mainframe Total

Enter Total Budget Amounts 1,000,000 500,000 750,000 500,000 250,000 100,000 3,100,000
Budget Per Year 166,667 83,333 125,000 [EERE] 41,667 16,667 516,667

2 In the Add Cost Pool dialog box, type the pool name, and then click Next.

3 In the Add Subpool dialog box, create subpools for the cost pool, and then click
Finish.

The new cost pool and subpools appear on the Budget Values, Percent Allocation, and
Cost Calculations tabs.

To add a subpool:
1 Click the cost pool that you want to add the subpool to, and then click Add Subpool.
2 In the Add Subpool dialog box, do the following:

a Confirm that the cost pool that you want to create the subpool for is selected in
the Cost Pool box.

b Type the subpool name in the Subpool Name box.
3 Click OK when you are finished.

The new subpool appears under the applicable cost pool.

To remove a cost pool:

m Click the pool that you want to remove, and then click Del Pool.

To remove a subpool:

m Click the subpool that you want to remove, and then click Del Subpool.
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Distributing Budgeted Costs

The Percent Allocation tab enables you to distribute the budgeted amount for each
subpool by rate code. For each rate code within a subpool, enter the percentage of the
budget that you want to apply to that rate code as shown in example Figure 7-2. (Note
that the broken-line boxes in this example are for illustration purposes only and do not
appear in the application.)

File View Action Help
Bfogout | [Jnew [Fopen Bl save S addRate Shared
“ié MewModel
Budget Yalues  Percent Allocation ‘ Cost Calculations ‘ Rate Calculations ‘
Distribute cost For each pool by entering percentages,
Storage Software
Windows UNIX Mainframe Windows UNIX Mainframe Total
Enter Total Budget Amounts 1,000,000 500,000 750,000 500,000 250,000 100,000 3,100,000
Budget Per Month 166,667 83,333 125,000 83,333 41,667 16,667 516,667
DISKSIZE - M5 Windows Folder Disk L. .. 40% 0% 0% 0% 0% 0% 66,667
DISKFILE - M5 Windows Files in Folder B0% 0% 0% 0% 0% 0% 100,000
ILLR10S - Unix Fllesystem Used (GB D... 0%  35%l 0% 0% 0% 0% 29,167
LLR104 - Unix Filesystem Size (G Days) 0% 35% 0% 0% 0% 0% 29,167
IERIDB_—UHiX_Fi\ESyStin NL&hEr’ Df_ e mi . _30°.fﬂ 0% 0% 0% 0% 25,000
| ZDSK@@03 - Secondary Space Aloc... 0% 0% 40%] 0% 0% 0% 50,000
ZDSK@@0Z - Disk Space Used (Non ¥, .. 0% 0% 25% 0% 0% 0% 31,250
| ZDSR@@O1 - Disk Spare Allocated (M., 0% 0% 35%| 0% 0% 0% 43,750
EXEYSNT - M3 Exchange Bytes Sent 0% 0% 0% 75% 0% 0% 62,500
EXEYRCY - M5 Exchange Bytes Recei... 0% 0% 0% 25% 0% 0% 20,833
IL[G106 - Unix Process Tatal CPU (M., 0% 0% 0% 0%  45%l 0% 18,750
LLG105 - Unix Process System CPU (... 0% 0% 0% 0% 25% 0% 10,417
&Glﬂ‘?_—unixﬂﬂteiuselﬁu (Mll [ ﬂu L % L % i Di L _30"./_.:' 0% 12,500
17733 - DBZ Transactions {Records) 0% 0% 0% 0% 0% 5%l 9,167
‘5232—_DB2 Trﬂsact\ﬂ Cpﬂnuti e ﬂ’u S ifn S % S D°/_u S D".fn_ = _45°f1‘ 7,500
Total 100% 100% 100% 100% 100% 100% 516,667
Ready User: deborah

Figure 7-2 « Allocating Budgets

To view the actual cost allocations for the budgeted amounts, click the
Cost Calculations tab.
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Adding and Removing Rate Codes

The Percent Allocation tab also enables you to add or remove rate codes to and from a
cost model. When this tab is open, the Add Rate and Remove Rate buttons are active or
inactive on the toolbar depending on the cells that you have selected on the Percent

Allocation tab.

Note ¢ You can also use the commands in the Action menu to add and remove rate
codes.

To add a rate code:
1 Click any cell on the Percent Allocation tab, and then click Add Rate on the toolbar.

File Wiew Action Help

ﬂLDDDUt ‘jNew 1% open [ Save ;*C Add te L
15 Mewade! Add Rate Code

Budget Values  Percent Allacation | Cost Caleulations | Rate Calculations |

Distribute cast For each pool by entering percentages.

Storage

Windows UNIX Mainframe Windows UNIX Mainframe Total
Enter Total Budget Amounts 1,000,000 500,000 750,000 500,000 250,000 100,000 3,100,000
Budget Per Year 166,667 83,333 125,000 83,333 41,667 16,667 516,667
DISKSIZE - M3 ‘Windows Folder Disk ... 4% 0% 0% 0% 0% 0% 66,667
DISKFILE - M3 Windows Files in Folder B0 0% 0% 0% 0% 0% 100,000
LLR.10S - Unix Filesystem Used {GE D, 0% 35% 0% 0% 0% 0% 29,167
LLR.104 - Unix Filesystem Size (GE Days) 0% 35% 0% 0% 0% 0% 29,167

2 In the Add Rate Code dialog box, click the rate code or codes that you want to add,
and then click OK.

The new rate code or codes are added to the top of the displayed rate codes.

To remove a rate code:

m Click the rate code or rate codes that you want to remove, and then click Del Rate.
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Calculating Rates

H 7-10

The Rate Calculations tab enables you to determine the rates that you want to apply to
the rate codes in the cost model. By default, a rate is calculated as a zero cost value for
the budget that you entered for the period. You can use this zero cost value or enter any
rate value. After you have set the rate values that you want to use, you can use CIMS
Financial Modeler to automatically update the rate values in the CIMSRate table.

The following describes the options and columns on the Rate Calculations tab:

m Exclude Accounts. If you do not want resource units for a specific account or accounts
to be included in the rate calculations, click the + sign in the Exclude Accounts box.
Click the account or accounts that you want to exclude, and then click OK.

To remove accounts from the list of excluded accounts, click the accounts and then
click the - sign.

m Start Date and End Date. Use these boxes to select a date range for calculating the
actual number of resource units consumed during that range.

Once you have entered the data range, click Calculate Rates.

m Resource Name. The resources that you want to calculate rates for as specified on the
Percent Allocation tab.

m Budget Per <Day/Week/Month/Year>. The budgeted amount for each resource for
the day, week, month, or year.

B Total Units. The actual number of resource units consumed for each resource for the
date range selected in the Start Date and End Date boxes.

m Units Per <Day/Week/Month/Year>. This column presents the units adjusted to
match the budget period type. The values in this column are calculated based on the
total units, the number of days selected in the Start Date and End Date boxes, and
the period type as follows:

Period Type Days If the period type is days, the Units Per Day value is calculated
by dividing the value in the Total Units column by the number
of days specified in the in the Start Date and End Date boxes.

total units
number of days in date range

Example: Total Units=700, Date Range = 61 days, Units Per Day
is 11.47541 (700+61 rounded to 5 decimal places)

Period Type Weeks If the period type is weeks, the Units Per Week value is
calculated by dividing the value in the Total Units column by
the quotient of the number of days specified in the Start Date
and End Date boxes divided 7.

total units
number of days in date range+7

Example: Total Units=700, Date Range = 61 days, Units Per
Week is 80.32783 (700+[61+7] rounded to 5 decimal places)

CIMS Server Administrator's Guide



Working With CIMS Financial Modeler W

Per. Type Months
and
Per. Type Years
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Depending on number of days in the date range, calculations for
units per month and per year are more complex than calculating
days and weeks. The following are some examples of how units
per month and year are calculated.

Calculating Units Per Month Examples

m If the number of days specified in the Start Date and End
Date boxes are equal to full months, the Units Per Month
value is calculated by dividing the value in the Total Units
box by the number of months in the date range.

total units
number of months in date range

Example: Total Units=700, Date Range = August 1 through
October 31, Units Per Month is 233.33333 (700 + 3 months)

m If the number of days specified in the Start Date and End
Date boxes are not equal to full months, the Units Per Month
value is calculated by dividing the value in the Total Units
column by a factor that is determined by:

e Calculating the total number of days in the months that
the date range falls in divided by the number of months
that the date range falls in. Quotient = x.

¢ Dividing the number of days in date range by the quotient
x to get the factor.

Example: Total Units=700, Date Range = 45 days (September
1 through October 15), Units Per Month is 474.44444...

61 days + 2 months = 30.5
45 days in date range + 30.5 = 1.4754009...
700 + 1.4754098... =474.44444 ...
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Calculating Units Per Year Examples

m If the number of days specified in the Start Date and End
Date boxes are equal to full years, the Units Per Year value is
calculated by dividing the value in the Total Units box by the
number of years in the date range.

total units
number of years in date range

Example: Total Units=700, Date Range = January 1, 2005
through December 31, 2006, Units Per Year is 350 (700 + 2
years)

m If the number of days specified in the Start Date and End
Date boxes are equal to full months, the Units Per Year value
is calculated by multiplying the value in the Total Units
column by the applicable number to equal 12 months. That
is:

If the date range is 1 month, multiply by 12
...2 months, multiply by 6

...3 month, multiply by 4

etc.

Example: Total Units=700, Date Range = March 31 through
April 30, 2006 (two months), Units Per Year is 4200 (700 x
6)

m If the number of days specified in the Start Date and End
Date boxes are not equal to full years or full months, the
Units Per Year value is calculated by dividing the value in the
Total Units box by a factor that is determined by:

e Calculating the total number of days in the months that
the date range falls in divided by the number of months
that the date range falls in. Quotient = x.

¢ Dividing the number of days in date range by the quotient
x to get a factor and then dividing that factor by 12.

Example: Total Units=700, Date Range = 45 days (September
1 through October 15), Units Per Year is 5693.33333...

61 days + 2 months = 30.5

45 days in date range + 30.5 = 1.4754009...
1.475409... + 12 =.12295...

700 +.12295... = 5693.33333..))
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B Current Rate. The current rate for each resource as set in the CIMSRate table.

m Per 1000. An Min this column indicates that the rate for this resource is per thousand
units. The zero cost rate is calculated as follows:

budget amount + units per period
1000

For example, if the budgeted amount is 10,000 and the units per period amount is
5,000, the zero cost rate is .002 (10,000+5,000=2 and 2+1,000=.002)

m Zero Cost Rate.The zero cost rate for each resource (i.e., budgeted amount + units per
period=zero cost rate).

m Factor. A factor that you want to multiply the zero cost rate by to determine the new
rate for each resource. The default is one.

m New Rate. By default, the new rate for each resource is the zero cost rate. However,
you can enter any rate. The factor adjusts accordingly.

B Calculate Rates. Click this button to refresh the values on the Rate Calculations tab.

m Update Rates. Click this button to update the CIMSRate table with the rates in the
New Rate column.

Once you have updated the rates, the Update Rates button becomes the Rollback
Rates button. Use the Rollback Rates button in the following situations:

e You want to revert to the rates as they appeared when you opened the cost model.

* You have changed something in the cost model and want to update the rates again.

Important! ¢ If you want to roll back rates, make sure you click Rollback Rates
before you close the cost model. When you update rates and then close the cost
model, the initial rates are deleted.
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m 7-14

Example 1-Monthly Rate Calculation

Assume that you created a budget for a six-month period as shown in Figure 7-1 on
page 7-6. You want to determine the rates for this budget based on the actual resource
units consumed during a two-month period (September-October). In this scenario you
would set the start and end date as follows:

Budget Yalues | Percent Allocation | Cost Calculations  Rate Calculations|

Exclude Accounts + - StartDate: | 09/01/2005 -

End Date: |10,|’31,|’2005 j I CalculateRatesN [ Update Rates

Figure 7-3 shows example data based on this date range. Because the budget period type
is months and the days in the date range are equal to two full months, the units per
month are calculated by dividing the total units by two.

File Wiew Action Help

B8 Logout | | Mew [ Open & save [~ Shared

~1% MewModel |

B
Budget Values | Percent Allocation | Cost Calculations  Rate Calculations ‘
Exclude Accounts + - StartDate: | 09/01[2005 M
EndDate: | 10312008 ¥| [ Calculate Rates ] [ Update Rates ] [ Run Report
Resource Name Budget Per Month Total Units Units Per Month Current Rate Per 1000 | 2ero Cost Rate Factor New Rate

DISKSIZE - M3 Windows Folder Disk L. 66,667 S53317069296.06000 29158534645.03000 0.00010 " 0.00229 1 0.00229
DISKFILE - M5 Windows Files in Folder 100,000 39947331.00000 1997 3665.50000 0.00200 0.00501 1 0.00501
LLR105 - Unix Filesystem Used (G D, 29,167 25473118.00000 12739059.00000 0.00100 0.00229 il 0.00229
LLR104 - Unix Filesystem Size (GE Days) 29,167 234125589.00000 117062794.50000 0.00100 0.00025 1 0.00025
LLR103 - Unix Filesystem Number of ... 25,000 27433833.00000 1371944400000 0.00100 0.00182 il 0.00182
ZDSK@@03 - Secondary Space Alloc.., 50,000 15575286.11020 FTE7A43.05510 0.01300 0.00642 i 0.00642
ZDSK@@OZ - Disk Space Used (Mon V... 31,250 13447186.54960 B723593.27480 0.01300 0.00465 il 0.00465
ZDSK@@01 - Disk Space Allocated (M... 43,750 16610103, 14440 §305051.57220 0.01300 0.00527 1 0.00527
EXEVSMT - M3 Exchange Bytes Sent 62,500 101026527698.00... S0513263549.00000 0.00010 " 0.00124 il 0.00124
EXBYRCY - M5 Exchange Bytes Recel... 20,533 99759055312.00000 49579527906.00000 0.00150 " 0.00042 1 0.00042
LLG106 - Unix Process Total CPU (Min. .. 18,750 1899326.19400 949665,09700 0.03000 0.01974 il 0.01974
LLG105 - Unix Process System CPU... 10,417 2752133.60500 137606680250 0.01500 0.00757 1 0.00757
LLG104 - Unix Process User CPU (Min... 12,500 1143769.00400 571854.50200 0.01000 0.02186 il 0.02186
Z733 - DBZ Transactions (Records) 9,167 2835162.,00000 1417551.00000 0.01500 0.00647 1 0.00647
Z732 - DB2 Transaction CPU Minutes 7,500 2042352 62200 1021176.31100 0.01500 0.00734 il 0.00734

Ready User: deborah

M specifies the rate is per thousand. Zero cost rate is calculated as:
budget amount -+ units per period
1000

Figure 7-3 « Example 1—Monthly Rate Calculation
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Example 2—Excluding an Account Code

Assume that you are using the same scenario as shown in Example 1—Monthly Rate
Calculation on page 7-14, but you want to exclude resources for account code ATM from
the calculations. In this case, you would add the account code ATM to the Exclude
Accounts List, and then click Calculate Rates.

If you compare the following figure to Figure 7-3 on page 7-14, you see the data has
changed due to the excluded account code.

File View Action Help

8 Logout | ] Mew (5 Open H save | = Shared

“2 NewMods!

Budget Values | Percent Allocation | Cost Caleulations  Rate Calculations |
Exclude Accounts + - StartDate: | 03f01/2005 bed

Endpate | 10/3Lj2008  v| [ Caloulate Rates ] [ Update Rates ] [ Run Repart
Resource Name Budget Per Month Total Units Units Per Month Current Rate Per 1000 | Zero Cost Rate Factor New Rate

DISKSIZE - M5 Windows Folder Disk L. .. 66,667 38544712864.04000 19272356432,02000 0.00010 il 0.00346 1 0.00346
DISKFILE - M5 Windows Files in Folder 100,000 28780554, 00000 14390277.00000 0.00200 0.00695 1 0.00695
LLR10S - Unix Filesystem Used (GE D... 29,167 13345957.00000 B672993,50000 0.00100 0.00437 1 0.00437
LLR104 - Unix Filesystem Size (G Days) 29,167 222802366.00000 111401183.00000 0.00100 0.00026 1 0.00026
LLR103 - Unix Filesystem Mumber of ... 25,000 25135855, 00000 12569444.00000 0.00100 0.00199 1 0.00199
ZDSK@@03 - Secondary Space Allac... 50,000 14320641.37780 7160320,68550 0.01300 0.00695 1 0.00695
ZDSK@@0Z - Disk Space Used (Non ¥, .. 31,250 13332641.15750 BEEE320,56575 0.01300 0.00465 1 0.00465
ZDSk@@01 - Disk Space Allocated (M. .. 43,750 16475435.73230 823771786615 0.01300 0.00531 1 0.00531
EXEYSNT - M35 Exchange Bytes Sent 62,500 B7E49933377.00000 33324966633,50000 0.00010 il 0.00185 1 0.00185
EXEYRCY - M5 Exchange Bytes Recei... 20,633 B7546921245.00000 33773460622,50000 0.00150 il 0.00062 1 0.00062
LLG106 - Uniz Process Tokal CPU (Min... 18,750 156599154000 782995.77000 0.03000 0.02395 1 0.02395
LLG105 - Unix Process System CPU (... 10,417 2552344.50000 1276172,25000 0.01300 0.00816 1 0.00816
LLG104 - Uniz Process User CPU (Min... 12,500 1131424.00000 S65712.00000 0.01000 0.02210 1 0.02210
7733 - DB2 Transactions (Records) 9,167 262373700000 13113863.50000 0.01500 0.00639 1 0.00639
7732 - DB2 Transaction CPU Minutes 7,500 1173794, 26550 58639713275 0.01500 0.01275 1 0.01275

eady User: deborah

Figure 7-4 - Example 2—Excluding an Account Code
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Example 3—Changing the Factor

Continuing with the previous examples, assume that you change the factor from 1 to 2
for all resources. The new rate values automatically recalculate as shown in Figure 7-5.

File Wiew Action Help
ERiogout | [ mew [ open B save | = ol

“1% NewModz!

Burdget Yalues | Percent Allocation | Cost Caleulations  Rate Calculations |
Exclude Accounts + - StartDate: | 09/01/2005 h

EndDater [ 10/31/2008  w| [ CalulsteRates | [ UpdateRstes | [ RunReport
Resource Name Budget Per Month Total Units Units Per Month Current Rate Per 1000 Zero Cost Rate Factor New Rate
DISKSIZE - M5 Windows Folder Disk L. .. 66,667 38544712864.04000 19272356432.02000 0.00010 M 0.00346 4 0.00652
DISKFILE - M5 Windows Files in Folder 100,000 2873055400000 1439027700000 0.00200 0.006595 4 0.01390
LLR10S - Unix Filesystem Used (GE D... 29,167 1334598700000 B672993.50000 0.00100 0.00437 4 0.00574
LLR104 - Unix Filesystem Size (G Days) 29,167 222802366.00000 111401183.00000 0.00100 0.00026 4 0.00052
LLR103 - Unix Filesystem Mumber of ... 25,000 251355885.00000 125694 44.00000 0.00100 0.00199 4 0.003%5
ZDSK@@03 - Secondary Space Allac... 50,000 1432064137780 7160320.63590 0.01300 0.00655 4 0.01397
ZDSK@@0Z - Disk Space Used (Non ¥, .. 31,250 13332641.13750 BREA320.56575 0.01300 0.00469 4 0.00935
ZDSk@@01 - Disk Space Allocated (M. .. 43,750 1647543573230 823771786615 0.01300 0.00531 4 0.01062
EXEYSNT - M35 Exchange Bytes Sent 62,500 BTE49933377.00000 33524966655.50000 0.00010 M 0.00185 4 0.00370
EXEYRCY - M5 Exchange Bytes Recei... 20,633 B7S4A921245.00000 33773460622.50000 0.00150 M 0.00062 4 0.00123
LLG106 - Uniz Process Tokal CPU (Min... 18,750 1565991.54000 782995.77000 0.03000 0.02395 4 0.04759
LLG105 - Unix Process System CPU (... 10,417 2552344.50000 1276172.25000 0.01800 0.005316 4 0.01632
LLG104 - Uniz Process User CPU (Min... 12,500 1131424.00000 S65712.00000 0.01000 0.02z10 4 0.04419
7733 - DB2 Transactions (Records) 9,167 2623737.00000 1311868.50000 0.01500 0.00659 4 0.01397
7732 - DB2 Transaction CPU Minutes 7,500 1173794.26550 SB6897.13275 0.01500 0.01275 4 0.02556
Ready User: deborah

Figure 7-5 » Example 3—Changing the Factor

Sharing the Cost Model

By default, the a cost model can be opened only by the CIMS user that created the model.
To enable other CIMS users to open and modify a model, click Shared on the toolbar or
click Action » Share Model on the menu bar.

Note ¢ If you share a cost model, other users can delete the model.
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Managing Cost Models

To create a cost model:

Click the New on the toolbar or File » New on the menu bar and follow the instructions
provided in Creating a New Cost Model on page 7-4.

To save a cost model:

Click the Save button on the toolbar or File » Save on the menu bar.

To open a cost model:

Click the Open button on the toolbar or File » Open on the menu bar.

To rename a cost model:

Click File » Rename on the menu bar.

To delete a cost model:

Click File » Delete on the menu bar.

To close a cost model:

Click the Close button * or click Logout on the toolbar.
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Working With Reports

You can run reports that reflect the data presented in CIMS Financial Modeler. At this
time, only the Cost Comparison Report is available with CIMS Financial Modeler.
However, more reports will be added in future CIMS Server releases.

The Cost Comparison Report enables you to view the current and adjusted rates by
account code or resource.

Note ¢ The reports included with CIMS Financial Modeler are separate from those
used by the CIMS Server Web Reporting application. CIMS Financial Modeler reports
do not require the administration steps required for CIMS Server Web Reporting
reports.

Running Reports

To run areport:
1 On the Rate Calculations tab, click Run Report.

2 In the report parameters dialog box, enter the following parameters:

e Order Output By. Click Account or Resource. If you click Account, the data in the
report appears by account code. If you click Resource, the data in the report
appears by resource.

e Account Code Level. The account code level that you want to view in the report.
The resource use and charge data will reflect the level that you select. For more
information about account codes, see Setting Up the Account Code Structure on
page 3-3.

¢ Date Range. The range for the data that you want to appear in the report. Click
This Month, Last Month, Current Year, Previous Year, or Custom.

e From and To. Enter the beginning and end date if you selected Custom in the
Date Range box.

3 Click OK to run the report.

The report opens in Microsoft Excel in a separate Web browser window.
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Report Examples

The following are examples of the Cost Comparison Report by account code and
resource. With the exception of the output type, the parameters are the same for both
report types.

Cost Comparison Report by Account Code

In this example, the parameters are set as follows:

Cost Report

Cost Comparison Report

Order Oukput By ,m
Account Code Level ’W
Date Range | Custom -
Fram ’WSL‘
ro [toptos <]

The resulting report appears as shown in Figure 7-6.

ke | http:firoca-delxp/cimsserve rweb/costpoolmodel/Run. aspx - Microsoft Internet Explorer

File Edit Wiew Insert Format Tools Data  AdobePDF GoTo  Fawvorites  Help @ "@'

- | ® " Findit ¥ Reference “. Highlight [ Oblocked ~ § S5/°F - Screensavers,.co *
A3G2 - £

IBE A ‘ B | o | D | E ‘ F | G | HEg

1

2 |Cost Comparison by Account
|3 | Account Range: |All Accounts
4 Date Range: 09/01/2005 - 10/31/2005

IEll Account  [Resource [Resource Units |Current Cost |New Cost]
¥ |3 AA 262141318.51 567.40 567.37
k 126|BB 16658523081.50 123709.01123708.24
F [129|CC 727923209.02 111805.91111805.91
+ 218/ DD 9858337031.38 42650.71| 42651.02
# 278|EE 1616342006.44 27547.40| 27546.62
* 317|FF 412015490.28 10714.85 10715.03
+ 333|GG 1786939769.37 1264994 12649.98
= 384|Grand Total 31322221906.49  329645.22 329644.17
3685
388
7|
=
@ A
WA >ﬂ;ﬁ\Run/ |< 3

Figure 7-6 « Example Cost Comparison Report by Account Code

Note that the resource units and rates are accumulated for all of the resources for the
account code. To view units and rates by resource for an account code, click the + sign
next to the account code to drill down. In this example, account code BB is expanded as
shown in Figure 7-7 on page 7-20.
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Fe | http:{froca-delxp/cimsserverweb/costpoolmodel/Run.aspx - Microsoft Internet Explorer,

File Edit Wiew Insert Format Tools Data  Adobe PDF  GoTo  Favorites
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Figure 7-7 « Example Cost Comparison Report by Account Code Drill Down

Note that not all of the individual resources for account code BB are shown in the

example figure.
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Cost Comparison Report by Resource
In this example, the parameters are set as follows:

Cost Report

Cost Comparison Report

Order Oukput By IWLI
Account Code Level ’W
Date Range | Custom -
Fram ’WSL‘
ro [topatzes ]

The resulting report appears as shown in Figure 7-8.

e | http:/iroca-delxp/cimsserve rweb/costpoolmode l/Run.aspx - Microsoft Internet Explorer

File Edit View Insert Format Tools Dats Adobe PDF GoTo  Faworites  Help @ .-',f
v! ®° Fndit § Reference * Highliht [ Oblocked » 4% SeF - [ Screensaversco

> f
A e F c [ D [ RO i S o o |

Cost Comparison by Resource

Account Range: All Accounts
Diate Range: 09/01/2005 - 10/31/2005

1PRT 62544.00 940.80 938.16
DISKFILE 55809114.00 111617.49 111618.23
DISKSIZE 672356465.26 672.36 672.36
EXBYRCV 1669915412.00 2504.75 2504.87
EXBYSNT 718740656.00 7165 7187
EXEMRCV 20216.00 0.00 0.00
EXEMSNT 9390.00 0.00 0.01
FCSBytes 235752901.00 2358 2357
FlIS-2 3471.00 0.48 0.35
FlIS-3 1226.00 0.15 0.24
FlIiS4 19.00 0.00 0.00
66 [FIIS5 794.00 053 0.40

L] I::i » ;I\E;ﬂ? T e r<"" T

>

Figure 7-8 + Example Cost Comparison Report by Resource

Note that the resource units and rates are accumulated for all of the account codes for
the resource. To view units and rates by account code for a resource, click the + sign next
to the resource to drill down. In this example, resource rate code IPRT is expanded as
shown in Figure 7-9 on page 7-22.
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e | http:ffroca-delxp/cimsserverweb/costpoolmodel/Run.aspx - Microsoft Internet Explorer,

File Edit Wiew Insert

Farmat

Tools

Data  Adobe PDF  Go To

Favorites  Help

@

" Findit ¥ Reference *. Highlight 5‘ Oblocked - B¢ S3°F - E@ Screensavers.co
| c | D LE H@
2 |Cost Comparison by Resource
3 | Account Range: |All Accounts
4 Date Range: |09/01/2005 - 10/31/2005
5)
ll Resource  |Account |Resource Units |Current Cost |New Cost
[ 7 |1PRT A 8064.00 121.44 120.96
5 [1PRT BE 25040.00 436.32 43560
9 |1PRT cc 9312.00 140.16 139.68
10 [1PRT [B]n] 4344.00 74.40 74.16
11 [1FRT EE 11184.00 165.48 167.76
1PRT 62544.00 940.80 938.16
DISKFILE 55809114.00 111617.49/111618.23
DISKSIZE 672356465.26 672.36 672.36
EXBYRCV 1669915412.00 2504.75| 2504.87
EXBYSNT 718740656.00 71.65 71.87
EXEMRCV 20216.00 0.00 0.00
EXEMSNT 9390.00 0.00 0.01
FCSBytes 235752901.00 2358 2357 =
M 4 » WN\Run/ G [«i” ] >

Figure 7-9 « Example Cost Comparison Report by Account Code Drill Down

Note that in this example, account codes FF and GG (which were shown in the previous
report by account code example) did not consume resources for rate code 1PRT and are
not included in the report.

Saving, Printing, and Editing Reports

Because reports open in Excel within the browser, you can save, print, and edit the
reports using Excel commands. To view the Excel Standard toolbar in the browser, click
View » Toolbars » Standard.
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Troubleshooting and
Additional Information

This chapter describes problems you may encounter while setting up and using the CIMS
Server system and how to solve them. If you cannot find the answer to your question
here, please contact CIMS Lab (see Contacting Technical Support on page 8-23).
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Installation Problems

Installation Problems

Unable to launch regasm.exe error appears

This problem occurs because the current user does not have the correct permissions for
the following key in the Windows registry:

HKEY_CLASSES_ROOT\Component Categories\{62C8FE65-4EBB-45e7-B440-6E39B2CDBF29}

To resolve this problem, refer to the Microsoft Knowledge Base Article 327507.

Data Processing Problems

General data processing problems
You can use the following tools to diagnose general data processing problems:

m Check the Process Results tab for the process definition (Chargeback
Administration » Processing » Process Definitions). This tab provides message and
results files for both CIMSAcct and CIMSBILL. These files provide information about
errors encountered during processing. Also, click Show All CIMS Events on the Event
Viewer subtab and check for unusual messages.

® When processing data using CIMS Server Administrator, check the status bar in the
lower left corner of the Edit Process Definition dialog box to note the point in the
processing cycle that the error occurs.

B Check the Load Tracking dialog box (Chargeback Administration » Database
Loading » Load Tracking) to see of any database loads have completed.

For database problems:

m Enable the Simple recovery model for SQL Server (see Setting the Database Recovery
Model on page 5-5) to decrease the size of the SQL Server log files.

m View the messages in the SQL Server log (Program Files » Microsoft SQL
Server » MSSQL » Log).

When account codes are converted using CIMSAcct, some records seem
to be lost

Records that do not match any account code entries in the account code conversion table
are written to CIMSAcct Detail file with the unconverted account code. If you want
unmatched records to go to an exception file for reprocessing at a later time, you must
enable exception processing in CIMS Server Administrator (see Setting the Account Code
Conversion Options on page 6-42).
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System Problems

System Problems

A prompt for the Windows installation CD appears while your are using
CIMS Server Administrator

In most cases, Windows is calling for dependencies that are not essential for you to run
the application properly. Click Cancel when these messages appear.

Visit the Microsoft Web site and download all updates for your version of Windows and
Microsoft Office (if you use Office). These updates should include the necessary
dependent files.

If problems persist, contact CIMS Lab.

Performance of the CIMS Server system is slow

This could be caused by a number of things, including excessive network usage,
problems with the network, excessive CIMS Server usage, etc.

It is also possible that the database you are using has become so large that it is difficult
for the server housing the data to adequately store and access it. In this case, consider
archiving certain data or upgrading the machine. You can also off load non-essential or
non-CIMS-related processing to other machines.

Performance might also be affected by computer-related problems (see the following
problem).

Computer “locks up’, provides unexpected results, or seems to run very

slowly

There could be some type of memory problem. Close CIMS Server Administrator and
any other Windows applications. Reopen CIMS Server Administrator as the only
Windows application and see if the problem corrects itself. If that fails to correct it, close
Windows and then restart it. Open CIMS Server Administrator again and see if the same
results occur.

The computer might not have enough memory to process. Try running the application
on a computer with more memory (preferably 256 MB or more).
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Web Reporting Problems

Web Reporting Problems

Problems accessing the Web site or generating reports

The following are problems that might occur as you are using the CIMS Server Web
Reporting Web site to generate reports. The problems are presented in the order are they
are most likely to occur, beginning with accessing the Web site.

Problem Solution(s)

User cannot access the Web site

Web site is not opening properly or is

having problems starting

Verify that the users have appropriate
network permissions and are using
Internet Explorer 5.5 or later on the
Windows platform.

Verify the following:

B Your Internet or network connection is
working properly.

m User has appropriate network
permissions and are using Internet
Explorer 5.5 or later.

B User entered the correct URL.

m User has the required security
permissions for the CIMS Server
program folders discussed in Assign
Folder Security Permissions on the Web
Server on page 2-69.

If the following error appears, see
page 8-10 for a possible solution:

Microsoft OLE DB Provider for ODBC
Drivers error '80004005' [Microsoft]
[ODBC Driver 1 Data source name not
found and no default driver specified.

If this does not resolve the problem, try
the following:

m Restart IIS.

Click Start » Run. In the Open box,
type iisreset /restart, and then click
OK.

m Check the security settings on the
computer running the Web server (see
Set the User Authentication Method for the
Web Sites on page 2-67).

m Install the latest service pack for
Microsoft SQL Server.
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Problem Solution(s)

If using multiple Web sites, Web sites other In IIS Manager, navigate to the virtual

than the default Web site do not open. The directory for the Web site and do the
following message appears: following:

Server Error in '/virtual directory 1

name' Application Expand the virtual directory.

2 Right-click the CIMSReporting folder,
and then click Properties.

3 Click the Create button next to the
Application name box.

4 Click OK when you are finished.

Make sure that you copied the
...CIMSLab\Server\Web folder to create
the folder for the Web site. You must
recreate the Web site folder from the Web
folder each time that you upgrade to a new
CIMS Server release. For more
information, see Using Multiple Databases
for CIMS Server Web Reporting on page 5-9.

Auto logon feature is not working for a Check the following:

user.
1 The Enable Intranet Auto Logon check

box is selected on the Web tab of the
Configuration dialog box (see Web
Settings on page 3-49). This is the
default setting.

2 The correct domain name and user ID
is entered for the user in the User
Maintenance dialog box (see Defining
Users on page 3-28).

3 1IS is using Windows authenticated
access rather than anonymous access
(see Set the User Authentication Method
for the Web Sites on page 2-67). The
auto logon feature is not available if
anonymous access is enabled for IIS.
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Web Reporting Problems

Problem Solution(s)

Report parameters page does not open
when a report is selected—a 405 error
appears

Report parameters page opens, but report
is not generated from the page—one of the
following error occurs:

B A time-out message appears
immediately or the following message
appears:

-2147192179 An error has occurred on

the server in attempting to access
the data source

B A 404 “page not found” error appears.

Make sure that ASP.NET is installed and
enabled as follows:

1 Click Start » Run. In the Open box,
enter aspnet_regiis.exe -i preceded
by the path. For example,
Windows\Microsoft.NET\
Framework\<version number>\
aspnet_regiis.exe -i.

2 Make sure that ASP.NET is enabled as
described in Enabling ASP.NET on
page 2-17. (This is applicable to
Windows 2003 only).

3 Apply any Microsoft critical updates
with latest .NET service pack.

In CIMS Server Administrator, click
System Administration »

Database » Database Object. In the
Database Objects Manager dialog box,
add any database objects that do not exist
in the database (i.e., Exists = No). See
Managing Database Objects on page 5-15.

If this does not solve the problem, drop all
stored procedures, indexes, triggers, and
views in the Database Objects Manager
dialog box and then create them again.

Important! Do not drop the tables in the
Database Objects Manager dialog box.
Dropping a table removes the table and
its data from the database.

To view the detailed error message, run the
report directly from Crystal Reports (not
the Web).

Make sure that ASP.NET is installed and
enabled as described in Report parameters
page does not open when a report is selected—
a 405 error appears at the top of this page.
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Problem Solution(s)

B You are using Crystal Reports 10 and
clientdoc.dll failure occurs.

B You are using Crystal Reports XI and
the following message appears:

Failed to read data from report file
C:\WINDOWS\TEMP\tmp.rpt.

Reason: Failed to open print engine
for C:\WINDOWS\TEMP\tmpreport\
<report>. Ensure that CRPE32 is
installed on this computer.”

B You are using SQL Server Reporting
Services and the following message
appears:

The User Account <account name> does
not have adequate permissions in
Reporting Services. Make sure the
User Account belongs to the
Re$orting Services's <role name>
Role

Do the following:

m In Crystal License Manager, make sure
that the Crystal licenses are entered for
the Crystal Reports Advanced and
Embedded editions.

m Make sure that the Crystal Report
Application Server service is running
(Control Panel » Administrative
Tools » Services).

This error message occurs on Windows
2003 computers running IIS 6.0 where the
default application pool is running under
the Network Service account. This account
does not have sufficient rights to the fields
and registry needed to create a copy of the
report in the Crystal Reports enterprise
system.

To resolve this problem, do the following:

1 InIIS Manager, expand the Application
Pools folder.

2 Right-click DefaultAppPool, and then
click Properties.

3 In the DefaultAppPool Properties
dialog box, click the Identity tab.

4 Make sure that the Predefined radio
button is selected, and then select the
Local System account from the
Predefined drop-down list.

5 Restart IIS.

Make sure that the Windows user account
that is accessing the Web site has been
assigned to the Reporting Services role as
described in Assign Folder Security
Permissions on the Web Server on page 2-69.
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Web Reporting Problems

Problem Solution(s)

Report is generated, but the following
problems occur:

m General problems viewing the report.
For example, headers and data do not
appear.

m Old or sample data appears in the
report.

m Cannot drill down in reports.

m Cannot print report when using the
HTML viewer with Crystal Reports 9 or
10. The following message appears:

There was an error opening this
document. This file cannot be found.

Change the viewer used to view reports.
For more information, see Defining Users
on page 3-28 and Web Settings on

page 3-49.

Note: If you are using the Crystal Reports
ActiveX viewer, you may not have
administrative privileges to allow the
viewer to be automatically downloaded
and installed on the computer on which
you are trying to run the report. Use the
Crystal HTML or Java viewer instead.

One or more old loads have not been
removed from the database. Unload the
old data. For more information, see
Tracking the History of Database Loads on
page 5-23.

Certain items do not have any additional
information available. If you place the
cursor on an item and the cursor icon
becomes a magnifying glass or a hand, you
can drill down. If it does not, there is no
detailed information available about the
item.

When prompted to open or save the file,
click Save and then click Open.
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An error message appears When ActiveX Data Objects (ADO) or ODBC is
used to open a database connection in an ASP page

When you use ActiveX Data Objects (ADO) or ODBC to open a database connection in
an ASP page, you may receive the following error message:

Microsoft OLE DB Provider for ODBC Drivers error '80004005' [Microsoft]
[ODBC Driver 1 Data source name not found and no default driver specified.

Solution

Note * Make sure that you have completed the steps in Set the User Authentication
Method for the Web Sites on page 2-67 before continuing with this solution.

The Windows 2000/2003 user account that is used to process the request for the ASP
page does not have sufficient permissions to read the registry key that stores the specified
ODBC Driver's configuration information. The Driver parameter in a DSN-less
connection string specifies the ODBC driver that is used to establish the database
connection.

Grant the Windows 2000 user account Read access to the specified ODBC Driver registry
key as follows:

1 Determine which account is used to process the request for the ASP page.

2 From the Start menu, click Run, type regedt32.exe, and then click OK to start
Registry Editor.

3 In the HKEY LOCAL MACHINE window, browse to the
HKLM\SOFTWARE\ODBC\ODBCINST.INI key. The ODBCINST.INI key contains a
subkey for each ODBC Driver that is installed on the server.

4 Click the Driver registry key for the Driver that is specified in the ADO connection
string.

5 From the Security menu, click Permissions.

6 Add the user account that you identified in Step 1 to the list of users who can access
this key, and select the Read check box for this user.

7 Click Apply, and then close Registry Editor.

This information was taken from the Microsoft Knowledge Base Article 306345.
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Database Connection Problems

An error message appears when selecting a CIMS Data Source
(Oracle only)

The CIMS Data Source for an Oracle database assigns an Oracle user to the schema for
the CIMS Server database.

A trigger (Togon_schema) must also be created to assign the user to the schema.

It the schema defined in the trigger differs from the schema defined for the CIMS Data

Source, the following message appears when you select a CIMS Data Source in the Select
CIMS Data Source list.

Checking Oracle environment failed: The datasource schema name ’name’ does not
match the current schema ’name’

To correct the problem, change the schema defined in CIMS Data Source (see page 2-44)
or run the OraclelogonTrigger.bat script to change the schema in the trigger (see
page C-16).
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SQL Server Reporting Services Problems

Report Server cannot decrypt the symmetric key message appears

If you encounter the following error, you need to delete encrypted data from the Report
Server database and restart the ReportServer service.

The report server cannot decrypt the symmetric key used to access sensitive or
encrypted data in a report server database. You must either restore a backup key
or delete all encrypted content and then restart the service. Check the
documentation for more information.

To delete the encrypted data and restart, make sure that the ReportServer services is
running, and then do the following:

1 Click Start » Run.
2 In the Open box, type rskeymgmt -delete, and then click OK.

3 Type Y to delete the data, and the press <Enter>.

The user account does not have adequate permissions message appears
when you try to generate a report

H 812

If the following message appears when you try to generate a report:

The User Account <account name> does not have adequate permissions in Reporting
Services. Make sure the User Account belongs to the Reporting Services's <role
name> Role

Make sure that the Windows user account that is accessing the Web site has been
assigned to the Reporting Services role as described in Assign Folder Security Permissions
on the Web Server on page 2-69.
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Executing Stored Procedures to Debug CIMS Server

WARNING - Because some stored procedures update data, you should use care when
executing procedures for debugging. If you are unsure as to whether you should use this
feature, consult CIMS Lab.

You can execute stored procedures from CIMS Server Administrator for debugging
purposes. To execute a stored procedure:

1 In the CIMS Server Administrator main window, click System Administration »
Database » Execute Stored Procedure.

The Stored Procedure Execute dialog box appears.

2 On the Stored Procedures tab, click the stored procedure that you want to run, enter
the parameters for the procedure, and then click Execute.

When the stored procedure has finished running, the results appear on the Results tab.
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Creating a Test Database for Troubleshooting

For troubleshooting purposes, you might need to send a copy of your database to
CIMS Lab.

If you are using a SQL Server database, CIMS Lab recommends that you use the
SaveDBSQLServer.wsf script to detach the database and create a zip file containing the
database files. See Option 1: Using the SaveDBSQLServer.wsf Script.

If you are using an Oracle or DB2 database, or the zip file containing your detached SQL
Server database is too large to send to CIMS Lab, you can export data from the database
and send it to CIMS Lab. See Loading Data Into a Test Database on page 8-16.

Option 1: Using the SaveDBSQLServer.wsf Script

Note ¢ This script supports SQL Server only.

The SaveDBSQLServer.wsf script automates the process of detaching the database,
creating a zip file containing the .MDF and .LDF files, and reattaching the database. You
can then send the zipped database files to CIMS Lab.

Note ¢ You cannot use this script to detach the master database.

SaveDBSQLServer.wsf Script Parameters

The SaveDBSQLServer.wsf script uses the following parameters.

Parameter Description/Values

ServerName (required) The name of the server that contains the database.
DatabaseName (required) The name of the database.

ArchiveFilename The full path and file name for the output zip file that
(required) contains the .MDF and . LDF files.

0DBCUserID and The SQL Server user ID and password for the database

ODBCPassword (optional) (if required).

Table 8-1 « SaveDBSQLServer Script Parameters
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Option 2: Exporting Data From a Database

This option requires that you export the tables from the database and archive any
database loads that you want to include for testing. The archived load files are
automatically placed in a zip file. You should also create a zip file for the exported tables,
and then send the zipped archive and table files to CIMS Lab.

Export the Database Tables
To export database tables:

1 In the CIMS Server Administrator main window, go to the Select CIMS Data Source
box and click the CIMS Data Source for the database that you want to export tables
from.

2 Click System Administration » Database » Database Table Manager.
The Database Table Manager dialog box appears.
3 Click Select all tables.

The check boxes for all tables are selected. Note that the ability to select all tables is
dependent on the privileges assigned by your DBA.

4 Clear the following check boxes:

¢ Audit-Client, Audit-Client Contact, Audit-Client Contact Number, Audit-Rate,
and Audit-Transaction

e Detail, Detailldent, and Ident
e Load Tracking
e Summary, Summary Daily, and Summary to Detail

5 Click Export selected tables. (Note that exporting a table does not remove the table
or its data.)

6 A dialogbox appears, prompting you to select the location that you want to load the
tables to. Select the correct folder, and then click OK.

The exported tables are saved as comma-delimited text files with the same name as the
original table. For example, the CIMSRate table is exported as CIMSRate. txt.
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Creating a Test Database for Troubleshooting

Archive the Database Loads

To include database loads in the test database, you need to archive the loads that you
want from the original database. To archive loads:

1 In the CIMS Server Administrator main window, click Chargeback
Administration » Database Loading » Load Archiving & Purging.

The Load Archive dialog box appears.

2 On the Archive tab, select the loads that you want to include in the new database. (To
define the loads that appear on the Archive tab, set the options in the Loads Filter
and then click Apply Filters.)

3 Click Archive.

The archived loads are stored in a zip file in the path and folder shown at the bottom of
the Load Archive dialog box. This path is set on the Archiving tab of the Configuration
dialog box (see Database Load Archive Settings on page 3-55). The naming convention for
the zip file is CIMSArchive_StartDate_£ndDate_SequenceNumber.zip.

Loading Data Into a Test Database

B 8-16

Note ¢ The information in this section is intended for use by CIMS Lab technical
support personnel to load customer data into a test database.

Create the Database and CIMS Data Source ID

To create the database and CIMS Data Source ID, see Create a Database on page 2-27 and
Configure the CIMS Data Source for the Database on page 2-33.

Create and Load the Tables

1 In the CIMS Server Administrator main window, go to the Select CIMS Data Source
box and click the CIMS Data Source that you created for the test database.

2 In the Database Table Manager dialog box (System Administration » Database »
Database Table Manager), click Select all tables and then click Create selected
tables.

3 When the tables have been created, click OK.
4 In the Database Table Manager dialog box, clear the following check boxes:

¢ Audit-Client, Audit-Client Contact, Audit-Client Contact Number, Audit-Rate,
and Audit-Transaction

e Detail, Detailldent, and Ident
e Load Tracking
e Summary, Summary Daily, and Summary to Detail
5 Click Load selected tables, and then click OK in the subsequent message boxes.

6 A dialogbox appears, prompting you to select the location that you want to load the
tables from. Select the correct folder, and then click OK.
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Build the Database Objects

In the Database Objects Manager dialog box (System
Administration » Database » Database Objects Manager), click Select All and then
click Create Selected Objects.

Restore the Database Loads

1 In the Load Archive dialog box (Chargeback Administration » Database
Loading » Load Archiving & Purging), click the Restore tab.

2 Click Select All, and then click Restore.
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Performing Disaster Recovery

In the event that the CIMS Server application server becomes inoperable due to media
failure or natural disaster, the following steps are required to recover the CIMS Server
system (including all databases, reports, folders, and files) to a new server.

B 8-18

Note that these steps reflect CIMS Server application server, the database server, and the
Web server on one computer. If your previous installation included multiple servers, you
need to restore accordingly.

To recover the CIMS Server system on a new server:

1

2

3

Ut

Install Microsoft SQL Server.

Install Microsoft Internet Information Services (IIS).

Install CIMS Server with the same options as the previous installation.

Restore a full backup of the database or databases that you are using for CIMS Server.
Restore the backup of the Program Files\CIMSLab folder structure.

Restore the backup of the Processes folder.

If your Reports folder or any of its subfolders are not installed in the CIMSLab folder,
restore the backup of the Reports folder and/or subfolders.
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About CIMS Data Sources for SQL Server Databases

Note ¢ For more information about creating CIMS Data Sources, see Configure the
CIMS Data Source for the Database on page 2-33.

The number of ODBC Data Sources and CIMS Data Sources that you need to configure
for a SQL Server database depends on the number of logins that you created for the
database and the authentication method used for the logins. Table 8-2 shows the
different database login configurations that might be used and the ODBC Data Source(s)

and CIMS Data Source(s) required for each configuration.

Database Login(s)

ODBC Data
Source(s)

CIMS Data Source(s)

One login (Windows or SQL

Server authentication).

(This is a common
configuration.)

One ODBC Data
Source.

One CIMS Data Source.

x number of SQL Server
authenticated logins.

(This is a common
configuration.)

One ODBC Data
Source.

Separate CIMS Data
Sources for each login.

For example, if you
have one login for the
CIMS Server
administrator and one
login for the Web
reporting end users, you
need to create two CIMS
Data Sources for the
same ODBC Data
Source. The CIMS Data
Sources store the SQL
server ID and password
for each login.

x number of SQL Server
authenticated logins.

And

y number of Windows
authenticated logins.

(This configuration is
uncommon.)

One ODBC Data
Source for the SQL
Server
authenticated
logins.

One ODBC Data
Source for the
Windows
authenticated
logins.

Separate CIMS Data
Sources for each login.

One CIMS Data Source
for all logins.

y number of Windows
authenticated logins.

(This configuration is very rare.)

One ODBC Data
Source.

One CIMS Data Source
for all logins.

Table 8-2 « Possible ODBC Data Source and CIMS Data Source Configurations
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If You Are Using Crystal Reports Developer 8.5

If You Are Using Crystal Reports Developer 8.5

B 8-20

To use the Help system for Crystal Reports 8.5 on a computer with Internet Explorer 6.0
installed, follow the instructions on the Business Objects Web site (http://
support.businessobjects.com/library/kbase/articles/c2010291.asp).

Crystal Reports 8.5 requires that you set security permissions for certain folders. For
more information, contact CIMS Lab.

If you are using an Oracle or DB2 database, Crystal Reports 8.5 is not supported.

Important! ¢« You need to install the ActiveX patch for Crystal Reports provided on
the CIMS Lab FTP site (ftp://ftp.cimslab.com) and CIMS Product CD. The path on
both the FTP site and CIMS Product CD is CIMSServer\CrystalPatches\Crystal
Decisions ActiveX Viewer Patch.exe).
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Installing Crystal Reports 9

Crystal Reports 9 Advanced Developer Edition includes Crystal Enterprise 9 Report
Application Server Edition. You need to install both of these components and Crystal
Reports 9 Service Pack 2 in the following order:

1 Crystal Reports 9 Advanced Developer Edition (provided on the CD labeled Crystal
Reports).

2 Crystal Enterprise 9 Report Application Server Edition (provided on a separate CD
labeled Crystal Enterprise Report Application Server).

Note * Make sure that you install the Report Application Server Edition. Crystal
Reports 9 Advanced Developer Edition also includes a Crystal Enterprise 9
Standard Edition CD. Do not install the Standard Edition.

3 Crystal Reports 9 Service Pack 2. (Service Pack 2 is available from CIMS Lab. Do not
use a later Service Pack.)

To install Crystal Reports 9 Advanced Developer Edition:
1 Logon to Windows as a user in the Administrators group.
2 Do one of the following:

e Ifyou are installing from the installation CD, insert the Crystal Reports CD. If the
CD does not start automatically, browse to your CD-ROM drive and double-click
Setup.exe.

e If you are installing from another location, for example from a network drive,
double-click Setup.exe.

3 Click Install and follow the instructions in the Installation Wizard. CIMS Lab
recommends that you select the Typical installation in the Select Installation Type
dialog box.

To install Crystal Enterprise 9 Report Application Server Edition:

Follow the same steps provided for installing Crystal Reports. However, install Crystal
Enterprise Report Application Server Edition rather than Crystal Reports. CIMS Lab
recommends that you select the Full installation in the Installation Type dialog box.

To install Crystal Reports 9 Service Pack 2:

Crystal Reports 9 Service Pack 2 is available on the CIMS Lab FTP site (ftp://
ftp.cimslab.com) and CIMS Product CD. The path on both the FTP site and CIMS
Product CD is CIMSServer\CrystalPatches\Crystal 9 Patches\cr90win_en_spZ.exe).

Double-click cr90win_en_sp2.exe and follow the instructions in the InstallShield
wizard.
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Installing Crystal Reports 10

The following are the steps required to install Crystal Reports 10 Advanced Edition. This
edition includes Crystal Enterprise 10 Embedded Edition provided on a separate CD.

To install Crystal Reports 10 Advanced Edition:
1 Logon to Windows as a user in the Administrators group.

2 Do one of the following:

e Ifyou are installing from the installation CD, insert the Crystal Reports CD. If the
CD does not start automatically, browse to your CD-ROM drive and double-click
setup.exe.

e Ifyou are installing from another location, for example from a network drive,
double-click setup.exe.

3 Click Install and follow the instructions in the Installation Wizard. CIMS Lab
recommends that you select the Typical installation in the Select Installation Type
dialog box.

To install Crystal Enterprise 10 Embedded Edition:

Follow the same steps provided for installing Crystal Reports. However, install Crystal
Enterprise Embedded Edition rather than Crystal Reports. CIMS Lab recommends that
you select the Full installation in the Installation Type dialog box.
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Contacting Technical Support

The CIMS Lab Technical Support department is here to answer your questions on any
aspect of CIMS Lab products.

CIMS Lab technical support can be reached in the following ways:

m Telephone: (800) 283-4267 in USA and Canada; 916-783-8525 International
B Email: support@cimslab.com

m Fax request: (916) 783-2090

International customers may contact one of our authorized international partners.
Contact CIMS Lab for more information.

In addition, customers may visit the Customer Area on our Web site for product
downloads, updates, technical documentation, and password information. We are on
the Web at http://www.cimslab.com.
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This appendix describes the layout of all database tables used by CIMS Server and
provides Entity Relationship Diagrams (ERDs) for the tables in the CIMS Server

database.

CIMSAUItClIeNt Table ......c.vuiinininiiiiiiiiiieieiiiieieieieeeesencecesesescncasenencns A-4
CIMSAuditClientContact Table .........cccovuiuieiiiiiiiieiiiiiieieieniieeneneicecenenennns A-5
CIMSAuditClientContactNumber Table ..........ccciviiiiiiiiiiiiiiiiiiieiieieieneeienenens A-7
CIMSAUdItRAte TabI@ .....viuiniiiiiieiiitiienietetersesssnsnsnsosessssssnsssossssssasnes A-9
CIMSAuditTransactionTable ..........cooiiiiiiiiiiiiiiiiiiieieneieieieereecnenenensnnes A-11
CIMSCalendar TabIe ........ccuvuineiiiiiniieneeieneneeeenensnssescscsscssnsssscsanscnes A-14
CIMSClient Table ......ciuiuininiiiiiiiiiiieieneieieeeerereneesesesesscscncscscsssscnes A-15
CIMSClientBudget Table ..........ooiiniiiiiiiiiiiiiiiiiiieiiieiiiieieienseneeenencnnnns A-16
CIMSClientContact TADI@ ......cuvtntninieieiiiiieieniiieieneneeeesenesesesesencncanans A-17
CIMSClientContactNumber Table ..........ociiiiiiiiiiiiiiiiiiiiiiieieieiiiienenennens A-18
CIMSCONSIBTaDbIE ....vuiniiiiiiiiiiiiiiiiiitieiiiieieitneesesescaeasesescacssescscnnans A-19
CIMSConfigOptions Table .....c.vuiniiiiiiiiiiiiieieiiiiiieieieneseseeececncncsessnscnes A-21
CIMSConfigAccountLevel Table ........ciuiiiiiiiiiieiiiiiieieiiiieieienceenenencnenns A-22
CIMSCPUNormalization Table .........ccoeiiuininiuieiiiiieieniiieneneicecenencncenens A-22
CIMSDetail Table ......c.ovnininiiiiiiiiiiiitieiiiieieieneeieieneneeneencacssencncnnnns A-23
CIMSDetailldent Table ........cciviininiuieiiiiiieiiiieieieneeieteneneececesencncanens A-24
CIMSHeadline TabIe ......ouiuiniiiiiiiiiiiiieieieieieerereneneseseseescscncncsessssnes A-24
(614 L e 1) 41 I 1 ) A-25
CIMSINpSKcCategory Table ........cciuiiiiiiiiiiiiieeieeieieeiecscsocssssecacessescncnns A-25
CIMSInpSrcCategorySource Table .......c.ouvuiiiiiiiiiiiiiiiiieneireneenenenenenennes A-25
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CIMSInpSrcMachineList Table ........coviiiiiiiiiiiiiiiiiiiiiiiiiierieneencccnenscnens A-25
CIMSLanguUage Table ........cciuviiiiiieriiiitieeiereeieeesseceasesssccasesssssascnsones A-26
CIMSLoadTrackingTable ........ccoeuiuiiiiiiiiiiiieieienieieieieneeiencncssenenencanss A-27
(011 2= 1 L - ) A-29
CIMSRateGroup Table .......ciuiiiiiiiieiiiiiiieieeieieeieeseeacssssesscesssssnscnsanes A-32
CIMSRateldentifiers Table .........coeiiiiiiiiiiiiiiiiiiiiiieieiiieeeeiesccecesencncnnns A-32
CIMSRateShift TADIE .....cuiuiiiiiiitieiiiiiiietetersesesaceseroressssssssososessssasns A-33
CIMSRateToORateGroup Table .........ocieiuiiiiiiiiiieiiiiiiririeneneneincacarecnenenns A-34
CIMSREPOIITaDIE ....cuiiiniiiiiiiiiitiieeiieeieeeseeeessseccsscensssnsssnsssnccnnes A-34
CIMSReportCustomFields Table .........cociuiiiiiiiiiiiiiiiiiirieieieieieccnrnenenanss A-35
CIMSReportDistribution Table ..........c.coiiiiiiiiiiiiiiiiiiiiririeicicerererasessnens A-35
CIMSReportDistributionCycle Table .......ccoviiiiiiiiiiiiiiiiiiiieiiienreeienenececnnns A-36
CIMSReportDistributionParm Table ........ccviiiiiiiiiiiiiiiieieieiisererereesssssans A-37
CIMSReportDistributionType Table .........ccciiiiiiiiiiiiiiiieiiiieieieiieenenencanss A-37
CIMSReEpOIGIroUP TabIe .....vuuiniiiiiieiiiiiiieiieieenesnesecsecsesscscescsscccncnnes A-37
CIMSReportStart Table .......ccoieeiiiiiieiiieiiiiiieiiieiieeeeceseccnsssnscsnccsnccnnns A-38
CIMSReportTOReporGroup Table ......civiuiiiiiiiiiiiiiieierierieiecieencsecnccncnnes A-38
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CIMSAuditClient Table

If auditing is enabled, this table tracks changes made to the CIMSClient table. To enable
auditing of the CIMSClient table, see page 3-54.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSClient table
(see page A-15).

Field Name Key Type Field Description

TransType char(1) The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

DateTimeChanged datetime The date and time that the
change was made.

UserID char(30) The Windows user ID of the user
who made the change.

01dAccountCode char(128) The old client account code.

NewAccountCode char(128) The new client account code.

OTdATtAccountCode char(128) The old alternate client account
code.

NewAltAccountCode char(128) The new alternate client account
code.

OTdAccountName varchar(255)  The old client name.

NewAccountName varchar(255)  The new client name.

OldLoadTrackingUID int The old load tracking unique

identifier for the client.

NewlLoadTrackingUID int The new load tracking unique
identifier for the client.

OldRateTable char(8) The old rate table for the client.
NewRateTable char(8) The new rate table for the client.
OldInvoiceContact int The old index number for the

contact name that appears on
the invoice.
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Field Name Field Description

NewInvoiceContact int The new index number for the
contact name that appears on
the invoice.

OldActionCodel- char(1) The old action codes—see the

OldActionCode8 ActionCode field description for
the CIMSClient table.

NewActionCodel- char(1) The new action codes—see the

NewActionCode8 ActionCode field description for
the CIMSClient table.

CIMSAuditClientContact Table

If auditing is enabled, this table tracks changes made to the CIMSClientContact table. To
enable auditing of the CIMSClientContact table, see page 3-54.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSClientContact
table (see page A-17).

Field Name Key Type Field Description

TransType char(1) The type of change that was
made to the table:

m U = update to existing data
m [ = addition of new data

B D =deletion of data

DateTimeChanged datetime The date and time that the
change was made.

UserID char(30) The Windows user ID of the user
who made the change.

OldLoadTrackingUID int The old load tracking unique
identifier for the client.

NewlLoadTrackingUID int The new load tracking unique
identifier for the client.

OTdAccountCode char(128) The old client account code.

NewAccountCode char(128) The new client account code.

OldContactIdx int The old index number for the
contact.
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Field Name Key Type Field Description
NewContactIdx int The new index number for the
contact.
OldAddressLinel- varchar(255)  The old address line by line
0TdAddressLineb number.
NewAddressLinel- varchar(255)  The new address line by line
NewAddresslLineb number.
OldContactName varchar(255)  The old contact name.
NewContactName varchar(255)  The new contact name.
OldDepartment varchar(255)  The old contact department.
NewDepartment varchar(255)  The new contact department.
01dOffice varchar(255)  The old contact office.
NewOffice varchar(255)  The new contact office.
OldComments varchar(255)  The old contact comments.
NewComments varchar(255) The new contact comments.
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CIMSAuditClientContactNumber Table

If auditing is enabled, this table tracks changes made to the CIMSClientContactNumber
table. To enable auditing of the CIMSClientContactNumber table, see page 3-54.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the
CIMSClientContactNumber table (see page A-18).

Field Name

TransType

DateTimeChanged

UserlD

OldLoadTrackingUID

NewlLoadTrackingUID

OTdAccountCode
NewAccountCode
01dContactldx
NewContactldx

0TdNumberIdx

NewNumberIdx

O0ldNumberDescription

NewNumberDescription

Key Type

char(1)

datetime

char(30)

int

int

char(128)
char(128)
int
int

int

int

varchar(255)

varchar(255)

Field Description

The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

The date and time that the
change was made.

The Windows user ID of the user
who made the change.

The old load tracking unique
identifier for the client.

The new load tracking unique
identifier for the client.

The old client account code.
The new client account code.
The old contact index number.
The new contact index number.

The old index number for the
contact number or e-mail
address.

The new index number for the
contact number or e-mail
address.

The old contact number
description.

The new contact number
description.
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Field Name Key Type Field Description
OTdNumberValue varchar(255)  The old contact number.
NewNumberVaTue varchar(255)  The new contact number.
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CIMSAuditRate Table

If auditing is enabled, this table tracks changes made to the CIMSRate table. To enable
auditing of the CIMSRate table, see page 3-54.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSRate table (see

page A-29).
Field Name

TransType

DateTimeChanged

UserlD

OldLoadTrackingUID

NewlLoadTrackingUID

OldRateTable

NewRateTable

0T1dRateCode
NewRateCode

0TdRateIndex

NewRatelIndex

OldRateValue

NewRateValue

01dResourceValue

Key Type
char(1)

datetime

char(30)

int

int

char(8)

char(8)

char(8)
char(8)

int

int

decimal(18,8)

decimal(18,8)

decimal(19,4)

Field Description

The type of change that was
made to the table:

m U =update to existing data
m [ =addition of new data

m D =deletion of data

The date and time that the
change was made.

The Windows user ID of the user
who made the change.

The old load tracking unique
identifier for the rate code.

The new load tracking unique
identifier for the rate code.

The old rate table for the rate
code.

The new rate table for the rate
code.

The old rate code.
The new rate code.

The old index number for the
rate code.

The new index number for the
rate code.

The old per unit value for the
rate code.

The new per unit value for the
rate code.

Deprecated.
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CIMSAuditRate Table

Field Name

Field Description

NewResourceValue
01dDiscountDollars
NewDiscountDollars
01dDiscount
NewDiscount
01dDiscountIndex
NewDiscountIndex
OldDescription
NewDescription

OldFactor

NewFactor

OTldRateValuel -
OldRateValuell

NewRateValuel -
NewRateValuell

OldEffDate

NewEffDate

0ldTermDate

NewTermDate

01dComments

NewComments

decimal(19,4)
decimal(19,4)
decimal(19,4)
decimal(7,4)
decimal(7,4)
int

int
varchar(255)
varchar(255)

numeric

numeric

char(1)

char(1)

datetime

datetime

datetime

datetime

varchar(255)

varchar(255)

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

Deprecated.

The old rate code description.
The new rate code description.

The old resource conversion
factor.

The new resource conversion
factor.

The old rate values—see the
RateValue field descriptions for
the CIMSRate table.

The new rate values—see the
RateValue field descriptions for
the CIMSRate table.

The old effective date for the rate
code. For future use.

The new effective date for the
rate code. For future use.

The old end date for the rate
code. For future use.

The new end date for the rate
code. For future use.

The old comments for the rate
code.

The new comments for the rate
code.
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CIMSAuditTransactionTable

If auditing is enabled, this table tracks changes made to the CIMSTransaction table. To
enable auditing of the CIMSTransaction table, see page 3-54.

For a detailed description of the fields in this table (with the exception of TransType,
DateTimeChanged, and UserID), refer to the field descriptions for the CIMSTransaction
table (see page A-44).

Field Name Field Description

TransType char(1) The type of change that was
made to the table:

m U =update to existing
data or transaction
marked as deleted

m [ = addition of new data

DateTimeChanged datetime The date and time that the
change was made.

UserID char(30) The user ID of the user who
made the change (usually
the Windows user ID or the

SQL Server login ID).
OldTransactionUID char(32) The old unique identifier for
the transaction.
NewTransactionUID char(32) The new unique identifier
for the transaction.
0ldAccountCode char(128) The old account code for the
transaction.
NewAccountCode char(128) The new account code for

the transaction.

OldTransactionType char(1) The old transaction type—
see the TransactionType
field description for the
CIMSTransaction table.

NewTransactionType char(1) The old transaction type—
see the TransactionType
field description for the

CIMSTransaction table.
01dShiftCode char(1) The old shift code.
NewShiftCode char(1) The new shift code.
OldRateCode char(8) The old rate code.
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CIMSAuditTransactionTable

B A-12

Field Name
NewRateCode

0TdResourceAmount

NewResourceAmount

01dFrequencyl-01dFrequency?

NewFrequencyl-NewFrequency?

01dFromDate
NewFromDate
O1dToDate
NewToDate
OldDateTimeSent
NewDateTimeSent

0T1dDateTimeModified

NewDateTimeModified

OldDateTimeEntered

NewDateTimeEntered

OldDateTimeStartProcessing

NewDateTimeStartProcessing

OldDateTimeStopProcessing

NewDateTimeStopProcessing

char(8)
decimal(18,5)

decimal(18,5)

Int

Int

datetime
datetime
datetime
datetime
datetime
datetime

datetime

datetime

datetime

datetime

datetime

datetime

datetime

datetime

Field Description

The new rate code.

The old resource amount for
the transaction.

The new resource amount
for the transaction.

The old frequency number—
see the Frequency field
descriptions for the
CIMSTransaction table.

The new frequency
number—see the Frequency
field descriptions for the
CIMSTransaction table.

The old from date.

The new from date.

The old to date.

The new to date.

The old date and time sent.
The new date and time sent.

The old date and time
modified.

The new date and time
modified.

The old date and time
entered.

The new date and time
entered.

The old processing start date
and time.

The new processing start
date and time.

The old processing end date
and time.

The new processing end date
and time.
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Field Name Key Type Field Description

01dUserID char(8) The old CIMS user ID of the
user who made the change.

NewUserID char(8) The new CIMS user ID of the
user who made the change.

0ldDateTimeDeleted datetime The old date and time that
the transaction was deleted.

NewDateTimeDeleted datetime The new date and time that
the transaction was deleted.

OldNote varchar(255)  The old note for the
transaction.

NewNote varchar(255)  The new note for the
transaction.
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CIMSCalendar Table

This table defines the billing periods for a billing organization.

Field Name Key Type Field Description

Year PKa int The calendar year.

Period PKa int The calendar period (1 - 13).

PeriodBeginDate datetime The beginning date of the
period

PeriodEndDate datetime The ending date of the period

CloseDate datetime The processing close date.

a. PK = Primary Key
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CIMSClient Table

This is the primary table for storing client information. All other client tables are related
to this table.

Field Name Key Type Field Description

AccountCode PKa char(128) The account code for the client.

AltAcctCode char(128) The alternate account code for
the client (optional).

AccountName varchar(255)  The client name.

LoadTrackingUID int A unique identifier that tracks

the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback

System.
RateTable char(8) The rate table for the client.
InvoiceContact int The index number for the client

contact name that appears on
the invoice.

ActionCodel - ActionCode8 char(1) These user-defined codes are
strictly for reporting purposes
and can be used in the custom
reporting process for selecting
data. CIMS Server does not use
action codes.

a. PK = Primary Key
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CIMSClientBudget Table

This table stores budget and actual information for amounts and resource units by
account code, date, and rate code.

Field Name

LoadTrackingUID

AccountCode

RateCode

Year
Period

BudgetAmt

ActualAmt

BudgetUnits

ActualUnits

Key Type

int
PKa char(128)
PKa char(8)
PKa int
PKa int

decimal(19,4)

decimal(19,4)

decimal(18,5)
decimal(18,5)

Field Description

A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The account code for the client.

A valid rate code for an
individual resource budget or
TOTAL for an overall account
budget.

The budget year.
The budget period (0 - 13).

The budget monetary amount
for the period.

Deprecated. The actual amount
is in the CIMSSummary table.

The budget units for the period.

Deprecated. The actual units
consumed are in the
CIMSSummary table.

a. PK = Primary Key

B A-16

CIMS Server Administrator's Guide



Database Tables H

CIMSClientContact Table

This table stores client contacts.

Field Name Key Type
LoadTrackingUID int
AccountCode PKa char(128)
Contactldx PKa int
AddressLinel varchar(255)
AddresslLine2 varchar(255)
AddressLine3 varchar(255)
AddressLined varchar(255)
AddresslLine5 varchar(255)
ContactName varchar(255)
Department varchar(255)
Office varchar(255)
Comments varchar(255)

CIMSdientContact Table

Field Description

A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The account code for the client.

The index number for the
contact.

Address Line 1

Address Line 2

Address Line 3

Address Line 4

Address Line 5

The name of the client contact.
The contact department.

The contact office.

Comments related to the
contact.

a. PK = Primary Key

CIMS Server Administrator's Guide

A-17 R



H Database Tables

CIMS(dlientContactNumber Table

CIMSClientContactNumber Table

This table stores numbers (phone, fax, etc.) and e-mail addresses for contacts.

Field Name Key Type
LoadTrackingUID int
AccountCode PKa char(128)
Contactldx PKa int
NumberIdx PKa int

NumberDescription

NumberValue

varchar(255)

varchar(255)

Field Description

A unique identifier that tracks
the client when loaded to the
database from a location outside
of CIMS Server. For example,
from CIMS Mainframe Data
Collector and Chargeback
System.

The account code for the client.

The index number for the
contact.

The index number for the
contact number or e-mail
address.

The type of number (VOICE, FAX,
EMAIL, etc.)

The contact number or e-mail
address.

a. PK = Primary Key
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CIMSConfigTable

This table defines configuration options that have a GUI option in CIMS Server
Administrator. One CIMS Config record is allowed per CIMS Server database.

Field Name
OrgName
AddressLinel
AddressLine?
AddressLine3
AddressLined

InvoiceNo

InvoiceNumberType

Usel3Periods

UseCalender

ReportAccessSecurity

LocationStandardReports

LocationCustomReports
LocationSavedReports

DatabaseVersion

LastProcessUID

CustomReportGroupID

Key Type

varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)

int

char(1)
char(1)

char(1)

char(1)

varchar(255)

varchar(255)
varchar(255)
char(7)

int

int

Field Description

The organization name
Address Line 1
Address Line 2
Address Line 3
Address Line 4

Deprecated. This is stored in the
CIMSConfigOptions table.

Deprecated.

Indicates whether 13 periods are
used:

m Y (Yes)
m N (No)

Indicates whether the CIMS
calendar is used:

m Y (Yes)
m N (No)

Indicates whether report security
is used:

m Y (Yes)
m N (No)

The path to the CIMS standard
reports.

The path to custom reports.
The path to published reports.

The CIMS Server database
version number.

Used by CIMSAcct and CIMSBIll.

The unique identifier for the
default report group for user-
defined Web reports.
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CIMSConfigTable

Field Name

Field Description

CustomSpreadsheetGroupID

SessionTimeoutMinutes

AccountParameterSelecti
onLevel

DefaultCrystalViewer

DBConnectionTimeout

WebCustomSite

WebBGCoTor

WebCSSLocation

WebImagelLocation

WebMenuVertStartPos

LastReportingDate

int

int

int

int

int

char(1)

varchar(32)

varchar(255)

varchar(255)

int

datetime

The unique identifier for the
default report group for user-
defined Web spreadsheets.

The number of minutes before a
CIMS Server Web Reporting
session expires and a new login
is required.

In CIMS Server Web Reporting,
this setting determines the level
of account codes that appear in
the Starting Account Code and
Ending Account Code
parameter lists.

The unique identifier for the
browser viewer used to view
Crystal Reports.

The maximum number of
seconds that a database may
respond to a query before timing
out

Indicates the Web site to be
used:

m D (Default)
m ( (Custom)

The hexadecimal number for
the background color of a
custom Web site.

The path to the CSS for a custom
Web site.

The path to the images for a
custom Web site.

The start position (in pixels) for
the menu of a custom Web site.

The last reporting date for
reports that end users who do
not have administrative
privileges can view.
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CIMSConfigOptions Table

This table defines configuration options that the administrator can add manually in
CIMS Server Administrator.

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

PropertyValue varchar(255)  The value for the configuration
option.

PropertyType int The data type of the

configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMSConfigAccountLevel Table

This table defines the account code structure.
Field Name Key Type Field Description

AccountStructureName char(32) The account code structure
name (e.g., Standard).

StartPosition int The starting offset position
for the account code.

AccountlLevel int The account code level.

AccountlLength int The length of the account
code level.

AccountDescription varchar(255) A description of the account
code level.

CIMSCPUNormalization Table

The table allows for differences in CPU speed.

Field Name Key Type Field Description

SystemID PKa char(32) The system identifier for the
computer that you want to
normalize. For z/OS, this is
the four-character System
Model ID. For UNIX and
Windows, it is the computer
name.

WorkID PKa char(32) The subystem name (e.g.,
CICS region name, DB2 plan
name, Oracle instance, etc.).

Factor decimal(10,4) The normalization factor.

a. PK = Primary Key
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CIMSDetail Table

This table stores the information contained in the CIMSBill Detail file. The table
contains the resource information collected from the records in the input CSR or CSR+
file. Each record in this table represents a single resource used/time period. This is the
most granular form of the resource data stored in the database.

Field Name Key Type Field Description

LoadTrackingUID int The load tracking unique
identifier from the
CIMSLoadTracking table.

DetailUID int The unique identifier that tracks
the CIMSBIll Detail load.

Detailline int The number of the record in the
input CSR or CSR+ file that
contains the resource (i.e., 1 ifit
is the first record, 2 if it is the
second record, etc.).

AccountCode char(128) The account code.

Aggregate int A count of the number of
original input records that have
been aggregated into this record.

StartDate datetime The resource usage start date.

EndDate datetime The resource usage end date.

ShiftCode char(1) The resource usage shift code.

AuditCode varchar(255)  The audit code (CIMS External
Transaction records only).

SourceSystem char(8) The system identifier for this
resource.

RateCode char(8) The rate code of this resource.

Resourcelnits decimal(18,5) The quantity of the resource
used.

AccountingStartDate datetime The accounting start date.

AccountingEndDate datetime The accounting end date.
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CIMSDetailldent Table

This table stores the information contained in the CIMS Ident file. The table contains the
identifier values collected from the records in the input CSR or CSR+ file. The identifier
names are stored in the CIMSIdent table and are represented by a number assigned to
the identifier name.

Field Name Key Type Field Description

LoadTrackingUID int The load tracking unique
identifier from the
CIMSLoadTracking table.

DetailUID PKa int The unique identifier that
tracks the CIMSBIll Detail
load.

DetaillLine PKa int The number of the record in

the input CSR or CSR+ file
that contains the identifier
(i.e., 1ifitis the first record,
2 if it is the second record,

etc.).

IdentNumber PKa int A sequential number
assigned to the identifier in
the CIMSIdent table.

IdentValue varchar(255)  The value of the identifier.

a. PK = Primary Key

CIMSHeadline Table

This table defines the headlines that appear on the CIMS Server Web Reporting home

page.

Field Name Key Key Field Description

HeadlineUID PKa int The sequential UID that
tracks the headline.

HeadlLineDate datetime The date that the headline
was created.

Headline varchar(255)  The headline text.

Headlinelink varchar(255)  The URL for the headline

link.

a. PK = Primary Key
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CiMSIident Table

This table stores all identifier names contained in the input CSR or CSR+ files processed.
As a file is processed, the identifier names in the file records are added to this table. This
table will continue to store identifier names even if the identifiers are no longer used by
records loaded in the database. To delete unused identifier names if needed, see
Maintaining Identifiers on page 3-40.

Field Name Key Type Field Description

IdentNumber PKa int A sequential number
assigned to the identifier.

IdentName varchar(32) A short name for the
identifier.
IdentDescription varchar(255) A full description of the

identifier name (optional).

IdentActiveFlag char(1) Indicates whether Active or
Inactive has been selected for
custom reports:

m Blank (Active)

m I (Inactive)

IdentReportFlag char(1) User-defined report flag.

a. PK = Primary Key

CIMSInpSrcCategory Table

This table is for future use.

CIMSInpSrcCategorySource Table

This table is for future use.

CIMSInpSrcMachineList Table

This table is for future use.
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CIMSLanguage Table

B A-26

This table is for future use. It is intended to display GUI options (menus, links, etc.) in
CIMS Server Web Reporting in the required language.

Field Name

StringName

ENG
SPA
FRA
DuT
ITA
GER
FIN
SWE
JPN
POR

OTH

Key Type

PKa

varchar(80)

varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)
varchar(255)

varchar(255)

Field Description

The tag name in the Web
reporting ASP page.

The GUI option in English.
The GUI option in Spanish.
The GUI option in French.
The GUI option in Dutch.
The GUI option in Italian.
The GUI option in German.
The GUI option in Finnish.
The GUI option in Swedish.
The GUI option in Japanese.

The GUI option in
Portuguese.

The GUI option in another
language.

a. PK = Primary Key
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CIMSLoadTracking Table

CIMSLoadTracking Table

This table records the loading of any data to the database. This enables database loads to

be deleted if required.

Field Name

LoadTrackingUID

FileType

FiTeName

Dateloaded

DateDeleted

TotalRecslLoaded

StartDate

EndDate

SourceSystem

SourcefFeed

Key Type

PKa

int

char(8)

varchar(255)

datetime

datetime

int

datetime

datetime

varchar(32)

varchar(32)

Field Description

The unique identifier for the
database load.

The type of file processed:

B Summary
B Detail (CIMSBIll Detail)
m Ident

m Resource (CIMSAcct
Detail)

The path and name of the
file that was processed

The date and time the input
CSR or CSR+ file was
processed by CIMSAcct.

The date and time the load
was removed from the
database.

The number of records
loaded.

The accounting start date for
CIMS Summary, CIMS
Detail, and CIMS Ident
records. The usage end date
for resource records.

The accounting end date for
CIMS Summary, CIMS
Detail, and CIMS Ident
records. The usage end date
for resource records.

The name of the computer
that produced the data.

The system that produced
the data (e.g., IIS, Exchange,
z/OS, etc.)
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CIMSLoadTracking Table

Field Name Key Type Field Description

DateArchived datetime The date and time that the
load was archived.

Archivelocation varchar(255)  The location of the archived
load.

LoadGroupUID int The unique identifier for the
group that the database load
belongs to.

a. PK = Primary Key
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CIMSRate Table
CIMSRate Table
This table stores the rate codes and rates for resource usage.
Field Name Key Type Field Description
LoadTrackingUID int The unique identifier that

tracks the rate when loaded
to the database from a
location outside of CIMS
Server. For example, from
CIMS Mainframe Data
Collector and Chargeback

System.

RateTable PKa char(8) The name of the rate table
that contains the rate code.

RateCode pKa char(8) The code for the rate.

RateIndex int The index number for the
rate code.

RateValue decimal(18,8) The per unit value for the
rate code.

ResourceValue decimal(19,4) Deprecated.

DiscountDollars decimal(19,4) Deprecated.

Discount decimal(7,4)  Deprecated.

DiscountIndex int Deprecated.

Description varchar(255) A description of the rate
code.

Factor decimal(15,8) A user-defined resource

conversion factor value for
the resource unit value in
reports.

RateValuel char(1) Indicates whether four
decimal positions are used
in the rate value in reports:

m  (Four digits are used)

m Blank (Eight digits are
used [the default])
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CIMSRate Table

B A-30

Field Name

RateValue?2

RateValue3

RateValued

Key Type
char(1)

char(1)

char(1)

Field Description

Indicates whether the rate is
per resource unit or per
thousand units in reports:

m M (Per thousand units)

m Blank (Per unit)

Indicates the resource
conversion factor for the
resource unit value in
reports.

m 1 (Divide total resource
value by 60)

m 2 (Divide total resource
value by 3600)

m 3 (Divide total resource
value by 1000)

m 4 (Multiply total resource
value by 60)

m 5 (Divide total resource
value by 60000)

m {f (Multiple total resource
value by user-defined
number in Factor field.)

m Blank (No conversion
factor)

Indicates whether the rate
code is included in zero cost
calculations:

B N (The rate will not be
included in zero cost
calculations)

m Blank (The rate will be
included in zero cost
calculations)

For more information about
zero cost calculations, see
page 3-11.
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CIMSRate Table
Field Name Key Type Field Description
RateValueb char(1) Indicates the number of

decimal digits that appear in
the resource units value in
reports:

m 0-5 (0 through 5 digits)
m Blank (2 digits, the

default)
RateValue6 char(1) For future use.
RateValue7 char(1) Indicates the whether the

resource units for the rate
code are considered a
monetary amount rather
than units if utilization:

m $ (flat fee)
m Blank (not flat fee)

RateValue8 char(1) User-defined report flag.

RateValue9 char(1) For future use.

RateValuelO char(1) User-defined report flag.

RateValuell char(1) Indicates whether the rate
should be included in CPU
normalization:
m Y (Yes)
m N(No)

EffDate datetime The effective date for the rate
code.

TermDate datetime The end date for the rate
code.

Comments varchar(255)  Comments for the rate code.

DetailDescription varchar(255)  User-defined description of
the rate code for custom
reports.

CurrencySymbo]l varchar(3) User-defined currency

symbol for custom reports.

a. PK = Primary Key
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CIMSRateGroup Table

CIMSRateGroup Table

This table defines the rate groups.

Field Name Key Type
RateGroup PKa int
ParentUID int
GroupTitle char(32)
GroupTitlelong varchar(255)
PrintIndex int

Field Description

A sequential number
assigned to the rate group.

For future use.
The rate group title.

A description of the rate
group.

The order in which the rate
group appears in reports.

a. PK = Primary Key

CIMSRateldentifiers Table

This table correlates rate codes to identifiers to enable drill down on the units consumed

for a resource by identifier.

Field Name Key Type
RateCode PKa char(8)
IdentNumber PKa int

Field Description
The rate code.
A sequential number

assigned to the identifier for
the rate code.

a. PK = Primary Key
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CIMSRateShift Table
CIMSRateShift Table
This table defines the optional rate shifts for rate codes.

Field Name Key Type Field Description

RateTable PKa char(8) The name of the rate table.

RateCode PKa char(8) The rate code.

ShiftCode PKa char(1) The shift code.

RateValue decimal(18,8) The rate value for the shift.

Description varchar(255) A description of the shift
(Swing, Night, etc.).

RateValuel char(1) For future use.

RateValue2 char(1) For future use.

RateValue3 char(1) For future use.

RateValue4 char(1) For future use.

RateValueb char(1) For future use.

RateValue6 char(1) For future use.

RateValue7 char(1) For future use.

RateValue8 char(1) For future use.

RateValue9 char(1) For future use.

RateValuelO char(1) For future use.

RateValuell char(1) For future use.

EffDate datetime The effective date for the rate
code.

TermDate datetime The end date for the rate
code.

Comments varchar(255)  For future use.

a. PK = Primary Key
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CIMSRateToRateGroup Table

This table correlates rate codes to rate groups.

Field Name
RateCode

RateGroup

Key Type
PKa char(8)
PKa int

Field Description
The rate code.

A sequential number
assigned to the rate group.

a. PK = Primary Key

CIMSReport Table

This table stores information about the reports used for CIMS Server Web Reporting.
These reports are entered in the Report List Maintenance dialog box (see Adding Reports
to the CIMS Server Report List on page 4-19).

Field Name

Key Type

Field Description

ReportID

ReportName

ReportFile

ReportDescription

UserID

ReportTemplateFile

PKa

int

char(32)
varchar(255)

varchar(255)
char(8)

varchar(255)

The unique identifier for the
report.

The name of the report

The .rpt file name for the
report. Also, the executable
for all reports (except user-
defined reports).

A description of the report.

For a user-defined reports,
the CIMS user ID of the
person who created the
report.

The .rpt file to be used as
the executable for user
defined reports.

a. PK = Primary Key
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CIMSReportCustomFields Table

This table stores the values for the user-defined reports that can be stored in the database
and supplied to the report automatically at run time.

Field Name Key Type Field Description

ReportID PKa int The unique identifier for the
report.

RateCode char(8) The rate code

ReportPosition PKa int The position within the

report where the values are
used beginning with 1 and
continuing sequentially.

DecimalPTlaces int The number of decimal
places to display for the
resource usage amount in
reports.

a. PK = Primary Key

CIMSReportDistribution Table

This table store the values for the report distribution requests. These requests are
associated with a report cycle.

Field Name Key Type Field Description

UserID char(8) The CIMS user ID for the
user assigned to the report.

GrouplID char(8) The CIMS user group ID for
the user group assigned to
the report.

ReportID int The unique identifier for the
report.

ReportCyclelD PKa int The unique identifier for the
report cycle.

RequestID PKa int The unique identifier for the

report distribution request.

ReportFormat int The unique identifier for the
report format.

a. PK = Primary Key
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CIMSReportDistributionCycle Table

CIMSReportDistributionCycle Table

This table stores values for report cycles.

Field Name

ReportCyclelD

ReportCycleName
ReportCycleDescription

EmailFromAddress

EmailSubject

EmailText

WebSiteCIMS

WebSiteReports

LinkType

MailServer

UserSelectable

EmailAdminAddress

Key Type

PKa

char(8)

char(8)
int

int

int

int

varchar(80)

varchar(255)

int

varchar(80)

int

varchar(128)

Field Description

The unique identifier for the
report cycle.

The report cycle name.
The report cycle description.

The address of the e-mail
sender.

The text in the e-mail
subject.

The text in the e-mail body.

The URL fo the CIMS Server
Web Reporting Web site.

The URL for the virtual
directory for published
reports.

The link type:
m 1 (UNC)
m 2 (URL)

The name of the SMTP mail
server used to send the
e-mail.

For future use.

The address of the CIMS
Server administrator to
receive the report
distribution log file.

a. PK = Primary Key
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CIMSReportDistributionParm Table

This table stores the values for each report assigned to a report cycle.

Field Name Key Type Field Description

ReportID PKa int The unique identifier for the
report.

ReportCyclelD PKa int The unique identifier for the
report cycle.

RequestID PKa int The unique identifier for the
report distribution request.

ParmName PKa varchar(255) The parameter name.

ParmValue varchar(255)  The parameter value.

a. PK = Primary Key

CIMSReportDistributionType Table

This table stores the values for report formats.

Field Name Key Type Field Description

TypelD PKa int The unique identifier for the
report format.

TypeValue varchar(255)  The description of the report
format.

a. PK = Primary Key

CIMSReportGroup Table

This table stores information about report groups.

Field Name Key Type Field Description

ReportGroupID PKa int The unique identifier for the
report group

ReportGroupName char(32) The report group name

ReportGroupDesc varchar(255) A description of the report
group.

a. PK = Primary Key
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CIMSReportStart Table

This table defines the order in which reports appear in CIMS Server Web Reporting.

Field Name

ReportStartlID

ReportStartGroup

Key Type

int

int

Field Description

A unique identifier for the
start group.

A sequential number that is
assigned to the start group.
The number is dependent on
the order in which the group
was created.

CIMSReportToReportGroup Table

This table relates reports to report groups.

Field Name

MemberID

MemberType

ReportGroupld

Sequence

Key Type

PKa

PKa

PKa

int

char(1)

int

int

Field Description

The unique identifier of the
report.

m R(Report)
m G (Graph)

The unique identifier for the
report group.

The order of the report in the
report group list.

a. PK = Primary Key
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CIMSResourceUtilization Table

This table stores the resource information contained in the CIMSAcct Detail file. In most
cases, you will not need to load the data in CIMSAcct Detail file to the database.

Field Name

CIMSResourceUtilization Table

Field Description

LoadTrackingUID

DetailUID

Detailline

AccountCode

Aggregate

StartDate
EndDate

ShiftCode

AuditCode

SourceSystem

RateCode

ResourceUnits

int

int

int

char(128)

int

datetime
datetime

char(1)

varchar(255)

char(8)

char(8)

decimal(18,5)

The load tracking unique
identifier from the
CIMSLoadTracking table.

The unique identifier that
tracks the CIMSAcct Detail
load.

The number of the record in
the input CSR or CSR+ file
that contains the resource
(i.e., 1 ifitis the first record,
2 if it is the second record,
etc.)

The account code.

A count of the number of
original input CSR or CSR+
records that have been
aggregated into this record.

The resource usage start date.
The resource usage end date.

The resource usage shift
code.

The audit code (CIMS
External Transaction records
only).

The system identifier for this
resource.

The rate code of this
resource.

The quantity of the resource
used.
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CIMSSummary Table

CIMSSummary Table

B A-40

This table stores the information contained in the CIMS Summary file created by
CIMSBIll. This table contains both resource utilization and cost data for reports. Note the
Bi11F1ag fields reflect the flags that were set in the CIMSRate table at the time that

CIMSBill was run.

Field Name

LoadTrackingUID

Year
Period

Shift

AccountCode

LenLevell

LenLevel?2
LenLevel3
LenlLevel4

RateTable

RateCode

StartDate

EndDate

Key Type

int

int
int

char(1)

char(128)

int

int
int
int

char(8)

char(8)

datetime

datetime

Field Description

The load tracking unique
identifier from the
CIMSLoadTracking table.

The resource usage year.
The resource usage period

The resource usage shift
code.

The account code.

Values are the following:

B 0—The record was created
from a Detail record.

m 1—Therecord was by
created by reprocessing a
CIMS Summary record.

m 2—Therecord was by
created by processing a
Summary record twice. If
the Summary record was
processed more than
twice, the value would be
3,4, 5, etc.

A value of 0.
A value of 0.
A value of 0.

The name of the rate table
that contains the rate code.

The rate code for the
resource.

The accounting start date.

The accounting end date.
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CIMSSummary Table
Field Name Key Type Field Description
Bi11Flagl char(1) Indicates whether four

decimal positions are used
in the rate value in reports:

m F (Four digits are used)

m Blank (Eight digits are
used [the default])

Bil1Flag2 char(1) Indicates whether the rate is
per resource unit or per
thousand units in reports:

m M (Per thousand units)

m Blank (Per unit)

Bi11F1ag3 char(1) Indicates the resource
conversion factor for the
resource unit value in
reports:

m 1 (Divide total resource
value by 60)

m 2 (Divide total resource
value by 3600)

m 3 (Divide total resource
value by 1000)

m 4 (Multiply total resource
value by 60)

m 5 (Divide total resource
value by 60000)

m {f (Multiple total resource
value by user-defined
number in Factor field.)

Bil1Flag4 char(1) Indicates whether the rate
code is included in zero cost
calculations:

B N (The rate will notbe
included in zero cost
calculations)

m Blank (The rate will be
included in zero cost
calculations)

For more information about
zero cost calculations, see
page 3-11.
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CIMSSummary Table

B A-42

Field Name

BiT1Flagbh

BiT1Flag6

BillFlag7/

BillFlag8
BiT1F1ag9
RateValue
ResourceUnits
BreakId

MoneyValue

UsageStartDate
UsageEndDate

RunDate

BillF1aglO

Bil1Flagll

Key Type

char(1)

char(1)
char(1)

char(1)
char(1)
decimal(18,8)
decimal(18,5)
int

decimal(19,6)

datetime
datetime

datetime

char(1)
char(1)

Field Description

Indicates the number of
decimal digits that appear in
the resource units value in
reports:

m 1-5(1 through 5 digits)

m Blank (2 digits, the
default)

For future use.

Indicates the whether the
resource units for the rate
code are considered a
monetary amount rather
than units if utilization:

m $ (flat fee)

m Blank (not flat fee)
User-defined report flag.
For future use.

Per unit charge for this rate.
The total units for this rate.
Deprecated.

The total currency units for
this rate. Note: This will be
21,6 only if using an existing
Oracle database prior to 4.2
and then upgradingto 4.2 or
later.

The resource usage start date.
The resource usage end date.

The date and time that
CIMSBIll was run.

User-defined report flag.

Indicates whether the rate
should be included in CPU
normalization:

m Y (Yes)
m N(No)
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CIMSSummaryDaily Table

This table stores the data in the CIMSSummary table at a monthly rather than daily level.
The fields are the same as the CIMSSummary table.

For more information about converting daily records to monthly records, see
ConvertSummaryDailyToMonthly.wsf Script on page C-9.

CIMSSummaryToDetail Table

This table is obsolete.

Field Name Key Type Field Description

SummarylLoadTrackingUID PKa int The load tracking unique
identifier from the CIMS
Load Tracking table.

DetailUID PKa int The unique identifier that
tracks the CIMSBill Detail
load.

StartDate datetime The accounting start date.

EndDate datetime The accounting end date.

DetailConverted char(1) Indicates whether the

CIMSBIll Detail records have
been converted:

Y (Yes)
Null (No)

SummaryConverted char(1) Indicates whether the CIMS
Summary records have been
converted:

Y (Yes)
Null (No)

a. PK = Primary Key
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CIMSTransaction Table

This table stores miscellaneous, recurring, and credit transactions. For more information
about creating and using transactions, refer to the CIMS Server Web Reporting User’s

B A-44

Guide.
Field Name Key Type
TransactionUID PKa char(32)
AccountCode char(128)
TransactionType char(1)
ShiftCode char(1)
RateCode char(8)
ResourceAmount decimal(18,5)
Frequencyl int

Field Description

The unique identifier for the
transaction.

The account code for the
transaction.

The transaction type:
m M(Miscellaneous)
m R(Recurring)

m C (Credit)

The shift code for the
transaction.

The rate code for the
transaction.

The amount of the
transaction.

Applicable only to recurring
transactions. The frequency
that the transaction should
occur (every month, every 6
months, etc.). Frequency is
based on the calendar year
(January-December)

1 (monthly)

2 (every other month)

3 (every quarter)

4 (every four months)

6 (every six months)

12 (once a year)
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CIMSTransaction Table
Field Name Key Type Field Description
Frequency? int Applicable only to recurring

transactions. The period in
which the transaction
should be processed. This
value corresponds to the
valuein the Frequencyl field.
For example, if the value in
the Frequencyl field is 6, a
value of 1 in this field
indicates the first month of a
6 month period (January or
July).

FromDate/ToDate datetime Applicable only to
miscellaneous and credit
transactions. The date range
that the transaction
occurred.

DateTimeSent datetime The date and time that the

transaction was exported to a
flat file.

DateTimeModified datetime The date and time that the

transaction was last
modified.

DateTimeEntered datetime The date and time that the
transaction was created.

DateTimeStartProcessing datetime Applicable only to recurring
transactions. The first day
that the transaction will be
processed.

DateTimeStopProcessing datetime Applicable only to recurring
transactions. The last day
that the transaction will be
processed.

UserID char(8) The CIMS user ID of the
person who entered the
transaction.

DateTimeDeleted datetime The date and time that the
transaction was deleted.

Note varchar(255) A description of the
transaction.

a. PK = Primary Key
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CIMSUser Table

This table stores the user options entered in the User Maintenance dialog box (see

Defining Users on page 3-28).

Field Name
UserID
Password
SessionID
UserFullName

UserFlagl

UserFlag?

CrystalViewer

DomainUserName

EmailToAddress

Key Type

PKa

char(8)

int

int
varchar(255)
char(1)

char(1)

int

varchar(255)

varchar(255)

Field Description

The CIMS user ID.

A hash of the user password.
A unique session identifier.
The full name of the user.

Indicates whether full report
path for published reports is
displayed for the user on
Favorites page in CIMS
Server Web Reporting:

m Y (Yes)

m N(No)

Indicates whether full report
path for published reports is
displayed for the user on

Published Reports page in
CIMS Server Web Reporting:

m Y (Yes)
m N(No)

The unique identifier for the
browser viewer used by the
user to view Crystal Reports.

The Windows domain and
user name for the user.

The e-mail address for the
user.

a. PK = Primary Key
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CIMSUserConfigOptions Table

This table stores the user configuration options entered in the User Configuration
Options List Maintenance dialog box (see Defining Users on page 3-28).

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

UserID PKa char(8) The CIMS user ID.

PropertyValue varchar(255)  The value for the configuration
option.

PropertyType int The data type of the

configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key

CIMSUserFavorites Table

This table stores information regarding the CIMS Server Web Reporting users favorite
reports. For more information about favorite reports, refer to the CIMS Server Web
Reporting User’s Guide.

Field Name Field Description
UserID char(8) The CIMS user ID.
FavoriteReportGroup int The unique identifier for the

report group that the favorite
report belongs to.

FavoriteReport int The unique identifier for the
favorite report.

DisplayOrder int The order in which the
favorite report is displayed.
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CIMSUserGroup Table

This table relates users to user groups.

Field Name Key Type Field Description
GroupID PKa char(8) The user group ID.
GroupFul1Name varchar(255)  The full name of the group.
TransactionSecurity char(1) Indicates whether group has
transaction maintenance
privilege:
0 (No)
9 (Yes)
RateSecurity char(1) For future use.
ClientSecurity char(1) For future use.
GroupType char(1) Type of user:
1 (Client)
9 (Admin)
AlTowFinModeler char(1) Indicates whether group has
access to CIMS Financial
Modeler:

0 (No access)

9 (Access)

AlTowWebConsole char(1) Indicates whether group has
access to CIMS Web
Console:

0 (No access)
9 (Access)

a. PK = Primary Key
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CIMSUserGroupAccountCode Table

This tables defines user the account codes that users within a user group can view.

Field Name Key Type Field Description
GroupID PKa char(8) The user group ID.
AccountCode PKa char(128) The client account code that

can be viewed. If the group
has access to all clients, this
field is blank.

a. PK = Primary Key

CIMSUserGroupAccountStructure Table

This table stores the account code structures assigned to a user group.

Field Name Key Type Field Description

GroupID PKa char(8) The user group ID.

AccountStructureName PKa char(32) The name of the account
code structure.

GroupDefault int Indicates whether the
account code structure is the
default:

1 (default)
0 (not default)

CIMSUserGroupConfigOptions Table

This table stores the user configuration options entered in the Group Configuration
Options List Maintenance dialog box (see Defining User Groups on page 3-33).

Field Name Key Type Field Description

PropertyName PKa varchar(80) The name of the configuration
option.

GroupID PKa char(8) The CIMS user group ID.

PropertyValue varchar(255)  The value for the configuration
option.
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CIMSUserGroupConfigOptions Table

Field Name Field Description

PropertyType int The data type of the
configuration option:

m 1 (String)

m 2 (Integer)

m 3 (Floating Point)

m 4 (Date/Time)
Sequence int For future use.

PropertyDescription varchar(255) A description of the
configuration option.

a. PK = Primary Key
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CIMSUserGroupReport Table

This tables defines the reports that users within a user group can view. If a group has
access to all reports, it is not included in this table.

Field Name Key Type Field Description
GroupID pPKa char(8) The CIMS user group ID.
ReportID PKa int The unique identifier of the
report.
ReportExecute char(1) Permission for users in this
group to run the report:
m Y (Yes)
m N (No)

a. PK = Primary Key
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Database Entity Relationship Diagrams

This section provides Entity Relationship Diagrams (ERDs) for most of the tables in the
CIMS Server database. (Tables that do not have explicit relationships are not shown.)

These diagrams show the following:

m The relationships of the client, report, and user tables

m The relationship of the CIMSTransaction and CIMSSummary tables to other tables
The following conventions are used in these diagrams:

m PK = Primary Key

® Bold = A required field

m Related tables are specified by their related fields. Related fields are connected by a
line with a single arrow on one side and double arrow on the other. This line specifies
both the related fields and the relationship of the tables. All linked tables reflect a
one-to-many relationship. For example, the CIMSClient table has a one-to-many
relationship with the CIMSClientBudget table (i.e., clients can have budgets for
multiple resources).

Note that some tables are shown in more than one diagram.
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Summary-Related Tables

Database Entity Relationship Diagrams

The ERD in Figure A-1 shows the relationship of the CIMSSummary table to other tables.

CIMSSummary

Year
Period
Shift

LenLevel1
LenLevel2
LenLevel3
LenLevel4

RateTable

RateCode
StartDate
EndDate
BillFlagl
BillFlag2
BillFlag3
BillFlag4
BillFlag5
BillFlag6
BillFlag7
BillFlag8
BillFlag9
RateValue

Breakld
MoneyValue

RunDate
BillFlag10
BillFlag11

LoadTrackingUID

CIMSDetail

Account Code

ResourceUnits

UsageStartDate
UsageEndDate

LoadTrackingUID

Detafll{ID PK | DetailUID

Detailli PK | Detailine

AccountCode PK | IdentNumber <+

Aggregate

StartDate LoadTrackingUID

EndDate IdentValue

ShiftCode

AuditCode

SourceSystem

RateCode

ResourceUnits

AccountingStartDate de

AccountingEndDate

PK | IdentNumber

IdentName
IdentDescription
IdentActiveFlag
IdentReportFlag

CIMSRate

PK

CIMSClient

AccountCode

AltAcctCode
AccountName
LoadTrackingUID
RateTable
InvoiceContact
ActionCodel
ActionCode2
ActionCode3
ActionCode4
ActionCode5
ActionCode6
ActionCode7
ActionCode8

CIMSRateS|

» PK | RateTable PK | RateTable
PK | RateCode « »» PK | RateCode
LoadTrackingUID PK_ | ShiftCode
Ratelndex LoadTrackingUID
RateValue Ratelndex
ResourceValue RateValue

DiscountDollars

Discount

DiscountIndex

Description
Factor
RateValuel
RateValue2
RateValue3
RateValue4
RateValue5
RateValue6
RateValue7
RateValue8
RateValue9

RateValuel0
RateValuell

EffDate
TermDate
Comments

DetailDescription
CurrencySymbol

PK

CIMSRateToRateGroup

RateCode
RateGroup

PK

ResourceValue
DiscountDollars
Discount
DiscountIndex
Description
Factor
RateValuel
RateValue2
RateValue3
RateValue4
RateValue5
RateValue6
RateValue7
RateValue8
RateValue9
RateValuel0
RateValuell
EffDate
TermDate
Comments
DetailDescription
CurrencySymbol

RateGroup

CIMSRateGro

Figure A-1 « Summary-Related Tables ERD
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GroupTitleLong
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Client Tables

The ERD in Figure A-2 shows the relationships of the client tables.

PK | AccountCode PK | AccountCode
PK | RateCode

AltAcctCode PK | Year
AccountName PK | Period
LoadTrackingUID
RateTable LoadTrackingUID
InvoiceContact BudgetAmt
ActionCodel ActualAmt
ActionCode2 BudgetUnits
ActionCode3 ActualUnits
ActionCode4
ActionCode5
ActionCode6
ActionCode?7
ActionCode8

CIMSClientContact CIMSClientContactNumber

PK | AccountCode PK | AccountCode

PK | Contactldx PK | Contactldx
LoadTrackingUID PK | Numberldx
AddressLinel

LoadTrackingUID
NumberDescription
NumberValue

AddressLine2
AddressLine3
AddressLine4
AddressLine5
ContactName
Department
Office
Comments

Figure A-2 + Client Tables ERD

User Tables

The ERD in Figure A-3 shows the relationships of the user tables.

PK | UserID <«
»| PK |GroupID [
Password
SessionID GroupFullName
UserFullName TransactionSecurity
UserFlagl RateSecurity
UserFlag2 ClientSecurity
CrystalViewer GroupType
DomainUserName AllowFinModeler
EmailToAddress AllowWebConsole
0
oupRepo e oupAcco
Userld — PK | GroupIlD »» PK | GroupID
FavoriteReportGroup PK | ReportID PK | AccountStructureName
FavoriteReport
DisplayOrder ReportExecute GroupDefault

Figure A-3 + User Tables ERD
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Report Tables

Database Entity Relationship Diagrams

The ERD in Figure A-4 shows the relationships of the report tables.

CIMSReport

CIMSReportCustomFields

N
> PK ReportID
ReportName
ReportFile
ReportDescription
UserlD
ReportTemplateFile

CIMSReportToReportGroup

PK | ReportID

PK | ReportPosition
RateCode
DecimalPlaces

Figure A-4 + Report Tables ERD
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> PK | MemberID ——
PK | MemberType P P
PK | ReportGrouplD »| PK | ReportGroupID
Sequence ReportGroupName
ReportGroupDesc
eportD butio CIMSReportDistributionParm
PK | ReportCycleID PK | ReportID
PK | RequestID PK | ReportCycleID
PK | RequestID
UserID
GroupID PK | ParmName
> ReportID ParmValue
ReportFormat
eportD butio
PK | ReportCycleID <
ReportCycleName
ReportCycleDescription
EmailFromAddress
EmailSubject
EmailText
WebSiteCIMS
WebSiteReports eportD butio pe
LinkType
MailServer —>| PK | TypelD
UserSelectable
EmailAdminAddress TypeValue

ReportStartID
ReportStartGroup
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Report Distribution Tables

B A-56

The ERD in Figure A-5 shows the relationships of the report distribution tables.

ReportD butio

ReportCycleID

ReportCycleName
ReportCycleDescription
EmailFromAddress
EmailSubject
EmailText
WebSiteCIMS
WebSiteReports
LinkType

MailServer
UserSelectable
EmailAdminAddress

PK

ReportCycleID
RequestID

UserID
GroupID
ReportID

ReportFormat

PK
—| PK
PK
PK

CIMSReportDistributionParm

»| PK | ReportID
ReportName
ReportFile
ReportDescription
UserID
ReportTemplateFile

po D b 0 p

PK | TypelD
TypeValue

ReportID
ReportCycleID
RequestID
ParmName

ParmValue

Figure A-5 + Report Distribution Tables ERD
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Transaction-Related Tables

Database Entity Relationship Diagrams

The ERD in Figure A-6 shows the relationship of the CIMSTransaction table to the
CIMSClient and CIMSRate tables.

Figure A-6 + Transaction-Related Tables ERD

CIMS Server Administrator's Guide

PK

TransactionUID

AccountCode
TransactionType
ShiftCode

RateCode

ResourceAmount
Frequency1l

Frequency2

FromDate

ToDate

DateTimeSent
DateTimeModified
DateTimeEntered
DateTimeStartProcessing
DateTimeStopProcessing
UserID
DateTimeDeleted

Note

PK

AccountCode

AltAcctCode
AccountName
LoadTrackingUID
RateTable
InvoiceContact
ActionCodel
ActionCode2
ActionCode3
ActionCode4
ActionCode5
ActionCode6
ActionCode7
ActionCode8

PK

PK

RateTable
RateCode

LoadTrackingUID
Ratelndex
RateValue
ResourceValue
DiscountDollars
Discount
DiscountIndex
Description
Factor
RateValuel
RateValue2
RateValue3
RateValue4
RateValue5
RateValue6
RateValue7
RateValue8
RateValue9
RateValuel0
RateValuell
EffDate
TermDate
Comments
DetailDescription
CurrencySymbol
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This appendix describes the layout of key files used by CIMS Server.

CIMS Server ResoUrce (CSR) FIlE . .vvviii ittt iiiiitieeieeteneneeeeenceesenssenenscennnas B-2
CIMS Server Resource PIUS (CSRH) Fil@ ......cviieeiiniiirenetiereeeeececensesnsacscancans B-4
CIMS External Transaction File ........oeeiiiitiiineeeeeeeeeeeeerecenacceanssccsnnsaannnns B-7
CIMSACCt Detall File ....iiviiieiiiiiieiiieiieeeiesesasonscssscsssosssssscsnsosssssscsnsans B-8
L 117 3 T 1<) 3 0 = | (A B-9
CIMSBIll Detail FIle ....cuiineiiiiietieeiiereeeraescaoscsssosssssscsssosssssscsnscsnssnns B-10
CIMSBIll Detail File Version 200306 (3.2 and Later) ..., B-10
CIMSBIll Detail File Version 200106 (3.1 and Earlier) ............ ... it B-12
CIMSSUMMAIYFIle ....vieiiiii ittt ittt tiiieietitetecenencncnnens B-14
Summary File Version 200306 (3.2 and Later) ............. ..o ittt B-14
Summary File Version 200106 (3.1 and Earlier) ............ ... . i, B-16
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CIMS Server Resource (CSR) File

CIMS Server Resource (CSR) File

H B-2

The primary method for input into CIMS Server is the CIMS Server Resource (CSR) file.
The CSR file is automatically produced by CIMS Data Collectors for Windows, UNIX,
and Mainframe (11.6 and earlier) and can also be produced and read by many other
third-party products.

The CSR records are in a standard ASCII display format (no packed, binary, or bit data)
with commas for delimiters and decimal points included in resource amounts. A
negative sign should precede negative numeric data, with no sign when the data is
positive. When the identifier data contains commas, there must be double quotes
around the identifier character data.

For CIMS Server 3.3 and earlier, CSR records can be up to 5,000 bytes long. For CIMS
Server 4.0 and later, CSR records can be up to 32,000 bytes long. CSR records in all CIMS
Server releases can contain a very large number of identifiers and resources. However, the
maximum length for the records in the output CIMSAcct Detail file is 5,000 bytes with
a limit of 100 resources.

The following table describes the fields in the CSR record.

Pos. Field Name Length Type Description

1 Header 8 Character  Defines the source of data. For
example, DB2 data from OS/
390 contains a header of
S390DB2.

There is no standard for this
header and any unique
combination of characters can

be used.
2 Start Date of 8 Number Date in format YYYYMMDD.
Usage
3 End Date of Usage 8 Number Date in format YYYYMMDD.
4 Start Time of 8 Character  Time in format HH:MM:SS.
Usage
5 End Time of Usage 8 Character  Time in format HH:MM:SS.
6 Shift Code 1 Character  Alphanumeric code denoting
time of day usage occurred.
Allows billing different rates by
shift. If you do not want to
charge by shift, the field should
be blank.
/ Number of 2 Number Number of identifiers in the
Identifiers following fields.
8 Identifier Name 1 32 Character  The name of the identifier.
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Pos. Field Name Length Type Description

9 Identifier Value 1  Variable  Character  Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

10 Identifier Name 2 32 Character The name of the identifier.

11 Identifier Value 2 Variable  Character Includes items such as database
name, server name, LAN ID,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

12 Identifier Name x 32 Character The name of the identifier.

13 Identifier Value x ~ Variable  Character  Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

X Number of 2 Number Number of resources being

Resources tracked in the following fields.
X Rate Code 1 8 Character  The rate code for the resource.
X Resource Value 1  Variable = Number Resource usage value such as

CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

X Rate Code 2 8 Character  The rate code for the resource.

X Resource Value 2 Variable = Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

X Rate Code x 8 Character  The rate code for the resource.

X Resource Valuex  Variable  Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.
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CIMS Server Resource Plus (CSR+) File

Note ¢ The description of the CSR file format and length is also applicable to the
CSR+ file (see page B-2).

The CIMS Server Resource Plus (CSR+) file is produced by CIMS Mainframe Data
Collector and Chargeback System 12.0 and later. The format of the CSR+ file record is
the same as the CIMS Server Resource record with the exception that the CSR+ record
contains an additional header at the beginning of the record. This is a fixed header that
enables the records to be sorted more easily. The header is in the following format:

"CSR+<usage start date><usage end date><account code length><account code><x’40°>",
Note that the quotation marks and comma are included in the header.

Examples

"CSR+2005022820050228010aaaaaaaaa ",S390DB2,20050228, ...
"CSR+2005022820050228010bbbbbbbbb " ,S$390DB2, 20050228, . . .

In these examples, the usage start and end dates are February 28, 2005 (20050228). The
account codes aaaaaaaaa and bbbbbbbbb are 10 characters. The account codes are followed
by a space (x'40"). The information after the header (S90082,20050228, . . .) represents the
remaining fields found in the record. These fields are described in the following table.

Note ¢ The CSR+ record does not supersede the CSR record. CIMS Server uses both
record types.

Pos. Field Name Length Type Description
1 Header 153 Character A fixed header used for sorting.
2 Header 8 Character  Defines the source of data. For

example, DB2 data from OS/
390 contains a header of
S390DB2.

There is no standard for this
header and any unique
combination of characters can

be used.
3 Start Date of 8 Number Date in format YYYYMMDD.
Usage
4 End Date of Usage 8 Number Date in format YYYYMMDD.
5 Start Time of 8 Character  Time in format HH:MM:SS.
Usage
6 End Time of Usage 8 Character  Time in format HH:MM:SS.
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Field Name

CIMS Server Resource Plus (CSR+) File

Description

10

11

12

13

14

Shift Code

Number of
Identifiers

Identifier Name 1

Identifier Value 1

Identifier Name 2

Identifier Value 2

Identifier Name x

Identifier Value x

Number of
Resources

Rate Code 1

Resource Value 1

Rate Code 2

32

Variable

32
Variable

32
Variable

8

Variable

8

Character

Number

Character

Character

Character

Character

Character

Character

Number

Character

Number

Character

Alphanumeric code denoting
time of day usage occurred.
Allows billing different rates by
shift. If you do not want to
charge by shift, the field should
be blank.

Number of identifiers in the
following fields.

The name of the identifier.

Includes items such as database
name, server name, LAN ID,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

The name of the identifier.

Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

The name of the identifier.

Includes items such as database
name, server name, LAN 1D,
user ID, program name, region,
system ID, and so forth. This
should be shortened as much as
possible to a meaningful code
for further translation.

Number of resources being
tracked in the following fields.

The rate code for the resource.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

The rate code for the resource.
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Field Name Description

X Resource Value 2 Variable = Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

X Rate Code x 8 Character  The rate code for the resource.

X Resource Valuex  Variable  Number Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.
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CIMS External Transaction File

Although the CIMS External Transaction file is supported, CIMS Lab recommends that
you use the CSR or CSR+ file for input into CIMS Server (see CIMS Server Resource (CSR)
File on page B-2). These files are more flexible and efficient than the CIMS External

Transaction record.

The CIMS External Transaction file contains CIMS External Transaction records. These
records are comma-delimited.

The following table describes the fields in the CIMS External Transaction record.

Pos. Field Name Length
1 TRANS 5
2 Rate Code 8
3 Start Date of 8
Usage
4 End Date of Usage 8
5 Resource Value Variable
6 Account Code 32
7 Audit Code 6

Type

Character

Character

Number

Number

Number

Character

Character

Description

Record header that identifies
the record as an External
Transaction record.

The rate code for the resource.

Date in format YYYYMMDD.

Date in format YYYYMMDD.

Resource usage value such as
CPU time, Input/Outputs,
megabytes used, lines printed,
transactions processed, etc.

The account code.

Optional and not used in
processing. This can be any code
that helps to identify the record
such as Employee Code, Service
Code, etc.
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CIMSAcct Detail File

This file is created by CIMSAcct and contains all the resource data processed by the
CIMSAcct run. The CIMSAcct Detalil file is basically the same as the CIMSBill Detail file
(see page B-10), but without CPU normalization, proration, or include/exclude
processing applied to the resources.

The following is the file layout for the CIMSAcct Detail file.

Starting
Position Length Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detail file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-ID 90 32 The work id where the record came

from (could be subsystem name,
could be Oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
DETAIL-END-TIME 150 8 The end time of the record.
DETAIL-SHIFT 159 1 The shift code.

DETAIL-DOW 161 1 The day of week.
DETAIL-ACCOUNT-CODE 163 128 The account code.
DETAIL-AUDIT-CODE 292 8 The audit code.
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CIMS Ident File

Starting
Position Description
DETAIL-INCLEXCL-AREA 301 60 Include/exclude data range.
DETAIL-RES-NUMBER 362 2 Number of resources being tracked
in the following fields.
DETAIL-RES-INFO 365 X Occurs 1 to 100 times depending
DETAIL-RES-NUMBER (see preceding).
DETAIL-RATE-CODE The resources rate code.
DETAIL-RESOURCE-VAL The resource value.
DETAIL-RESOURCE-SIGN This field is blank if the resource is
positive

and '-' if the resource is negative.

CIMS Ident File

This file is created by CIMSAcct and contains all the identifiers (such as user ID,
jobname, department code, server name, etc.) that are contained in the input records.
These identifiers are used during account code conversion to create your target account
code structure. This is a simple, comma-delimited file.

The following is the file layout for the CIMS Ident file.

Field Description

UNIQUE LOAD ID The unique ID for the load.

RECORD NUMBER The record number.

IDENTIFIER NAME The name of the identifier (e.g., Jobname).
IDENTIFIER VALUE The value for the identifier (e.g., ACPSJEFU).
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CIMSBIll Detail File

This file is created by CIMSBIll and is a key component of the drill down feature of CIMS
Server Web Reporting.

The CIMSBIll Detail file differs from the CIMSAcct Detail file in that the CIMSBIll Detail
file reflects any proration, CPU normalization, or include/exclude processing that was
performed. The CIMSBIll Detail file also includes accounting dates.

For CIMS Server 3.2 and later, the file version number for the CIMSBill Detail file is
200306. Version number 200106 is deprecated. The version number is in the DETATL-
EYE-CATCH field, starting position 14.

CIMSBIll Detail File Version 200306 (3.2 and Later)
The following is the file layout for the CIMSBill Detail file for CIMS Server 3.2 and later.

Starting
Position Length Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detail file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-ID 90 32 The work id where the record came

from (could be subsystem name,
could be oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
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CIMSBIll Detail File

Starting
Position Length Description
DETAIL-END-TIME 150 8 The end time of the record.
ACCOUNTING-START-DATE 159 8 The accounting period start date.
ACCOUNTING-END-DATE 168 8 The accounting period end date.
DETAIL-SHIFT 177 1 The shift code.
DETAIL-DOW 179 1 The day of week.
DETAIL-ACCOUNT-CODE 181 128 The account code.
DETAIL-AUDIT-CODE 310 8 The audit code.
DETAIL-INCLEXCL-AREA 319 60 Include/exclude data range.
DETAIL-RES-NUMBER 380 2 Number of resources being tracked in
the following fields.
DETAIL-RES-INFO 383 X Occurs 1 to 100 times depending
detail-res-number (see above).
DETAIL-RATE-CODE The resources rate code.
DETAIL-RESOURCE-VAL The resource value.
DETAIL-RESOURCE-SIGN This field is blank if the resource is
positive

and '-' if the resource is negative.
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CIMSBIll Detail File Version 200106 (3.1 and Earlier)

This file is deprecated as of CIMS Server 3.2, see CIMSBill Detail File Version 200306 (3.2
and Later) on page B-10.

Starting
Position Description
DETAIL-REC-TYPE 1 3 Always '991".
DETAIL-REC-ID 5 8 Identifies the type of record. For
example:

0S390DB2 - (OS/390 DB2 records)
DETAIL-EYE-CATCH 14 7 The version of the record.

DETAIL-LOAD-ID 22 10 The unique ID of the file that
contained this detail record.

DETAIL-REC-NUMBER 33 10 The record number within the
original detail file.

DETAIL-NUM-RECS 44 10 The number of records that were
aggregated to make this one record.
This field applies only to mainframe

data.

DETAIL-SORT-ID 55 1 (Reserved)

DETAIL-SYSTEM-ID 57 32 The system ID of the source of the
record.

DETAIL-WORK-ID 90 32 The work ID where the record came

from (could be subsystem name,
could be oracle instance name).

DETAIL-START-DATE 123 8 The start date of the record.
DETAIL-END-DATE 132 8 The end date of the record.
DETAIL-START-TIME 141 8 The start time of the record.
DETAIL-END-TIME 150 8 The end time of the record.
DETAIL-SHIFT 159 1 The shift code.

DETAIL-DOW 161 1 The day of week.
DETAIL-ACCOUNT-CODE 163 128 The account code.
DETAIL-AUDIT-CODE 292 8 The audit code.
DETAIL-INCLEXCL-AREA 301 60 Include/exclude data range.
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CIMSBIll Detail File

Description

DETAIL-RES-NUMBER

DETAIL-RES-INFO

DETAIL-RATE-CODE
DETAIL-RESOURCE-VAL

DETAIL-RESOURCE-SIGN

Starting

Position  Length
362 2

365 X

Number of resources being tracked
in the following fields.

Occurs 1 to 100 times depending
detail-res-number (see preceding).

The resources rate code.
The resource value.
This field is blank if the resource is

positive
and "-" if the resource is negative.

CIMS Server Administrator's Guide
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CIMS Summary File

This file is created by CIMSBill and provides resource usage and cost data used for Web
reports or for input to other financial or resource accounting systems.

For CIMS Server 3.2 and later, the file version number for the CIMS Summary file is
200306. Version number 200106 is deprecated. The version number is in the Release 1D

field, starting position 262.

Summary File Version 200306 (3.2 and Later)

The following is the file layout for the CIMS Summary file for CIMS Server 3.2 and later.

B B-14

Field

“SUMMARY”
Version

Reserved
Reserved
Reserved
AccountCode
RateTable
SourceSystem
RateCode
ShiftCode
AccountingFromDate
AccountingToDate
BillFlag1

BillFlag2

BillFlag3

BillFlag4

BillFlag5

BillFlag6

BillFlag7

BillFlag8

Start Position

1

9
12
15
18
21
149
157
158
166
167
175
183
184
185
186
187
188
189
190

Length

8

3

Type
Character
Numeric
Numeric
Numeric
Numeric
Character
Character
Character
Character
Numeric
Numeric
Numeric
Character
Character
Character
Character
Character
Character
Character

Character

CIMS Server Administrator's Guide



File Layouts H

CIMS Summary File
Field Start Position Length Type
BillFlag9 191 1 Character
BillFlag10 192 1 Character
BillFlag11 193 1 Character
RateValue 194 18 Numeric
ResourceUnits 212 18 Numeric
MoneyValue 230 18 Numeric
Breakld 248 1 Character
Conv Factor 249 13 Numeric
Release ID 262 6 Numeric
Date-Century 268 2 Numeric
Date-Year 270 2 Numeric
Date-Month 272 2 Numeric
Date-Day 274 2 Numeric
Time-HH 276 2 Numeric
Time-MM 278 2 Numeric
Time-SS 280 2 Numeric
Period 282 2 Numeric
Year 284 4 Numeric
UsageStartDate 288 8 Numeric
UsageEndDate 296 8 Numeric
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Summary File Version 200106 (3.1 and Earlier)

This file is deprecated as of CIMS Server 3.2, see Summary File Version 200306 (3.2 and
Later) on page B-14.

Field Start Position Length Type
“SUMMARY” 1 8 Character
Version 9 3 Numeric
Reserved 12 3 Numeric
Reserved 15 3 Numeric
Reserved 18 3 Numeric
AccountCode 21 128 Character
RateTable 149 8 Character
SourceSystem 157 1 Character
RateCode 158 8 Character
ShiftCode 166 1 Numeric
FromDate 167 8 Date
ToDate 175 8 Date
BillFlag1 183 1 Character
BillFlag2 184 1 Character
BillFlag3 185 1 Character
BillFlag4 186 1 Character
BillFlag5 187 1 Character
BillFlag6 188 1 Character
BillFlag7 189 1 Character
BillFlag8 190 1 Character
BillFlag9 191 1 Character
RateValue 192 18 Numeric
ResourceUnits 210 18 Numeric
MoneyValue 228 18 Numeric
Breakld 246 1 Character
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CIMS Summary File

Field Start Position Length Type

Period 2 Character

Conv Factor 13 Numeric

Release ID 6 Numeric
Date-Century 2 Numeric

Date-Year 2 Numeric
Date-Month 2 Numeric

Date-Day 2 Numeric

Time-HH 2 Numeric

Time-MM 2 Numeric

Time-SS 2 Numeric
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Scripts

This appendix describes of the scripts included in the CIMS Server installation. These
scripts are located in the following locations (if you installed CIMS Server in the default
location):

m C:\Program Files\CIMSLab\Scripts
B ...\Scripts\Batch Reporting
B ... \Scripts\Client Load

B ... \Scripts\Desktop

Important! ¢« Some scripts change or purge the data in your database. If you are
unsure whether you should use a particular script, consult CIMS Lab.

If you make changes to a script, make sure that you rename the file. Otherwise, the
file will be overwritten when you upgrade to a new version of CIMS Server.

RUNNING SCHPLS oo viiiiiiiiiiiiiiiiiiiiiiiitititteteeeeseseescscnserscsssscscssncncns Cc-3
Running Scripts Using CIMS JOD RUNNEY . . .. ... . e C-3
Running Scripts Using a Batch File ............. ... ... . ... .. . i C-5
(0 3 T=) = 5o 1 Cc-7
BUIldCSRFrOMDB.WST SCript . ... e Cc-7
CIMSLIb.WST SCHipt . . . c8
CIMSULIIS.WSC SCHPt . . oo Cc-8
ClientPropagate.wsf SCript . ... . C-8
ConvertSummaryDailyToMonthly.wsf Script . ... .. ... . c9
CSRAggregator.Wsf SCript . ... ... C-12
DropldentFromDB.wsf SCript .. ... o e c13
DropldentBeforeLoad.wsf Script ......... ... . C-13
ExportClientToMainframe.wsf Script . ........ ... C-14
ExportRateToMainframe.wsf SCript . ....... ... .. c-14
FTP.wsc and FTPSample.wsf SCripts . . ... ... e C-15
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B C-2

ListUnusedldentifiers.wsf .. ... . . C-15
OracleLogonTrigger.bat SCript . . . ... ... C-16
ProRate.Wsf SCHipt . .. ... c-18
PurgeLoads.wsf SCript . . ... ..o C19
Rebill.wsf and ResourceConversion.wsf SCrpts . . .......... ... C-21
SampleBulkUserLoad.wsf Script . ...... ... C-24
SampleExportSummary.wsf SCript . ... ... C-25
SampleSQLMaintenance.bat Script . ... .. C-26
SaVeDBSQLSEIVELWSS . . . oo e e C-28
Schedule wsf . ... C-28
Table.wsf SCHipt . .. .. C29
ZeroCost.WST SCHiPt . ... oo C30
Batch Reporting SCrpts ......ooiuiiiiniiiii ittt i iieeeas C-31
ReportDistribution.wsf Script .......... .. . 32
BatchReport.wsf Script . ... .. C-33
AlTACAS.WSE SCHIPE . .. G40
EmailDistribution.wsf Script . . ... . e Cc-42
Client Load SCHPES . .vivininiiiiiiiiiiiiiiiiiitiiieieeeeecnseetsesesscnsessescsssscanns Cc-43
MainframeClientContactToServer.wsf Script ............. ... ... oL c43
LoadClientTableFromCSVFilewsf Script ......... ... ... . . C-43
DESKEOP SCHIPES «oviiiiiiiiiiiiiiiiiiiiititieieieieterereressosasasasesessssssasasnsnns Cc-44
UnloadDesktop<Client/Rate/Summary>ForServerwsf Script . ................. .. ... ... C-44
Data Source Parameters ........cooiuiniiiiiiiieiiiiiiiiititieietetetatatatiatacacacans C-44
Scripts Used by CIMS Server 3.3 and Earlier .........ccoviiiiiiiiiiiiiiiiiiinineienenenss C-45
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Running Scripts

CIMS Lab recommends that you run the scripts described in this chapter using CIMS Job
Runner and a job file as used for data collection process for CIMS Server. This
architecture provides the following benefits:

m [t enables you to run the script automatically on scheduled basis (daily, monthly,
etc.) using Windows Task Scheduler.

B You can receive a log file via e-mail that provides the results of the report generation
and distribution process. If a warning or failure occurs during processing, the file
indicates at which point the warning/failure occurred. The log file can be sent to
multiple recipients.

You can also use a .bat file to run a script on a scheduled basis. However, this method
does not provide notification of the success or failure of the script run.

Note ¢ CIMS scripts use the StepRunWSF.d11 file. If you installed CIMS Server in the
default location, this DLL is in C:\Program Files\CIMSLab\Process Engine\
JobLibrary.

Running Scripts Using CIMS Job Runner

To run a script via CIMS Job Runner, you need to create a job file for the script and then
run CIMS Job Runner to execute the job file as shown in the following steps.

Create a Job File for the Script

In the JobFiles folder, create an XML job file for the script using the structure shown in
the following example job file for the ExportRateToMainframe.wsf script (see page C-14).
(Ifyou installed CIMS Server in the default location, the JobFiles folderisin C:\Program
Files\CIMSLab.) For a complete description of the components of a job file, refer to the
CIMS Data Collectors for Microsoft Windows Installation and User Guide.

<2xml version="1.0" encoding="utf-8"7>
<Jobs xmIns="http://www.cimslab.com/CIMSJobs.xsd">
<Job id="Export Rate"

description="Export Rate"
processPriorityClass="Low"
smtpSendJoblLog="true"
smtpServer="mail.cimslab.com"
smtpFrom="CIMSProcessResults@cimslab.com"
smtpTo="CIMSProcessResults@cimslab.com"
stopOnProcessFailure="false"
jobTogWriteToXMLFile="false"
JjobTogShowStepOutput="true"
JjoblogShowStepParameters="true"
active="true">
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<Process id="Export Rate"

description="Export Rate"

buildProcessfFolder="false"

JjobTogShowStepOutput="true"

jobTogShowStepParameters="true"

active="true">

<{Steps>
<Step id="Export Rate"

description="Export Rate"
type="Process"
programName="ExportRateToMainframe.wsf"
programlype="wsf">

<{Parameters>
<Parameter QutputFilename="C:\Rate Files\Rate.txt"/>
<Parameter CreateRateGroups="true"/>

</Parameters>

</Step>
</Steps>
</Process>
</Job>
</Jobs>

Note that the required parameter for this script, OutputFilename, is included in the XML.
The CreateRateGroups parameter is optional.

Run CIMS Job Runner

Once you have created a job file, you can run CIMS Job Runner to execute the file using
Windows command prompt or Windows Task Scheduler.

To run CIMS Job Runner from command prompt:

At the C:\Program Files\CIMSLab\Process Engine> prompt type cimsjobrunner.exe
Jjobfilename.xml where jobfilename.xml is the name of the job file, and then press
<Enter>. Or from any prompt, type "C:\Program Files\CIMSLab\Process
Engine\CIMSJobRunner.exe" jobfilename.xml, and then press <Enter>.

Examples
C:\Program Files\CIMSLab\Process Engine>CIMSJobRunner.exe jobfilename.xml

Or

C:\>"C:\Program Files\CIMSLab\Process Engine\CIMSJobRunner.exe"
Jobfilename.xml

To run CIMS Job Runner from Task Schedular:

1 In Windows Control Panel, double-click Scheduled Tasks.
2 Double-click Add Scheduled Task.

3 The Scheduled Task Wizard appears. Click Next.

4 Click Browse to find the program CIMSJobRunner.exe, and then double-click the
program. If you installed CIMS Server in the default location, this program is in
C:\Program Files\CIMSLab\Process Engine.
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5 Type a name for the task or accept the default and click the schedule for the task. Click
Next.

6 Select the time and day to start the task, and then click Next.

7 Type the password for the user account under which you want the scheduled task to
run. The password cannot be blank. Click Next.

8 Select the Open advanced properties for this task when I click Finish check box,
and then click Finish.

9 In the Task tab, type following in the Run box where jobf7ilename.xml is the name of
the job file that you want to run:

"C:\Program Files\CIMSLab\Process Engine\CIMSJobRunner.exe" jobfilename.xm]
10 Click OK.

11 In the Set Account Information dialog box, type the password for the user account
again, and then click OK.

The task appears in the Scheduled Task list. To execute CIMSJobRunner . exe immediately,
right-click the task, and then click Run. For more information about Task Schedular,
refer to the Microsoft documentation.

Running Scripts Using a Batch File

You can use a batch file to run a script and pass parameters. For example, CIMS Lab
provides a default batch file ExportRateToMainframe.bat for the
ExportRateToMainframe.wsf script. This file contains the following:

cscript ExportRateToMainframe.wsf "c:\Program Files\CIMSLab\Scripts\Rate.txt" "true"

The values in quotation marks are the parameter values for the OutputFilename and
GenerateRateGroups parameters. You can modify these parameters as needed. Note that
only the OutputFilename parameter is required for the ExportRateToMainframe.wsf
script.

If a default batch file is not included for a script, you can copy and modify a similar file.
If you are unsure as to what to include in the batch file, refer to the example that is
provided in each script.

To run a batch file from command prompt:

1 Change the command prompt directory to the path that contains the .bat file that
you want to run. For example, C:\Program Files\CIMSLab\Scripts>.

2 Type the name of the .bat file and then press <Enter>. For example, C:\Program
Files\CIMSLab\Scripts>ExportRateToMainframe.bat.
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To run a batch file from Task Scheduler:

1

2

3

8

In Windows Control Panel, double-click Scheduled Tasks.

Double-click Add Scheduled Task.

The Scheduled Task Wizard appears. Click Next.

Click Browse to find the .bat file that you want to run, and then double-click the file.

Type a name for the task or accept the default and click the schedule for the task. Click
Next.

Select the time and day to start the task, and then click Next.

Type the password for the user account under which you want the scheduled task to
run. The password cannot be blank. Click Next.

Click Finish.

The task appears in the Scheduled Task list. To execute the script immediately, right-click
the task, and then click Run. For more information about Task Scheduler, refer to the
Microsoft documentation.
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General Scripts

The scripts described in this section are in C:\Program Files\CIMSLab\Scripts (if you
installed CIMS Server in the default location).

BuildCSRFromDB.wsf Script

The BuildCSRFromDB.wsf script extracts information from the CIMSIdent and
CIMSDetail tables and creates an output file containing CIMS Server Resource (CSR)
records for further processing (e.g., to perform account code conversion, proration, and
other processing that requires a CSR file).

BuildCSRFromDB.wsf Script Parameters

The BuildCSRFromDB.wsf script uses the following parameters.

Parameter Description/Values

Start Date and End Date These parameters specify the date range for the records

(required) that you want to select from the CIMSDetail table. Any
records that have accounting start and end dates in this
range are selected for processing.

Valid values are:

m preday (previous day)

m premon (previous month)
B rndate (current day)

m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system'’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

Output Filename (required) The full path and file name for the output CSR file.

Rate Code (optional) The rate code or codes that you want to appear in the
output CSR file records. If you set this parameter to A1l
or do not include the parameter, all rate codes in the
selected CIMSDetail table records are included.

DataSourcelD (optional) See Data Source Parameters on page C-44.

Table C-1 « BuildCSRFromDB Script Parameters
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CIMSLib.wsf Script

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

CIMSUtils.wsc Script

For information about this script, refer to the CIMS Data Collectors for Microsoft Windows
Installation and User Guide.

ClientPropagate.wsf Script

The ClientPropagate.wsf script propagates the account name and contact information
of top level account codes to lower level account codes that do not have account names.
This script will not overwrite existing names for lower level account codes that have
names or add contacts to those levels.

For example, the account code AABBBBCCC contains three levels: the two-digit
company code AA, the 6-digit division code AABBBB, and the 9-digit department code
AABBBBCCC. If account name for the account code AA is ABC Headquarters, the name
ABC Headquarters and any contact information will be assigned to account codes
AABBBB and AABBBBCCC.

ClientPropagate.wsf Script Parameters

The ClientPropagate.wsf script uses the following parameters.

Parameter Description/Values

TopLevellength (required) The length of the top level account code. The top level
account code must have a valid account name.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword
(optional)

Table C-2 « ClientPropagate Script Parameters

H C38 CIMS Server Administrator's Guide



Scripts H
General Scripts

ConvertSummaryDailyToMonthly.wsf Script

Important! ¢ This script consolidates daily CIMS Summary records into a monthly
record. Consult CIMS Lab before using this script.

The ConvertSummaryDailyToMonthly.wsf script consolidates the daily data in your
CIMSSummary table so that data is stored at a monthly level. (For more information
about the CIMSSummary table, see Chapter 6, Processing Data and CIMSSummary Table
on page A-40). This script calls the CIMSSp_ConvertSummaryDailyToMonthly stored
procedure, which is built in the CIMS Server database. This stored procedure aggregates
the daily summary records and produces a monthly summary record with Monthly
Aggregation listed as the source file name in the CIMSLoadTracking table.

This consolidation process minimizes storage space used (there is typically a 90 percent
or greater reduction in Summary records) and decreases the time required to generate
monthly reports. A drawback to this consolidation is that you cannot run costed daily
reports against the CIMSSummary table.

Note ¢ The ConvertSummaryDailyToMonthly.wsf script is intended primarily to
improve reporting performance. To drastically reduce storage space used by the
database, you can run the Purgeloads.wsf script (see PurgeLoads.wsf Script on
page C-19).

Before the monthly CIMS Summary aggregated data is created, daily data is copied from
the CIMSSummary table to the CIMSSummaryDaily table for archival purposes. You can
then run daily summary reports against the CIMSSummaryDaily table.
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ConvertSummaryDailyToMonthly.wsf Script Parameters

The ConvertSummaryDailyToMonthly.wsf script uses the following parameters.

Parameter Description/Values

StartDate and These parameters specify the date range for the records

EndDate(required) that you want to consolidate from the CIMSSummary
table. Any records that have accounting start and end
dates in this range are consolidated. Typically, the start
date is the first day of the month and the end date is the
last day of the month.

Valid values are:

m preday (previous day)

B premon (previous month)
m rndate (current day)

®m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword
(optional)

RemoveSummaryDaily If this parameter is set to true, the daily records that are
(optional) archived in the CIMSSummaryDaily table for this date
range are purged.

If this parameter is set to false or is not provided, the
records are maintained in the table.

Table C-3 « ConvertSummaryDailyToMonthly Script Parameters
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ConvertSummaryDailyToMonthly.wsf Script Considerations

m Ifan error occurs while processing the ConvertSummaryDailyToMonthly.wsf script, the
script will back out all database changes. You can then correct the error and run the
script again.

B You cannot run the script with an EndDate parameter equal to or greater than the
current day.

m CIMS Lab recommends that you run the script only once for a particular date range.
Although the script can be run multiple times against the same date range, the
CIMSSummaryDaily table is updated only once. If there is new data in a daily
CIMSSummary table and you run the script a second time, the script will fail and the
update will be backed out of the database because the data in the
CIMSSummaryDaily table does not match the data in the CIMSSummary table. In
this situation, you should run the script with the RemoveSummaryDaily parameter set
to true and then rerun the script with this parameter set to false. For more
information, contact CIMS Lab.

B The script could run for more than an hour per month. A status does not appear while
the script is running.
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CSRAggregator.wsf Script

Although CIMS Data Collectors automatically aggregate the records in the output CIMS
Server Resource (CSR) and CIMS Server Resource Plus (CSR+) file records, you might
want to use the CSRAggregator.wsf script to further aggregate the records in the following
situations:

B You want to remove an identifier or identifiers from the aggregated records. For
example, you might want to remove an identifier such as Time from the records to
reduce the size of the CSR or CSR+ file.

B You want to remove a rate code or codes from the aggregated records. For example,
the records contain a rate code that is not contained in the CIMSRate table and you
do not want to receive the CIMSBill message “One or more rate codes were missing”.

B You want to aggregate the records in a CSR or CSR+ file that was created by a source
other than CIMS Data Collectors. In this situation, all records that contain the same
identifier values are aggregated into one record that contains sum total resource
values for the rate codes within these records.

CSRAggregator.wsf script can read CSR files that have multiple record formats. That is,
records that have different identifier names and rate codes.

CSRAggregator.wsf Script Parameters

The CSRAggregator.wsf script uses the following parameters.

Parameter Description/Values

InputFilename (required)  The full path and file name of the input CSR or CSR+

file.
OutputFilename (required) The full path and file name of the aggregated CSR or
CSR+ file.
ExceptionFilename For future use.
(optional)
IdentifiersToRemove The identifier name or names that you want to remove.
(optional) If you want to remove multiple identifiers, separate the

identifier names by commas (e.g., time, feed, server).
The identifier names can be in any order.

If a record contains any of the specified identifiers, the
identifier or identifiers are removed.

Table C-4 - CSRAggregator Script Parameters
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Parameter Description/Values
ResourcesToRemove The rate code or codes that you want to remove. If you
(optional) want to remove multiple rate codes, separate the codes

by commas (e.g., 2018,2000,7003). The rate codes can
be in any order.

If a record contains any of the specified rate codes, the
rate code or rate codes are removed.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword

(optional)

Table C-4 - CSRAggregator Script Parameters

DropldentFromDB.wsf Script

The DropIdentFromDB.wsf script deletes a specified identifier from the CIMSDetailldent
and CIMSIdent tables. You should use the ListUnusedIdentifiers.wsf script (see

page C-15) to determine which identifiers are obsolete before using this script. You need
to run this script for each identifier that you want to delete

WARNING - Because this script irreversibly changes the database, CIMS Lab highly
recommends that you back up the database before you run the script.

DropldentFromDB.wsf Script Parameters

The DropIdentFromDB.wsf script uses the following parameters.

Parameter Description/Values

IdentifierName (required) The name of the identifier that you want to delete.

DataSourcelD (optional) See Data Source Parameters on page C-44.

Table C-5 « DropldentFromDB Script Parameters

DropldentBeforeLoad.wsf Script

The DropIdentBeforeload.wsf script deletes a specified identifier from the Ident. txt file.
Consult CIMS Lab before using this script.
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ExportClientToMainframe.wsf Script

The ExportClientToMainframe.wsf script creates a Client file that you can load into CIMS
Mainframe Data Collector and Chargeback System.

ExportClientToMainframe.wsf Script Parameters

The ExportClientToMainframe.wsf script uses the following parameters.

Parameter Description/Values

OutputFilename (required) The full path and file name of the output Client file.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword

(optional)

Table C-6  ExportClientToMainframe Script Parameters

ExportRateToMainframe.wsf Script

The ExportRateToMainframe.wsf script creates a rate file that you can load into CIMS
Mainframe Data Collector and Chargeback System.

ExportRateToMainframe.wsf Script Parameters

The ExportRateToMainframe.wsf script uses the following parameters.

Parameter Description/Values

OutputFilename (required) The full path and file name of the output rate file.

CreateRateGroups If set to true, rate groups will be created in the output
(optional) rate file. Rate groups are required if you plan to produce
reports on the CIMS Mainframe system.

Warning: The rate index in the output rate file will be
renumbered if this is set to true.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword

(optional)

Table C-7 < ExportRateToMainframe Script Parameters
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FTP.wsc and FTPSample.wsf Scripts

The FTP.wsc and FTPSample.wsf scripts assist in performing FTP transfers from a script.

ListUnusedldentifiers.wsf

The ListUnusedIdentifiers.wsf script creates a list of identifiers in the CIMSDetailldent
table that are unused as of a specified date. You can use this script to determine
identifiers that might be obsolete and then delete the obsolete identifiers using the
DropldentFromDB.wsf script (see page C-13).

The criteria for including an identifier in the list is based on the date entered for the
DateSelection parameter as follows:

m If an identifier is contained in the CIMSDetailldent table with usage end dates before
and after the DateSelection date, the identifier is not included in the list.

m Ifan identifier is contained in the CIMSDetailldent table with usage end dates before
the DateSelection date only, the identifier is included in the list.

ListUnusedldentifiers.wsf Script Parameters

The ListUnusedIdentifiers.wsf script uses the following parameters.

Parameter Description/Values

OutputFilename (required) The full path and file name of the output list file.
DateSelection (required)  The date that you want to use to select identifiers.

DataSourcelD (optional) See Data Source Parameters on page C-44.

Table C-8 « ListUnusedldentifiers Script Parameters
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OracleLogonTrigger.bat Script

B C-16

The OraclelogonTrigger.bat script enables you to install a trigger (1ogon_schema) that
changes a user’s default schema to the schema for the CIMS Server database at log on.
When the user logs on to the database, the schema defined in the trigger rather than the
default schema is used.

Note * You must also define the user and the schema in the Configure CIMS Data
Source Dialog box as described in Configuring the Data Source for an Oracle Database
beginning on page 2-44.

The OraclelogonTrigger.bat script presents the following command line options that
enable you to create, remove, and test the 1ogon_schema trigger. Following each option
is a description of the parameters that you are prompted to enter for that option.

Option/Parameters Description

1> Create Oracle Togon trigger Calls the Togon_trigger_create.sql
script to install the trigger for a specified
user.
Enter Oracle Database If this prompt appears, type the TNS

service name for the database.

Enter User ID for database? If this prompt appears, type a user ID for
the database that has administrative
privileges required to add or remove the
trigger.

Password for user IDP If this prompt appears, type the
password for the user ID.

Enter user to modifyb Type the user that you want to create the
trigger for.

New Schema for user Type the new schema that you want to
assign to the user.

2> Remove Oracle Togon trigger Calls the Togon_trigger_drop.sql script
to remove the trigger for a specified user.
Enter Oracle Database, User ID, See parameter descriptions for
and Password (if prompted for) Create Oracle logon trigger.

Enter user to remove trigger from Type the user that you want to remove
the trigger from.

Table C-9 - OracleLogonTrigger Script Options and Parameters
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Option/Parameters Description

3> Test Oracle logon trigger Calls the Togon_trigger_test.sqlscript
to confirm whether the trigger has been
created for a user. If the trigger has been
created, the user name and schema that
were defined for the schema are
returned. If the trigger has been removed
or was not created, the user name and
the user’s original schema are returned.

Enter Oracle Database See the parameter description for
Create Oracle logon trigger.

Enter User Type the name for the user that you want
to test the trigger for.

Enter Password Enter the user’s password.

4> Exit Exits the OraclelogonTrigger.bat script.

Table C-9 - OracleLogonTrigger Script Options and Parameters (Continued)

a. This parameter is required to connect to the database. Once you have entered this pa-
rameter, you are not prompted for the database again during the script session.

b. The User ID and Password parameters are required the first time that you create or re-
move a trigger during a script session (whichever you perform first). Once you have en-
tered these parameters, you are not prompted for them again during the script session.

Running the PLSQL Scripts Manually

You can execute any of the PLSQL scripts manually by typing the following at the
appropriate command prompt (e.g., C:\Program Files\CIMSLab\Scripts>).

To create a trigger:

sqlplus <user ID>/<password>@<database> @logon_trigger_create.sql <user>
<schema>

user ID=user ID used to install the trigger
password=password for the user ID
database=TNS service name for the database
user=user you want to create the trigger for

schema=new schema for the user
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To remove a trigger:
sqlplus <user ID>/<password>@<{database> @logon_trigger_drop.sql <user>

Where:

password=user ID used to remove the trigger
password=password for the user ID
database=TNS service name for the database
user=user you want to remove the trigger from

To test a trigger:
sqlplus <user>/<password>@<{database> @logon_trigger_test.sq]

Where:
user=user you want to test the trigger for
password=user’s password

database=TNS service name for the database

ProRate.wsf Script

The ProRate.wsf script is provided for backward compatibility. If you are using CIMS
Server 4.0 or later, you should use the CIMSPrat program as described in CIMS Data
Collectors for Microsoft Windows Installation and User Guide.

For assistance in converting your ProRate.wsf script to this new functionality, contact
CIMS Lab.
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PurgeLoads.wsf Script

Important! ¢ This script permanently removes data from the CIMSSummary,
CIMSDetail, CIMSDetailldent, and CIMSResourceUtilization tables. Consult CIMS
Lab before using this script.

The CIMSSummary, CIMSDetail, CIMSDetailldent, and CIMSResourceUtilization tables
can accumulate a large amount of data. To control the size of these tables, you can use
the Purgeloads.wsf script to delete loads that have accounting start and end dates within
a specified date range. All data loaded to the database within this date range is removed
permanently, not archived.

PurgeLoads.wsf Script Parameters

The Purgeloads.wsf script uses the following parameters.

Parameter Description/Values

StartDate and EndDate These parameters specify the date range for the loads

(required) that you want to delete from the tables. Any loads that
have accounting start and end dates in this range are
deleted.

Valid values are:

m preday (previous day)

m premon (previous month)
B rndate (current day)

m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system'’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

PurgeSummary, These parameters specify whether the CIMSSummary,

PurgeBillDetail, CIMSDetail, CIMSDetailldent, and/or

Purgeldent, and/or CIMSResourceUtilization tables are purged. If set to

PurgeAcctDetail he table i dIf he table i

(required) true, the table is purged. If set to false the table is not
purged.

Table C-10 « PurgeLoads Script Parameters
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Parameter Description/Values
SkipConfirmation If this parameter is set to false or is not provided, a
(optional) message appears and confirmation is required before
the script is run. If this parameter is set to true, the
confirmation message does not appear.
DataSourcelD (optional) See Data Source Parameters on page C-44.

Table C-10  PurgeLoads Script Parameters (Continued)
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Rebill.wsf and ResourceConversion.wsf Scripts

Important! ¢ The following scripts change the data in the CIMS Server database. You
should back up the database before running these scripts.

You can recalculate rate codes that you previously processed and loaded into the CIMS
Server database using a different rate value and/or resource conversion factor without
reprocessing the data. That is, if you change the rate value and/or resource conversion
factor for a rate code in the CIMSRate table, you can update the rate value and conversion
factor and recalculate the money value directly in the CIMSSummary table. (For more
information about the rate code value and resource conversion factor, see Working With
Rates on page 3-9.)

CIMS Lab provides the following scripts to perform this process:

m Rebill.wsf. This script updates the rate code value and recalculates the money value
for a rate code or codes in the CIMSSummary table. If you have not changed the
resource conversion factor for a rate code or codes, you do not need to run the
ResourceConversion.wsf script.

B ResourceConversion.wsf. This script updates the rate code resource conversion factor
in the CIMSSummary table. You need to run the Rebi11.wsf script after running this
script to recalculate the money value for the rate code.

Important! ¢« Consult CIMS Lab before using the ResourceConversion.wsf script.
If you run this script more than once for the same rate code or codes, the resource
units that are converted are the units that were converted previously, not the
original units. For example, if the conversion factor for a rate code is Divide by 60
and the resource units are 120, the resource unit value after calculating once is 2,
after calculating twice it is .033 (2+60), etc.

This scenario is not applicable to the Rebil1.wsf script—you can run this script
multiple times for the same rate code or codes.
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Rebill.wsf and ResourceConversion.wsf Script Parameters

The Rebi11.wsf and ResourceConversion.wsf scripts use the following parameters.

Rebill.wsf Parameters

Parameter Description/Values

StartDate and EndDate These parameters specify the date range for the records

(required) that contain the rate code or codes that you want to
rebill. Typically, the start date is the first day of the
month and the end date is the last day of the month.

Valid values are:

m preday (previous day)

m premon (previous month)
®m rndate (current day)

m curmon (current month)
B date in yyyymmdd format

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

RateCode (optional) The rate code or codes that you want to recalculate. If
you want to recalculate all rate codes, set the parameter
to A11 or do not include the parameter.

RateTable (optional) The rate table that contains the rate code or codes that
you want to recalculate.

If this parameter is set to C1ient or is not provided, the
CIMSClient table is read to determine the rate table for
each client in the CIMSSummary table.

If you provide a specific rate table name, for example
STANDARD, that table is used for all clients in the
CIMSSummary table.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword
(optional)

Table C-11 ¢ Rebill.wsf Script Parameters
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ResourceConversion.wsf Parameters

Parameter Description/Values

StartDate and EndDate See the description for Rebill.wsf Parameters on
(required) page C-22.
RateCode (optional) The rate code or codes that you want to change the

resource conversion factor for.

If you want to change the conversion factor for all rate
codes, set the parameter to Al1, leave the parameter
blank, or do not include the parameter.

CIMS Lab recommends that you do not use A1l as a
parameter because all resources for rate codes with an
specified resource conversion factor will be further
factored by that value. That is, if a resource has already
been factored, the resulting resource number, not the
original resource number, will be factored again.

DecimalPositions The number of decimal positions that you want to

(optional) appear in the resource units that will be written out by
the conversion. For example, if you want two decimal
positions to appear in the converted resource units, set
this parameter to 2.

If you do not include this parameter, the default is four
decimal positions.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword
(optional)

Table C-12 + ResourceConversion Script Parameters
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SampleBulkUserLoad.wsf Script

B C-24

The SampleBulkUserload.wsf script loads users into the CIMSUser table. A user group
with the same name as the user ID is created in the CIMSUserGroup table.

Note ¢ You should use this script to load users to a test database before loading to a
production database.

To use this script you can:

m Customize this script to automatically gather and load the user information from
another source such as a database. Please contact CIMS Lab for assistance in
customizing this script.

Or

m Create comma-delimited client access and report access files for the users that provide
the following information. The information must be provided in the order shown.

Client access file format

user ID,domain user ID,domain name,full name,client account code
Report acces file format
user ID,domain user ID,domain name,full name,report file name

If you want to assign specific client account codes or reports to a user, include a separate
line for each client/report. If you want to assign all client account codes and reports to
the user, leave the client account code and report file name fields blank.

Do not include the extension for the report file name (e.g., .rpt, .rdl, .xml).

SampleBulkUserLoad.wsf Script Parameters

The SampleBulkUserLoad.wsf script uses the following parameters.

Parameter Description/Values

InputClientAccessFileName The full path and file name for the input file containing

(required) the client or clients for the user group.
InputReportAccessFileName The full path and file name for the input file containing
(required) the report or reports for the user group.
AccountCodeStructureName  The account code structure to assign to the user if other
(optional) than the Standard structure.

DataSourcelD (optional) See Data Source Parameters on page C-44.

Table C-13 - SampleBulkUserLoad Script Parameters
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SampleExportSummary.wsf Script

This script creates a file containing the data from the CIMSSummary table in a general
format. Because this script requires modification for your organization to specify the
output file format, the script must be renamed ExportSummary.wsf (or another name).
Renaming the script prevents it from being overwritten when you upgrade to a new
version of CIMS Server.

SampleExportSummary.wsf Script Parameters

The SampleExportSummary.wsf script uses the following parameters.

Parameter Description/Values

StartDate and EndDate These parameters specify the date range for the records

(required) that you want to export from the CIMSSummary table.
Any records that have accounting start and end dates in
this range are exported.

Valid values are:

m preday (previous day)

m premon (previous month)
m rndate (current day)

®m curmon (current month)

m date in yyyymmdd format or a format valid for your
operating system’s regional settings

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

OutputFilename (required) The full path and file name for the output summary file.

DataSourceID (optional) The CIMS Data Source ID for the CIMS Server database.
See Data Source Parameters on page C-44.

Table C-14 - SampleExportSummary Script Parameters
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SampleSQLMaintenance.bat Script

B C-26

Note ¢ This script supports SQL Server and MSDE only.

The purpose of the SampTleSQLMaintenance.bat script is to ensure that your CIMS Server
database(s) are backed up and maintained on a regular schedule. This script is used to
set up a database backup and maintenance routine if you do not have another method
in place (see Managing CIMS Data Sources and Setting the Database Recovery Model on
page 5-5).

This script performs all standard SQL Server maintenance tasks, including:

Ensures that the database is set to a Simple recovery model.
Backs up the database.
Deletes backups that are over two weeks old.

Checks the database for errors with a CheckDB command and a check of the indexes
and catalog.

Performs an index rebuild.
Updates the database statistics.
Removes unused space in the database with a ShrinkDatabase command.

Writes a log file called SQLMaintyyyymmddhhmm. txt that provides feedback from the
SampleSQLMaintenance.bat script and distributes the file via e-mail.

Important Notes About the SampleSQLMaint.bat Script

Because this script requires modification for your organization, the script must be
renamed SQLMaintenance.bat (or another name) so that the file is not overwritten
when you upgrade to a new version of CIMS Server.

By default, all users will be disconnected from the database while this script is
running. You can change this default if necessary (see the Set DB to Single User step
in the script).

Depending on the size of your database, this script could run for minutes or hours.
Typically, a 5 GB database will run for less than 1 hour.

By default, the User1D and Password parameters are not used. The script assumes that
you are using Windows authentication for the database and any values set for these
parameters are ignored. It is preferable to use Windows authentication for the
database so that the ID and password are not kept in the script.

If a user ID and password is required for the database:

e Remove the -t from every line in which it appears.

e Add -Ufollowed by %userID%and -P followed by %password?% to these lines. For
example, -U %admin% -P %global%.
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m For MSDE users:

e The steps Setting Recovery Model to Simple, Set DB to Single User, and Set
Database back to Multi User return a warning message. These messages to not
require any action.

Setting Up the SampleSQLMaint.bat Script
You need to modify the SampleSQLMaint.bat script as follows:

1 Set the correct values for the SQLServerInstalllocation, BackupDirectory, Database,
Server, SMTPServer, and ToEmailAddress parameters.

The SQLServerInstalllocation parameter defines the path for the SQL Server
installation.

The BackupDirectory parameter defines the path for the database backup. A folder
with the same name as the database is automatically created using this path. The
database backup is placed in this folder.

The Database parameter defines the database name.
The Server parameter defines the name of the server that contains the database.

The SMTPServer parameter defines the name of the SMTP mail server that will be used
to send the SQLMaintyyyymmddhhmm.txt log file.

The ToEmailAddress parameter defines the e-mail address that the log file is sent to.

2 Follow the remarks in the script to set the values required for the remaining lines in
the script.

3 Save the modified script with the name SQLMaint.bat or choose another name.

4 Use Windows Task Schedular to run this script, preferably on a weekly basis on the
weekend. To use Task Schedular, see To run a batch file from Task Scheduler: on
page C-6.

5 If1IS is run from a server other than the server running this script, restart IIS.
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SaveDBSQLServer.wsf

Note ¢ This script supports SQL Server only.

The SaveDBSQLServer.wsf enables you to easily send your database to CIMS Lab for
troubleshooting purposes. This script automates the process of detaching the database,
creating a zip file containing the .MDF and . LDF files, and then reattaching the database.

Note ¢ You cannot use this script to detach the master database.

SaveDBSQLServer.wsf Script Parameters

The SaveDBSQLServer.wsf script uses the following parameters.

Parameter Description/Values

ServerName (required) The name of the server that contains the database.
DatabaseName (required) The name of the database.

ArchiveFilename The full path and file name for the output zip file that
(required) contains the .MDF and . LDF files.

0DBCUserID and The SQL Server user ID and password for the database

ODBCPassword (optional) (if required).

Table C-15 « SaveDBSQLServer Script Parameters

Schedule.wsf

The Schedule.wsf script runs a script or program daily at a specified time.
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Table.wsf Script

WARNING - This script loads tables in the CIMS Server database. Extreme caution
should be used when loading a table. Deleting or overwriting data can cause unexpected
results. Be sure a backup exists before using this script.

The Table.wsf script loads the CIMSClient and/or CIMSRate tables from comma-
delimited files. This script performs the same function as the Load Selected Tables option
in the Chargeback Tables dialog box (see Loading and Exporting Client and Rate Tables on
page 5-13).

The files must have the same name as the tables (i.e., CIMSC1ient.txt and CIMSRate. txt)
and must be in the same comma-delimited format as a file that is exported from the table
(including the column headers in the first record of the file).

For examples of the required formats for the files, you can export the CIMSClient and
CIMSRate tables to files using the steps on page 5-13. For a description of the fields in
the files, see CIMSClient Table on page A-15 and CIMSRate Table on page A-29.

Table.wsf Script Parameters

The Table.wsf script uses the following parameters.

Parameter Description/Values

CSVFilesFolderPath The full path for the folder that contains the
(required) CIMSClient.txt and CIMSRate.txt files.
DataSourcelID (optional) See Data Source Parameters on page C-44.

Table C-16 « Table Script Parameters
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ZeroCost.wsf Script

The ZeroCost.wsf script recalculates the money values in the CIMSSummary table for a
rate code among all accounts using a specified amount. For example, if you specify a zero
costamount of $100,000 for the rate code DISKSIZE, the resource usage for this rate code
for all accounts will be factored to this amount and a new CSR file is written.

ZeroCost.wsf Script Parameters

The ZeroCost.wsf script uses the following parameters.

Parameter Description/Values

OutputFilename (required) The full path and file name for the output CSR file.

StartDate and EndDate These parameters specify the date range for the records
(required) in the CIMSSummary table that contain the rate code
that you want to recalculate.

Valid values are:

m preday (previous day)

m premon (previous month)
m rndate (current day)

m curmon (current month)
m date in yyyymmdd format

If you use the premon or curmon keyword for the start
date or end date, the first day of the month is used for
the start date and the last day of the month is used for
the end date.

ZeroCostAmount The amount by which you want to factor the money
values for the rate codes. You can enter the amount with
or without decimals, but do not include commas or
currency symbols.

AdjustmentRateCode The rate code that you want to apply the zero cost value
to.

DataSourcelD, 0DBCUserID, The CIMS Data Source ID for the CIMS Server database.

and ODBCPassword See Data Source Parameters on page C-44.
(optional)

Table C-17 « Table Script Parameters
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Batch Reporting Scripts

CIMS Lab provides the following scripts for creating and distributing batch reports.
These scripts are described in detail in the following sections. If you installed CIMS
Server in the default location, these scripts are in C:\Program Files\CIMSLab\
Scripts\Batch Reporting.

ReportDistribution.wsf. This script automates the process of creating and
distributing published reports. This script calls the BatchReport.wsf to create the
reports and the EmailDistribution.wsf script to distribute the reports via a link or
attachment in an e-mail message.

BatchReport.wsf. This script automates the process of creating published reports and
directs the reports to the proper location in the Published folder. You can run this
script independently of the ReportDistribution.wsf script; however,
BatchReport.wsf does not call EmailDisrtibution.wsf to provide e-mail report
distribution.

In addition, the ReportDistribution.wsf script automatically processes the
definitions in a specified report cycle and creates the report parameters file required
by the BatchReport.wsf script. If you do not use the ReportDistribution.wsf script,
you need to create the parameters file manually or use the optional Al11Accts.wsf
script to create the file.

A11Accts.wsf. This script produces files that contain the report parameters used by
the BatchReport.wsf script. If you are using the ReportDistribution.wsf script, this
script is not applicable. If you are running the BatchReport.wsf script directly, this
script is optional—you can create the report parameter files without using this script.

EmailDistribution.wsf. This script automates the process of distributing reports via
e-mail.

ReportParms.wsf. This script is for use by CIMS Lab.

If you run these scripts on a computer other than the computer that contains the CIMS
reporting folders (Custom, Standard, and Published), you need to do the following:

1

Create a share for each of the folders. Set the folder share permission to Full Control
for the Windows user account or accounts that are publishing the report.

Define the path for each folder as a UNC path in the Configuration dialog box (see
Reporting Settings on page 3-45).

Restart IIS on the Web server (see page 8-5).

Run a report on the CIMS Server Web Reporting Web site to make sure that the report
paths are set up correctly.
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ReportDistribution.wsf Script

The ReportDistribution.wsf script publishes all reports defined for a report cycle and
distributes the resulting reports as a link or attachment in an e-mail message.

The ReportDistribution.wsf script uses the following parameters.

Parameter Description/Values

Cycle (required) The name of the report cycle that you want to run.

LogFolder (required) This parameter defines the location of the following
output files produced by this script:

m A file that logs the batch reporting process.

B Areport parameters file used by the BatchReport.wsf
script.

The log file is automatically assigned the file name
YYYYMMDDHHMM. txt and the report parameters file is
assigned the file name InputVYYYYMMDDHHMM. txt.

DataSourcelD (optional) The CIMS Data Source ID for the database that you want
to use for reporting. See Data Source Parameters on
page C-44.

Email (optional) This parameter is helpful in testing or other situations in
which you want to publish reports but do not want to
distribute the reports via e-mail or you want to send an
e-mail for reports that have already been published.

Valid values are:

B Trial. An e-mail message is not sent, but reports are
published.

m Only. Ane-mail is sent, but reports are not published.
The e-mail contains a link to the previously
published report.

Silent (optional) If this parameter is set to Y, no messages appear when
the ReportDistribution.wsf script is run. If this
parameter is set to N or is not provided, interactive
messages appear and you must click OK to continue.

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not provided, this information does not appear in the
log file.

Table C-18 « ReportDistribution Script Parameters
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BatchReport.wsf Script

The BatchReport.wsf script generates published reports and places the reports
in the proper location in the Published folder. This script is called by the
ReportDistribution.wsf script.

The BatchReport.wsf requires the following input:
B The report parameters file described in About the Report Parameters File.

m The BatchReport.wsf script parameters described in BatchReport.wsf Script Parameters
on page C-39.

About the Report Parameters File

The BatchReport.wsf script requires a file containing the parameters for the report(s)
that you want to publish. If you are using the ReportDistribution.wsf script to run the
batch reporting process, this file is created automatically using the definitions in the
report cycle.

If you are not using the ReportDistribution.wsf script, you can create this file manually
or you can use the AlTAccts.wsf script to create the file (see AllAccts.wsf Script on
page C-40).

One file may contain the parameters required to run multiple reports. CIMS Lab
provides sample report parameters files for running a single report (inputl.txt) and
multiple reports (input2.txt). These files are in the Batch Reportingfolder. To use these
files to publish sample reports, follow the steps in the readme.txt file.

Any line in the report parameter file that begins with an asterisk (*) or does not include
an equal sign (=) is considered a comment.

The parameters listed in Table C-19 are used for the standard reports included in the
CIMS Server installation. The parameters required differ by report. (For a description of
each of these reports and their required parameters, refer to the CIMS Server Web
Reporting User’s Guide). The parameters for custom reports used by your organization
might differ.

Parameter Description/Values

Run Parameters

The following parameters are applicable to all reports defined in the file. These
parameters can be in any order, but must precede report-specific parameters.

LOCALDRIVE= If you are running the BatchReport.wsf script on a
(optional) computer other than the Web server, the drive that you are
mapping to that contains the CIMS Server Reports folder.

Example: LOCALDRIVE=W

Table C-19 « Batch Report Parameters
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Parameter Description/Values

To enable drill down within published invoices, you need set the following three
parameters as required. For more information about drilling down in reports, refer to
the CIMS Server Web Reporting User’s Guide.

RUNSERVERNODE= The name of the server running the CIMS Server Web

(optional) Reporting Web site. For more information about drilling
down in reports, refer to the CIMS Server Web Reporting
User’s Guide.

Example: RUNSERVERNODE=SERVERABC

RUNPORTNUMBER= If the port number for the Web site if it is other than port 80.
(optional) Example: RUNPORTNUMBER=81

RUNVIRTUALDIRECTORY= " The virtual directory name of the CIMS Server Web
(optional) Reporting Web site.

Example: RUNVIRTUALDIRECTORY=DIRECTORYABC

Report Parameters

The RUNreporttype=parameters indicate the beginning of a new report to be published.
These parameters can be in any order, but cannot precede the run parameters described
previously.

The report specified by the RUNreporttype= parameter must be a Crystal Report in the
Customor Standard report folder.

For an example parameter file for multiple reports, refer to the file input2.txt in the
Batch Reporting folder.

RUNREPORT= The file name of the report that you want to publish. If want

(required for reports) O publish an invoice that provides invoice numbers, use
the RUNINVOICE parameter.

Example: RUNREPORT=XSUMCOO1. rpt

RUNINVOICE= If you want to publish an invoice that provides invoice

(required for numbers, that is, Invoice by Account Level, Invoice with

invoices) Shifts, etc., use this parameter to specify the file name of the
invoice.

Example: RUNINVOICE=RINVC007.rpt

RUNSPREADSHEET= The file name of the spreadsheet that you want to publish.
(required for Example: RUNSPREADSHEET=SYTDCOO1 . rpt

spreadsheets)

RUNPDF= This parameter enables you to publish a report or
(optional) spreadsheet as a PDF file. For example, if you want to

publish the Invoice by Account Level report as a PDF,
specify RUNPDF=RINVICO007.rpt.

Table C-19 - Batch Report Parameters (Continued)
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Parameter Description/Values
ACCOUNTSTRUCTURE= The name of the account code structure to be used for the
(optional) report. If you are using the account code structure Standard,

this parameter is not required. If you are not using the
Standard account code structure, this parameter is required
after the RUNREPORTYPFE= parameter.

Note that you can use more than one account code structure
in the parameter file. The BatchReport.wsf script will use
the first account structure specified or the Standard structure
until it encounters another ACCOUNTSTRUCTURE= parameter.
Each time the script encounters a different parameter it will
use that parameter.

If the account code structure varies by report, you need to
specify Standard as a parameter if it follows a different
ACCOUNTSTRUCTURE= parameter.

Examples: ACCOUNTSTRUCTURE=Standard
ACCOUNTSTRUCTURE=DivisionA

RUNDATESTART= and The start and end dates for the data that you want to appear

RUNDATEEND= in the report in the format mm/dd/yyyy.

ﬁg{e}ga%ged depending on All reports within the report parameter file use these
parameters until another set of RUNDATESTART and
RUNDATEEND parameters or another date parameter (see the
following) is encountered. These parameters must appear
before the RUNreporttype= parameters. For an example,
refer to the file input2.txt in the Batch Reporting folder.
Example: RUNDATESTART=07/01/05

RUNDATEEND=07/31/05

REPORTMONTH= The month for the data that you want to appear in the

(required depending on Teportin the format mm.

report) Example: REPORTMONTH=07

REPORTYEAR= The year for the data that you want to appear in the report

(required depending on in the format yyyy.

report) Example: REPORTYEAR=2005

USER= The user ID used to execute the report. The report will

(required) contain only those clients that are assigned to the user’s user

group (see Adding or Removing Client Access to/from a Group
on page 3-38). If you have restricted client access for some
users, make sure that you do not execute the report using a
user ID that can view all clients.

Example: USER=admin

Table C-19 - Batch Report Parameters (Continued)
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Parameter Description/Values

DEST= The report must be saved in the published reports folder
(required) specified on the Reports tab in the Configuration dialog
box (see Reporting Settings on page 3-45). This parameter
specifies the destination location of the report as follows:

m DEST=GLOBAL. The report will be stored in the globa
subfolder in the published reports folder.

m DEST=GROUP=group id. The report will be stored in a
subfolder with the same name as the group id in the
group subfolder in the published reports folder. For
example, the destination for DEST=GROUP=Admin would be
.../group/Admin.

m DEST=USER=user id. The report will be stored in a
subfolder with the same name as the user id in the user
subfolder in the published reports folder. For example,
the destination for DEST=USER=joe would be . .. /group/
joe.

m DEST=ACCOUNT=account code. The report will be
stored in a subfolder with the same name as the account
code in the account subfolder in the published reports
folder. For example, the destination for DEST=ACCOUNT=AA
would be . . ./account/AA.

REPORTPERIOD= Published reports are further stored in a subfolder

(optional) indicating the report period. For example, .../account/AA/
200507 (July 2005 if you are using the default
CIMSCalendar table). The report period is in YYYYMM
format. If this parameter is not provided or is left blank, the
folder name defaults to the current period.

The report period can be any date. It does not have to reflect
the dates of the data in the report.

Depending on the report type specified by the RUNREPORT/
INVOICE/SPREADSHEET= parameter, a subfolder named
Reports or Spreadsheets is automatically created in the
report period folder. The published reports reside in this
folder. For example, the path for a published Invoice by
Account Level report might appear as follows: .../
Published/account/AA/200507/Reports/rinvc007.rpt.

Example: REPORTPERIOD=200507

Table C-19 - Batch Report Parameters (Continued)
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Parameter Description/Values
NAME= The file name that you want to assign to the report. The
(optional) report is saved with the extension . rpt.

If this parameter is not provided or is left blank, the name
defaults to the file name specified by the RUNREPORT/
INVOICE/SPREADSHEET= parameter.

Note that if you assign a new file name, the report will not
be included in the end user’s favorite reports list in CIMS

Server Web Reporting. For more information about favorite
reports, refer to the CIMS Server Web Reporting User’s Guide.

Example: NAME=AccountlevelInvoice

Some invoice reports contain separate invoices for the account codes selected. The first
invoice number is read from the CIMSConfigOptions table. This number is set in the
in the Configuration dialog box (see Invoice Subtab on page 3-47).

The invoice numbers continue to increase sequentially in the table each time you run
an invoice. For example, if the last invoice in a report was 99, the next invoice that you
run will begin with invoice number 100.

If you do not want to use the invoice number in the table when your run the
BatchReport.wsf script, use the INVOICENUMBER= parameter.

INVOICENUMBER= This parameter sets the number at which you want invoice
(optional) numbers within the report to begin. Invoices numbers
increase in sequential order from this number.

The invoice number in the CIMSConfigOptions table is not
used or changed when this parameter is used.

Example: INVOICENUMBER=10

INVOICELEVEL= A number representing the account code level that you want

(required) to view in the report. For example, the account code
AABBBBCCC might contain three levels: the company code
AA, the division code AABBBB, and the department code
AABBBBCCC. The resource usage and charge data will
reflect the level that you specify—1, 2, or 3.

Example: INVOICELEVEL=2

ACCOUNTCODESTART= and  This parameter works in conjunction with the Invoicelevel

ACCOUNTCODEEND= parameter (see the following) and specifies the account

(required) codes for that level that appear in the report. For example,
if INVOICELEVEL=2 and you want data for account codes
AABBBB, BBBBBB, CCBBBB, and DDBBBB, enter AA as the
starting account code and DD as the ending account code.

Table C-19 - Batch Report Parameters (Continued)
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Parameter Description/Values
GRAPH= If this parameter is Y a graph appears before the report. If
(optional) this parameter is N, is left blank, or is not provided, the
graph does not appear.
Example: GRAPH=Y
IDENTIFIER= The identifier that you want to report data by.
ﬁgggf%g?d for some Example: IDENTIFIER=JOBNAME
RATECODE= The rate code that you want to report data by.
ﬁggg uired for some Example: RATECODE=Z003
RATEGROUP= The rate group that you want to report data by.
ﬁggg‘#jﬁg?d for some Example: RATEROUP=Oracle charges
PRORATE= The amount that you want to prorate across accounts in
(required for some proration reports.
reports)

Example: PRORATE=3000

TERMINALIDSTART= and ~ The CICS terminal ID range that you want to report data by.

TERMINALIDEND= For example, if you want data for the terminal IDs 3191,

(required for some 3C02, and 8A33, enter 3191 as the starting transaction ID

reports) and 8A33 as the ending ID. Numbers precede letters in the
range order. Therefore, 3191 precedes 3C02.

TOPN= The number of account codes that appear in a report or the

(optional) drill down for a report. For example, if you enter 1, only the

account code that used the most resources or incurred the
most charges appears. If you enter 2, the highest and second
highest account codes appear.

Example: TOPN=3

TRANSACTIONTYPE= The transaction type that you want to report data by. For
(required for some more information about transactions, refer to the CIMS
reports) Server Web Reporting User’s Guide.

Example: TRANSACTIONTYPE=Recurring

Table C-19 - Batch Report Parameters (Continued)
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Parameter Description/Values

ZEROCOSTPROCESSINGOPTI  One of the following letters indicating how the Zero Cost

ON= Invoice report will be processed:
ﬁ gggl}f]ﬁg?d for some m A —This factors the invoice total by the zero cost amount.
m B—This factors each resource rate in the invoice by the
Zero cost amount.
Example: ZEROCOSTPROCESSINGOPTION=A
ZEROCOSTAMOUNT The zero cost amount. You can enter this amount with or

without the decimal point. For example, 100000 or
100000.00. For more information about zero cost, refer to
page 3-11.

Example: ZEROCOSTAMOUNT=50000

Table C-19 - Batch Report Parameters (Continued)

BatchReport.wsf Script Parameters

The BatchReport.wsf script uses the following parameters.

Parameter Description/Values

Input (required) The file that contains the parameters needed to process
the report (see About the Report Parameters File on
page C-33).

DataSourcelID (optional) The CIMS Data Source ID for the CIMS Server database.
See Data Source Parameters on page C-44.

Silent (optional) If this parameter is set to Y, no messages appear when
the BatchReport.wsf script is run. If this parameter is set
to N or is not provided, interactive messages appear and
you must click OK to continue.

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not provided, this information does not appear in the
log file.

Table C-20 - BatchReport Script Parameters
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AllAccts.wsf Script

B C-40

Note ¢ If you are using the ReportDistribution.wsf script, this script is not
applicable.

This script produces the report parameters files that are used by the BatchReport.wsf to
publish reports in batch. The primary purpose of this script is to retrieve the account
codes associated with a user from the database and to create the parameters required to
run a separate report for each account code.

You can create the report parameters file without using the A1TAccts.wsf script. In
addition, the script does not provide all required parameters for some reports. To create
a report parameters file or to add parameters to a file created by the A11Accts.wsf script,
refer to About the Report Parameters File on page C-33.

The ATTAccts.wsf script requires an input file to determine the content of the report
parameters file. The parameters for this input file are described in Input File Parameters.
The parameters required process the input file are described in AllAccts.wsf Script
Parameters on page C-42.

Input File Parameters

To specify the parameters that you want to appear in the report parameter file, you need
to create an input file containing the parameters shown in Table C-21. You can add the
parameters in any order.

You can include other parameters in the input file, but only the parameters in Table C-21
are used by the Al1Accts.wsf script. Any other parameters are passed to the report
parameters file.

Any line in the input file that begins with an asterisk (*) or does not include an equal
sign (=) is considered a comment.

CIMS Lab provides a sample input file, input3.txt, that you can use to create a report
parameter file. If you installed CIMS Server in the default location, this file is in
C:\Program Files\CIMSLab\Scripts\Batch Reporting. Follow the steps in the
readme. txt file.

Parameter Description/Values

LOCALDRIVE= If you are running the A11Accts.wsf script on a computer
(optional) other than the Web server, the drive that you are mapping
to that contains the CIMS Server Reports folder.

Example: LOCALDRIVE=W

ACCOUNTSTRUCTURE= The name of the account code structure to be used (see
(required) Defining the Account Code Structure on page 3-4).

Example: ACCOUNTSTRUCTURE=Standard

Table C-21 « Allacct.wsf Input File Parameters
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Batch Reporting Scripts
Parameter Description/Values
USER= The user ID. Only those account codes to which the user has
(required) access are included in the report parameter file (see Adding
or Removing Client Access to/from a Group on page 3-38).
INVOICELEVEL= A number representing the account code level that you want
(required) to view in the report. For example, the account code

AABBBBCCC might contain three levels: the company code
AA, the division code AABBBB, and the department code
AABBBBCCC. The resource usage and charge data will
reflect the level that you specify—1, 2, or 3.

Example: INVOICELEVEL=2

RUNREPORT= The file name of the report that you want to publish.

(required) Example: RUNREPORT=XSUMC001. rpt

RUNINVOICE= If you want to publish an invoice that provides invoice

(required) numbers, that is, Invoice by Account Level, Invoice with
Shifts, etc., use this parameter to specify the file name of the
invoice.

Example: RUNINVOICE=RINVC007.rpt

RUNSPREADSHEET= The file name of the spreadsheet that you want to publish.
(required) Example: RUNSPREADSHEET=SYTDCOO1 . rpt

Table C-21 « Allacct.wsf Input File Parameters (Continued)
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AllAccts.wsf Script Parameters

The Al11Accts.wsf script uses the following parameters.

Parameter Description/Values

InputFile The file that contains the parameters needed to create
the report parameters file used by the BatchReport.wsf
script (see About the Report Parameters File on

page C-33).
QutputFite The output report parameters file.
LogFolder The full path for the output file that logs the process of

creating the report parameters file. The file name is
YYYYMMDDHHMM. tXT.

DataSourcelD, ODBCUserID, See Data Source Parameters on page C-44.
and ODBCPassword
(optional)

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not provided, this information does not appear in the
log file.

Table C-22 « AllAccts Script Parameters

EmailDistribution.wsf Script

B C-42

The EmailDistribution.wsf script distributes all reports defined for a report cycle as a
link or attachment in an e-mail message.

The EmailDistribution.wsf script uses the following parameters. These parameters are
passed from the ReportDistribution.wsf script.

Parameter Description/Values

Cycle The name of the report cycle that is used.
DataSourcelD See Data Source Parameters on page C-44.
Silent (optional) If this parameter is set to Y, no messages appear when

the EmailDistribution.wsf script is run. If this
parameter is set to N or is not provided, interactive
messages appear and you must click OK to continue.

Debug (optional) If this parameter is set to Y, debugging information
appears in the log file. If this parameter is set to N or is
not provided, this information does not appear in the
log file.

Table C-23 + EmailDistribution Script Parameters
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Client Load Scripts

The scripts described in this section are used to load the CIMSClient table. If you
installed CIMS Server in the default location, these scrips are in C:\Program
Files\CIMSLab\Scripts\Client Load.

MainframedlientContactToServer.wsf Script

The MainframeClientContactToServer.wsf script loads client and contact data from the
CIMS Mainframe Client file into the CIMSClient table. This script retrieves the CIMS
Mainframe Client file data from the CIMS Report Writer report SPWTR806.

MainframedClientContactToServer.wsf Script Parameters

The MainframeClientContactToServer.wsf script uses the following parameter.

Parameter Description/Values

strMainFrameFile The full path for the report file to be loaded.

Table C-24 - MainframeClientContactToServer Script Parameter

LoadClientTableFromCSVFile.wsf Script

The LoadClientTableFromCSVFile.wsf script is provided for backward compatibility. If
you are using CIMS Server 4.0 or later, you should use the Table.wsf script (see
page C-29).
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Desktop Scripts

The scripts described in this section are in C: \Program Files\CIMSLab\Scripts\Desktop
(if you installed CIMS Server in the default location).

UnloadDesktop<Client/Rate/Summary>ForServer.wsf Script

These scripts export the data from the CIMS Desktop Client, Rate, and Summary tables
into a comma-delimited text file. This file can then be loaded into the CIMS Server
database (see To load or export a table: on page 5-12).

UnloadDesktop<Client/Rate/Summary>ForServer.wsf
Script Parameters

The UnloadDesktop<Client/Rate/Summary>ForServer.wsf script uses the following

parameters.
Databaselocation The full path to the CIMS Desktop database.
OutputlLocation The full path and file name for the exported table.

Table C-25 + UnloadDesktop<Client/Rate/Summary>ForServer Script Parameters

Data Source Parameters

The following optional data source parameters are common to many of the scripts
described in this chapter.

Parameter Description/Values

DataSourcelD The CIMS Data Source ID for the database that you want
to use with the script.

If this parameter is not provided, the data source that is
set as the Web/collector default in the CIMS Data Source
Maintenance dialog box is used (see page 5-7).

To use a CIMS Data Source other than the default, set
this parameter to the appropriate data source ID.

0DBCUserID and These parameters are deprecated for most scripts. They

ODBCPassword were previously used to pass the SQL Server user ID and
password for the database (if required). For security and
convenience, the user ID and password are retrieved
using the CIMS Data Source in CIMS Server
Administrator.

Table C-26 « Common ODBC Parameters
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Scripts Used by CIMS Server 3.3 and Earlier

The following scripts are provided for backward compatibility only. For descriptions of
these scripts, refer to the CIMS Data Collectors for Microsoft Windows Installation and User
Guide for releases 3.3 and earlier.

CIMSUtils.wsf
CleanUp.wsf
ProcCIMS.wsf
ProcConvEngine.wsf
SampleMonthly.wsf
SampleNightly.wsf
Scan.wsf

SendMail.wsf

Shell.wsc
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Control and Processing
Statements

This appendix describes the statements in the AcctCntl1.txt, Bi11Cnt1.txt, and
ProcessCnt1.txt files.

CIMSAcct Control Statements .........ccoeiuiiuiiiiiiiiiiiiiiiiiiiiiiiieiieieeneenenecnenns D-3
ACCOUNT CODE CONVERSION . .. e e e e et e e e e D-5
ACCOUNT FIELD . . oottt et et et e et e e et e ettt e e e e e e e e e D-5
DATE SELECTION . .o e e e e e e e e e e e D-6
DEFINE FIELD . ..o e e e e e e e e e e D-7
DEFINE MOVEFLD . ... it et e ettt i D-8
EXCEPTION FILE PROCESSING ON . ... e e e e e et e D-9
IGNORE ORIGINAL SOURCE IDENTIFIERS ... ...ttt e e D-10
INCLUDE FIELD . . . .ot e e e e e e e e e e e et e D-10
PROCESS . .\ttt et e D-11
PRINT ACCOUNT NO-MATCH . . ..ottt e e e et D-11
SHIET e e e e e D-11
81 2R D-12
UPPERCASE ACCOUNT FIELDS . . ..ot e e e e e e et e e D-13
VERIFY DA T A o D-13
CIMSBIll Control Statements .........cociuiiiiiiiiiiiiiiiiiiieieieieneenciencnenenenennes D-14
BACKLOAD DAT A ..ttt et e D-16
CLIENT SEARCH ON . ..o e e e e e e e e e e e e D-16
DATE SELECTION . ..o e e e e e et et et et et e e e e e e D-17
DEFAULT CLOSE DAY ..ottt ettt e e e e e ettt D-18
DEFINE . . o e D-19
DYNAMIC CLIENT ADD ON ..ottt ettt et e e ettt et D-21
EXCLUDE . .. e e e D-21
INCLUDE . .ottt e ettt e e e e e e e D-22
NORMALIZE CPU VALUES . . . . oottt e e e e ettt D-22

CIMS Server Administrator's Guide D-1 W



Bl Control and Processing Statements

PROCESS . .. D-23
PRORATE MONEY . ..o e e e e e e D-23
PRORATE RESOURCES . . . . . oottt e e e e D-24
PRINT PRORATION REPORT . . . ..o e e D-25
REPORT DATE ..o e e e e e D-25
USE SHIFT CODES . ... e e e e e D-26
TS T et D-26
Processing Control Statements ...........coviiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii e D-27
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CIMSAcct Control Statements

This section describes control statements that you can use in the CIMSAcct Control file,
AcctCnt1.txt. By default, the control statements in the control file reflect the process
definition settings in CIMS Server Administrator (see CIMS Server Administrator
Processing on page 6-21). However, some optional statements do not have a
corresponding GUI option and must be entered in the control file manually.

Where applicable, the control statement descriptions in this section include a reference
to the corresponding option in CIMS Server Administrator.

Note ¢ Control statements are not case-sensitive, except for the literals in the DEFINE
MOVEFLD statement (see page D-8).

CONTROL STATEMENT SEE DESCRIPTION

ACCOUNT CODE CONVERSION [page D-5] Specifies processing of the CIMS account
code conversion table.

ACCOUNT FIELD [page D-5] Defines how to build the account code
from the identifiers within the input file
record.

DATE SELECTION [page D-6] Defines a date range for records to be
processed by CIMSAcct.

DEFINE FIELD [page D-7] Used only during account code

conversion. Defines the fields for
comparison within the account code
input field (which is built from the
ACCOUNT FIELD statements or from the
identifier Account_Code).

DEFINE MOVEFLD [page D-8] Used only during account code
conversion. Defines the fields that are to
be moved from the account code input
field (which is built from the ACCOUNT
FIELD statements or from the identifier
Account_Code) to the account code
output field.

EXCEPTION FILE PROCESSING ON [page D-9] Used only during account code
conversion. When present, any record
that does not match an entry in the
account code conversion table is written
out to the exception file.

IGNORE ORIGINAL SOURCE [page D-10]  Specifies that CIMSAcct does not write
IDENTIFIERS the identifiers SourceName and
Sourceline to the CIMS Ident file.
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CONTROL STATEMENT

DESCRIPTION

INCLUDE FIELD

PROCESS

PRINT ACCOUNT NO-MATCH

SHIFT

TEST

UPPERCASE ACCOUNT FIELDS

VERIFY DATA

[page D-10]

[page D-11]

[page D-11]

[page D-11]
[page D-12]

[page D-13]

[page D-13]

Moves identifiers into an area that is
used by CIMSBill for include/exclude
processing.

Specifies the type of data that is
contained in the input file. CIMSAcct
can process only one type of data at a
time.

Prints the first 1000 input identifiers
that are not matched during account
code conversion.

Sets up the shifts within the system.

Prints tracing messages to the CIMSAcct
Message file.

Specifies that the account code built
from the account code input field is
uppercase.

Specifies whether CIMSAcct is to check
for embedded nulls.
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ACCOUNT CODE CONVERSION

Related interface option: Perform Account Code Conversion, see page 6-42.
Format:
ACCOUNT CODE CONVERSION

This statement enables account code conversion using and DEFINE FIELD and DEFINE
MOVEFLD statements and the account code conversion table.

When account code conversion is enabled, all no-match records are written to the
CIMSAcct Detail file with the unconverted account code input field value. If you want
the record written to an exception file for later processing, you must add the control
statement Exception File Processing On.

ACCOUNT FIELD

Related interface option: Account Fields, see page 6-40.
Format:

ACCOUNT FIELDn,identifier_name,offset_into_identifier,length
n=0-9 (up to 10 ACCOUNT FIELD statements supported)
offset_into_identifier =1-255

length = 1-128

Note ¢ Although the maximum number of characters for each account field is 128,
the overall length of all account fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and
move field values, cannot exceed 128 bytes.

This statement defines the identifier(s) that you want to use to build the account code.
Begin at ACCOUNT FIELDO and continue sequentially as needed. The account fields are
used (along with DEFINE FIELD and DEFINE MOVEFLD statements) in account code
conversion if account code conversion is enabled. If account code conversion is not
enabled, then the account code is built directly from this statement or from the
Account_Code identifier in the input file records (if present). For more information, see
Defining the Account Code on page 6-40.

Example:

ACCOUNT FIELDO,UserName,1,10
ACCOUNT FIELDI,Division,1,2

In this example, the UserName and Division identifiers will be used to create the account
code. The offset for both identifier values is 1 and the length of the values are 10 and 2,
respectively.

If the UPPERCASE ACCOUNT FIELDS statement is specified, lowercase identifier values in the
account field are converted to uppercase values.
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DATE SELECTION

B D-6

Related interface option: Input—Date Selection, see page 6-27.
Format:
DATE SELECTION {YYYYMMDD YYYYMMDD | keyword}

This statement defines a date range for records to be processed by CIMSAcct. Records are
selected by the end date in the record (either the usage end date or the accounting end
date, depending on the record type). You can use the following values:

m From and to dates. For a record to be selected, it must be greater than or equal to the
from date and less than or equal to the to date.

or

® One of the following keywords:

Keyword Description

**RNDATE Selects records based on the run date

**CURDAY Selects records based on the run date and the run date less one day
**CURWEK Selects records based on the run week (Sun-Sat)

**CURMON Selects records based on the run month

**PREDAY Selects records based on the run date, less one (day)

**PREWEK Selects records based on the previous week (Sun-Sat)

**PREMON Selects records based on the previous month

CURRENT Selects current period from the CIMSCalendar table

PREVIOUS Selects previous period from the CIMSCalendar table

The start and end dates of data processed through CIMS Server must reflect the start and
end dates of the target billing period. If the billing period runs from January 1 through
January 31, any records produced with a date of February 1 (or later) should not be
included as part of the processing. In most cases, this data screening has already been
performed, either by CIMS Server or through the creation of data inputs reflecting the
desired date range.

Note that it is rare that you would need to limit the date range of the data used as input
to CIMSAcct. CIMSBIll provides the ability to create billing records reflecting a specific
date range (see page D-17).

Examples:
DATE SELECTION 20050601 20050630
DATE SELECTION **PREMON
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DEFINE FIELD

Related interface option: Define Fields, see page 6-42.

Format:

DEFINE FIELDn,offset,length

n=0-9 (up to 10 DEFINE FIELD statements supported)

offset = 1-128 (from the start of the account field or the Account_Code identifier value)

length=1-128

Note ¢ Although the maximum number of characters for each define field is 128, the
overall length of all define fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and
move field values, cannot exceed 128 bytes.

This statement is used only during account code conversion. Use this statement to
specify the offset and length of the account code input field value that you want to use
for conversion. Begin at DEFINE FIELDO and continue sequentially as needed.

For more information about using define fields, see Setting the Account Code Conversion
Options on page 6-42.

Example:

ACCOUNT FIELDO,UserName,1,10
ACCOUNT FIELD1,Division,1,?2
DEFINE FIELDO,3,8
DEFINE FIELD1,11,2

In this example, the first two characters of ACCOUNT FIELDO will not be considered for
account code conversion as specified by the offset of 3 for DEFINE FIELDO. However, the
full value of ACCOUNT FIELDI will be used because the offset for DEFINE FIELD1is 11 (the
Division identifier value starts in position 11 of the combined account fields) and the
length for both the account field and define field are the same.

For example, if the combined value for ACCOUNT FIELDO and ACCOUNT FIELDI is
AABBCCDDEEXZ, the value as defined by the DEFINE FIELDO and DEFINE FIELDI is
BBCCDDEEXZ.
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DEFINE MOVEFLD

Related interface option: Move Fields, see page 6-42.

Format:

DEFINE MOVEFLDn,offset,length,literal

n=0-9 (up to 10 DEFINE MOVEFLD statements supported)

offset = 1-128 (from the start of the account field or the Account_Code identifier value)
length=1-128

Titeral = aliteral can be moved instead of a particular field (literals in this statement are
case-sensitive)

Note ¢ Although the maximum number of characters for each move field is 128, the
overall length of all move fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and
move field values, cannot exceed 128 bytes.

This statement is used only during account code conversion. Use this statement to move
all or a portion of the account code input field value to a position in the output account
code. Begin at DEFINE MOVEFLDO and continue sequentially as needed.

Targets within the account code conversion table are specified as @)-@9.

For more information about using move fields, see Setting the Account Code Conversion
Options on page 6-42.

Example:

ACCOUNT FIELDO,UserName,1,10
ACCOUNT FIELDI1,Division,1,?
DEFINE FIELDO,3,8

DEFINE FIELD1,11,2

DEFINE MOVEFLDO,11,2

In this example, the value for DEFINE MOVEFLDO specifies that the value beginning at
position 11 account code input field will be placed in the output account code as defined
by the account code conversion table.

For example, if the 2-character value beginning at position 11 is X7 and the account code
conversion table is:

BBC, , FINACCT@O
The resulting account code will be FINACCTXZ.

For more information about the account code conversion table, see Creating an Account
Code Conversion Table on page 6-44.
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EXCEPTION FILE PROCESSING ON

Related interface option: Enable Exception Processing, see page 6-42.
Format:
EXCEPTION FILE PROCESSING ON

This control statement is used only during account code conversion. When this
statement is present, any record that does not match an entry in the account code
conversion table is written to an exception file. If this control statement is not present,
the records that are not matched are written to the CIMSAcct Detail file with the
unconverted account code input field value.

For more information the exception file processing, see About Exception File Processing on
page 6-17.

Example:

EXCEPTION FILE PROCESSING ON

Considerations

m If you enable exception processing, do not include a default account code as the last
entry in the account code conversion table (e.g., ", ,DEFAULTCODE"). If a default
account number is used, records will not be written to the exception file.

® When an input file is processed through CIMS Server Administrator, the default file
name for the exception file is Exception.txt. You should rename the output
exception file so that it is not overwritten when subsequent files are created.
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IGNORE ORIGINAL SOURCE IDENTIFIERS

Related interface option: None
Format:
IGNORE ORIGINAL SOURCE IDENTIFIERS

When this control statement is present, the identifiers SourceName and Sourcel ine are
not written to the CIMS Ident file. These identifiers are built by CIMS Conversion
Engine. The SourceName identifier, which provides the name and location of the input
file, can be quite long. Use this statement if you are not interested in tracking this
information and want to conserve space.

INCLUDE FIELD

Related interface option: Include Fields, see page 6-28.

Format:

INCLUDE FIELDn,identifier_name,offset_into_identifier_value,length
n=0-9 (up to 10 INCLUDE FIELD statements supported)
offset_into_identifier = 1-255

length =1-60

Note * The overall length of all include fields added together can not exceed 60
characters.

Use this control statement to move identifiers from the input file records into an area
that can be later used by CIMSBIll for include/exclude processing. For more information
about using include fields, see Include/Exclude Processing on page 6-58.

Example:
INCLUDE FIELDO,UserName,1,10

In this example, the UserName identifier value would be moved into the DETATIL-
INCLEXCL-AREA field of the CIMSAcct Detail records. This field is used by the CIMSBill
DEFINE control statement to define the include/exclude fields for CIMSBIll (see

page D-19).
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PROCESS
Related interface option: Process Type, see page 6-27.
Format:
PROCESS {CIMS SERVER RESOURCE RECORDS | CIMS MAINTENANCE RECORDS FROM CIMSACCT |
EXTERNAL TRANS RECORDS | CIMS SUMMARY}
This control statement specifies the type of data that is contained in the input file.
CIMSAcct can process only one type of data at a time.
Example:
PROCESS CIMS SERVER RESOURCE RECORDS

PRINT ACCOUNT NO-MATCH
Related interface option: None
Format:
PRINT ACCOUNT NO-MATCH
When this statement is present, a message is printed in the CIMSAcct Message file
showing the identifier values from the input file that were not matched during account
code conversion. If this statement is not present, only the total number of unmatched
records is provided. The system prints up to 1000 messages.

SHIFT

Related interface option: Shifts, see page 6-29.

Format:

SHIFT [day] [code] [end time] [code] [end time] ... [code] [end time]
day = SUN | MON | TUE | WED | THU | FRI | SAT

code = 1-9 (the shift code)

end time = the end time of the shift

This control statement defines shifts within the system. Seven shift records are supported
(one for each day of the week) and up to nine shifts can be specified on each. End times
are entered in hours and minutes using the 24-hour clock.

Rules that apply to shift records:

m Day is defined as the first three letters of the day

m Up to nine shifts per day can be specified

B The preceding end time must always be less than the next end time

m No shift spans midnight
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TEST
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Example:

For the following shifts:

Monday through Friday

Shift 1 - 5 AM to 8 AM and 3:30 PM to 5 PM

Shift 2 - 8 AM to 11:30 AM and 1:30 PM to 3:30 PM

Shift 3 -5 PM to 8 PM

Shift 4 - 9:30 PM to 12 AM and 12 AM to 5 AM

Shift 5-11:30 AM to 1:30 PM and 8 PM to 9:30 PM

Saturday and Sunday

Shift 1 - 8 AM to 5 PM

Shift 2 - 5 PM to 12 AM and 12AM to 8 AM

The SHIFT statements are as follows:

SHIFT SUN 2
SHIFT MON 4
SHIFT TUE 4
SHIFT WED 4
SHIFT THU 4
SHIFT FRI 4

SHIFT SAT 2

0800 1 1700 2 2400
0500 1 0800 2 1130
0500 1 0800 2 1130
0500 1 0800 2 1130
0500 1 0800 2 1130
0500 1 0800 2 1130
0800 1 1700 2 2400

51330 2 1530 1 1700 3 2000 5 2130 4 2400
51330 2 1530 1 1700 3 2000 5 2130 4 2400
51330 2 1530 1 1700 3 2000 5 2130 4 2400
51330 2 1530 1 1700 3 2000 5 2130 4 2400

51330 2 1530 1 1700 3 2000 5 2130 4 2400

Related interface option: Trace flag, see page 6-31.

Format:

TEST ¢

¢ = a character (A for account code conversion messages Y for general messages)

This control statement is used to print tracing messages to the CIMSAcct Message file.

Example:

TEST A

CIMS Server Administrator's Guide



Control and Processing Statements W
CIMSAcct Control Statements

UPPERCASE ACCOUNT FIELDS

Related interface option: Convert account fields to uppercase during processing, see
page 6-40.

Format:
UPPERCASE ACCOUNT FIELDS

This control statement instructs CIMSAcct to convert lowercase account code input field
values to uppercase values in the resulting account code. For example, the value ddic
would be converted to DDIC. By using this option, CIMSAcct account code processing
becomes case-insensitive and makes defining account conversion tables much easier.

VERIFY DATA

Related interface option: None
Format:
VERIFY DATA ON|OFF

This control statement instructs CIMSAcct to check for embedded null characters within
an input record (if ON is specified) and changes the null characters to spaces. Null
characters should be contained only at the end of record, not within a record. CIMS
standard interfaces do not embed nulls. Turning verification on slows processing and
should be used only when processing non-standard feeds.

The default is VERIFY DATA OFF.
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CIMSBIll Control Statements

This section describes control statements that you can use in the CIMSBill Control file,
Bi11Cnt1.txt. By default, the control statements in the control file reflect the process
definition settings in CIMS Server Administrator (see CIMS Server Administrator

Processing on page 6-21).

The control statement descriptions in this section include a reference to the
corresponding option in CIMS Server Administrator.

CONTROL STATEMENT

BACKLOAD DATA

CLIENT SEARCH ON

DATE SELECTION

DEFAULT CLOSE DAY

DEFINE

DYNAMIC CLIENT ADD ON

EXCLUDE

INCLUDE

NORMALIZE CPU VALUES

PROCESS

PRORATE MONEY

PRORATE RESOURCES

SEE

[page D-16]

[page D-16]

[page D-17]

[page D-18]
[page D-19]

[page D-21]

[page D-21]
[page D-22]
[page D-22]
[page D-23]

[page D-23]

[page D-24]

DESCRIPTION

Instructs CIMSBIll to ignore the close
date. The accounting dates created by
CIMSBIll are the same as the usage end
date regardless of the close date

Instructs CIMSBIll to use the account
code structure definition to search the
CIMSClient table for the rate table
associated with a client.

Defines a date range for records to be
processed by CIMSBill.

Overrides the system-wide close date.

Defines the account code structure
used by the statements CLIENT SEARCH
ON and DYNAMIC CLIENT ADD ON. Also
defines character strings in the CIMSBill
Detail record that are used for include/
exclude processing.

Specifies that CIMSBill automatically
insert corresponding client entries into
the CIMSClient table for all clients that
have a resource usage charge.

Specifies an exclude record condition.
Specifies an include record condition.
Normalizes CPU values.

Specifies the type of data that is
contained in the input file. CIMSBill can
process only one type of data at a time.

Splits money for a specific resource (or
all resources) among multiple accounts.

Splits a specific resource (or all
resources) among multiple accounts.

B D-14
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CONTROL STATEMENT

PRINT PRORATION REPORT

REPORT DATE

USE SHIFT CODES

TEST

SEE

[page D-25]

[page D-25]

[page D-26]

[page D-26]

CIMSBiIll Control Statements

DESCRIPTION

Generates a proration report that
contains the original record and all
subsequently-generated prorated
records.

Specifies the date that is put into the
CIMS Summary records created by
CIMSBIll.

Instructions CIMSBIll to use the shift
character specified in the CIMSAcct
Detail record and apply the appropriate
rate shift value.

Used to print tracing messages to the
CIMSBill Message file.

CIMS Server Administrator's Guide

D-15 H



Bl Control and Processing Statements

CIMSBiIll Control Statements

BACKLOAD DATA

Related interface option: Back Load Data, see page 6-33.
Format:
BACKLOAD DATA

This statement instructs CIMSBill to ignore the close date. The accounting dates created
by CIMSBill are the same as the usage end date regardless of the close date.

CLIENT SEARCH ON

B D-16

Related interface option: Enable client search, see page 6-35.

Format:
CLIENT SEARCH ON

This statement instructs CIMSBill to use the account code structure definition (by use of
the DEFINE Jn fields, see page D-19) to search the CIMSClient table for the rate table
associated with a client. If this statement is not specified, the STANDARD rate table is
used for all clients.

CIMSBill searches the CIMSClient table in a minor-major sequence to find client
information. Consider the following example control statements:

DEFINE J1 1 1 /DIVISION/
DEFINE J2 1 5 /DEPARTMENT/
SEQUENCE FIELDS J1 J2
CLIENT SEARCH ON

Assume the data value for J1 and J2 is AABBB (J1 = AA, J2 = AABBB). CIMSBill searches
the CIMSClient table for account code AABBB. If account code AABBB is not found,
CIMSBIll then searches the table for account code AA. If account code AA is found, the
rate table for account code AA is used. If account code AA is not found, the STANDARD
rate table is used.
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DATE SELECTION

Related interface option: Input — Date Selection, see page 6-32.

Format:
DATE SELECTION {YYYYMMDD YYYYMMDD | keyword}

This statement defines a date range for records to be processed by CIMSBill. Records are
selected by the accounting end date in the record. You can use the following values:

m From and to dates. For a record to be selected, it must be greater than or equal to the
from date and less than or equal to the to date.

or

m One of the following keywords:

Keyword Description

**RNDATE Selects records based on the run date
**CURDAY Selects records based on the run date and the run date less one day
**CURWEK Selects records based on the run week (Sun-Sat)
**CURMON Selects records based on run month
**PREDAY Selects records based on run date, less one (day)
**PREWEK Selects records based on previous week (Sun-Sat)
**PREMON Selects records based on previous month
CURRENT Selects current period from the CIMSCalendar table
PREVIOUS Selects previous period from the CIMSCalendar table
Examples:

DATE SELECTION 20050601 20050630

DATE SELECTION **PREMON
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DEFAULT CLOSE DAY

Related interface option: Default Close Date, see page 6-32.
Format:

DEFAULT CLODE DAY=nn

nn=01-31

This statement overrides the system-wide close date set in the Configuration dialog box
(see Processing Settings on page 3-44). The year and month used for the close day reflect
the year and month in which CIMSBill is run. For more information about the close date,
see page 6-18.

Example:
DEFAULT CLOSE DAY=8

This statement sets the close date to the eighth of the month. If the CIMSBIll run date is
20050706, the close date is set to 20050708. If the CIMSBill run date is 20050712, the
close date is also set to 20050708.
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The DEFINE statement defines the account code structure used by the statements
CLIENT SEARCH ON and DYNAMIC CLIENT ADD ON. This statement also defines character
strings in the CIMSBill Detail record that are used for include/exclude processing. The
format differs depending on the use of the statement as described in the following
sections.

Account Code Fields Define

Related interface option: Account Code Search Fields, see page 6-35.

This statement is used with the CLIENT SEARCH ONand DYNAMIC CLIENT ADD ON statements
to specify the client account code structure. You can specify up to nine account levels
(fields J1-J9).

Format:

DEFINE Jn start_loc len /desc/

n=1-9

start_loc = starting position within the account code
Ten = total length of the level

desc = a description for the field

Example:

Account code AAABBBCCDDDDD contains four levels. To search from the lowest level to the
highest level, use the following define fields:

DEFINE J1 1 3
DEFINE J2 1 6
DEFINE J3 1 8
DEFINE J4 1 13
CLIENT SEARCH ON

For the previous define fields:

J1=AAA

J2=AAABBB
J3=AAABBBCC
J4=AAABBBCCDDDDD

CIMSBIll first searches for AAABBBCCDDDDD and if it does not find an entry it searches for
AAABBBCC and so on.
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Include/Exclude Fields Define
Related interface option: Define Include/Exclude Fields, see page 6-60.

This statement defines any string of characters within the CIMSBill Detail record for
include/exclude processing.

Format:
DEFINE fd loc Ten /desc/
fd = two-character field ID, for example A1

Toc = starting position in the CIMSBIill Detail record (see CIMSBill Detail File on
page B-10). For example 163 is the start of the account code field.

Ten = length of the field
desc = a description for the field
Example:

In this example, you want to define UserName identifier, which starts at position 301 of
the CIMSBIll Detail file, so that you can exclude all UserName values that begin with geo.

First, define the field in CIMSAcct using the INCLUDE FIELD statement (see page D-10):
INCLUDE FIELDO,UserName,1,10

Define the field in CIMSBill:

DEFINE Al 301 3 /usergeorge/

And then use the following EXCLUDE statement:

EXCLUDE Al geo geo
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DYNAMIC CLIENT ADD ON

Related interface option: Add new clients to Client table, see page 6-35.
Format:
DYNAMIC CLIENT ADD ON

This statement specifies that CIMSBill automatically insert corresponding client entries
in the CIMSClient table for all clients that have a resource usage charge, but are not
entered in the table. Use this statement with caution because it can quickly fill the CIMS Client
table with extraneous records.

If you are using multiple rate tables for clients, this statement requires that the control
statement CLIENT SEARCH ON is also used (see page D-16).

The inserted client entries will include account names only if a matching top level
account is currently in the CIMSClient table. For example, if account code AA exists in
the CIMSClient table and account code AABBB is inserted, account AABBB is assigned
the same account name as AA. However, contacts and budgets assigned to the top level
account are not copied to the new client.

EXCLUDE

Related interface option: Define Include/Exclude Records, see page 6-60.
Format:

EXCLUDE fd Tow high

fd = two-character field id (from the DEFINE control statement - see page D-19)
Tow = specifies the low or from selection value (1 to 8 characters)

high = specifies the high or to selection value (1 to 8 characters)

This statement specifies an exclude record condition. The specified data from the field
must be equal to or greater than the low value and equal to or less than the high value.

Example:

Assume that you want to exclude records with usage start dates between the dates of June
1,2005 and June 12, 2005. You need to define the field that contains the usage start date
in the CIMSBill Detail records. This field begins at position 123.

DEFINE Al 123 8 /Start Date/
EXCLUDE Al 20050601 20050612
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INCLUDE

Related interface option: Define Include/Exclude Records, see page 6-60.
Format:

INCLUDE fd low high

fd = two-character field ID (from the DEFINE control statement—see page D-19)
Tow = specifies the low or from selection value (1 to 8 characters)

high = Specifies the high or to selection value (1 to 8 characters)

This statement specifies an include record condition. The specified data from the field
must be equal to or greater than the low value and equal to or less than the high value.

Example:

Assume that you want to include records with usage start dates between the dates of June
1,2005 and June 12, 2005. You need to define the field that contains the usage start date
in the CIMSBill Detail records. This field begins at position 123.

DEFINE Al 123 8 /Start Date/
INCLUDE Al 20050601 20050612

NORMALIZE CPU VALUES

Related interface option: Normalize CPU Values, see page 6-33.
Format:
NORMALIZE CPU VALUES

This statement instructs CIMSBIill to normalize CPU values. For more information about
normalizing CPU values, see page 6-57.
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PROCESS
Related interface option: Process Type, see page 6-32.
Format:
PROCESS {DETAIL RECORDS | CIMS SUMMARY RECORDS}
This control statement specifies the type of data that is contained in the input file for
CIMSBIll. CIMSBIll can process only one type of data at a time.
Example:
PROCESS DETAIL RECORDS
PRORATE MONEY

Related interface option: Proration Type Money, see page 6-49.
Format:

PRORATE MONEY Ten

Ten = the length to match for proration

This statement splits money for a specific resource (or all resources) among multiple
accounts. To prorate money, a prorate table must be set up to specify how the monies
are split. The length specified is used to determine at what level to match for the splitting.
Assume that the following control statement is specified:

PRORATE MONEY 5
The following prorate (or split table) is defined as:

AAABB,AAL,40,AT1
AAABB,AAZ,60,AT1

The accounts AAABB, AAABBBB, and AAABBCC will match and be split into AA1 and
AA2.

Example:

PRORATE MONEY 5
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Prorating Resources vs. Prorating Money

In CIMS Server Administrator, you can set the option to prorate on resources or on
money. Both options display the same prorated units and charges in Web reports.
However, you cannot drill down on resource units by identifier if you prorate by money.
The following describes the advantages and disadvantages of prorating resources and
prorating money:

Prorating resources. The CIMSAcct Detail file from CIMSSort is prorated before
CIMSBIll applies rates and figures money and a new CIMSAcct Detail file is built with all
the prorated resources. The new CIMSAcct Detail file is then used in the CIMSBill
process.

An advantage of prorating resources is that the CIMSBill Detail records match the records
in the CIMS Summary file. Therefore, users can drill down on resource units by identifier
when viewing invoices in CIMS Server Web Reporting. A disadvantage is that the
CIMSBIll Detail file can contain a potentially large number or records.

Prorating money. The CIMS Summary file is prorated just before CIMSBill ends. A new
CIMS Summary file is built with the prorated values.

An advantage of prorating money is that the CIMSBIll Detail file contains fewer records
than it would if you prorated by resources. A disadvantage is that the CIMSBill Detail
records do not match the CIMS Summary records and drilling down by identifier will
not produce accurate data.

PRORATE RESOURCES

B D-24

Related interface option: Proration Type Resources, see page 6-49.
Format:

PRORATE RESOURCES Tlen

Ten = the length to match for proration

This statement splits a specific resource (or all resources) among multiple accounts. To
prorate resources, a prorate table must be set up to specify how the resources are split.
The length specified is used to determine at what level to match for the splitting. Assume
that the following control statement is specified:

PRORATE RESOURCES 5
The following prorate (or split table) is defined as:

AAABB,AAL,40,AT1
AAABB,AAZ,60,AT1

The accounts AAABB, AAABBBB, and AAABBCC will match and be split into AA1 and
AA2.

Example:

PRORATE RESOURCES 5

CIMS Server Administrator's Guide



Control and Processing Statements W
CIMSBIll Control Statements

PRINT PRORATION REPORT
Related interface option: Print Proration Report, see page 6-49.
Format:
PRINT PRORATION REPORT

This statement generates a proration report that contains the original record and all
subsequently-generated prorated records. The proration report will reside in the
processing directory with the file name of ProrateRep.Txt.

Example:

PRINT PRORATION REPORT

REPORT DATE

Important! « CIMS Lab recommends that you do not use this statement. This
statement will place report dates rather than actual usage end dates in the accounting
date fields of the CIMSBill Summary records. You should use the default Auto option
in CIMS Server Administrator rather than report dates (see page 6-32).

Related interface option: Output-Summary Date Range, see page 6-33.

Format:
REPORT DATE {YYYYYMMDD YYYYYMMDD | keyword}

This statement specifies the dates that are used as the accounting dates in the CIMS
Summary records created by CIMSBIll. This is the date that is used for reporting purposes
in CIMS Server. You can use the following values:

®m From and to dates
or

m One of the following keywords:

Keyword Description

**RNDATE Sets the date range based on the run date

**CURDAY Sets the date range based on the run date and the run date less one
day

**CURWEK Sets the date range based on the run week (Sun-Sat)

**CURMON Sets the data range based on the run month

**PREDAY Sets the date range based on the run date, less one day

**PREWEK Sets the date range based on the previous week (Sun-Sat)
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Keyword Description

**PREMON Sets the date range based on the previous month

CURRENT Sets the date range based on the current period from the
CIMSCalendar table

PREVIOUS Sets the date range based on the previous period from the
CIMSCalendar table

USE DETAIL DATES  Sets the date range based on the CIMSAcct Detail record (consult
CIMS Lab before using this keyword)

Examples:
REPORT DATE 20050601 20050630
REPORT DATE **PREMON

USE SHIFT CODES

TEST

B D-26

Related interface option: Use Shift Codes, see page 6-33.
Format:
USE SHIFT CODES

This statement instructs CIMSBill to use the shift character specified in the CIMSAcct
Detail record and apply the appropriate rate shift value.

If a shift value is not defined for the rate, the default rate value for the resource will be
used. The default rate value is also the SHIFT1 rate value.

Related interface option: Trace flag, see page 6-36.
Format:
TEST ¢

¢ = a character (D for dates, R for display rate information [each rate code read from the
database], Y for general messages, Z for trace client processing [dynamic client add and
client searching])

This control statement is used to print tracing messages to the message file.

Example:

TEST Y
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Processing Control Statements

CIMS Server Administrator stores additional processing setting for each process
definition in the ProcessCnt1.txt file. This file resides in the folder of each process
definition.

The following table describes the processing settings in the ProcessCnt1.txt file and
provides the corresponding GUI option in CIMS Server Administrator.

Processing Statement GUI Option

AcctInputFile filename Input File, see page 6-28

Where f77ename = the name of CIMSAcct input file.

AcctQOutputDetailFile filename Output Files: Detail,

. see page 6-28
Where filename = the name of CIMSAcct Detail file.

AcctQutputIdentFile f7ilename Output Files: Ident,

see page 6-28
Where filename = the name of CIMS Ident file.

AcctOutputExceptionFile f7lename Output Files: Exception,
) . see page 6-28
Where f77ename = the name of CIMSAcct exception

output file.

ArchiveProcessFiles Yes/No Archive process files,
. . . . see page 6-24
This setting archives previous output files before

processing.
AutolLoadIdentFile Yes/No Load record type records,
AutolLoadSummaryFile Yes/No see page 6-24

AutolLoadDetailFile Yes/No
AutolLoadResourceFile Yes/No

These settings determine if the system automatically
loads these files into the database at conclusion of
processing.

BillInputFile filename Input File, see page 6-34

Where f77ename = the name of CIMSBIll input file.

BillDetailFile filename Output Files: Detail, see
) . page 6-34
Where 77lename = the name of the CIMSBIll Detail file.
BiT1SummaryFile filename Output Files: Summary, see
) page 6-34
Where f7]lename = the name of the CIMS Summary file.
Bi11MultFile filename Proration Table, see
page 6-50

Where filename = the name of the proration table file.
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AcctCodeConversionTable filename

Where f7ilename = the name of the account code
conversion table.

Conversion Table, see
page 6-43

CreateCSRPFile Yes/No

This setting creates a CSR+ file.

Create CSR Plus,
see page 6-28

CSRPFile filename

Where f7ilename = the name of the CSR+ file.

CSR Plus, see page 6-28

Description name

Where name = a description of the process definition.

Process Description, see
page 6-23

DSN name

Where name = the name of the ODBC data source.

Data Source Name,
see page 6-26

DSNUID user ID

Where user ID=the user ID needed to access the ODBC
data source.

Database User ID,
see page 6-26

DSNPWD password

Where password = the encrypted password needed to
access the ODBC data source.

Database Password,
see page 6-26

GenerateODBCINF Yes/No

This setting generates an INF file that passes along user
ID and password information to the ODBC data source.

Automatically generate
ODBC INF file from above
parameters, see page 6-26

RemoveFilesBeforeProcessing Yes/No

This setting deletes previous output files from the
process definition folder.

Remove output files before
processing, see page 6-24

RunCIMSAcct Yes/No

This setting determines whether CIMSAcct is run as part
of the process.

Run CIMS Account,
see page 6-24

RunCIMSBi11 Yes/No

This setting determines whether CIMSBIll is run as part
of the process.

Run CIMS Bill, see page 6-24

UseBulkLoadInterface Yes/No

This setting determines whether the SQL server bulk
load interface is used.

Use bulk load interface,
see page 6-25
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ASP  Acronym for Active Server Pages. A server-side scripting environment developed
by Microsoft for developing Web pages and applications.

cascading style sheets * Cascading style sheets contain typographical information on
how an HTML page should appear (i.e., fonts, colors, table and list formats, etc.).

CIMS Server Resource (CSR) File ¢ The resource file that contains the data that is
input into CIMS Server. The CIMS Server Resource file contains CIMS Server Resource
records. These records are comma-delimited and can contain a very large number of
resource identifiers and resources. See also identifier and rate code.

CIMS Server Resource Plus (CSR+) File ¢ These files are produced by CIMS
Mainframe 12.0 and later. CSR+ files are similar to CIMS Server Resource (CSR) files,
with the exception that the records in the CSR+ file contain an additional header at the
beginning of the record.

client « 1. A computer that accesses shared network resources provided by a server. 2.
In CIMS Server, an entity that consumes resources. A client is represented by an account
code.

COM - Acronym for Component Object Model. A specification developed by
Microsoft for building software components that can be assembled into programs or add
functionality to existing programs running on Microsoft Windows platforms.

cookie < A small text file that stores information about a Web site user. CIMS Server
Web Reporting stores user information, such as the report parameter values entered by a
user, in a cookie.

database alias ¢ An alias name given to a remote or local DB2 database. Database
names must be unique on a DB2 server. However, a DB2 client can have connections to
two different databases that have the same name if those databases reside on different
servers and each database has its own alias. If an alias is not specified for a database, the
default alias is the database name.

DBMS ¢ Acronym for Database Management System. Software used to organize,
analyze, and modify information stored in a database.
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domain ¢ A set of network resources (applications, printers, etc.) for a group of users.
The user need only to log in to the domain to gain access to the resources, which may be
located on a number of different servers in the network.

ERD ¢ Acronym for Entity Relationship Diagram. A diagram that illustrates the logical
structure of a database.

identifier ¢ In the CSR or CSR+ record, a unique key that denotes the source of a
resource that has been consumed. Examples include device name, server name, system
ID, phone number, user ID, state code or building number. A consumed resource can
have one to many identifiers.

internationalization ¢ In software development, internationalization is the process of
planning and implementing a product so that it can easily be adapted (localized) to
specific languages. The word “internationalization” is sometimes abbreviated as “118N"
because there are 18 letters between the first letter “I” and the last letter “N”. See also
localization.

IIS ¢ Acronym for Internet Information Services. Microsoft software that supports Web
site creation, configuration, and management.

localization ¢ In software development, the process of adapting an internationalized
product for a specific language, script, culture, and coded character set. The word
“localization” is sometimes abbreviated as “L10N" because there are 10 letters between
the first letter “L” and the last letter “N”. See also internationalization.

ODBC ¢ Acronym for Open Database Connectivity. An interface providing a common
language for database access.

offset « A number that indicates how far from a starting point an item is located.

rate code < A rate code represents the resource units being reported (for example, CPU
time, transactions processed, or lines printed). The rate code includes the value for the
resource and other rate processing information.

UNC ¢ Acronym for Universal Naming Convention. A file naming system beginning
with two backslashes (\\) that indicates that the resource exists on a network computer.
The syntax is \\servername\sharename.

URL ¢ Acronym for Uniform Resource Locator. The address for a resource on the
Internet or an intranet.

Windows Script Host « A language-independent scripting host for Windows Script-
compatible scripting engines. WSH acts as a host for scripts—it makes objects and
services available for the script and provides a set of guidelines within which the script
is executed.

XML < Acronym for Extensible Markup Language. A simple, very flexible text format
derived from SGML. XML allows for more precise declarations or content and more
meaningful search results across multiple platforms.
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Numerics
13 periods, using 3-44

A
account code conversion
about 6-17
example 6-46 to 6-48
options for, setting 6-42 to 6-43
table, creating 6-44 to 6-45
account code structure
about 3-3
alternate 3-8
adding 3-8, 8-13
removing 3-8
renaming 3-8
example of 3-3
levels
creating 3-4 to 3-7
editing 3-4 to 3-7
offset number, setting 3-7
removing 3-7
Standard 3-4
account codes
about 6-17, 6-39
assigning clients to 3-20 to 3-22
defining the identifiers used for 6-40 to 6-41
starting and ending code levels for Web
reporting, setting 3-49
accounting dates
about 6-18
and the close date 6-18
calculation of 6-19
accounting periods, using 13 periods 3-27
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adding

account code structure levels 3-4 to 3-7
alternate account code structures 3-8, 8-13
alternate rate tables 3-15
budgets
for clients 3-22 to 3-23
to cost models 7-6, 7-8
CIMS Data Sources 5-6
client contacts 3-25
clients 3-20 to 3-21
clients to user groups 3-38
cost models 7-4
cost pools and subpools 7-7
process definitions 6-22
rate codes 3-9 to 3-12
rate codes to rate group 3-11, 3-19
rate groups 3-11, 3-17 to 3-18
rate shifts 3-13
report cycles 4-29 to 4-37
report groups 4-21 to 4-22
reports to report groups 4-22
reports to reports list 4-19 to 4-20
reports to user groups 3-37
user groups 3-33
users 3-28
users to a group 3-36
Web headlines 3-39

aggregating CSR and CSR+ files C-12
AllAccts.wsf script C-40 to C-42
archiving

database loads 5-20 to 5-22

archive file path setting 3-55

compression type and level settings 3-55
previous CIMS Processing Engine output 6-24

Index-1 W



B Index

ASP.NET, installing and enabling 2-17
auto logon for CIMS Web applications, enabling
3-50

backing up databases 5-5, C-26
backload data option 6-33
batch reporting See published reports
BatchReport.wsf script C-33 to C-39
browser requirements
CIMS Server Web Reporting 2-7
SQL Server Reporting Services Report Manager
2-19
budgets
for clients
adding 3-22 to 3-23
removing 3-24
in cost models, creating 7-6, 7-8
BuildCSRFromDB.wsf script C-7
bulk loading the database option 6-25
BulkUserLoad.wsf script C-24

C

calendar
about 3-26
considerations 3-27
enabling the use of 3-44
setting 3-26 to 3-27
using 13 accounting periods 3-27, 3-44
CIMS Advanced Spreadsheets, setting up 4-6
CIMS Aggregation Engine, installing 2-23
CIMS Conversion Engine, installing 2-23
CIMS Data Collectors
about 1-5
installing 2-23
CIMS Data Sources
about 5-6
adding 5-6
creating and configuring
for DB2 database 2-49 to 2-56
for MSDE database 2-41 to 2-43
for Oracle database 2-44 to 2-48
for SQL Server database 2-33 to 2-40
default, setting 5-7
editing 5-6
removing 5-7
renaming 5-6
selecting for CIMS Server Administrator 2-57
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CIMS Financial Modeler
about 7-2
access to, enabling 3-34
auto logon for, enabling 3-50
budgets
creating 7-6
distributing 7-8
cost models
adding rate codes to 7-9
creating and setting up 7-4 to 7-17
removing rate codes from 7-9
sharing 7-16
cost pools and subpools
adding 7-7
removing 7-7
installing 2-23
logging on to 2-84, 7-3
rates in
calculating 7-10 to 7-16
updating 7-13
reports in
running 7-18 to 7-22
saving, printing, and editing 7-22
CIMS Ident File
about B-9
eliminating duplicates from 6-29
layout of B-9
load option 6-24
CIMS Job Runner, about 6-3
CIMS Processing Engine
about 6-5
archiving previous output created by 6-24
components 1-9
installing 2-23
removing previous output created by 6-24
CIMS Server
benefits 1-4
configuration settings
accessing 3-43
defaults, returning to 3-43
debugging 8-13
features 1-4
getting started 2-27 to 2-81
installing 2-22 to 2-24
on multiple computers, about 2-6
pre-installation procedures 2-9 to 2-16
internationalization of 2-13 to 2-16
license key, entering 3-48
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setup instructions 2-33 to 2-70 Exception File, about 6-9
system input
components 1-9 to 1-12 file selection option 6-28
specifications 2-3 to 2-7 files, list of 6-7 to 6-8
updates, downloading 2-84 record date selection option 6-27
upgrading 2-26 record type selection option 6-27
CIMS Server Administrator Message File
about 1-10 about 6-9
dialog boxes, moving and resizing 2-84 file name setting 6-28
help, accessing 2-84 printing trace messages to 6-31
installing 2-23 printing unmatched identifiers to D-11
processing data using 6-38 null character check, using D-13
setting data processing options in 6-21 to 6-37 output
starting 2-33 file name options 6-28
CIMS Server Resource File files, list of 6-9
about 1-8, B-2 run option 6-24
format of B-2 to B-3 CIMSAdminLib, about 6-15
identifiers in, defining for CIMS Server 1-8 CIMSBILL
rate codes in, defining for CIMS Server 1-8 about 6-11
CIMS Server Resource Plus File control statements D-14 to D-26
about 1-8, B-4 Detail File
format of B-4 to B-6 about B-10 to B-13
identifiers in, defining for CIMS Server 1-8 layout of B-10 to B-13
rate codes in, defining for CIMS Server 1-8 load option 6-25
CIMS Server Web Reporting input
about 1-12 file selection option 6-34
auto logon, enabling 3-50 files, list of 6-13
browser requirements 2-7 record date selection option 6-32
installing 2-23 record type selection option 6-32
starting 2-80 Message File
CIMS Summary File about 6-14
about B-14 printing trace messages to 6-36
creating from CIMSSummary table C-25 output
layout of B-14 to B-17 file name options 6-34
load option 6-24 files, list of 6-14
CIMS Web Console run option 6-24
requirements for 2-5 CIMSLib.wsf script C-8
setting up 2-82 to 2-83 CIMSRateldentifiers table, updating 5-14
starting 2-84 CIMSSORT, about 6-11
CIMSACCT CIMSUtil.wsf script C-8
about 6-6 client (account code)
account codes and account code conversion, about 3-20
about 6-17 add to client table option 6-35
control statements D-3 to D-13 adding 3-20 to 3-21
Detail File budgets for
about B-8 to B-9 about 3-22
layout of B-8 to B-9 adding 3-22 to 3-23
load option 6-25 removing 3-24
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contacts
adding 3-25
automatic creation of C-8
editing 3-25
loading from mainframe Client file C-43
removing 3-25
data, exporting 3-25
editing 3-21
name
assigning 3-21
automatic creation of C-8
rate table search option 6-35
removing 3-22
table
exporting 5-12, 5-13
exporting for mainframe C-14
loading 5-12, 5-13, C-29
client (computer)
installing CIMS Server Administrator on 2-7
system specifications 2-7
viewing Web reports on 2-7
ClientPropogate.wsf script C-8
close date
about 6-18
setting
for all process definitions 3-44
for an individual process definition 6-32
configuration settings
accessing 3-43
defaults, returning to 3-43
entering
database settings 3-48
license information 3-48
organization information 3-43
processing settings 3-44
report settings 3-45 to 3-47
table audit settings 3-54
Web settings 3-49
contacts for clients, entering 3-25
control statements
CIMSACCT D-3 to D-13
CIMSBILL D-14 to D-26
processing D-27 to D-28
ConvertSummaryDailyToMonthly.wsf script C-9
to C-11
cost modeling See CIMS Financial Modeler
CPU values, normalizing 6-55 to 6-57
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creating
account code conversion tables 6-45
account code structure levels 3-4 to 3-7
alternate account code structures 3-8, 8-13
alternate rate tables 3-15
budgets
for clients 3-22 to 3-23
in cost models 7-6, 7-8
CIMS Data Sources
for DB2 database 2-49 to 2-56
for MSDE database 2-41 to 2-43
for Oracle database 2-44 to 2-48
for SQL Server database 2-33 to 2-40
client contacts 3-25
clients 3-20 to 3-21
cost models 7-4
cost pools and subpools 7-7
databases
MSDE 5-3
MSDE 2000 2-27
SQL Server 2-29 to 2-31, 5-2
processes folder 2-58
proration tables 6-50
rate groups 3-11, 3-17 to 3-18
rate shifts 3-13
report groups 4-21 to 4-22
user groups 3-33
users 3-28
Crystal Reports
creating parameter fields in 4-16 to 4-18
system specifications
for designing reports 2-8
for running reports 2-4
version 10, installing 8-22
version 8.5, using 8-20
version 9, installing 8-21
version XI
configuring Crystal Reports Server 2-77 to
2-80
installing 2-20 to 2-21
Crystal Reports editions supported by 2-4
CSRAggregator.wsf script C-12
custom
reports
about 1-13
path setting 3-45
Web site, settings for 3-52 to 3-53
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D
data collectors See CIMS Data Collectors
data processing See processing data
data sources See CIMS Data Sources
database
about 1-11
backing up 5-5, C-26
CIMS Data Source for See CIMS Data Sources
CIMS Server Administrator connection,
confirming 5-26
creating
MSDE 2000 2-27, 5-3
SQL Server 2-29 to 2-31, 5-2
ERDs (Entity Relationship Diagrams) A-52 to
A-57
initializing 2-57
loading 5-18 to 5-19
loading files to 6-24 to 6-25
from CIMS Server 5-18 to 5-19
loads
archive settings 3-55
archiving 5-20 to 5-22
deleting 5-23
purging 5-22, C-19
restoring 5-22
tracking 5-23
objects
about 5-15
creating 5-16
dropping 5-16
profiling 5-25
recovery model, setting (SQL Server only) 5-5
sending to CIMS Lab for troubleshooting (SQL
Server only) 8-14 to 8-17
tables
converting daily summary data to monthly
summary data C-9 to C-11
creating 5-14
description of A-4 to A-51
dropping 5-14
exporting 5-12
loading 5-12
viewing 5-14
time-out setting 3-48, 3-54
upgrading 5-26
using multiple databases for Web reporting 5-9
to 5-10
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versions supported
DB2 2-5
Oracle 2-5
SQL Server 2-5
DB2 database
CIMS Data Source for, creating 2-49 to 2-56
Crystal Reports editions supported by 2-4
version supported by CIMS Server 2-5
debugging CIMS Server 8-13
deleting
account code structure levels 3-7
alternate account code structures 3-8
alternate rate tables 3-15
budgets for clients 3-24
CIMS Data Sources 5-7
client contacts 3-25
clients 3-22
clients from user groups 3-38
cost models 7-17
cost pools and subpools 7-7
database loads 5-22, 5-23, C-19
published reports 4-28
rate codes 3-13
rate codes from rate groups 3-19
rate groups 3-18
report cycles 4-37
report groups 4-22
reports from report groups 4-22
reports from reports list 4-20
reports from user groups 3-37
unused identifiers 3-4 1
from the CIMSDetailldent table C-13
from the CIMSIdent table C-13
user groups 3-37
users 3-32
users from a group 3-37
Web headlines 3-39
Detail File See CIMS Account Detail File or
CIMSBILL Detail File
disaster recovery 8-18
DropldentBeforeLoad.wsf script C-13
DropldentFromDB.wsf script C-13
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E
editing

account code structure levels 3-4 to 3-7

CIMS Data Sources 5-6

client contacts 3-25

clients 3-21

rate codes 3-10 to 3-12

report cycles 4-37

report settings 4-20, 4-30

user groups 3-34 to 3-35

users 3-29 to 3-31

Web headlines 3-39
EmailDistribution.wsf script C-42
Entity Relationship Diagrams (ERDs) A-52 to A-

57

Event Viewer, increasing log size in 2-65
events, viewing 6-38
exception file processing

about 6-17

enabling 6-43

file name setting 6-28
ExportClientToMainframe.wsf script C-14
ExportRateToMainframe.wsf script C-14

F

file layouts
CIMS External Transaction File B-7
CIMS Ident File B-9
CIMS Server Resource File B-2
CIMS Server Resource Plus File B-4
CIMS Summary File B-14 to B-17
CIMSACCT Detail File B-8 to B-9
CIMSBILL Detail File B-10 to B-13

FIP.wsc script C-15

FTPSample.wsf script C-15

G

getting started 2-27 to 2-81
groups See users and groups, report groups, and
rate groups

hardware, suggested 2-4
client 2-7
server 2-4
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headlines, Web
about 3-39
adding 3-39
editing 3-39
removing 3-39

help, accessing 2-84

I
Ident File See CIMS Ident File
identifiers
adding descriptions for 3-40
defining for account codes 6-40 to 6-41
definition of 1-2
in the CSR or CSR+ file 1-8
including or excluding from processing 6-58 to
6-63
removing unused 3-41
from the CIMSDetailldent table C-13
from the CIMSIdent table C-13
unused list, creating C-15
updating in CIMSRateldentifiers table 5-14
I1S
anonymous access
enabling 2-68
authenticated access, enabling 2-67
required version 2-4
restarting 8-5, 8-12
user access, enabling
anonymous access 2-67 to 2-638
Windows authenticated access 2-67
include fields, specifying 6-28
include/exclude processing 6-58 to 6-63
example 6-61 to 6-63
initializing the database 2-57
installing
ASP.NET 2-17
CIMS Aggregation Engine 2-23
CIMS Conversion Engine 2-23
CIMS Data Collector 2-23
CIMS Processing Engine 2-23
CIMS Server 2-22 to 2-24
modifying an existing installation 2-25
on multiple computers, about 2-6
pre-installation procedures 2-9 to 2-16
CIMS Server Administrator 2-23
CIMS Server Web Reporting 2-23
Crystal Reports 10 8-22
Crystal Reports 9 8-21
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Crystal Reports XI 2-20 to 2-21

MSDE 2-23
internationalizing CIMS Server 2-13 to 2-16
Internet Explorer, required version 2-7
invoice number parameter setting 4-40
invoices

entering contact information for 3-25

entering organization information for 3-43

setting invoice numbers 3-47

L

license

key, entering 3-48

third-party software 2-9
ListUnusedIdentifiers.wsf script C-15
LoadClientTableFromCSVFile.wsf script C-43
localizing CIMS Server 2-13 to 2-16
logo for reports, changing 4-24

MainframeClientContactToServer.wsf script C-43

MDAC

downloading 2-22

version in CIMS Server installation 2-22
MSDE 2000

database, creating 2-27, 5-3

installing 2-23

when to use 1-12

N
normalizing CPU values 6-55 to 6-57

0

offsets for account code levels 3-7

Oracle database
CIMS Data Source for, creating 2-44 to 2-48
client requirement 2-3
Crystal Reports editions supported by 2-4
versions and platforms supported by CIMS

Server 2-5
OracleLogonTrigger.bat script C-16

P

parameters for reports
customizing 4-16 to 4-18
list of 4-38 to 4-41
password for CIMS Server Web Reporting user
default 3-28
setting 3-30
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permissions (folder)

required for accessing published reports 4-48
required for data processing 6-4
required for Web user 2-69

pre-installation checklist 2-10
process definitions

See also processing data

about 6-21

adding 6-22

processing options, setting 6-23 to 6-36
samples 2-64

processes folder

creating 2-58
path setting 3-44

processing control statements D-27 to D-28
processing data

about 6-3
account code conversion
about 6-17
example 6-46 to 6-48
options for, setting 6-42 to 6-43
table, creating 6-44 to 6-45
account codes
about 6-17
defining the identifiers used for 6-40 to 6-41
accounting dates
about 6-18
and the close date 6-18
calculation of 6-19
CIMS Processing Engine, about 6-5
CIMSACCT
about 6-6
control statements D-3 to D-13
input files, list of 6-7 to 6-8
output files, list of 6-9
CIMSBILL
about 6-11
control statements D-14 to D-26
input files, list of 6-13
output files, list of 6-14
CIMSSORT, about 6-11
control statements
CIMSACCT D-3 to D-13
CIMSBILL D-14 to D-26
processing D-27 to D-28
CPU values, normalizing 6-55 to 6-57
events, viewing 6-38
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exception file processing
about 6-17
enabling 6-43
file name setting 6-28
folder permissions required for 6-4
frequency of, suggested 6-4
in CIMS Server Administrator 6-38
include/exclude processing 6-58 to 6-63
example 6-61 to 6-63
process definitions
about 6-21
adding 6-22
process options 6-25
account code search fields 6-35
account fields 6-41
add new clients to CIMSClient table 6-35
archive process files 6-24
back load data 6-33

print proration report 6-50
process definition path 6-23
process description 6-23
process name 6-23
proration match length 6-50
proration table 6-50
proration type 6-49
remove output files before processing 6-24
run CIMSACCT option 6-24
run CIMSBILL run 6-24
use shift codes 6-33
process priority, setting 3-48
proration
about 6-49
options, setting 6-49 to 6-54
results of, viewing 6-37
setting processing options in CIMS Server
Administrator 6-21 to 6-37

check for bad file input 6-31 processing engine See CIMS Processing Engine

CIMSACCT input file 6-28

CIMSACCT input record date 6-27

CIMSACCT input record type 6-27

CIMSACCT output files 6-28

CIMSACCT trace flag 6-31

CIMSBILL input file 6-34

CIMSBILL input record date 6-32

CIMSBILL input record type 6-32

CIMSBILL output files 6-34

CIMSBILL trace flag 6-36

client search 6-35

conversion table 6-43

convert account fields to uppercase 6-41

default close day 6-32

define fields 6-42

define include/exclude fields 6-60

define include/exclude records 6-60

eliminate duplicates (from CIMS Ident File)
6-29

enable exception processing 6-43

generate ODBC INF file 6-26

include fields 6-28, 6-59

load CIMS Ident File 6-24

load CIMS Summary File 6-24

load CIMSACCT Detail File 6-25

load CIMSBILL Detail File 6-25

move fields 6-43

normalize CPU values 6-57

perform account code conversion 6-42

B Index-8

ProRate.wsf script C-18
proration
about 6-49
account code match length setting 6-50
enabling 6-49
money vs. resources 6-54
options, setting 6-49 to 6-54
report, printing 6-50
table
creating 6-50
examples 6-51 to 6-53
specifying 6-50
published reports
about 2-60, 3-45, 4-25
creating 4-25
creating a report cycle for 4-29 to 4-37
deleting 4-28
distributing 4-26
drill down in 4-50
folder structure for 4-27 to 4-28
path setting 2-60, 3-45
PDF, option for publishing as 3-47
security for 4-48
virtual directory for, creating 4-49
PurgeLoads.wsf script C-19
purging database loads 5-22, 5-23, C-19
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R

rate codes

about 3-9
adding 3-9 to 3-12
adding to rate groups 3-11, 3-19
editing 3-10 to 3-12
in the CSR or CSR+ file 1-8
moving to another rate group 3-19
rates for
calculating 7-10 to 7-16
updating in CIMS Financial Modeler 7-13
updating in CIMS Server Administrator 3-10
rebilling C-21 to C-23
removing 3-13
removing from rate groups 3-19
setting shifts for 3-13
synchronizing with CIMS Mainframe 3-16

rate groups

about 3-17

adding 3-11, 3-17 to 3-18
adding rate codes to 3-11, 3-19
changing descriptions of 3-18
changing sequence of 3-19
changing titles of 3-18

moving rate codes 3-19
removing 3-18

removing rate codes from 3-19

rate tables

alternate 3-15
adding 3-15
removing 3-15
duplicating 3-15
exporting 5-12, 5-13
exporting for mainframe C-14
loading 5-12, 5-13, C-29
STANDARD 3-9
synchronizing with CIMS Mainframe 3-16

Rateldentifiers table, updating 5-14
rates See rate codes

Rebill.wsf script C-21 to C-23
removing

account code structure levels 3-7
alternate account code structures 3-8
alternate rate tables 3-15

budgets for clients 3-24

CIMS Data Sources 5-7

client contacts 3-25

clients 3-22
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clients from user groups 3-38

cost models 7-17

cost pools and subpools 7-7

database loads 5-22, 5-23, C-19

previous CIMS Processing Engine output 6-24

rate codes 3-13

rate codes from rate groups 3-19

rate groups 3-18

rate shifts 3-14

report groups 4-22

reports from report groups 4-22

reports from reports list 4-20, 4-37

reports from user groups 3-37

unused identifiers 3-41
from the CIMSDetailldent table C-13
from the CIMSIdent table C-13

user groups 3-37

users 3-32

users from a group 3-37

Web headlines 3-39

renaming

alternate account code structure 3-8
CIMS Data Sources 5-6

cost models 7-17

report groups 4-22

report cycles

adding 4-29 to 4-37

editing 4-37

example set up for 4-42
parameters, setting 4-37 to 4-41
removing 4-37

running 4-44 to 4-47

report groups

about 4-21

adding 4-21 to 4-22

adding reports to 4-22
changing description of 4-22
removing 4-22

removing reports from 4-22
renaming 4-22

re-sorting display order of 4-23
types of 4-21

Reporting Services

components of 2-18

configuring for use with CIMS Server Web
Reporting 2-73 to 2-76

installing 2-18 to 2-20

licensing 2-9, 2-18
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system specifications
for designing reports 2-8
for running reports 2-19
troubleshooting 8-12
reports
adding to reports list 4-19 to 4-20
custom
about 1-13
path setting 3-45
designing, specifications for 2-8
editing settings 4-20, 4-30
last reporting date setting 3-46
location of 4-3
logo for, changing 4-24
parameters for 4-38 to 4-41
customizing 4-16 to 4-18
path setting
custom reports 3-45
published reports 2-60, 3-45
standard reports 3-45
published
about 2-60, 3-45
path setting 2-60, 3-45
publishing in batch 4-25 to 4-50
removing from reports list 4-20
re-sorting display order of 4-23
security, setting 3-46
standard
about 1-13
path setting 3-45
types of 4-3 to 4-6
user-defined reports default group, setting 4-23
ResourceConversion.wsf script C-21 to C-23
restoring database loads 5-22

S

SampleExportSummary.wsf script C-25
SampleSQLMaintenance.bat script C-26
Schedule.wsf script C-28
scripts
AllAccts.wsf C-40 to C-42
batch reporting C-31
BatchReport.wsf C-33 to C-39
BuildCSRFromDB.wsf C-7
BulkUserLoad.wsf C-24
CIMSLib.wsf C-8
CIMSUtil.wsf C-8
ClientPropogate.wsf C-8

B Index-10

ConvertSummaryDailyToMonthly.wsf C-9 to
C-11
CSRAggregator.wsf C-12
DropldentBeforeLoad.wsf C-13
DropldentFromDB.wsf C-13
EmailDistribution.wsf C-42
ExportClientToMainframe.wsf C-14
ExportRateToMainframe.wsf C-14
FIP.wsc C-15
FTPSample.wsf C-15
ListUnusedIdentifiers.wsf C-15
LoadClientTableFromCSVFile.wsf C-43
MainframeClientContactToServer.wsf C-43
ODBC parameters for C-44
OracleLogonTrigger.bat C-16
ProRate.wsf C-18
PurgeLoads.wsf C-19
Rebill.wsf C-21 to C-23
ReportParms.wsf C-31
ResourceConversion.wsf C-21 to C-23
running
from a batch file C-5 to C-6
from CIMS Job Runner C-3 to C-5

SampleExportSummary.wsf C-25
SampleSQLMaintenance.bat C-26
Schedule.wsf C-28
TableManager.wsf C-29
UnloadDesktopForServer.wsf C-44
ZeroCost.wsf C-30

Secure Sockets Layer See SSL, enabling for Web

site

sharing
cost models 7-16

shifts
enabling CIMSBILL to process 6-33
recalculating 6-29
removing 3-14
setting 3-13

software, suggested 2-4
client 2-7
server 2-4

SQL Server database 2-4
CIMS Data Source, creating for 2-33 to 2-40
creating 2-29 to 2-31, 5-2
simple recovery, setting 5-5
user logins, creating 2-29 to 2-32
versions supported by CIMS Server 2-5

SSL, enabling for Web site 2-70
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standard reports
about 1-13
path setting 3-45
starting
CIMS Server Administrator 2-33
CIMS Server Web Reporting 2-80
Summary File See CIMS Summary File
system specifications 2-4
client
browser 2-7
CIMS Server Administrator 2-7
Crystal Reports 2-8
Reporting Services 2-8
server 2-4

T

TableManager.wsf script C-29
tables, database
auditing 3-54
converting daily summary data to monthly
summary data C-9 to C-11
creating 5-14
description of A-4 to A-51
dropping 5-14
ERDs (Entity Relationship Diagrams) A-52 to
A-57
exporting 5-12
loading 5-12
profiling 5-25
purging load data from C-19
viewing 5-14
technical support 8-23
trace flag option
for CIMSACCT 6-31
for CIMSBILL 6-36
transactions
auditing 3-54
parameters for, customizing 4-16 to 4-18
troubleshooting 8-3 to 8-17

u

UnloadDesktopForServer script C-44
updates, downloading 2-84
upgrading

CIMS Server 2-26

the CIMS Server database 5-26
use bulkload interface 6-25
users and groups

CIMS Server Administrator's Guide

about 3-28
groups
adding 3-33
assigning administrative privileges for 3-28,
3-34
clients, adding 3-38
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